Using
ADOBE® CONNECT™ 9
Legal notices
# Contents

## Chapter 1: What's new in Adobe Connect 9.4
- Seminar Administrators ................................................................. 1
- Webinar Manager ........................................................................... 1
- Virtual Classroom Managers .......................................................... 1

## Chapter 2: Adobe Connect Meeting
- Adobe Connect popular How To topics ............................................. 3
- Meeting basics ............................................................................... 4
- Accessibility features ..................................................................... 6
- Creating and arranging meetings ...................................................... 13
- Starting and attending meetings ...................................................... 18
- Updating meetings ......................................................................... 24
- Viewing data about meetings ........................................................ 30
- Sharing content during a meeting .................................................... 33
- Notes, chat, Q&A, and polls ............................................................ 52
- Breakout rooms ............................................................................. 61
- Managing attendees ....................................................................... 66

## Chapter 3: Adobe Connect Training and Seminars
- About Adobe Connect Training ....................................................... 71
- Creating training courses ................................................................. 77
- Creating training curriculums ........................................................... 84
- Creating virtual classrooms .............................................................. 96
- Monitoring training with reports .................................................... 102
- Conducting training with Adobe Connect ........................................ 108
- Participating in training sessions and meetings ............................... 111
- Creating and managing seminars .................................................. 114

## Chapter 4: Adobe Connect Events
- About Adobe Connect Events ........................................................ 122
- Creating and editing events ............................................................. 125
- Managing events ............................................................................ 148
- Attending Adobe Connect Events .................................................. 160

## Chapter 5: Audio and video conferencing
- Audio in meetings .......................................................................... 163
- Video in meetings .......................................................................... 174
- Recording and playing back meetings ........................................... 178
- Adobe Connect Webcast ................................................................. 186

## Chapter 6: Managing content
- Working with library files and folders ......................................... 187
- Working with content in the Content library .................................. 190
- Viewing data about content .......................................................... 196

Last updated 3/20/2015
Chapter 7: Administering Adobe Connect

Getting started administering accounts ................................................................. 200
Adobe Connect Central How To Topics ............................................................... 216
Configure audio providers for universal voice ..................................................... 217
Configure video telephony devices ...................................................................... 222
Change the timeout period ................................................................................... 223
Access MP4 conversion queue .............................................................................. 223
Enhancing Adobe Connect account security ......................................................... 224
Creating and importing users and groups ............................................................. 224
Managing users and groups .................................................................................. 232
Setting permissions for library files and folders .................................................. 237
Generating reports in Adobe Connect Central ...................................................... 247
Chapter 1: What’s new in Adobe Connect 9.4

Adobe® Connect™ is a web conferencing solution for web meetings, e-learning, and webinars. It powers mission critical web conferencing solutions end-to-end, on virtually any device, hence boosting productivity within the organizations. The latest release of Adobe Connect provides new user groups and bug fixes across different areas of the product. Below is a summary of the new features.

Seminar Administrators

Adobe Connect 9.4 onwards, Seminar Hosts group is renamed as Seminar Administrators. Also, the group members now have access to the Event Management section and to Shared Webinar rooms in the Shared Seminar section.

Webinar Manager

Adobe Connect 9.4 introduces three new groups titled Webinar Manager 100, Webinar Manager 500, and Webinar Manager 1000. The numbers indicate the maximum participant capacity in a webinar created by a respective manager. These groups are available as system groups with membership driven by the number of licenses provisioned in any account. A user can be a member of only one of these three groups at a time.

Any group members can access My Seminars, Seminar Sessions, Seminar Calendar, and Seminar Dashboard tabs. The members can create seminars in the My Seminar tab within the license they own. Also, the members cannot access the seminars they do not have access to.

Virtual Classroom Managers

Another new group introduced in Adobe Connect 9.4 is called Virtual Classroom Managers to simplify the creation and management of Virtual Classrooms. Members of this new group can create virtual classrooms with a capacity of up to 200 participants in the My Trainings section. The group members also have access to the Event Management section. The following screenshot displays the groups:
New groups in Adobe Connect 9.4 include VC Managers and Webinar Managers
Chapter 2: Adobe Connect Meeting

Adobe Connect popular How To topics

**How To topics for Hosts and Presenters**

- “Create and use audio profiles” on page 164
- “Create meetings” on page 13
- “Start meetings” on page 18
- “Start meeting audio” on page 168
- “Join audio conference” on page 169
- “Record a meeting” on page 178
- “Invite attendees and grant or deny access” on page 19
- “Share your screen” on page 35
- “Share a document or PDF” on page 40
- “Share a presentation” on page 42
- “View or change an attendee’s role” on page 66
- “Taking notes in a meeting” on page 52
- “Chat in meetings” on page 54
- “Place a meeting on hold or end a meeting” on page 23

**How to topics for Participants**

- “Join a meeting” on page 22
- “Adjust or mute audio volume” on page 171
- “Join audio conference” on page 169
- “Broadcast your voice using VoIP” on page 170
- “Share webcam video” on page 175
- “Share your screen” on page 35
- “Chat in meetings” on page 54
- “Attending virtual classroom training” on page 113
- “Play back a recorded meeting” on page 182

Last updated 3/20/2015
Meeting basics

About meetings
Adobe Connect™ Meeting is a live online conference for multiple users. The meeting room is an online application that you use to conduct a meeting. The meeting room consists of various display panels (pods) and components. There are several prebuilt meeting room layouts, or customize a layout to suit your needs. The meeting room lets meeting attendees share computer screens or files, chat, broadcast audio, and video, and participate in interactive online activities.

Once you create a meeting room, it exists until you delete it. The meeting room location is a URL, assigned by the system when the meeting is created. When you click the URL, you enter the virtual meeting room. A meeting room can be used over and over for the same weekly meeting. The host can leave the meeting room open or closed between scheduled meetings. If a meeting room is open between meetings, attendees are free to enter the room at any time to view content.

To take part in a meeting you must have a browser, a copy of Flash® Player 10 or higher, and an Internet connection. Your capabilities in a meeting depend on your assigned role and permissions.

More Help topics
“Creating and arranging meetings” on page 13
“Starting and attending meetings” on page 18
“Meeting room templates and layouts” on page 14

Inside a meeting room
Content in a meeting room is displayed in pods, which are panels that contain various types of media. Individual pods contain a list of those attending the meeting, notes, chat, files, and video. A host can send attendees from the main meeting room to breakout rooms (smaller meetings) to collaborate as a small group.

A second display area, the Presenter Only area, is visible to hosts and presenters, not attendees. Hosts and presenters can use the Presenter Only area to prepare content to be shared with attendees or to view confidential content.

To display the Presenter Only area, choose Meeting > Enable Presenter Only Area.

The menu bar contains several menus. A host sees the Meeting, Layouts, Pods, Audio, and Help menus. A presenter or participant sees only the Meeting and Help menus. Messages and warnings also appear in this corner. A red circle in the menu bar indicates that the host is recording the meeting. The Secure Sockets Lock indicates that the meeting is connected over a secure socket (verifying the host server’s identity)

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

In-meeting options for the participants

In-meeting options for the hosts and the participants
Connection status in a meeting room
At the far right edge of the menu bar, the colored bar indicates the connection status of the meeting room. The connection status also conveys information about your meeting connection.

A sample connection status in the meeting room

A connection made using RTMP or RTMPS is distinguished by showing a lock icon over a green bar. A 'T' after the latency details, indicates that the connection is tunneled over HTTP. If the latency value is high, the streams you receive (camera, screen share, and so on) may be slightly delayed.

More Help topics
“Work with pods” on page 20

Meeting roles and permissions
Your role determines your capabilities for sharing, broadcasting, and other activities in an Adobe Connect Meeting. There are three roles for meeting room attendees: host, presenter, and participant. Icons in the Attendees pod let you identify the role and if they are connecting from mobile devices.

The creator of a meeting is designated as the host by default. The host can specify each attendee's role, including selecting other attendees to be hosts for the meeting. Permissions for each role are as follows:

**Host**  
Hosts can set up a meeting, invite guests, add content to the library, share content, and add or edit layouts in a meeting room. They can promote other participants to the role of meeting room host or presenter, or give enhanced permissions to a participant without promoting the participant. Hosts can start, stop, join, and leave audio conferences. They can also start and stop broadcasting audio into a meeting room. Hosts are able to create and manage small group breakout rooms within a meeting. They can also perform all the tasks that a presenter or participant can.

**Presenter**  
Presenters can share content already loaded into the meeting room from the library. They can share content from their computer. Shared content includes Adobe ® Presenter presentations (PPT or PPTX files), Flash ® application files (SWF files), images (JPEG files), Adobe PDF files, MP3 files, and FLV files. They can share their screen with all attendees, chat, and broadcast live audio and video. Presenters can mute audio broadcasts on their computers.

**Participant (Registered)**  
Registered participants can view the content that the presenter is sharing, hear, and see the presenter’s audio and video broadcast, and use text chat. Participants can mute audio broadcasts on their computers.

**Participant (Guest)**  
Guest participants can view the content that the presenter is sharing, hear, and see the presenter’s audio and video broadcast, and use text chat. Participants can mute audio broadcasts on their computers.

More Help topics
“Assign enhanced participant rights” on page 68
About the Meetings library
The Meetings tab in Adobe Connect Central contains three panes for accessing meetings: Shared Meetings, User Meetings, and My Meetings. Each pane contains folders and files with meeting content and recordings. Users can create and manage content in the My Meetings pane that appears when they are logged in to Adobe Connect Central. You can determine access to content in the other panes by the meeting library permissions set for each user by the Adobe Connect Central administrator.

Content that you place in the Meetings library is available only for use in meetings. To make the content available for other activities initiated in Adobe Connect Central (such as events, seminars, or training), upload the content to the Content library. Alternatively, move content from the Meetings library to the Content library.

More Help topics
“Working with content in the Content library” on page 190
“Content library supported file types” on page 190

Accessibility features
People with disabilities, for example mobility impairments, blindness, and low vision require accessible documents or applications. Accessibility features in Adobe Connect enable people with disabilities to use the Meeting functionality as much as possible without a mouse.

More Help topics
Adobe Connect Accessibility information
Accessibility tutorial
Accessibility whitepaper

Menu navigation
You can use a keyboard to navigate to the menus at the top of the Meeting client (Application Bar menus) and execute the menu options.

- Ctrl+Space activates the Meeting menu.
- The Left and the Right arrow keys activate adjacent menus on the Application Bar.
- The Down arrow key activates the current menu. To select an item within the menu, use the Down, Up, Left, and Right arrow keys.
- Enter selects the current menu item.
- Escape key closes the current menu.

Keyboard shortcuts
The following keyboard shortcuts provide improved accessibility so that the Adobe Connect Meeting client can be used as much as possible without a mouse.

Important: In Microsoft Internet Explorer, for the keyboard shortcuts of the format Ctrl + <alphanumeric character>, use Alt key too, that is, the shortcut is Ctrl + Alt + <alphanumeric characters>. For example, to undo use Ctrl + Alt + Z, instead of Ctrl + Z.
Shortcuts for screen sharing dialog

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch to different tabs (in Aero mode only)</td>
<td>Ctrl+Tab</td>
<td></td>
</tr>
<tr>
<td>Move to different applications or focus</td>
<td>Tab</td>
<td></td>
</tr>
<tr>
<td>Select or deselect an application check box</td>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>Make Share pod for attendees</td>
<td>Alt+P</td>
<td></td>
</tr>
<tr>
<td>Share content</td>
<td>Alt+H</td>
<td></td>
</tr>
<tr>
<td>Cancel a session</td>
<td>Alt+C</td>
<td></td>
</tr>
<tr>
<td>Movement</td>
<td>Arrow keys</td>
<td></td>
</tr>
<tr>
<td>Select desktop in Non-aero mode</td>
<td>Alt+D</td>
<td></td>
</tr>
<tr>
<td>Select applications in Non-aero mode</td>
<td>Alt+A</td>
<td></td>
</tr>
<tr>
<td>Select windows in Non-aero mode</td>
<td>Alt+W</td>
<td></td>
</tr>
</tbody>
</table>

Shortcuts for attendee management

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift focus to the active speaker label, effectively pointing to speaker activity.</td>
<td>Ctrl+H</td>
<td>Command+H</td>
</tr>
<tr>
<td>Toggles Raise-Hand status</td>
<td>Ctrl+E</td>
<td>Command+E</td>
</tr>
<tr>
<td>Promote to host. Requires selected items in Attendees pod</td>
<td>Ctrl+’</td>
<td>Command+’</td>
</tr>
<tr>
<td>Demote to participant. Requires selected user in Attendees pod</td>
<td>Ctrl+]</td>
<td>Command+]</td>
</tr>
<tr>
<td>Promote to Presenter. Requires selected user in Attendees pod</td>
<td>Ctrl+/</td>
<td>Command+/</td>
</tr>
<tr>
<td>End meeting</td>
<td>Ctrl+\</td>
<td>Command+\</td>
</tr>
</tbody>
</table>

Shortcuts for navigating pods, menus, and windows

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle between notification window and meeting room</td>
<td>F8</td>
<td>F8</td>
</tr>
<tr>
<td>Bring focus to the application menu bar for keyboard navigation.</td>
<td>Ctrl+Space</td>
<td>Command+F2</td>
</tr>
<tr>
<td>Move focus to next / previous pod</td>
<td>Ctrl+F6 / Ctrl+Shift+F6</td>
<td>Command+F6 / Command+Shift+F6</td>
</tr>
<tr>
<td>Display pod menu for keyboard navigation</td>
<td>Ctrl+F8</td>
<td>Command+F8</td>
</tr>
<tr>
<td>Retitle pod</td>
<td>F2</td>
<td>F2</td>
</tr>
</tbody>
</table>

In Windows, press Ctrl+F9 to display a pod if overlapping pods hide it.

Shortcuts for audio and recordings

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggles Microphone on or off</td>
<td>Ctrl+M</td>
<td>Command+M</td>
</tr>
</tbody>
</table>

Last updated 3/20/2015
### Shortcuts for Adobe Presenter content in the Share pod

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/Stop Recording. For Start, brings up the Start Recording Dialog</td>
<td>Ctrl+5, Command+5,</td>
<td></td>
</tr>
<tr>
<td>Toggles Play/Pause during playback of recorded meetings</td>
<td>P</td>
<td>P</td>
</tr>
</tbody>
</table>

### Shortcuts for the whiteboard

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/Stop Desktop Sharing</td>
<td>Ctrl+{ (Windows)</td>
<td>Command+{ (Mac OS)</td>
</tr>
<tr>
<td>Next page/slide</td>
<td>Page Up or Right Arrow</td>
<td>Page Down or Left Arrow</td>
</tr>
<tr>
<td>Previous page/slide</td>
<td>Page Down or Left Arrow</td>
<td></td>
</tr>
<tr>
<td>Play/Pause</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Stop</td>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>Mute</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>Change view</td>
<td>F</td>
<td>F</td>
</tr>
</tbody>
</table>

### Shortcuts for the Chat pod

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift the focus to the input field of the Chat pod that announced a new public message via chat sounds.</td>
<td>Ctrl+Shift+O</td>
<td>Command+Shift+O</td>
</tr>
<tr>
<td>Select and open the tab of the Chat pod that announced a private message via chat sounds.</td>
<td>Ctrl+Shift+O</td>
<td>Command+Shift+O</td>
</tr>
<tr>
<td>Place focus on Chat pod, activate cursor in new message field</td>
<td>Ctrl+;</td>
<td>Command+;</td>
</tr>
<tr>
<td>When cursor is in new message field, sends message</td>
<td>Enter</td>
<td>Return</td>
</tr>
</tbody>
</table>
Shortcuts for the Notes pod

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Underline text</td>
<td>Ctrl+U</td>
<td>Command+U</td>
</tr>
<tr>
<td>Italicize text</td>
<td>Ctrl+I</td>
<td>Command+I</td>
</tr>
<tr>
<td>Place text in boldface</td>
<td>Ctrl+B</td>
<td>Command+B</td>
</tr>
</tbody>
</table>

Shortcuts for dialog boxes

<table>
<thead>
<tr>
<th>Result</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close or cancel a dialog box</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Execute the default action (defined per dialog)</td>
<td>Enter</td>
<td>Return</td>
</tr>
</tbody>
</table>

Accessibility in the pods

You can navigate among the visible pods entirely by keyboard.

- To bring a pod in the focus, use Ctrl + F6 keyboard shortcut.
- Keep pressing Ctrl + F6 for the focus to cycle through the available pods a meeting room. A colored border around a pod indicates that the pod is focused.

Certain pods have a default field that assumes focus. For example:

- **Chat pod**  Focus defaults to the new message field. Select the option Reverse order of messages to allow the screen reader to read the messages in the reverse order, that is, from the latest to the first message.
- **Notes pod**  Focus defaults to the note letting you change the message.
- **Attendees pod**  Focus defaults to the selected users in the list, or to the first user in the list if no users are selected.
Once a pod is in focus, you can use Tab to navigate inside the pod or press Ctrl + F8 to access the Pod Option menu. When the Adobe Connect client starts, the default focus is set to the Message entry area of the visible Chat pod, if one is available. The Adobe Connect client may lose focus (for example, if you switch to another application) and later regain the focus. In this case, the Meeting application defaults back to the Message entry area of the visible Chat pod.

**Change the role of a participant from the Attendee pod**

1. To bring a pod in the focus, use Ctrl + F6 keyboard shortcut.
2. Keep pressing Ctrl + F6 for the focus to cycle through the available pods a meeting room. A colored border around a pod indicates that the pod is focused.
3. Once Attendee pod is selected, press Tab a few times to highlight the area listing the participants.
4 Use arrow keys to expand the relevant section, to highlight the user, and select the required role.

5 Use the arrow keys to select a meeting attendee.

6 Once the attendee is announced, press Ctrl + F8 to navigate to the Pod Options menu. Use the arrow keys to navigate the Pod Menu options.

7 Once the Attendee Options submenu is announced, press the right arrow key to access the submenu and then press the down arrow key until you hear the announcement of the privilege you wish to grant. Hit enter when you reach the appropriate option.

**Answer a poll question in the Poll pod**

1 To bring a pod in the focus, use Ctrl + F6 keyboard shortcut.

2 Keep pressing Ctrl + F6 for the focus to cycle through the available pods a meeting room. A colored border around a pod indicates that the pod is focused.

3 After selecting the Poll pod, depending on the type of the poll created, do one of the following:

   **Multiple Answers** Press Tab to highlight the first checkbox and then arrow keys to move to the other checkboxes. Press Space to select a highlighted checkbox. The selection is automatically submitted. To undo a selection, highlight the checkbox and press Space.

   **Multiple Choice** Press Tab to highlight the first radio button, use arrow keys to highlight the required option, and press Space to submit the selection. To change your submission, highlight a different radio button using the arrow keys and press Space.

   **Short Answer** Press Tab to highlight the text field, type your short answer, press Tab to highlight the Send Answer button, and press Space to submit the answer. To update your submitted answer, retype a new answer and submit it. It overwrites your previous submission.
Accessibility-related account settings

Adobe Connect Administrators can update a few account-wide settings to improve the accessibility of users using the deployment. The administrators can customize the color theme of the login screen, meeting rooms, and of the Adobe Connect Central user interface to better suit the needs of the differently abled users.

Also, administrators can change the color of the border to highlight the focused pods.

Customize the color of the border of the selected pods to improve accessibility
Creating and arranging meetings

Create meetings

You create meetings in Adobe Connect Central. You can create meeting rooms to which you return repeatedly for your own use, and leave persistent content in the meeting room. To incorporate registration as part of your meeting, you must have the Event Management tab. See “About Adobe Connect Events” on page 122.

Your account administrator can request for a large webinar for 1500 participants using a separate license. If the Adobe Connect administrators approve the request, you receive a meeting room URL. Use this URL to create an event registration system.

You can use the meeting room anytime to run 25 participant meetings for trial. Configure the meeting room with content/layouts before you start the meeting. However, participants can log in to the meeting 15 minutes before the scheduled time of the meeting. Smaller meetings can be run at any time, without scheduling, if a meeting room is created.

1. Create an audio profile (for audio conferences)

Use the My Audio Profiles window (My Profile > My Audio Profiles) to configure an audio profile to use with an audio conference. Audio profiles use the conference settings associated with the selected audio provider to start the audio conference. See “Create and use audio profiles” on page 164.

2. Start the Meeting wizard

You have two options for starting the Meeting wizard. To create the meeting in your individual My Meetings folder, navigate to the Adobe Connect Central home page. On this page, locate the Create New menu bar, and click Meeting. To create your meeting in another folder for which you have Manage permission, navigate to that folder in the Meetings library. Then click the New Meeting button.

3. Enter meeting information

On the first page of the Meeting wizard, enter details about the meeting. These details include a name, custom URL, summary, date, duration, template, language, access restrictions, and audio conference settings (Only the name and language are required). If available, you can select an audio profile from the pop-up menu instead of manually entering audio conference settings. For more information about audio profiles, see “Create and use audio profiles” on page 164.

Enable opt out to provide an option to the participants to not provide non-explicitly submitted information to hosts. When participants choose to opt out, Adobe Connect excludes engagement index and private chat message count from the meeting reports.
See also
“Opt out from tracking” on page 154
The Rules of Engagement

4. Select meeting participants
Use the Available Users And Groups list to add participants. Find participants by name and expand groups to select individuals in the group. If you want, assign roles by selecting participant names and clicking Permissions from the bottom of the current participants list. Then, proceed to the final step of sending invitations or exit the wizard to send invitations later.

5. Send invitations
The wizard guides you through two separate processes, depending on whether the meeting is open to registered users only or to anyone. If the former, you select Send Invitations, select a group to invite (for example, hosts only), and edit the text that appears in the email message. You have the option of including a Microsoft Outlook calendar appointment. If the latter, you click Send E-Mail Invitations, which open your email application, and add invitees to the distribution list of your email message.

Note: Adobe Connect is unable to send a meeting invite for a meeting where the character count for the content to send to the email client is more than 1000 characters. The issue is related to HTML tag mailto, as browsers cannot launch an email client when the content exceeds 1000 characters.

More Help topics
“Edit meeting information” on page 27
“Viewing data about meetings with the dashboard” on page 30

Meeting room templates and layouts
A template is simply a meeting room that has already been designed. It can contain one or several layouts with different display panels (or pods), configurations, and content. Layouts can be optimized for a specific task, such as presenting slides or collaborating with peers. Leverage existing layouts and content to reduce repetitive customization each time you create a meeting. Create your own templates or use the default templates included in Adobe Connect.

To help you quickly create a meeting room, Adobe Connect offers three built-in templates: Default Meeting, Default Training, and Default Events. When creating a meeting by using the New Meeting wizard in Adobe Connect Central, select one of these three templates for your meeting room. Then, add your content, and start your meeting.

When you create a meeting room from a template, the latest version of the content is added to your room. If you edit the source file for the embedded content, the changes do not affect the content in your room. To update the content in your meeting room, upload the revised file to the Adobe Connect Server. Then, replace the existing content in the meeting room with the revised content on the server.

Default Meeting template General template for meetings. It contains three layouts: Sharing, Discussion, and Collaboration. The Sharing layout is optimized for sharing content (Microsoft PowerPoint presentations, video, Adobe PDF, and so on). The Discussion layout is optimized for discussing issues interactively and taking notes. The Collaboration layout is optimized for annotating content and drawing freehand on content.
Default Training template  Used for online collaborative instruction and virtual classrooms. It contains three layouts: Lobby, Classroom, and Analysis. The Lobby layout is a place to exhibit a self-running presentation or display other preliminary content. Leave the Lobby layout open so that attendees can browse its content while waiting for the meeting to begin. From the Classroom layout, present PowerPoint slides, share your screen, or share a whiteboard. The Analysis layout enables you to collaborate with students, provide files to download and links to browse, and use a whiteboard for instruction. Default Training template and Default Virtual Classroom Template are available in the Shared Training Templates folder, latter being the default template for Virtual Classrooms.

Default Events template  Used for meetings or seminars with a large audience. It contains three layouts: Lobby, Presentation, and Questions And Answers. The Lobby layout is a place to play music, exhibit a self-running presentation, or display other preliminary content. Leave the Lobby layout open so that attendees can browse content while waiting for the meeting to begin. From the Presentation layout you present PowerPoint slides, share your screen, or show a whiteboard. The Questions And Answers layout facilitates an open Q&A session with participants.

Information preserved in a template
A meeting room converted to a template is a duplicate of the original room. Layouts, pods, room information, and most types of content are preserved in the template, including the following:

- Layouts with name, order, and starting (selected) status
- Pods with name, size, position, and settings for full-screen toggle
- Pod content
- Page number in PDF files and position of the seek bar in FLV files
- Whiteboard overlay contents
- Poll state (Prepare, Open, Close), questions, answers, and broadcast results
- Questions and answers, Chat pod link, and status (Open, Answered, All)
- Text in Notes pod
- Video settings
- Room on hold (Yes, No)
- Value for guest entry
- Messages displayed to users when a meeting is on hold or ended
- Room background, screen resolution, and bandwidth
- Presenter Only area status
- Contact invitees description
• All the settings of and changes to the breakout rooms. Also, these settings are carried forward when the template is used to create a meeting.

Certain information is not saved to the template. Audio conference settings, Audio Setup wizard settings, and the content of a Chat pod are not saved to a template.

**Apply a template to a new meeting**

1. On the Adobe Connect Central home page, in the Create New menu bar, click Meeting.
2. On the Enter Meeting Information page, next to Select Template, click the menu and make a selection. (The Shared Templates\Default Meeting Template is the default.)

**Convert a meeting room to a template**

If you are a host, you can create a meeting room template. To add a meeting room to the Shared Template folder, you must have manager permissions for the folder. By default, you have full control over meetings and templates in your user meeting folder.

1. From the Meetings tab in Adobe Connect Central, navigate to the meeting room you want to convert.
2. Select the check box next to the meeting room.
3. On the navigation bar, click Move.

Two columns are displayed in Adobe Connect Central. The name of the meeting room is displayed in the left column. In the right column, under the heading Move to This Folder, User Meetings > [your account] is selected by default. If you want to use this folder, go to step 5.

4. Navigate to and select a template folder, such as the Shared Template folder.
5. Click Move at the bottom of the column.

Your meeting room now resides in the template folder that you selected. The template is added to the list in the appropriate folder.

When you create a meeting with the New Meeting wizard, you can select the template you created from the Select Template menu. You can customize this room just like any other to meet your needs. Once the meeting is created, you cannot apply a new template to it. Instead, create a meeting by using the new template.

**Create layouts**

The Layouts menu and the Layout bar are visible only to hosts. The default layouts are Sharing, Discussion, and Collaboration.

- To create a blank layout to which you manually add pods, or a duplicate of an existing layout, do one of the following:
  - Choose Layouts > Create New Layout
  - Click in the Layout bar

**Manage layouts**

The default layouts are Sharing, Discussion, and Collaboration. You can delete, rename, or change the order of the layouts.

**Rename a layout**

1. To rename a layout, choose Layouts > Manage Layouts.
2. In the Manage Layouts dialog box, select a layout.
3 Click Rename and enter a new name.

Double-click the layout name in the Layout bar and then enter a new name.

Delete a layout
1 To delete a layout, choose Layouts > Manage Layouts.
2 In the Manage Layouts dialog box, select a layout.
3 Click Delete and confirm.

In the Layout bar, move the pointer over the layout and then click the X icon that appears to delete it.

Note: If you delete a layout that is currently in use, default Sharing layout is applied to the meeting.

Reorder layouts
1 To change the order the layouts, choose Layouts > Manage Layouts.
2 In the Manage Layouts dialog box, select a layout.
3 Click Up or Down buttons to reorder the layouts.

Drag the layout preview in the Layout bar to change the order of the layouts.

Change layouts during a meeting
The Layouts menu and the Layout bar are visible only to hosts. The default layouts are Sharing, Discussion, and Collaboration. Any custom layouts are also listed. The Layout bar also displays thumbnails for the layouts. When a host chooses a different layout, the new layout appears on every attendee’s screen.

❖ To change the layout, do one of the following:
  • Choose Layouts > [Layout Name]
  • Click a layout in the Layout bar.

Note: If the layouts don’t fit in the Layout bar, scroll through them and hover the pointer over the first or the last preview. You can also use the panning options or the mouse wheel to scroll through.

Adjust layouts during a meeting
During a meeting, hosts can adjust layouts without affecting the active layout currently visible to attendees.

1 Choose Meeting > Switch to Prepare Mode. Alternatively, click $\$\$ in the Layout bar.
2 From the Layouts menu or the Layout bar, choose the layout you want to adjust. Then move, hide, or show pods as needed.
3 When you finish adjusting the layout, choose Meeting > End Prepare Mode or click $\$\$ in the Layout bar.

Choose a background image for the meeting room
You can replace the default gray background with an image.

1 Choose Meeting > Preferences.
2 Click upload, then navigate to the desired image. If you haven’t previously added the file to Adobe Connect, click Browse My Computer.
Reset Layouts
Reset layouts to revert to the default layouts. Any modifications to the Sharing, Discussion, and Collaboration layouts are reverted, and custom layouts are deleted.

❖ Choose Layouts > Reset Layouts.

*Note: You cannot reset layouts if a meeting is being recorded.*

Specify Layout bar options
Layout bar options let you specify the docking position, and Auto hide settings. Do one of the following:

❖ From the Layout bar menu, choose one of the following:

Dock to the left Enable user to dock the Layout Bar to the left edge of the meeting room window.

Dock to the right Enable user to dock the Layout Bar to the right edge of the meeting room window.

Auto Hide Enable to Auto Hide the Layout Bar. Click 📌 to pull out the Layout Bar.

Starting and attending meetings

Start meetings
If you are host, start a meeting by logging in to your meeting room and then invite others through email or instant message. Meetings can be spontaneous or prearranged.

When you enter a meeting room, you can perform setup tasks for attendees. For example, specify conference information, accept or decline requests to join the meeting, rearrange pods, and type notes.

More Help topics
“Place a meeting on hold or end a meeting” on page 23
“Create and use audio profiles” on page 164

Enter a meeting room
❖ Do one of the following:

• From the home page in Adobe Connect Central, click My Meetings, and click the Open button for the desired meeting.

• In Adobe Connect Central, navigate to the Meeting Information page for a specific meeting and click Enter Meeting Room.

• Click the meeting URL in the email invitation that you have received. Type your Adobe Connect login and password, and then click Enter Room.

• Enter the meeting URL in your browser. Type your Adobe Connect login and password, and then click Enter Room.

💡 The first time you visit a meeting room, bookmark it for quick access the next time you want to start a meeting.
Start a meeting using the Start Meeting button
The Start Meeting button is included in software applications such as Adobe Acrobat 8, Adobe Reader 8, and some Microsoft Office programs. As a meeting host, use the Start Meeting button to access your meeting room login screen or to set up a new Adobe Connect account.

Note: In Acrobat 9 and Reader 9, you can use Adobe ConnectNow, a personal web-conference tool, for online meetings.

1. Click Start Meeting.
2. If the Welcome To Start Meeting dialog box appears, click Create Trial Account to set up a new account. Alternatively, click Log In if you already have an account.
3. In the Start Meeting Log In dialog box, type your meeting URL, login, and password, and click Log In.

Note: In Acrobat 8 or Reader 8, your meeting preferences determine how much login information you have to enter before your meeting room opens. To change your Acrobat or Reader meeting preferences, select Edit > Preferences (Windows) or Acrobat > Preferences or Reader > Preferences (Mac OS). Then select Meeting on the left.

More Help topics
“Place a meeting on hold or end a meeting” on page 23

Set meeting room bandwidth
The bandwidth consumed by a meeting room is governed by the video quality set in the meeting preferences by the Hosts. Go to Meeting > Preferences, click Video, and set the Video Quality using the slider. Also, Hosts can set the quality for screen sharing to optimize bandwidth usage. Go to Meeting > Preferences, click Screen Share, and set the Quality using the slider.

Choose a room video and audio quality that matches the connection speed used by attendees. If attendees are using various connection speeds, choose the lowest quality to ensure that all participants have a good connection.

1. Choose Meeting > Preferences.
2. In the list on the left, select Room Bandwidth. Then select one of the following options:
   - **LAN** One presenter can generate around 250 kbits/second of data. Attendees need around 255 kbits/second. If screen sharing is used, attendees should have 400 kbits/second.
   - **DSL/Cable** One presenter can generate around 125 kbits/second of data. Attendees need around 128 kbits/second for a good connection. If screen sharing is used, attendees should have 200 kbits/second.
   - **Modem** One presenter can generate around 26 kbits/second of data. Attendees need around 29 kbits/second for a good connection. Having more than one presenter with the Modem setting is not recommended. Screen sharing with the Modem setting is not recommended.

Invite attendees and grant or deny access
While in the meeting room, hosts can invite people to attend a meeting. A host can choose to block access to a meeting, and allow or disallow requests to enter a blocked meeting.

More Help topics
“View and modify a participant list” on page 25
Invite attendees while a meeting is in progress
Hosts can invite people to a meeting from the Adobe Connect Meeting room.

1. In the menu bar, select Meeting > Manage Access And Entry > Invite Participants.
2. In the Invite Participants dialog box, do one of the following:
   • Click the Compose E-mail button to open your default email application and send invitees an automatically generated email message with the meeting URL.
   • Copy the meeting URL from the Invite Participants dialog box into an email or instant message and send the message to invitees. Return to the meeting room and click Cancel to close the dialog box.

Allow participants to join without host permitting each entry
You can set up a meeting room to automatically allow the participants in the meeting room, without any intervention from the meeting hosts. When creating a new meeting, select Anyone who has the URL for the meeting can enter the room in the Access section. For an existing meeting, go to Edit Information and make the same selection.

Block incoming attendees
1. In the menu bar, select Meeting > Manage Access and Entry > Block Incoming Attendees.
2. To allow incoming attendees to request entry to the meeting, select Incoming Attendees Can Request Entry.
3. (Optional) In the text box, edit the message for incoming attendees. Select Save Message to save the message for future use.

Block guests who lack registered Adobe Connect accounts
❖ In the menu bar, select Meeting > Manage Access and Entry > Block Guest Access.

Work with pods
Hosts can show and hide, add, delete, rearrange, and organize pods. More than one instance of a pod (except the Attendees and Video pods) can be displayed in a meeting at the same time.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Share your screen” on page 35
“Share content in the Share pod” on page 33

Show or hide a pod
• To show a pod, select it from the Pods menu. (For pods that can have multiple instances, select the instance name from the submenu.)
   A check mark appears next to the name of pods that are currently visible in the meeting.
• To hide a pod, deselect it in the Pods menu. Or click the menu icon ☐ in the upper-right corner of the pod, and choose Hide.
Add a pod
1. In the menu bar, select Pods and select the name of a pod.
2. From the pod submenu, select New [pod name] Pod.

Move and resize pods
1. In the menu bar, select Pods > Move And Resize Pods. A check mark appears next to the option when it is selected.
2. To move a pod, drag it by its title bar. To resize a pod, drag the lower-right corner.

Display a pod at maximum size
When you maximize a pod, it expands to fill the current browser window.
1. In the upper-right corner of the pod, click the menu icon , and select Maximize.
2. To restore the pod to its original size, click the menu icon again, and select Restore.

To expand the Share pod beyond the current browser window to the edge of the display, click the Full Screen button.

Organize pods
1. In the menu bar, select Pods > Manage Pods.
2. Do one of the following:
   • To delete pods, select them from the list, and click Delete.
   • To rename a pod, select it from the list, and click Rename.
   • To locate all unused pods, click Select Unused. Any unused pods are highlighted in the list on the left. Click Delete if you want to remove the unused pods.
3. Click Done.

Join as a first-time Adobe Connect user
New users, who log in for the first time, are guided through the user interface depending on their role in the system. The rules that govern a new users’ destination in Adobe Connect, upon their first login, are listed below.

<table>
<thead>
<tr>
<th>Group membership</th>
<th>Directed here upon first login</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Hosts only</td>
<td>New system generated meeting</td>
</tr>
<tr>
<td>Meeting Hosts, along with any other membership</td>
<td>New system generated meeting</td>
</tr>
<tr>
<td>Training Managers only</td>
<td>Training tab</td>
</tr>
<tr>
<td>Authors only</td>
<td>Content tab</td>
</tr>
<tr>
<td>Seminar Administrators only</td>
<td>Seminar tab</td>
</tr>
<tr>
<td>Learners only</td>
<td>Home tab</td>
</tr>
<tr>
<td>Event Managers only</td>
<td>Events tab</td>
</tr>
<tr>
<td>Event Administrators only</td>
<td>Home tab</td>
</tr>
</tbody>
</table>
When a user is taken to a new system generated Meeting room, the user can either enter a more meaningful name and URL for the Meeting room. Alternatively, the user can continue with the system generated name and the URL. Also, the user can click More Settings, in the left pane, to launch Adobe Connect Central and configure the meeting room. For example, if the user, as a meeting host, wants to associate an audio profile with the meeting room.

<table>
<thead>
<tr>
<th>Group membership</th>
<th>Directed here upon first login</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any combination of two or more memberships, not including Meeting Hosts group</td>
<td>Home tab</td>
</tr>
<tr>
<td>Administrators, Administrators – Limited, or both</td>
<td>Home tab</td>
</tr>
<tr>
<td>Any role along with one or more of the administrator roles (Administrators, Administrators – Limited, and Event Administrator)</td>
<td>Applicable tab depending on the role</td>
</tr>
</tbody>
</table>

First-time meeting user is taken to a system generated meeting room with an option to rename it.

**Note:** In a new user account, if a meeting is created in the My Meetings folder, the new user is taken to My Meetings folder, instead of a system generated meeting room.

**More Help topics**

“Built-in permission groups” on page 239

**Join a meeting**

Attendees join a meeting as a guest or as a registered user, depending on the options chosen by the meeting host.
If your connection to the server fails, Adobe Connect displays an error message. It provides a link to a test wizard, which leads you through a series of steps to test your connection status.

1. Do one of the following:
   - If you have been invited to a meeting by someone in your organization, on the Adobe Connect Home tab, click My Meetings. In the list of meetings on the left, locate the meeting you want to join and click Enter.
   - Click the URL for the meeting, most likely received in an email or instant message.

2. Log in to the meeting room as either a guest or an Adobe Connect user:
   - Select Enter As A Guest. Type the name to be used as your identifier in the meeting. Enter appropriate values in the guest access fields, for example email id and contact number and click Enter Room.
   - Select Enter With Your Login And Password. Enter your login name and password. Click Enter Room.

If you are the administrator of a hosted account, Adobe Connect displays the terms of service (ToS) by default. To log in to a meeting, first acknowledge that you have read and agree to the ToS.

If you are a user, ToS is not displayed for hosted accounts. You can log in to a meeting before the ToS expires even if the administrator hasn’t accepted the ToS yet.

For shared site accounts, the ToS are displayed when you first log in to Adobe Connect either as an administrator or a user. To proceed, acknowledge that you have read and agree to the ToS. Select the check box on the screen to indicate that you have read and agree to the ToS and Adobe Online Privacy Policy.

Note: If the administrator for your meeting has activated client-side certificates, the Select Certificate dialog box appears when you attempt to enter a meeting. The dialog box prompts you to select a certificate to verify your identity. An administrator may have enabled a compliance Term of Use notice. Accept this notice to enter a meeting. (For more information, see “Working with compliance and control settings” on page 211.)

Place a meeting on hold or end a meeting
Hosts can place participants on hold to temporarily restrict meeting room access to hosts and presenters, letting them prepare materials. Audio conference calls are placed on hold.

Hosts can end a meeting to remove everyone, including hosts, presenters, and participants. Audio conference calls are disconnected. If an Adobe Connect account is billed by the minute, you can prevent unnecessary charges by explicitly ending a meeting when a meeting is not in session.

Place participants on hold
1. In the menu bar, select Meeting > Manage Access And Entry > Place Participants On Hold.
2. Revise the message to participants if you want, and click OK to place the meeting on hold.

Attendees who log in to a meeting that is on hold automatically enter when the meeting resumes.

End a meeting
1. In the menu bar, select Meeting > End Meeting.
2. Revise the message to participants if you want, and click OK to end the meeting.

Save an On Hold or End Meeting message for future use
You can write an On Hold or End Meeting message without interrupting the meeting. This feature lets you compose the message during the meeting and then send it at the appropriate time.

1. In the menu bar, select Meeting > Manage Access And Entry > Place Participants On Hold.
2 Revise the message in the message box.
3 Click Save Message to save the message for future use and return to the meeting.

**Restarting a meeting that is on hold or ended**
❖ In the upper-right corner of the meeting room, click Start Meeting in the Participants On Hold window.

> If you’ve closed that window, choose Meeting > Manage Access And Entry, and deselect Place Participants On Hold.

**Working with notifications and requests**
Pending requests and notifications are displayed in the menu bar. This feature gives you a unified view of requests and notifications, and you can act on them. Notification and request icons display if you have pending requests.

Click a request or notification button to view details and respond as required. Raise hand requests and access requests are indicated separately. Other notifications are displayed under the Info button.

**Updating meetings**
After creating a meeting, you can update meeting information, change the participant list, and manage content associated with the meeting.

**Obtain information about a meeting**
You can obtain details about an individual meeting at any time.

1 On the Adobe Connect Central Home tab, click My Meetings.
2 Under My Meetings, click the meeting name.

The Meeting Information page appears on the right with the following details:

- **Name**: The meeting title.
- **URL**: The web address where the meeting is to occur (the meeting room’s virtual location).
**Summary**  A brief description of the meeting.

**Start time**  The date and time that the meeting begins.

**Duration**  The projected length of time of the meeting.

**Language**  The language in which the meeting is conducted.

**Telephony information**  The telephone number for participants who call in to this meeting and the code that they must enter (necessary only when the meeting is in progress).

3.  From here, click the Open button next to the meeting name on the left to join the meeting.

**More Help topics**

“Viewing data about meetings with the dashboard” on page 30

“Meeting reports” on page 32

**View and modify a participant list**

If you have Manage permissions for a meeting, you can view a list of all invited attendees for each meeting room. However, if this meeting is presented as an event, view and manage participants in the Event Management tab. For more information, see “Adobe Connect Events” on page 122.

If you are an administrator or have Manage permissions for this meeting’s folder, you can add or remove attendees. You can also change an attendee’s permission setting (host, presenter, or participant).

Attendees that have been removed do not receive any notification. They cannot enter the meeting unless the meeting access setting is changed to allow entry to anyone who has the meeting URL.

**More Help topics**

“Workflow for creating and importing users and groups” on page 224

“Invite attendees and grant or deny access” on page 19

**View a meeting participant list**

1.  Click the Meetings tab at the top of the Adobe Connect Central home page.

2.  If necessary, navigate to the folder that contains the meeting.

3.  Click the meeting name in the list.

4.  In the Meeting Information page, click the Edit Participants link on the navigation bar.

**Add meeting participants**

1.  Click the Meetings tab at the top of the Adobe Connect Central home page.

2.  If necessary, navigate to the folder that contains the meeting.

3.  Click the meeting name in the list.

4.  In the Meeting Information page, click the Edit Participants link on the navigation bar.

5.  In the Available Users And Groups list, do one of the following to select the users or groups:
   - Control-click (Windows) or Command-click (Macintosh) or Shift-click to select multiple users or groups.
   - To expand a group to select any individual members, double-click the group name. When you finish selecting names, double-click Up One Level in the list to restore the original list.
To find a name in the list, click Search at the bottom of the window. Enter the name to display it in the list, and then select it.

6 Click Add.

7 For each new participant user or group that you added, select the appropriate permission type (Participant, Presenter, Host, or Denied). Use the Set User Role menu at the bottom of the Current Participants list to select the permission type.

**Remove meeting participants**

1 Click the Meetings tab at the top of the Adobe Connect Central home page.

2 If necessary, navigate to the folder that contains the meeting.

3 Click the meeting name in the list.

4 In the Meeting Information page, click the Edit Participants link on the navigation bar.

5 In the Current Participant list, do either of the following to select users or groups:
   - Control-click (Windows) or Command-click (Macintosh) or Shift-click to select multiple users or groups.
   - To locate a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.

6 Click Remove.

**Change a participant’s meeting permission**

1 Click the Meetings tab at the top of the Adobe Connect Central home page.

2 If necessary, navigate to the folder that contains the meeting.

3 Click the meeting name in the list.

4 In the Meeting Information page, click the Edit Participants link on the navigation bar.

5 In the Current Participants list, do either of the following to select the users or groups whose meeting permissions you want to change:
   - Control-click (Windows) or Command-click (Macintosh) or Shift-click to select multiple users or groups.
   - To locate a name in the list, click Search at the bottom of the window. Enter the name to display it in the list, and then select it.

6 For each name, select the new user role (Participant, Presenter, Host, or Denied) from the Set User Role menu. The menu is at the bottom of the Current Participants list.

**View and manage meeting content**

You can view uploaded content, move the content to the Content library, or delete uploaded content at any time.

**More Help topics**

“Working with content in the Content library” on page 190

“Share content in the Share pod” on page 33

“Sharing content during a meeting” on page 33
**View a list of uploaded content**
If you have Manage permissions for a meeting folder, you can view content uploads to the server from a meeting room within that folder.

1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If necessary, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Uploaded Content link on the navigation bar.
5. A list of all uploaded content appears. From here, do any of the following:
   - To see the information about a specific item in the list, click the item name.
   - Move uploaded content to the Content library.
   - Delete uploaded content.
   - To determine if the content is still being used in the meeting room, view the Referenced column. A Yes indicates that it is still being used. An empty column indicates that it is not.

**Move uploaded content to the Content library**
To move uploaded content to the Content library, obtain administrator rights or permissions to manage the specific Meetings library folder that contains this meeting.

1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If necessary, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Uploaded Content link on the navigation bar.
5. Click the check box to the left of each file you want to move.
6. Click the Move To Folder button on the navigation bar.
7. Click the folder titles or Up One Level button to navigate to the folder where you want to move the content file.
8. Click Move.
9. Click OK.

**Delete uploaded content**

1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If necessary, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Uploaded Content link on the navigation bar.
5. Click the check box to the left of each file that you want to delete.
6. Click Delete.
7. Click Delete on the confirmation page to permanently delete the selected content.

**Edit meeting information**
If you are an administrator or a user with Manage permissions for this meeting folder, you can modify the meeting properties on the Meeting Information page.
To edit meeting information while in the meeting room, choose Meeting > Manage Meeting Information.

1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If necessary, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Edit Information link on the navigation bar.
5. Edit any of the meeting information, such as start time or duration.
6. Click Save.

**More Help topics**

“Obtain information about a meeting” on page 24

“Meeting reports” on page 32

“Allocate meeting minutes to cost centers” on page 210

**Options in the Edit Information page**

- **Name**  A required field that appears in the meeting list, the meeting login page, and in reports.
- **Summary**  A meeting description that appears on the Meeting Information page, and is included in meeting invitations by default. Summary length is limited to 4000 characters.
- **Start time**  The month, day, year, and time that the meeting starts.

  **Note:** Some Adobe Connect pricing models ignore meeting start dates and allow attendees to enter meetings before the designated start date. Depending on the meeting pricing model, if the start date changes to a future date, users may enter the meeting room after you create the meeting. When you are logged in to a meeting room, you can stop participants from entering the room between meetings.

- **Duration**  The meeting length, in hours and minutes.
- **Language**  The primary language used in the meeting room.

  **Note:** If you change the meeting language on the Edit Information page, the names of the pods in the meeting room remain in the original language. It is best to set the language when creating a meeting and keep the language the same.

- **Access**  Use the following options:
  - **Only registered users may enter the room (guest access is blocked)**  This option allows registered users and participants to enter the room with their user name and password. Guest access is denied.
  - **Only registered users and accepted guests may enter the room**  With this option, the meeting room is accessible only to people invited as registered users and guests.

Registered users must enter their user name and password to enter the meeting room. Accepted guests are accepted into the room by the host. Adobe Connect can generate an individual attendance report for each registered user in the meeting. Accepted guests are added to the total number of meeting attendees on meeting reports, but no individual attendance report is available.

  **Note:** For some Adobe Connect accounts, a host must be present in a meeting in order for attendees to enter.

  - **Users must enter room passcode**  Specify an alphanumeric code, to act a password to enter a meeting, if you want to increase meeting security.
• **Anyone who has the URL for the meeting can enter the room**  Anyone who receives the meeting URL. Click Send E-mail Invitations to create an email invitation in your own email application. The new message contains a pre-populated subject (Adobe Connect Invitation) and a pre-populated message (containing the meeting date, time, duration, location, and summary) that you can edit.

**Cost Center**  Determines how meeting room minute costs are allocated. Use the menu to select an option and bill costs to individual users, your cost center, or a specified cost center.

**Audio Conference Settings**  You can choose not to include audio in the meeting, or choose from these audio conference options:

• **Include this audio conference with this meeting**  Audio profiles with preconfigured audio conference settings. Select a profile to associate it with the meeting. Adobe Connect uses the profile to connect to the meeting room and start the audio conference for you. If you have created an audio profile, it is the default audio conference option selected while creating a new Meeting. If you have created multiple audio profiles, associate a specific audio profile with a new meeting.

• **Include other audio conference with this meeting**  Telephone numbers and other settings for calling into an audio conference when the audio provider has not been configured with a dialing sequence. The settings are for display only, for example, in the meeting invitation and meeting room. You must have an account with the provider.

**Note:** If you did not add audio conference settings when you initially created the meeting, you can add them during the meeting. Ask all users to log out of the meeting while you add conference settings, and then log back in to the meeting.

**Update information for any items linked to this item**  Select this check box to update any items linked to the meeting with the revised meeting information.

### Send meeting invitations for an existing meeting

You can send invitations for a meeting if you are the host, an administrator, or have Manage permissions for this meeting’s folder.

A meeting invitation is an email invitation informing participants of the date, time, duration, summary, URL, and audio conference information. You can also choose to attach a Microsoft Outlook calendar event to the email message. This feature enables attendees to add the meeting to their Outlook calendar.

**Note:** Adobe Connect is unable to send a meeting invite for a meeting where the character count for the content to send to the email client is more than 1000 characters. The issue is related to HTML tag mailto, as browsers cannot launch an email client when the content exceeds 1000 characters.

The way that invitations are sent depends on the type of meeting:

**Registered guests**  If your meeting is for registered users only, create a custom email message from within Adobe Connect Central. Send the email invitation to all hosts, participants, and presenters; presenters only; or participants only. The subject and message body can be edited.

**Anyone**  If your meeting is open to anyone who receives the meeting URL, click Send E-mail Invitations to create an email invitation in your own email application. The new message contains a subject (the meeting name) and message (containing the meeting date, time, duration, URL, and summary) that you can edit.

### More Help topics

“Edit meeting information” on page 27

### Send invitations to registered guests only

1  Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If necessary, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Invitations link on the navigation bar.
5. From the To menu, select the group to invite: All Hosts, Presenters, And Participants; Hosts Only; Presenters Only; or Participants Only.
6. Edit the subject and the message body as appropriate.
7. To attach an Outlook calendar event to the email, select the check box next to Attach Microsoft Outlook Calendar Event (iCal) To E-mail Message. Otherwise, clear the check box.
8. Click Send.

**Send invitations to an unrestricted meeting**
1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If necessary, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Invitations link on the navigation bar.
5. Do either of the following as appropriate:
   • Click Send E-Mail Invitations to automatically display a new blank message in your email application.
   • Manually create an email message, then copy and paste the meeting URL (shown in the meeting details) into the message.
6. Type the email addresses of the invitees or add them from your address book.
7. Edit or type, as appropriate, the email subject and message.
8. Send the email invitation.

**Viewing data about meetings**

**Viewing data about meetings with the dashboard**
The Meeting Dashboard provides a graphical representation of statistical data about your meetings. To see the Dashboard, from the Home Tab click Meetings, then click Meeting Dashboard. The data, which reflects all the meetings you have created, appears in three-bar graphs. Clicking in any of the bar graphs brings up the Summary Report for the meeting.

- **Most Active Meetings Over Last 30 days**  Determined by the number of sessions.
- **Most Participant Meetings Over Last 30 Days**  Determined by the number of participants. This feature counts only registered attendees; guest attendees are not included in the count. However, guest attendees are included in the data reported in the Summary Report for each meeting.
- **Most Viewed Recordings Over Last 30 days**  Determined by the number of views (that is, the number of times each archived meeting has been viewed).

The bar graphs appear within the Adobe Connect Central Meetings tab. Click Printable Version to export the Dashboard to a browser window for printing.
Viewing user attentiveness with the Engagement Dashboard

As a presenter or host in a seminar, an event, a meeting, or a virtual classroom use the Engagement Dashboard to view participants’ attention and interactivity levels. Participant interactivity data provides a real-time visual cue to the effectiveness of the virtual classroom or webinar. The data helps you improvise the flow of your webinar appropriately.

The Engagement Dashboard displays the following:

- Current attendance in a virtual classroom or webinar
- Aggregate attentiveness of participants
- Changes in user attentiveness over time

The Dashboard displays user interactivity level through the following cues:

- For a Q&A pod, the Engagement Dashboard displays the number of questions answered out of the total questions
- For polls, the Engagement Dashboard displays the participation level for each of the poll questions

  **Note:** Open polls are always placed above polls that are faded out or closed. Polls in the current layout are placed at the top-most position.

The Engagement dashboard is visible to hosts and presenters in the Presenter Only area.

To view the Engagement Dashboard:

1. Choose Meeting > Enable Presenter Only Area. The Presenter Only area is displayed on the right of the meeting interface.
2. Choose Pods > Meeting Dashboard.

Enable opt out to provide an option to the participants to not provide non-explicitly submitted information to hosts. When participants choose to opt out, Adobe Connect excludes engagement index and private chat message count from the meeting reports.

See also
Monitoring individual engagement

The engagement score works best as an aggregate metric for medium to large meetings. However, there are scenarios like training sessions where the trainer may want to monitor the engagement of specific participants.

Adobe Connect provides an option in the Attendees pod called ‘Show Individual Engagement’ that enables meeting hosts to see individual engagement. The individual engagement is shown, against the name of the individuals, in three different levels—Green (high engagement), Yellow (average engagement), and Red (low engagement).

Meeting reports

The Reports feature of Adobe Connect Central lets you create reports that show you a given meeting from different perspectives. To use this feature, navigate to the Meeting Information page of an individual meeting and then click the Reports link. This displays links that let you define the following meeting information:

Summary
The first report type that appears when you access the Reports feature. The Summary displays aggregate meeting information, which includes:

- Name
- URL for viewing
- Unique Sessions (a single instance in which a given user joins and exits the meeting)
- Last time that a particular invitee enters the meeting room (most recent session)
- Number of invitees
- Number of attendees
- Highest number of people who entered the room at a time (peak users)

By Attendees
Lists the name and email address of each meeting participant, as well as the time they entered the meeting and the time they left it.

By Sessions
Lists the start and end time of each session, the session number, and the number of attendees. Clicking the session number displays the participant list for this session, including participant name and entry and exit times for each participant.

By Questions
Lists each poll by session number, number, and question. Select a view by clicking one of the following options under the Report column:

- View answer distribution Displays a pie chart in which each answer is color-coded with a unique color.
- View user responses provides an answer key that lists each answer for this poll and its corresponding answer number; these numbers map to the pie chart. This option also displays a list of participants who responded to the poll. It also displays the number of the answer they selected (if the poll question allowed multiple responses, all responses are shown for the user).

More Help topics

“Obtain information about a meeting” on page 24

“About Adobe Connect Central reports” on page 247
Sharing content during a meeting

Sharing a computer screen, document, or whiteboard
Hosts and presenters (and participants who have been given rights) use the Share pod to display content to attendees.

Content you can share:
- Selected items on your computer screen, including one or more windows, one or more open applications, or the entire desktop. See “Share your screen” on page 35.
- A document, such as a presentation, Adobe PDF file, FLV file, a JPEG, or other file format. See “Share a document or PDF” on page 40.
- A whiteboard with various writing and drawing tools. You can share a stand-alone whiteboard, or a whiteboard overlay that appears on top of other shared content. See “Share a whiteboard” on page 44.

Except for PDF files, attendees can view all documents shared in the Share pod but cannot download them. To enable attendees to download non-PDF documents, a host or presenter must instead use the File Share pod.

Installing the Adobe Connect Add-in
Presenters and hosts must install the Adobe Connect add-in the first time they attempt to upload content or share a screen. The add-in is a special version of Flash Player with additional features for hosts and presenters. The add-in provides support for uploading PPTX files to the server and sharing screens during a meeting. You can install the latest add-in (and other updates) from the Downloads and Updates page.

Note: Installing the add-in is not necessary to upload files of all the supported types, except PPTX files. Former can be uploaded from the browser too.

More Help topics
“Work with pods” on page 20
“Turn off display synchronization for documents” on page 42

Share content in the Share pod
The Share pod controls let hosts and presenters share content in various ways. You can maximize the pod to make contents larger.

When you share content in the Share pod, attendees see your pointer move in the Share pod window. All activities you perform in a shared window, application, or document are visible to attendees. The file formats supported in the Share pod are JPG, PNG, SWF, PPT, PPTX, PDF, FLV, F4V, MP3, MP4, and ZIP.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Work with pods” on page 20
“Share a whiteboard” on page 44
“Share a document or PDF” on page 40
Change the content displayed in a Share pod
❖ In the upper-right corner of the Share pod, click the menu icon , select Share, and choose My Screen, Document, or Whiteboard. You can also reshare Recently Shared items.

Using My Screen option, hosts and presenters can choose to share your entire Desktop, the open Applications, or the open Windows.

Using Document option, hosts and presenters can choose to share whiteboards, previously uploaded files, content from the Content Library, and content shared with them.

Display in Full Screen mode
❖ To display the Share pod at full screen size, click Full Screen  in the upper-right corner of the pod. Click the button again to return to normal display size.

Note: When you enable full screen mode, use Alt+Tab to go to the window that you want to share.

Hide the title bar of the Share pod
❖ To hide the title bar of a Share pod, hosts and presenters can click the menu icon  and select Hide Title Bar.

Note: To access the menu icon, hover pointer at the top of the Share pod and the title bar is displayed.

Hiding the title bar removes it for all the attendees and they cannot switch to full screen or change the view.

Display changes in the presenter’s Share pod to all participants
If you choose to display changes in the presenter’s pod to all attendees, the presenter controls the pod size for attendees. For example, if the presenter sets the Share pod to Full Screen mode, the pod also fills the screen of attendees.
❖ In the upper-right corner of the Share pod, click menu icon , and select Force Presenter View.

Turn off sharing but keep the Share pod open
❖ Click Stop Sharing in the Share pod.
**Redisplay Share pod content that was closed**

❖ In the upper-right corner of the Share pod, click the menu icon ☐️. Then choose Share > Recently Shared, and select the shared document or whiteboard from the submenu.

*The submenu lists the five most recent documents. To see previously shared documents, choose Share > Document.*

**Use a pointer in a Share pod**

When content is displayed in the Share pod, you can use a pointer to beckon users to focus on particular areas.

❖ In the upper-right corner of the Share pod, click the Pointer 🖋️.

**Share your screen**

As a host or presenter in a meeting, you can share windows, applications, or your entire desktop. Your account administrator can restrict the applications and processes that you can share. As a participant in a meeting, to share your screen, a host must give you permission or promote you to a presenter or host. If users have a dual monitor setup, upon clicking Share My Screen, users get an option to share either of the two monitors. However, only one screen can be shared at a time.

When you share anything on your computer screen, actions you take in the shared region are visible to all participants in the meeting. Participants follow the progress of your cursor as you move it across your screen. When starting a screen share, the hosts and the presenters can enforce their settings for the participants. The Share pod can be opened in full screen mode for all attendees for a better viewing experience.

*Hosts can show their cursors without sharing their screens. Choose Meeting > Preferences, and select a Host Cursors option.*

The region or regions that you share must be visible on your desktop to be visible in the Share pod to other participants. Overlapping windows on the desktop appear as a blue crosshatched pattern in the Share pod. If you are sharing an application and showing the native cursor of the application, you can enable the Show Application Cursor option in the Screen Share tab in the Preferences dialog.

**More Help topics**

“Share screen in Compact mode using the MiniControl” on page 36

“Sharing a computer screen, document, or whiteboard” on page 33

“Share a whiteboard” on page 44

“Share a document or PDF” on page 40

“Specify applications to share or block” on page 213

“Work with pods” on page 20

**Optimize screen sharing quality**

1 Choose Meeting > Preferences > Video.

2 Use the following legend to choose between the four available quality settings.

**High** 20 fps video at a maximum resolution of 640 x 480.

**Standard** 10 fps video at a maximum resolution of 320 x 240.

**Medium** 8 fps video at a maximum resolution of 320 x 240.
Low 4 fps video at a maximum resolution of 160 x 120.

For example, if there are large delays before attendees see changes to a shared screen, reduce the Quality setting.

3 (Optional) If you wish to disable previewing webcam feed before starting the feed, select Disable Webcam Preview.

4 (Optional) If you wish to highlight the video feed of the current speakers in the Video Pod, select Highlight Active Speakers.

Share your screen (Host or Presenter)

1 Do one of the following to open a Share pod:
   • Choose Layouts > Sharing.
   • Choose Pods > Share > Add New Share.

2 Click the pop-up menu in the center of the Share pod, and select Share My Screen.

Note: If the Share Pod is empty, you are a participant and do not have permission to share.

3 Set “Screen sharing options” on page 36.

4 (Optional) To make the attendees watch the shared content in full screen mode, select Make Share Pod Full Screen for Attendees, at the bottom of the Start Sharing Screen window.

5 Click the Share button at the bottom of the Start Screen Sharing window to begin sharing.

Share your screen (Participant)

1 Ask a host to select your name in the Attendees pod and click Request Screen Share.

2 An alert appears on your screen that says “Begin Sharing Desktop?” Click Start.

3 Set “Screen sharing options” on page 36.

4 Click the Share button at the bottom of the Start Screen Sharing window to begin sharing.

Screen sharing options

Desktop (or Secure Desktop Sharing) Shares the contents of your desktop. If you have more than one monitor connected to your computer, a desktop appears for each monitor. Choose the desktop that you want to share.

The Secure Desktop Sharing option appears only if the account administrator has restricted the applications and processes that you can share. The Desktop option allows you to share authorized contents on your desktop.

Windows Shares one or more authorized windows that are open and running on your computer. Choose the window or windows that you want to share.

Applications Shares an authorized application and all its related windows that are open and running on your computer. Choose the application or applications that you want to share.

Share screen in Compact mode using the MiniControl

Participants who share their screen, can share, collaborate, and take some in-meeting actions directly from a MiniControl that opens in the Compact mode. The palette is displayed only for the user sharing the screen.
Options to switch to the MiniControl
A. Use the icon in the top bar of the Share pod  B. Use the notifier in the upper right corner of the meeting room  C. Use the option in the context menu of the Share pod

The presenter can take multiple actions from the MiniControl and can access some pods, like the Chat pod and the Attendees pod. If a pod is not available in the meeting room, its icon in the MiniControl is disabled. The presenter can also see the in-meeting notifications in the palette.

Screen share control panel

You can perform the following actions from the palette, depending on your access permissions:

- Switch to the traditional meeting room by clicking Switch to Meeting Room in the upper right corner of the MiniControl.
- Start and stop screen sharing and preview your screen being shared.
Start, stop, and preview screen sharing

- Pause and annotate the screen being shared.
- Control the camera, speaker, and microphone options in the meeting room. View the webcam feeds available in the meeting room in Grid or Filmstrip layout and switch the primary feed.

Multiple webcam feeds in the control panel

- Access and use the Attendees pod.
• Access and use the Chat pod.

![Screen share chat control](image)

You can disable the MiniControl from the Meeting Preferences. In the Meeting Preferences, select Screen Share, and deselect Enable MiniControl panel for Screen Share. By default, this option is selected.

**Share control of your screen**

While screen sharing, you can transfer control of the shared desktop, window, or application to another host or presenter.

1. Start sharing your screen.
2. A host or presenter clicks Request Control on the Share pod title bar.
3. You see a request message in the upper-right corner of the meeting room window. Do one of the following:
   • Click Accept to grant control of your screen.
   • Click Decline to deny control of your screen.
Request control of a shared screen
Hosts and presenters can request control of the screen. They can take control once they receive the necessary permissions.
❖ Click the Request Control button on the Share pod title bar.
If the request is accepted, a message informs you that you have been granted control of the screen. The Request Control button becomes a Release Control button. You can now take control of the shared screen.

Release control of a shared screen
❖ Click Release Control on the Share pod control strip to return control of the shared screen to the original Host or Presenter.

Change the view of a shared screen
If another presenter is sharing a screen with you, you can scale the screen to fit entirely within the Share pod. In addition, you can zoom in for a clearer image.
❖ In the upper-right corner of the Share pod, choose Change View, and then select either Scale To Fit or Zoom In.

Preview your shared screen
When sharing an application, window, or desktop on your computer, you can see a preview that shows what participants see in their Share pod.
❖ In the upper-right corner of the Share pod, click the menu icon, and select Preview Screen.

Share a document or PDF
As a host or presenter, you can share documents that have been uploaded to the Content library, or share documents directly from your computer. Sharing documents from the Content library has the following advantages over sharing your screen:
• Better and higher fidelity viewing experience for participants.
• Lower bandwidth requirement for presenters and participants.
• More navigation options with the Adobe Presenter sidebar.
• Pre-loading and organizing documents in the meeting room.
• Easier presentation when multiple presenters are involved.
If you turn off sharing, change the content in a Share pod, or close the Share pod, the document is still part of the meeting room. It can be displayed again. To edit a shared document, edit the source document and reload it into the meeting.

More Help topics
“Working with content in the Content library” on page 190
“Work with pods” on page 20
“Share a whiteboard” on page 44

PDF files in Adobe Connect
In the Content library, PDF files are stored as is. When shared in a meeting room, PDF files are converted to SWF files to enable synchronized navigation and whiteboard capabilities.
From the Share pod, hosts and presenters can download PDF files. Participants can download PDF files if hosts and presenters click the Sync button to turn off display synchronization.

PDF Portfolios and PDF files that are password protected cannot be converted into SWF files, preventing them from being shared in Adobe Connect. In addition, certain PDF features are not supported when sharing PDF files in Adobe Connect. In some cases objects within the PDF are either dropped, or only a simple image preview is displayed.

The following objects are dropped in Adobe Connect:

- Comment text (only the sticky note icon is shown)
- Attachments
- Bookmarks
- Audio clips (only the play button icon is shown)

The following objects retain a simple image preview (an image representing the object) in Adobe Connect:

- Forms
- 3D objects
- Multimedia objects (audio, video, and SWF files)

**Share documents**

As a host or presenter, you can share the PPT, PPTX, PNG, MP4, F4V, Adobe PDF, SWF, FLV, JPEG, and MP3 file types from the Content library or your computer. The Content library is available in Adobe Connect Central. In a meeting, you can share GIF content from the Content Library. However, GIF is not supported when you share content by browsing to your local filesystem using the file picker dialog.

*Note: You create presentations from PowerPoint presentations using Adobe Presenter. Adobe Connect does not support progressive-scan JPEG files.*

1. Do any of the following:
   - In an empty Share pod, click the pop-up menu in the center, and select Share Document.
   - In the upper-right corner of the Share pod, click the menu icon , and choose Share > Document.

2. Select one of the following:
   - **Whiteboards**  Displays whiteboards created for the current meeting.
   - **Uploaded Files**  Displays content uploaded for the current meeting.
   - **Click Browse My Computer to upload content for the current meeting. The document is added to the Uploaded Content folder for the meeting in Adobe Connect Central. An administrator can move the document to the Shared Content folder to make the document available for other meetings.**
   - **My Content**  Displays content in your user folder in Adobe Connect Central.
   - **Shared Content**  Displays content in Adobe Connect Central that is available to all account holders with the appropriate permissions.
   - **Share History**  Displays content in other user folders in Adobe Connect Central. To view the content in another user’s folder, you must have View permission from that user.

3. Select the document that you want to share, and click Open.

The selected document appears in the Share pod. The document name appears in the title bar of the pod.
Turn off display synchronization for documents
By default, Adobe Connect synchronizes display of documents so that attendees see the frame that the presenter sees. A host or presenter can use the Sync button to turn off synchronization. This functionality lets attendees go through presentations or PDF documents at their own pace.

Note: The Sync button appears only when you have multi-frame content loaded in the Share pod.

With content loaded in the Share pod, click the Sync button in the lower-right corner to disable synchronization.

Controls for presentation playback appear at the bottom of the Share pod.

Share a presentation
For hosts or presenters who share a presentation in the Share pod, special controls are available for navigating and displaying the presentation. A presentation layout has the following areas:

Presentation The main part of the window, which displays the presentation slides.

Presentation sidebar Area on the right of the browser window that shows the name of the presentation, the presenter information, Outline, Thumb, Notes, and Search tabs. If you cannot see the sidebar, click Show Sidebar ❯ to the lower left of the presentation.

Presentation control bar A bar at the bottom of the presentation that gives you control over the presentation playback, audio, attachments, and screen size. The bar is visible to hosts only, unless a host chooses to display it to participants. (To see all presentation toolbar options, load the presentation file to the Content library from Adobe Presenter. If you load the PowerPoint PPT or PPTX file directly into the Share pod from your computer, not all presentation toolbar options are visible. Click Sync in the lower right corner of the presentation.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Working with content in the Content library” on page 190
“Work with pods” on page 20
“Share a whiteboard” on page 44

Use the presentation Outline tab
Most presentations have an Outline tab on the sidebar. The Outline tab lists the title and duration of each slide. You can use the Outline tab to display information and to move to a specific slide in the presentation. The current slide is highlighted with a glow color, which you can change in the theme. You can choose to display the highlight outline to all attendees or to hosts and presenters only.

1 Click the Outline tab in the sidebar at the right.
2 To move to a slide in the presentation, click its title in the Outline tab.
3 To show the full slide title, move the pointer over the title.

Use the Presentation Thumb tab
Presentations can have a Thumb tab on the sidebar. The Thumb tab shows a small picture of each slide, the slide title, and the slide duration. The current slide is highlighted with a glow color, which you can change in the theme. You can use the Thumb tab to see the contents each slide quickly and to move to a specific slide in the presentation.
Note: If you upload your presentations directly from your computer and into a meeting, the Thumb tab is not displayed. Adobe recommends adding presentations to a meeting from the Content library.

1. Click the Thumb tab in the sidebar at the right.
2. To move to a slide, click its title in the Thumb tab.
3. To show the slide title, move the pointer over the title.

View Presentation slide notes
When creating a presentation in PowerPoint, you can enter notes for individual slides. If any slide notes exist, they can be displayed in the presentation. Slide notes appear on the right side of the presentation window. You cannot change the size of the slide Notes tab.

❖ Click the Notes tab in the sidebar on the right side.

The complete notes text is displayed. The text is not formatted and cannot be edited directly on the tab.

Search for text in a presentation
1. Click the Search tab in the sidebar on the right side.
2. Type the text to search for directly into the text box.
3. Click Search ➼.
4. Search results are displayed below the text box. Click any slide title in the results list to display that slide.

Presentation toolbar options
You can control the presentation appearance and playback by using the toolbar at the bottom of the presentation. (To see all presentation toolbar options, load the presentation file in the Content library from Adobe Presenter. If you load the PowerPoint PPT or PPTX file directly into the Share pod from your computer, not all presentation toolbar options are visible. Click Sync in the lower right corner.)

Play/Pause  Pauses and resumes play of the current slide.
Back  Moves to the previous slide in the presentation.
Forward  Moves to the next slide in the presentation.
Slide progress bar  Shows and controls the playback location within the current slide. The position marker moves as the slide plays. You can drag the marker arrow forward or back in the current slide to change your playback location. You can also click a specific location on the progress bar to move the slide marker position and slide playback there.
Current slide number  Shows the number of the currently displayed slide and the total number of slides (for example, 2/10).
Status  Shows the status of the current slide, such as Playing, Stopped, No audio, or Presentation complete.
Time  Shows the current slide time and the total slide time as the slide plays (for example, 00.02/00.05).
Audio volume  Shows the volume level that is set for the slide.
Attachments  Displays a small window showing any attachments (for example, documents, spreadsheets, images, or URLs) that have been added.
Show/Hide sidebar  Shows or hides the sidebar.
Share a whiteboard

A host or presenter (or a participant with the necessary rights) can use a whiteboard to create collaborative text, drawings, and annotations in a meeting.

*Note:* Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics

“Work with pods” on page 20

“Share content in the Share pod” on page 33

“Share a presentation” on page 42

Provide drawing rights to participants

Hosts and Presenters can let any participant draw on whiteboard by granting the drawing rights in three ways.

*Note:* Participants cannot turn on the Drawing mode for Share pods with these rights. Only Hosts and Presenters can enable the Drawing mode.

- To provide drawing rights to individuals, select the name from the Attendee list and from the pop up menu, select Enable Drawing. You can revoke the rights by selecting Disable Drawing.

- To provide drawing rights in a specific whiteboard to all the participants, select Enable Participants to draw from the pod’s context menu. Deselect the option to revoke the rights in the whiteboard, for all the participants.
Enable drawing rights on a Share pod for all participants

- You can grant universal drawing rights to all participants in all pods, from the in-meeting Preferences dialog. This preference is remembered for every session using the meeting room.

Enable drawing rights for everyone in a meeting room

Create and display a whiteboard

A whiteboard allows hosts or presenters to create text, shapes, insert some symbols, and draw freehand drawings in real time during a meeting. By providing drawing rights to some or all the participants, meeting hosts can facilitate better collaboration. Users can zoom in and pan the whiteboard for a better experience.

You can use a whiteboard in two different ways in a Share pod:

- A stand-alone whiteboard allows presenters to create content on a white background.
- An overlay whiteboard allows presenters to create content over an existing document in a Share pod, adding annotations to and drawing on the document. You can lay a whiteboard over presentations, JPG, SWF content, FLV file, and PDF documents.

If you turn off sharing, change the content in a Share pod, or close the Share pod, the whiteboard is still part of the meeting room. It can be displayed again.
**Create a stand-alone whiteboard in a blank Share pod**

- In the Share pod, choose Share My Screen > Share Whiteboard.

**Add an overlay whiteboard in a Share pod**

- With the document displayed in a Share pod, do one of the following:
  - In the upper-right corner of the Share pod, click Draw. See “Whiteboard drawing tools” on page 47.
  - If you share an application, in the upper-right corner of the application window, click the arrow next to the Stop Sharing button. Then select Pause and Annotate.
  - If you are sharing your entire desktop, click the Adobe Connect add-in icon in the system tray (Windows) or icon bar (Macintosh) and select Pause and Annotate.

**Display an existing whiteboard**

- Select Pods > Share > [name of whiteboard].
Navigate between multiple whiteboard pages
A stand-alone whiteboard contains multiple pages that you can move between during a presentation.

❖ In the lower-left corner of the Share pod, click the left or right arrow. Page numbers are displayed alongside the arrows.

Whiteboard drawing tools

Whiteboard tools
A. Select objects or pan while drawing  B. Markers tool  C. Delete the selected objects  D. Text tool  E. Draw shapes and symbols  F. Undo changes  G. Redo changes  H. Arrange an object relative to other objects

The tools available to create text and drawings on the whiteboard are displayed below.
Whiteboard marker tools and their samples
A. Marker  B. Highlighter  C. Pen  D. Pencil
Drawing shapes and symbols
A. Select a shape or a symbol to draw  B. Set border  C. Set line thickness  D. Set fill color  E. Set opacity of the shape

Selection tool ➤ Selects a shape or area of the whiteboard. Click a shape to select it. Drag on the whiteboard or content to create a selection rectangle that selects all the shapes within the rectangle. The selection rectangle has eight control points for resizing the selected shape or shapes. Shift-drag a corner control point to maintain the aspect ratio when you resize. Select and drag a shape to move it. To add a shape to the selection, Shift-click the shape.
Pen tool Its width and alpha remain constant with stroke width, except at a bend, at the start, and at the end. The tool is sensitive towards the speed of the pointer movement.

Pencil tool Creates a free-form line. You can customize stroke color and stroke weight by using the color picker and stroke weight pop-up menu. Its width and alpha increase with the speed of the stroke. The tool is sensitive towards the speed of the pointer movement.

Marker tool Its width and alpha decrease with the speed of the stroke.

Highlighter tool Creates a free-form thick marker line. You can customize stroke color and stroke weight by using the color picker and stroke weight. Its alpha decreases with the speed of the stroke but the width increases.

Delete Selected Deletes items selected with the Selection tool.

Text tool Creates a floating multiline text field. You can customize fill color, font face, and font size by using the color picker, font pop-up menu, and font size pop-up menu. Drag to create a text area where you can type.

Shapes tool Click and hold to choose from rectangles, ellipses, lines, arrows, and more. Use the options to the right of the tool to customize appearance. Drag to expand the shape. Hold down the Shift key while dragging to create even width and height for shapes, or snap lines every 45°.

Undo Undoes the previous action. You can undo the following actions: drawing a shape, moving a shape, resizing a shape, clearing the whiteboard, and changing a shape’s property. There is no limit to the number of times that you can perform this operation in the pod.

Redo Repeats the previous action.

Arrange menu Using the arrange menu options, you can move the objects to the front or the back relative to the other objects in the whiteboard.

If your company has a licensed Adobe Connect account, you can use custom images for shapes. See www.adobe.com/go/devnet_connect_stamps.

Print or export the contents of a whiteboard
To save your whiteboard content locally you can either print a whiteboard or export the contents in a local file.

- In the upper-right corner of the Share pod, click the menu icon , and select Print.
- Click the menu icon , and select Export Snapshot > Save As PNG, to create a local snapshot.
- Click the menu icon , select Export Snapshot > Send Snapshot, and provide an email address to send a PNG snapshot via email.

Upload and manage files using the File Share pod
Hosts and presenters can upload files to share with meeting attendees either from their computers or from the Content library. Unless a host changes a participant’s status, participants cannot upload files. Participants who want to upload files can request a host to change their attendee role or to grant enhanced rights for the File Share pod.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Working with content in the Content library” on page 190
“Share content in the Share pod” on page 33
Upload a file
1 If you do not have a File Share pod in your meeting room, click Pods > File Share > Add New File Share.
2 In the File Share pod, click Upload File, or choose that command from the pod menu.
3 Navigate to the file, and click Open.

Download a file
Meeting attendees can download files from the File Share pod to their computers.
1 In the File Share pod, select the files to download.
2 Click Download File.
A browser window opens with the Save to My Computer dialog box. (If this window does not appear, adjust the browser’s pop-up blocker settings.)
3 Click the Click to Download link.
4 Click Save. Navigate to the desired location, and again click Save.
5 When the downloading process is complete, click Close.
6 Close the browser window that opened in step 2.

Download all files
To quickly download multiple files, meeting attendees can download all files simultaneously from the File Share pod, instead of downloading one by one.
1 In the upper-right corner of the File Share pod, click the menu icon.
2 Click Download All.
A browser window opens with the Save to My Computer dialog box. (If this window does not appear, adjust the browser’s pop-up blocker settings.)
3 Click the Click to Download link.
4 Click Save. Navigate to the desired location, and again click Save.
5 When the downloading process is complete, click Close.
6 Close the browser window that opened in step 2.

Rename a file
This operation changes only the label that appears in the File Share pod; it doesn’t change the actual filename.
1 In the File Share pod, select the file that you want to rename.
2 In the upper-right corner of the pod, click the menu icon.
3 From the pop-up menu, select Rename Selected.
4 Type the new name, and click OK.

Remove a file
1 In the File Share pod, select the file that you want to remove.
2 In the upper-right corner of the pod, click the menu icon.
3 From the pop-up menu, select Remove Selected.
Display web pages to attendees
During meetings, hosts or presenters may want participants to view websites. You can use the Web Links pod to force attendees' browsers to open a designated URL. Participants who want to add links ask the host to change their attendee role.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Work with pods” on page 20

Add a web link
1 If you do not have a Web Links pod in your meeting room, click Pods > Web Links > Add New Web Links.
2 In the upper-right corner of the web links pod, click the menu icon.
3 Select Add Link.
4 Type the URL path, and if desired a URL name.
5 Click OK.

The full list of links appears for both hosts and participants.

Display a web page to all attendees
1 Select a link in the Web Links pod, or enter a URL in the Browse To box.
2 Click Browse To.
On your screen and each attendee's individual screen, the URL opens in a new instance of the web browser.

Rename a web link
1 Double-click a URL name in the Web Links pod.
2 Type the new name in the URL Name box.
3 Click OK.

Remove web links
1 Select one or more links in the Web Links pod.
2 In the upper-right corner of the web links pod, click the menu icon.
3 Select Remove Selected from the pop-up menu.

Notes, chat, Q&A, and polls

Taking notes in a meeting
Hosts and presenters use a Notes pod to take meeting notes that all attendees can see. It remains visible in a Notes pod throughout the meeting or until a presenter edits the note or displays a different note. A host can remove the Notes pod from view, or switch to a different room layout that does not contain that Notes pod.
When you type a message in the Notes pod of one layout, the same text appears in other layouts that contain the same pod. With the Add New Notes option, you can create a unique instance of a Notes pod that appears in only one layout.

Hosts and presenters can use the Notes pod in several ways:

- Create a single, persistent note that is visible to attendees during the entire meeting.
- Create multiple Notes pods to display different notes.
- E-mail the contents of a Notes pod or export a text file.

**Note:** Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

### More Help topics

- “Work with pods” on page 20
- “Chat in meetings” on page 54

### Create a Notes pod

A host can create and display multiple Notes pods, each with its own text. You can use different Notes pods for different layouts and meetings.

- From the menu bar at the top of the Stage, select Pods > Note > Add New Notes. Or, choose New Note from the Notes pod options menu.

You can rename, move, and resize the Notes pod after it is created.

### Add a note to a Notes pod

1. As a host or presenter, click anywhere inside the Notes pod.
2. Type the text that you want to appear in the Notes pod.

### Edit note text

A host, presenter, or participant with enhanced rights can edit the text in a Notes pod. (See “Assign enhanced participant rights” on page 68.) All changes are immediately visible to attendees.

1. Click in the Notes pod to select the text that you want to edit.
2. Edit the text, or change size, style, and color using the options at the top of the pod.

### Select which Notes pods to display

A host or presenter can choose which notes to display.

- Do either of the following:
  - Choose Pods > Notes. Select the name of the note that you want to display.
  - Click the menu icon in a Notes pod, click Select Notes, and select the name of the note you want to display.

### Rename a Notes pod

If you are a host, you can rename a Notes pod after creating it.

- Do either of the following:
  - Double-click the note name in the pod and enter a new one.
• Choose Pods > Manage Pods, select the Notes pod, and click Rename.

**Delete a Notes pod**
1. Choose Pods > Manage Pods.
2. Select the Notes pod, and click Delete.

**Export notes to a text file or email**
Hosts can export the contents of a Notes pod. (The Adobe Connect add-in must be installed to use this option.)
1. Click the pod menu icon in the upper-right corner.
2. Select Export Note, and then select either Save As RTF (to create a text file) or email Note.

**Use sound alerts for new chat messages**
The Chat pod can generate a sound to alert a user, if two chat messages are more than five seconds apart. This option is available individually for each Chat pod and is specific to a meeting room. It is remembered across all the meeting sessions of a meeting room.

![Chat sounds](image)

Enable sound alerts for new message in Chat pod

❖ To activate the chat notifications, click Chat sounds from context menu of the Chat pod.

**Chat in meetings**
Use the Chat pod to communicate with other attendees while a meeting is in progress. If you have a question and do not want to disturb the meeting flow, you can send a chat message to another meeting participant. For example, when you first enter a meeting room, you can introduce yourself by sending a chat message to everyone in the room.

As a presenter, you can use more than one Chat pod simultaneously. Chat pods can display content to either everyone or only presenters (in the Presenter Only area).

Chat pod content is persistent, and remains in a meeting room until deleted. If you want to preserve Chat pod content for future use, send the content through email.

*Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.*
Send a chat message

Use the Chat pod to compose a chat message and address it to a specific participant, to all presenters at the meeting, or to all attendees.

1. By default, everyone can view the message. To limit the recipients, click the menu icon in the upper-right corner of the Chat pod. Choose Start Chat With, and then select Hosts, Presenters, or specific attendees.

At the bottom of the Chat pod, tabs appear that let you view different conversations.

2. Click the text box in the Chat pod.
3. Enter your message.
4. Do one of the following:
   - Click Send Message to the right of the text box.
   - Press Enter or Return.

Your name, the addressee name, and your message appear in the Chat pod.

Clear messages from a Chat pod

When an empty Chat pod is required in a meeting, a host can clear all messages for all attendees.

1. In the upper-right corner of the Chat pod, click the menu icon.
2. Select Clear Chat.

Disable private chat between participants

By default, two participants can chat privately. As a host or presenter, you can disable this option and prevent private chat.

1. Choose Meeting > Preferences.
2. Select Chat Pod from the list on the left.
3. Deselect Enable Private Chat For Participants.
Use chat notifications
If you are a host or presenter using the Adobe Connect add-in, chat notifications let you communicate with your audience while you are presenting. The meeting window is minimized or maximized to full-screen, concealing the Chat pod. If an attendee sends a message while you are presenting, a notification appears in the lower-right corner of the screen. You can see the sender’s name and the first few words of the message in the notification window. By default, chat notifications are enabled. To prevent notifications from displaying while you are presenting, disable them.

1. Choose Meeting > Preferences.
2. Select Chat Pod from the list on the left.
3. From the pop-up menu, choose either Disable or a time duration to display each notification.

Format chat text
❖ In the upper-right corner of the Chat pod, click the menu icon, and select any of the following:

- Text Size: Changes size in your view only.
- My Chat Color: Changes your text color in the view of all participants, making your remarks stand out.
- Show Timestamps: For hosts only, displays the date and time of chat entries.

Email the contents of a Chat pod
Hosts and presenters can email a chat history for future reference.
❖ In the upper-right corner of the Chat pod, click the menu icon, and select Email Chat History.

Reverse the order of reading messages by a screen reader
For users that use JAWS or some other accessibility tool, they can read the messages in the reverse order by selecting Reverse order of messages. Messages in the Chat pod are read starting from the latest to the first, instead of the other way round.

Questions and answers in meetings
You can use a Q&A pod to answer questions posed by attendees. When a presenter answers a question, the question and answer appear as pairs in the Q&A pod.

Hosts can give participants enhanced rights, letting them answer questions as well. See “Assign enhanced participant rights” on page 68.

Here are some examples in which the Q&A pod is helpful:
• During a large meeting, questions are added to a queue on the Q&A pod while the speaker presents. After completing the presentation, the speaker reviews the messages, applies a filter, and begins answering the questions.
• A meeting moderator answers logistical questions but forwards technical inquiries to an engineer, who is presenting.
• A meeting moderator returns certain replies to the sender only. Replies that are relevant to all attendees are sent to everyone in the meeting.
View the Q&A pod as participants do
By default, hosts and presenters see the Q&A pod with additional controls, but you can quickly see questions with answers as participants do.

❖ In the upper-right corner of the Q&A pod, click either of the following:
  - **Presenter View** displays additional filtering and assignment controls visible only to hosts and presenters.
  - **Participant View** displays the simple list of questions and answers that participants see and the ones received from individuals.

Move the Q&A pod presenter view to Presenter Only Area
1. In the upper-right corner of the Q&A pod, click the menu icon 📚⬇.
2. Choose Move Presenter View to POA.

**Note:** To return the Q&A pod to the Share area, in the Presenters Only Area click 📚⬇ and choose Hide.

Submit a question in the Q&A pod
1. In the Participant View 🛡 of the Q&A pod, type your question in the text box at bottom.
You can add clickable hyperlinks in questions.

2  To the right of the text box, click the Send Question button 🗣️, or press Return.

**Answer questions using the Q&A pod**

1  Select an incoming question from the list.

2  Type your answer in the text box at the bottom of the pod.

3  Click one of the following buttons in the lower-right corner of the Q&A pod:

**Send to all 🗣️** Sends the answer to all meeting attendees.

**Send privately 🗣️** Sends the answer only to the attendee who sent the question.

Answered questions appear in italics with a checkmark. Icons, in the top bar and besides the names, indicate that a question is assigned to you.

When answering questions, you can include clickable hyperlinks in the answers.

**Assign a question to a specific presenter**

You can assign questions to presenters with specific expertise, including yourself, preventing others from answering.

1  In the Presenter View 🗣️ of the Q&A pod, select the question from the Incoming Messages list.

2  Select a presenter name from the Assign To pop-up menu.

💡 Presenters can reassign questions to other presenters or choose None to cancel assignment.
Show questions with different statuses
As a host or presenter, you can add a filter to the queue of questions in a Q&A pod to view specific questions while hiding others. You can also forward a question to another presenter to answer.

1. In the Presenter View of the Q&A pod, click the pop-up menu in the upper-left corner.
2. Select one of the following:
   - **Show All Questions**: Displays all questions that you have received, starting either with a new pod or from the last time the pod was cleared.
   - **Show Open Questions**: Displays all unanswered questions not assigned to anyone.
   - **Show Answered Questions**: Displays all questions that have been answered.
   - **Show My Questions**: Displays only unanswered questions that have been assigned to you. A question answered by someone else, can still be reassigned to a user and then shows in their list.

Delete individual questions
You can delete questions to clean up the Presenter View. (Deleted questions and associated answers remain in the Participant View.)

1. In the Presenter View of the Q&A pod, select a question.
2. Click the Delete icon.

Clear all questions
To remove all content from the Presenter and Participant views, do the following:

1. In the upper-right corner of the Q&A pod, click the menu icon.
2. Select Clear All Questions.
Hide attendee names for questions
By default, attendee names appear next to submitted questions, but hosts and presenters can hide those names in Participant View.

1. Choose Meeting > Preferences.
2. In the list at left, select Q&A pod.
3. Deselect Show Submitter Name or Show Presenter Name.

Export Q&A contents to a text file or email
1. In the upper-right corner of the Q&A pod, click the menu icon.
2. Choose Export Q&A Logs, and then select either Save As RTF or E-mail Q&A.

Send message from the Q&A pod
From the Presenter view of the Q&A pod, you can send a message to specific attendees or groups. This message appears in the participant view of the Q&A pod and is visible only to the specified attendees or groups.

The message has a different format that distinguishes it from the regular Q&A messages that are visible to all attendees.

To send a message to specific attendees or groups, select Send message and then select appropriate attendees or groups to send the message.

Polling attendees
Hosts and presenters can use the Poll pod to create questions, or polls, for participants and to view the results. Only hosts and presenters control poll management and how polls appear to meeting participants. Hosts can also cast votes.

Polls are useful during a meeting if you want instant feedback on what is being presented. Polls can also be used at the end of a meeting to find out if participants felt the meeting, content, and presenters were high quality.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Work with pods” on page 20
“Chat in meetings” on page 54
“Assign enhanced participant rights” on page 68

Create a poll
1. If the Poll pod is not displayed, click the Pods menu and select Poll > Add New Poll.
2. In the upper left of the pod, choose Multiple Choice, Multiple Answers, or Short Answer.
3. Enter a question into the Poll pod. Then enter one or more answers if your choice is Multiple Choice or Multiple Answers. If your choice is Short Answer, you need not enter any answer.
4. Click Open.

Close the answer period for a poll
❖ At the upper right of the Poll pod, click Close. (Results are sent to Adobe Connect server).
Click continue a poll, click Reopen.

Edit a poll
Note: If you edit an open poll, current results are lost.
1. Click Prepare in the upper-left corner of the Poll pod.
2. Edit the text.
3. Click Open.

View poll results
As a host or presenter, you can view poll results. These results are updated in real time as participants continue to cast or change their votes.
1. In the upper-right corner of the Poll pod, click the menu icon.
2. Select Results Format, and choose a display option: percentages, numbers, or both.
The overall responses appear in the Poll pod. To view responses from individual participants, click View Votes.

Show poll results to participants
By default, only hosts and presenters can see poll results, but you can show them to all participants by doing the following:
1. In the upper-right corner of the Poll pod, click the menu icon.
2. Select Broadcast Results.

Navigate among polls
You can create multiple polls and navigate among them quickly and easily.
1. In the upper-right corner of the Poll pod, click the menu icon.
2. Choose Select Poll, and select a poll name.

Clear poll answers
1. In the upper-right corner of the Poll pod, click the menu icon.
2. Select Clear All Answers.

Breakout rooms
Breakout rooms are subrooms that can be created within a meeting or training session. They are useful for splitting a large group into smaller groups that can talk or collaborate. Breakout rooms can be used in meetings and training sessions that have 200 or fewer people. Hosts can create up to 20 breakout rooms for a single meeting or training session.

For example, if you have 20 people in a session, you could create 4 breakout rooms and move 5 attendees to each room. In the breakout rooms, the attendees can speak to each other depending on the audio configuration. They can use the Chat pod, collaborate on a whiteboard, and share their screens. The host can visit all of the breakout rooms to assist and answer questions.
When work in the breakout rooms is complete, the host can end the breakout session and return attendees to the main room. Hosts are able to share what happened in the breakout rooms with everyone. If necessary, the host can return attendees to their same breakout rooms. If you use the room again, you can also reuse the breakout room layout and content. (However, the assignment of attendees to breakout rooms is not retained.)

When an audio conference is in progress, the number of breakout rooms cannot exceed the number supported by the audio provider. If in any of the breakout rooms the number of users exceed the maximum number supported by the audio provider, breakout rooms cannot be started.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Create meetings” on page 13
“Start meetings” on page 18
“Invite attendees and grant or deny access” on page 19

Audio in breakout rooms

Note: Breakout rooms in audio conferences that use universal voice do not have their own audio, just the audio from the main meeting room. If your organization requires that all online conversations be recorded, consider using the compliance and control settings to disable breakout rooms. See “Working with compliance and control settings” on page 211.

If an integrated telephony provider supports Adobe Connect breakout rooms, each breakout becomes a separate audio conference. When breakout rooms are closed, all attendees return to the main audio conference line automatically.

When using a non-integrated provider that supports audio breakouts, manually configure your telephony breakouts (using private audio bridges) to match the online breakout rooms.

If your provider does not support audio breakouts, instead use VoIP with computer microphones. A separate VoIP audio channel is created for each breakout room, allowing each to have separate conversations. Participants are automatically assigned the role of presenter in a breakout room, giving them full VoIP rights. When a host ends a breakout session, everyone returns to the main meeting room and VoIP audio channel.

If VoIP is not possible, attendees can use the Chat pod to communicate in breakout rooms.

Video in breakout rooms

Note the following behavior of the Video pod in Breakout rooms:

- Force Presenter View option is not available in a Breakout room.
- Force Presenter View setting is preserved before and after a Breakout room is used.
- Everyone goes out of the Full Screen mode when a Breakout room is started or ended.

About breakout room layouts

Hosts can use the default breakout room layout or design a new layout to use specifically with breakout rooms. Create a custom breakout room layout if you want to do preparatory work before sending content and people to breakout rooms. Creating custom layouts can help meetings go faster and be better organized.
The layout active when you click the Start Breakouts button is reproduced in all breakout rooms. For example, if layout 1 is active and you begin breakouts with three rooms, those three rooms use layout 1. If you change the meeting or training session to layout 2 and add breakout room 4, then breakout room 4 uses layout 2.

There are cases where you want to have different layouts for different breakout rooms. For example, different breakout rooms may contain different content or attendee exercises. In this case, create separate layouts for the breakout rooms and ensure that the desired layout is active when you click Start Breakouts.

You can create a breakout room during the Preparing mode, while a meeting is in-progress, without disturbing the layout of the participants. When a breakout session is started, the layout created in the Preparing mode is used.

If you want different content in each breakout room but do not require different layouts, prepare the rooms before attendees join the meeting or training session. First configure the number of breakout rooms required. Then, click Start Breakouts and move yourself from room to room, loading the required content into each Share pod. Then, end the breakouts. When attendees join and you click Start Breakouts again, the content is ready. (If necessary, you can also alter the layout and content of breakout rooms during a meeting.)

Creating and managing breakout rooms

Define breakout rooms and assign members
While in a meeting or training session, hosts can create breakout rooms and send attendees into the rooms.

1. In the Attendees pod, click the Breakout Room View button.

   Note: Only the host sees the Breakout Room View of the Attendees pod.

2. In the Attendees pod, three breakout rooms are available by default. Click the Create A New Breakout button until you have the number of rooms you want (the maximum available is 20).

3. Assign attendees to breakout rooms by doing either of the following:
   - Manually select an attendee name in the list (Control-click or Shift-click to select multiple attendees). Then, either select a breakout room from the pop-up menu, or drag attendees to a breakout room.
   - Automatically assign attendees to breakout rooms by clicking the Evenly Distribute From Main button.
   (Attendees previously assigned to specific breakout rooms remain in those rooms.)

   ![Before and after dragging attendees to different breakout rooms]

Begin a breakout session
In breakout rooms, attendees are automatically assigned the role of presenter. They can share their voice, share content in the Share pod, modify whiteboards, and add text to the Notes pod. When attendees are returned to the main room, they revert to their prior status.
**Note:** All attendees, even ones who sign in as guests, can download shared content in breakout rooms.

1. In the Attendees pod, define breakout rooms, and assign attendees to the rooms.
2. Click Start Breakouts.

Attendees are placed in the breakout rooms to which they were assigned.

![Breakout room with attendees assigned as presenters](image)

**Note:** If you are recording a meeting or training session and send attendees to breakout rooms, the recording continues to record only the main room. (To edit the recording so those watching do not have to view an empty main room, see “Edit a recorded meeting” on page 180.)

### Visiting breakout rooms

When breakout rooms are in use, hosts can visit different rooms, including the main room.

- To visit another room, drag your name to it in the Attendees pod.

### Send a message to all attendees in breakout rooms

Hosts can broadcast messages to all breakout rooms. This feature can be useful if you have noticed one or more rooms have a similar question. It is a good practice to send attendees a warning message a few minutes before ending breakout sessions and returning them to the main room. This mechanism allows attendees to finish speaking, loading files, and working on the whiteboard before a breakout session ends.

1. In the upper-right corner of the Attendees pod, click the menu icon \(\equiv\), and choose Broadcast Message.
2. Type the message, and then click Send.

Attendees in all rooms see the message in the center of the Adobe Connect window.

### Communicate attendee status in breakout rooms

Either with or without the Host present, use the options in the Attendee Status View \(\equiv\) of the Attendees pod. For example, ask a question and ask the attendees to respond by using the status options Agree or Disagree.

For more information, see “Communicate with training or meeting attendees” on page 111.

Hosts in the main meeting room can see the status changes of any user in a BOR.

### Conduct a poll in breakout rooms

Hosts can conduct separate polls in each individual breakout room by placing themselves in the rooms and opening Poll pods.

For general information about polling, see “Polling attendees” on page 60.
Asking and answering questions in breakout rooms
Attendees in breakout rooms can ask hosts a question at any time, whether a host is in their breakout room or not.

- To verbally ask a host in the same breakout room a question, use the audio provided (VoIP or telephony).
- To type a question for hosts in the same breakout room, use the Chat pod menu to send a message to the host. The host can then respond in the Chat pod to the attendee alone or everyone.
- To ask all hosts in the meeting a question, type in the Send Message To Hosts box, and then click the Send button. The question appears to all meeting hosts in a small message box with the attendee’s name. Hosts can respond by entering the attendee’s breakout room and using the Chat pod.

Chatting in breakout rooms
If the Chat pod is available in the breakout room, use chat to communicate with others in your room only. You cannot chat with attendees in different breakout rooms.

For general information about using the Chat pod, see “Chat in meetings” on page 54.

End a breakout session
Only hosts can end a breakout session. When breakout rooms are closed, all attendees are returned to the main meeting room.

- In the Breakout Room View of the Attendees pod, click End Breakouts.

Share breakout room content in main room
After ending a breakout session, hosts can share the contents of a single breakout room with everyone in the main room.

1. In the main room, choose Pods > Breakout Pods.
2. Select a breakout room name, and then select Chat, Share, or Whiteboard.

The selected content appears in a new floating pod. The contents are view only and cannot be changed or edited.

Reopen closed breakout rooms
After ending a breakout session, you can return attendees to the breakout rooms again. The configuration of rooms and assigned users remains in place for the entire meeting.

1. In the Attendees pod, click the Breakout Room View button.
2. (Optional) Make changes, such as adding a room, deleting a room, or moving attendees into different rooms.
3. Click Start Breakouts.
**Remove breakout rooms**

*Note:* In the Pods menu, pods from breakout rooms remain available until you remove them in the Attendees pod.

- To remove all rooms, click the Attendees pod menu ▼, and choose Remove All Rooms. To store pod content, select Save Pod Information For Future Reference, and enter a session name. (You can access saved pods from the Pods > Breakout Pods menu.)
- To remove an individual breakout room, including all pods and content it contains, click the X button to the right of the room name. The numbering of subsequent rooms is adjusted to ensure continuity.

**Managing attendees**

In the Attendees pod, everyone can quickly see who is logged in to a meeting. Hosts and presenters can monitor attendee names, roles, and statuses (such as Raised Hand or Agree). If configured, the active speakers are also displayed in real time, in a dedicated area in the Attendees pod.

Use the Attendee (A) and Attendee Status (B) views to monitor names, roles, and discussion status.

*Note:* Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

**More Help topics**

“Enable microphone for participants using computers” on page 170

“Participating in training sessions and meetings” on page 111

**View or change an attendee’s role**

A host can change the role of any attendee in the Attendees pod, promoting, and demoting attendees as necessary.

**More Help topics**

“Meeting roles and permissions” on page 5

“Invite attendees and grant or deny access” on page 19

“Work with pods” on page 20
About attendee names

Adobe Connect users who logged in with a password appear with their full name in the Attendees pod, as it is registered in Adobe Connect Central. If an attendee logs in to a meeting as a guest, the name in the Attendees pod is the name the attendee entered at login. Within a role group (hosts, presenters, and participants), attendee names are organized alphabetically.

Attendees pod displays the telephone number of the participants who dial in or dial out using a telephone. Meeting Hosts can mask the phone numbers of the participants to respect the privacy of the participants. The option is available in the in-meeting preferences dialog, in the Attendee Pod section. The option is persistent for a meeting room.

*Note:* The option for Hosts to mask the phone numbers is enabled only if masking is not enabled cluster-wide from telephony capabilities on a cluster.

Customize attendee names

As a meeting host, you can customize the display name of attendees in the Attendees pod. You can include custom information in display names, and sort attendees based on the customized display names.

To add custom information:

1. In the upper-right corner of the pod, click the menu icon.
2. From the pop-up menu, select Preferences.
3. In the dialog box, select Display Name on the left pane and then select Customize format.
4. From the Available fields list, select predefined custom fields for the display name, and include them in the Displayed fields list. The custom fields hold custom information for the attendees. You can sort attendees based on the information in these fields. To include additional custom fields, see Add custom fields.
5. Select a custom field in the Available fields list, and then select a delimiter from the corresponding list at the bottom.

*Note:* The custom changes to the display name attendees reflect immediately at all places on the Adobe Connect interface, including Chat pods and polls.

To sort attendees based on their customized display names:

1. In the Attendees pod, click the menu icon in the upper-right corner.
2. From the pop-up menu, select Preferences.
3. In the dialog box, select Attendees Pod on the left pane.
4. From the Available fields list, select custom fields to sort attendees, and include them in the Sort by list.
5. Click Done to sort attendees based on the custom fields in the order they appear in the Sort by list.

To add custom fields:

*Note:* You need administrator rights to modify custom fields. Modifying custom fields impacts the entire account.

1. From the Adobe Connect main menu, click Administration.
2. From the second-level menu, click Users and Groups.
3. From the next-level menu, click Customize User Profile.
4. Click Add Predefined Field to add a custom field in Adobe Connect.
Change an attendee’s role

As a host, you can demote yourself to a presenter or participant, revealing how attendees with other roles see the meeting room.

1. In the Attendees pod, select one or more attendees. (Shift-click to select multiple.)
2. Do either of the following:
   - Drag the attendees to different roles.
   - From the pop-up menu, select Make Host, Presenter, or Participant.

Automatically promote participants to presenters

If all participants in a meeting are presenters, do the following:

❖ Choose Meeting > Manage Access & Entry > Auto-Promote Participants to Presenters.

Assign enhanced participant rights

Hosts can change the rights of a participant to give them control over selected pods. This arrangement enhances a participant’s rights without promoting the participant to the presenter or host role.

1. In the Attendees pod, select the name of one or more participants.
2. In the upper-right corner of the pod, click the menu icon 
4. In the dialog box, select the pods that you want the participant to control.

More Help topics
“Meeting roles and permissions” on page 5
“Work with pods” on page 20

Remove an attendee from a meeting

1. In the Attendees pod, select the attendees you want to remove.
2. In the upper-right corner of the pod, click the menu icon 
   and choose Remove Selected User.

More Help topics
“Invite attendees and grant or deny access” on page 19
“Work with pods” on page 20
View and change attendee status

By default, participant status is blank in the Attendees pod. However, participants can change their own status. When a participant selects a status, an icon appears to the right of the participant’s name. Participants can clear their status at any time during a meeting.

More Help topics
“Participating in training sessions and meetings” on page 111
“Meeting roles and permissions” on page 5
“Invite attendees and grant or deny access” on page 19
“Work with pods” on page 20

View attendee status
❖ In the Attendees pod, do either of the following:
  • To view statuses grouped by hosts, presenters, and participants, click the Attendee View button.
  • To view groups of attendees who share a status (such as Disagree), click the Attendee Status View button.

<table>
<thead>
<tr>
<th>Attendee status</th>
<th>Icon</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raise Hand</td>
<td>🗹</td>
<td>Remains displayed until attendee or host clears</td>
</tr>
<tr>
<td>Agree</td>
<td>✅</td>
<td>Remains displayed until attendee or host clears</td>
</tr>
<tr>
<td>Disagree</td>
<td>❌</td>
<td>Remains displayed until attendee or host clears</td>
</tr>
<tr>
<td>Step Away</td>
<td>🏞</td>
<td>Remains displayed until attendee clears</td>
</tr>
<tr>
<td>Speak Louder</td>
<td>📜</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Speak Softer</td>
<td>🎧</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Speed Up</td>
<td>🎮</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Slow Down</td>
<td>🎭</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Laughter</td>
<td>🎈</td>
<td>10 seconds</td>
</tr>
<tr>
<td>Applause</td>
<td>🎉</td>
<td>10 seconds</td>
</tr>
</tbody>
</table>

Change your status (participant)
When you select one of these statuses, the status icon is displayed in the Attendees pod for 10 seconds:
  • Speak Louder
  • Speak Softer
  • Speed Up
  • Slow Down
• Laughter
• Applause

The Raise Hand, Agree, and Disagree status icons remain visible until you or the host remove them manually. Attendees can remove the Stepped Away status icon themselves.

In application bar, click triangle to right of status button to access other statuses

1 In the application bar, click the triangle to the right of the status button.
2 Select the status you want to show to all attendees.

💡 To quickly toggle the Raised Hand status, simply click the button to the left of the menu. (If you select the Raise Hand status and then select another status, the second status icon is displayed, but the Raised Hand remains in effect.)

Clear a participant’s status (host)
1 In the Attendees pod, select one or more participant names.
2 In the main menu, click the triangle to the right of the status button, and choose Clear Status.

Clear everyone’s status (host)
❖ From the Attendees pod menu , choose Clear Everyone’s Status.

Disable hand raising or change notification duration
1 Choose Meeting > Preferences.
2 In the list on the left, click Attendees Pod. Then do either of the following:
• Select Disable Raise Hand.
• Choose a notification duration from the pop-up menu. Select Persist In Screen Share if you want notifications to remain visible during screen sharing until a host closes them.
Chapter 3: Adobe Connect Training and Seminars

About Adobe Connect Training

About content, courses, and curriculums

Note: You can only use the Training application if this feature has been enabled for your Adobe Connect account.

The Adobe Connect Training application consists of content, courses, curriculums, and virtual classrooms.

Content is files stored in the Adobe Connect Content library. Content can be any of the following file types: PPT, PPTX, FLV, SWF, PDF, GIF, JPG, PNG, MP3, HTML, MP4, F4V, or ZIP.

With content, no individual user information is stored. Reports are created for content, but they are aggregate, content-specific reports, and are based on access. If content is created with Adobe Presenter and the presentation contains quizzes, you cannot set the number of attempts users have to pass the quizzes. (In contrast, you can set number of attempts with courses.)

Also, content contains no resume functionality so, for example, if a user quits half way through a content item, the next time they launch the item they are taken back to the beginning of the content.

You can publish Adobe Presenter, Adobe Captivate, PDF, and third-party SCORM content to the Content library. For Adobe Presenter and Adobe Captivate, the user continues to be able to Publish to Adobe Connect directly from the application. For PDF and third-party content the user is able to upload the file or a ZIP package to the Content library.

Note: Do not name a SCORM launch file or references with ‘+’ character in the filename or with filename beginning with a number.

A course contains any item from the Content library. A course is associated with a given set of enrolled learners and contains no usage tracking for each individual learner. The course can be delivered and administered independently or as part of a curriculum or virtual classroom. When you use courses, scores can be captured for AICC-compliant objects and you can enforce the number of attempts users have to complete the course. Courses also contain resume functionality so that users can view half a course, close the course, and then open it again later at the spot where they left off.

A virtual classroom can be used to conduct training sessions. Virtual classrooms are added to a curriculum, just like a course. There are three access levels for virtual classrooms: enrolled students only, enrolled students and accepted guests, and anyone who has the URL for the virtual classroom.

A curriculum is a group of courses, meetings, and virtual classrooms that moves students along a particular learning path. A curriculum consists primarily of courses, but can include other items such as live training sessions. With curriculums, you can assign prerequisites, test-outs, and completion requirements to enforce a specific learning path. As is the case with courses, you can generate reports to track the progress of the enrollee as they move through the curriculum to ensure that they meet the learning objectives.
Training courses and curriculums have three attendance permissions: Enrolled, Denied, and Pending Approval. Enrolled indicates a learner whom a training manager placed in a course or curriculum; Denied indicates a user who is denied access to that course or curriculum. Usually a training manager uses the Denied permission to exclude a user from a group course (for example, if that user already took the course). Pending Approval indicates a user waiting for approval from the training manager.

**Note:** Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of virtual classrooms and what you can do in virtual classrooms. For more information, see “Working with compliance and control settings” on page 211.

**More Help topics**
- “Creating a course” on page 77
- “Creating a curriculum” on page 85
- “Creating a virtual classroom” on page 96
- “Working with content in the Content library” on page 190

**Accessing the Training library**
All Adobe Connect Training courses, curriculums, and virtual classrooms are contained and organized in a directory of folders called the Training library. You access the Training library by clicking the Training tab at the top of the Adobe Connect Central window. As you navigate the library, the names of the folders appear as a navigation trail at the top of the browser window.

A Training Manager can create courses and curriculums. Adobe Connect 9.4 onwards, a Virtual Classroom Manager also has all the permissions that a Training Manager has and can create courses and curriculums. To manage a Training library folder, you need not be a training manager, but you must have Manage permissions for this folder in the Training library. You can create a course object using existing content types (including Adobe Presenter, Adobe Captivate, PDF, and many others). You can also create course objects using third-party SCORM content. Course metadata (Edit Information, Enrollment, Communications, and so on, all Course Object tabs) can be defined on these objects in Training. Any of the Course objects defined in Training can be added to Curriculums.

**More Help topics**
- “Working with library files and folders” on page 187
- “Working with content in the Content library” on page 190

**About Training library permissions**
Consider the following aspects of permissions when you work with the Training library:

**Enrollee permissions** define the access that learners have for a given course or curriculum. The three enrollee permissions are: Enrolled, Denied, and Pending Approval. Individuals with an Enrolled permission can view a course or curriculum; individuals with a Denied permission cannot access the course or curriculum. Individuals with a Pending Approval permission need approval from the training manager.

Enrollee permissions are assigned when a course or curriculum is created. Permissions can also be changed after the course or curriculum is created. To change permissions, the training manager must open the course or curriculum and edit the participant list to add or remove enrollee. The training manager must also have Manage permissions for the folder where this course or curriculum is located.
Training library management permissions define who can perform the different tasks associated with the Training library files and folders, such as adding and deleting files, searching the library archives, and so on. The ability to create, delete, and edit courses and curriculums in various folders in the Training library is determined by the groups that a user belongs to and the individual permissions that are assigned to a user for specific files and folders. The Training library has only two permissions: Manage and Denied.

Members of the Administrator group can manage all files and folders in the Training library. By default, training managers have Manage permissions only for their individual folder in the User Training folder. This means that training managers can add, delete, change, or assign permissions only for their own folders. All other Manage permissions are assigned on an individual or group basis by the administrator.

Training library permissions for Built-in groups Adobe Connect recognizes six default permission groups called Built-in groups. You cannot change the permissions for these groups, but you can extend them by assigning individuals or groups to more than one Built-in group.

The Training module applies to the Training Managers group. This group is associated with the Training library. Each training manager has an individual folder in the User Training folder within the Training library, in which they can create and administer their courses and curriculums. Each training manager also has a content folder. Your Adobe Connect administrator can also assign Manage permissions for specific Training library folders to users who are not training managers. Only training managers can create new courses or curriculums, however.

More Help topics
“Working with library files and folders” on page 187
“Working with content in the Content library” on page 190
“Multiple permissions precedence” on page 245

Course and curriculum registration
Depending on the type and purpose of a given course or curriculum, the training manager might want to have the guests register. If so, the manager must have the Event Management tab as part of the Adobe Connect Central application, since registration for any training can only be done through the Event Management tab. A training manager who has this tab must first use the Course or Curriculum wizard to create the course or curriculum from the Training tab, but skip the select participant and send invitations steps. Next, the training manager creates an event by opening the Event Wizard, selecting the Present A Adobe Connect Training Course Or Curriculum option, and selecting the course or curriculum to be used as an event.

The Event wizard lets the training manager select and invite enrollee, select and customize registration questions, and send invitations, even to large email lists.

If the training is presented as an event, all enrollee, regardless of whether they have an Adobe Connect account or whether the URL is public, must provide registration information before the training. In this case, the training manager can review the registration applications before the training and approve or deny admittance to each registrant.

More Help topics
“Events overview” on page 122

AICC content for courses
When you use Aviation Industry CBT Committee (AICC) content in courses, Adobe Connect applies some specific rules. For more information, see “Upload content” on page 191.
**Viewing data about training**

The Training Dashboard contains two-bar graphs, one for courses and one for curriculums:

**Course Summary Over the Last 30 Days**  
Shows the courses over the last 30 days with the greatest number of enrollee who have passed; click any bar to see more detail.

**Curriculum Summary Over the Last 30 Days**  
Shows the curriculums over the last 30 days with the greatest number of enrollee who have completed the curriculum; click any bar to see more detail.

The bar graphs appear within Adobe Connect Central. However, you can also export the Dashboard to a browser window that you can print. To export the Dashboard, click Printable Version on the left, above the display.

**More Help topics**
- “Viewing data about content” on page 196
- “Monitoring training with reports” on page 102

**Create and manage training groups**

From the Training tab in Adobe Connect Central, Training managers, Administrators, and Limited Administrators can create, change, and remove sets of learners called training groups. Training managers can modify any training groups, including those created by other Training managers.

*Note: Training managers cannot create new users, modify information about existing users, delete users, delete groups not created by training managers, or assign users to system groups.*

**More Help topics**
- “Manage curriculum enrollee” on page 95
- “Managing users and groups” on page 232

**Create a training group**

Training groups cannot be given the same name as system groups or administration groups.

1. Click the Training tab in Adobe Connect Central.
2. Click Users and Groups.
3. Click New Group.
4. Enter a name for the new group.
5. (Optional) Type in a description of the group.
6. Click Next.
7. In the Possible Group Members list, select a user or group and click Add. You can also click Search to find a user or group that is not listed.

As you add users and groups, the Current Group Members list on the right is updated to reflect your changes.

8. When you are done, click Finish.

**Add learners to an existing training group**

1. Click the Training tab in Adobe Connect Central.
2. Click Users and Groups.
In the Users and Groups list, select the group you want to change and click Information.

4. Click View Group Members.

5. In the Possible Group Members list, select the individual or group you want to include and click Add.

**Remove learners from a training group**

1. Click the Training tab in Adobe Connect Central.

2. Click Users and Groups.

3. In the Users and Groups list, select the group you want to change and click Information.

4. Click View Group Members.

5. In the Current Group Members list, select the member or members you want to delete and click Remove.

**Using CSV files to add learners**

If you have a comma-separated values (CSV) file, you can use the file to add learners. Three different kinds of imports can be done.

Before you can perform any of these imports, create a UTF-8 encoded CSV file. You can also use or modify an existing CSV file. The CSV file you create must include the correct information.

To add training groups, use a CSV file with each row containing name and description like the following:

<table>
<thead>
<tr>
<th>name,</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group 1,</td>
<td>HRTraining</td>
</tr>
<tr>
<td>group 2,</td>
<td>FinanceTraining</td>
</tr>
<tr>
<td>group 3,</td>
<td>SalesTraining</td>
</tr>
<tr>
<td>group 4,</td>
<td>ProductTraining</td>
</tr>
<tr>
<td>group 5,</td>
<td>MarketingTraining</td>
</tr>
</tbody>
</table>

To add users to a selected group, use a CSV file with each row containing a login like the following:

<table>
<thead>
<tr>
<th>login</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:rblatt2@mycompany.com">rblatt2@mycompany.com</a></td>
</tr>
<tr>
<td><a href="mailto:rbloom3@mycompany.com">rbloom3@mycompany.com</a></td>
</tr>
<tr>
<td><a href="mailto:cbond4@mycompany.com">cbond4@mycompany.com</a></td>
</tr>
<tr>
<td><a href="mailto:pdavis5@mycompany.com">pdavis5@mycompany.com</a></td>
</tr>
</tbody>
</table>

To add learners to a training group, use a CSV file with each row containing a login and name like the following:

<table>
<thead>
<tr>
<th>login,</th>
<th>group name</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:mbetts1@mycompany.com">mbetts1@mycompany.com</a>,</td>
<td>group 1</td>
</tr>
<tr>
<td><a href="mailto:rblatt2@mycompany.com">rblatt2@mycompany.com</a>,</td>
<td>group 1</td>
</tr>
</tbody>
</table>
Notice that in the third example above, you can add the same user to multiple groups in the same CSV file; user cbond4@mycompany.com has been added to group 1 and group 2 using two separate entries.

Here are some additional tips for using CSV files:

- Because of browser limitations, Adobe recommends that if you have a large number of users to add, that you create several smaller CSV files instead of one large CSV file.
- Use quotes around names containing comma. For example, the name John Doe, Jr., must appear in the CSV file as “John Doe, Jr.” for the file to import correctly.

**Add learners using a CSV file**

1. Click the Training tab in Adobe Connect Central.
2. Click Users and Groups.
3. Click Import.
4. Select one of the following options:
   - Click Create New Groups to have the groups in the imported CSV file (containing rows with name and description) become their own new training group. This option creates training groups.
   - Select Add Existing Users To A Group to have the users in the imported CSV file (containing rows with login information) added to the group you specify in the drop-down menu.
   - Select Add Existing Users To New/Existing Training Groups to have the users in the imported CSV file (containing rows with login and group name) added to the training group specified as the name value on each row of the CSV file. Select the Create New Training Groups From CSV File option to create new training groups for any groups specified in the CSV file that do not exist as a training group in Adobe Connect. When the new training groups are created, users are added if their login appears on the same row in the CSV file as the new group. (If the Create New Training Groups From CSV File option is not selected, every row in the CSV containing a training group name that does not exist generates an error.)
5. Click Browse, and navigate to the desired CSV file.
6. Click Upload.

When finished uploading, a confirmation message appears stating if the import process was successful. Information about users and groups imported is also provided. An error report is generated for entries that fail the import process.

**Tips for creating training courses and curriculums**

Following are some tips for creating training courses and curriculums in Adobe Connect Training:

- Use Adobe Presenter and Adobe Captivate to create content for courses. Presenter is suitable for the creation of rapid e-learning content using Microsoft PowerPoint. Adobe Captivate can be used for creating training materials that must contain complex branching and simulations.
- At the course level, set client-side maximum retries to one and server-side maximum retries to any number. (Set server-side maximum retries to unlimited if you want learners to have as many attempts as they need to pass.)
• Add curriculum items directly into curriculums, not into folders.
• When adding content from the Content library directly into a curriculum, the content is automatically converted to a course and tracking is enabled. For example, when you add a PDF file to a curriculum, that file becomes a course and tracking can be done down to the page level (you can see if learners looked at seven out of ten pages or all ten pages of the file). In addition, a curriculum resource folder is automatically created and any curriculum-specific courses (that is, content automatically converted to a course for this curriculum) are placed in the folder.
• Communicate with your learners about how to take courses and curriculums, especially any specific settings you have used. For example, tell them how many times they can attempt to pass a quiz. Also, if you change a curriculum after making the curriculum available, such as adding or removing items, inform your learners.
• Ask learners to open an item or course in only one browser window and to close that browser window when they are done.
• When planning to make a large curriculum available, do a test first. For example, ensure that your Adobe Connect system (network, servers, database, and so on.) is set up properly and has sufficient resources to manage the volume of learners scheduled to enroll in the curriculum.
• Minimize changes to your courses and curriculums after you have made them available to learners.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of virtual classrooms and what you can do in virtual classrooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Creating a course” on page 77
“Creating a curriculum” on page 85
“About changes to course content” on page 80
“Adding and deleting items from a curriculum” on page 88

Creating training courses

Creating a course
A course is content for a set of enrolled learners that also includes usage tracking for each learner. For example, a course could be a stand-alone presentation offered as part of a curriculum or shown in a virtual classroom.

Note: The material on courses applies only to accounts that include the Adobe Connect Training application.

In creating a course, your workflow involves the following tasks:

1. Create content and add to Content library
A course is based on existing content, so ensure that you have content such as presentations, PDF files, or image files stored in your Content library. Content can be any of the following file types: PPT, PPTX, FLV, SWF, PDF, GIF, JPG, PNG, MP3, HTML, MP4, F4V, or ZIP. See “Upload content” on page 191.

2. Start the Course wizard
On the Adobe Connect Central Home page, locate the Create New menu bar and click Course. Alternatively, click Training > New Course.
3. Course information
On the first page of the Course wizard you enter background details about the course, such as a name and summary. (Only the course name is required; all other fields are optional.) You can edit this information after the course is created.

Note: By default, the Update Information for Any Items Linked To This Item option is selected. Since you are creating a course, you probably do not have any items linked to the course yet, but keep this item selected if you think you will link any items later.

4. Select course content
In this part of the Course wizard, Adobe Connect directs you to the Content library, where you navigate to the content file you want to use. You can select only one file from the library, and you must have either View or Manage permissions for this file. After adding content, you can continue in the wizard and enroll learners or save the curriculum and exit the wizard. (To enroll learners, set up course notifications, or enable email reminders later, you can edit the course.) You can run Adobe Presenter, Adobe Captivate, PDF, and third-party SCORM content from the Content library URL in a web browser. All listed content items are objects within the Content library, with existing permissions, content-level tracking, information pages, and so on. Users are able to access this content from the library URL, as with content in the existing product today.

5. Enroll learners
Only enrolled users can browse to the course URL and log in to view the course. To enroll large numbers of users, if you have the Event Management application, present the course as an event. You can add and delete learners, as required, after the course is created. For information about enrolling users in bulk, see “Add or remove course enrollee” on page 83.

6. Set up notifications
A course notification is an email message telling enrollee how to access the course.

When you format your notification, you can use run time fields in the subject line and in the body of the message. These fields are course information variables that are automatically filled in for you when the email notification is sent. You can change the course notifications after the course is created.

7. Set up reminders
Reminders are optional. A course reminder is an email message sent to either all or selected course enrollee after you set up the course. You can use reminders, for example, to remind enrollee that they are scheduled to take the course or to notify specific individuals that they are required to complete the course.

More Help topics
“About changes to course content” on page 80
“Edit courses” on page 82
“Creating a curriculum” on page 85
“Creating virtual classrooms” on page 96
“Working with content in the Content library” on page 190

View course information and the enrollee list
After you create a course, you can view information about the course and a course enrollee list.
View course information

You can view or change information about a course from the Course Information page, the page that appears when you click the course name in the Training folder list. From this page, you can view or edit the information for a specific course, including the course summary, content, enrollee, and settings for notifications and reminders. Each of these features is accessible as a navigation link.

Every course has a Course Information page, which is a summary that contains the information displayed in the following illustration.

![Course Information](Image)

The Course Information page shows key information about individual courses.

**Course Information** The course name, ID, summary, open date, close date, course URL, number of slides or pages, duration, maximum attempts (the maximum number of attempts the enrollee has to pass this course), maximum score, and language.

**Training Catalog Settings** Details about the Training Catalog options selected when the course was created, such as self-enrollment procedures and notifications.

**Reminder Policy** A field that indicates whether a reminder policy is enabled, to whom reminders are being sent, the date that the next reminder is sent, and how often reminders are sent. Click the Training tab at the top of the Adobe Connect Central window. Navigate to the folder that contains the course for which you want to get information. In the course list, click the name of the course to select it.

**View a course enrollee list**

1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the folder that contains the course.
3. In the course list, click the name of the course.
4 Click the Manage Enrollees link in the navigation bar. A list of enrolled users and groups are shown in the Current Enrollees window on the right.

**About notifications and reminders**

Notifications are placed in a queue and are sent as follows:

- Notifications set to Send now are sent when you click Send.
- Notifications set up for future dates are processed every night at midnight. On the set date, depending on the number of notifications in the queue, they are sent within a few minutes or a few hours after midnight PST.

Notifications appear to be sent from whoever creates the course, using the email address specified in their Adobe Connect account. Any email delivery failure notifications are also sent to that address.

All email notifications are sent individually. Recipients do not see the list of other recipients in the message header.

Reminders are placed in a queue and are sent as follows:

- Reminders to be sent starting on the current date are sent shortly after the course is created.
- Adobe Connect sends reminders from the person who creates the course, using the email address specified in the curriculum creator’s Adobe Connect account. The email reminders are sent individually; recipients do not see the list of other recipients in the message header. (Also, any email delivery failure notifications are sent to the course creator’s email address.)
- Reminders set up for future dates are processed every night at midnight. On the set date, depending on the number of email reminders in the queue, they are sent within a few minutes or a few hours after midnight PST.

**More Help topics**

“Creating a course” on page 77

“Edit courses” on page 82

**About changes to course content**

Following are some important points to remember when changing course content:

- When you add content to a course, the content is copied into the course. If you change the original content file, the change is not carried over to the course. (For more information, see “Edit courses” on page 82.)
- When you add a course to a curriculum, it is a link to the course and not a copy. If you change a course, the change is carried over to the course inside a curriculum.
- Try to minimize changes to course content if the current course content has a quiz that users have already taken. Minimizing changes helps lower the number of versions that exist. It also lowers the number of reports for users who took earlier versions.

**More Help topics**

“Tips for creating training courses and curriculums” on page 76

“Adding and deleting items from a curriculum” on page 88
About review modes

Adobe Connect Training contains two review modes: server-side and client-side. It’s important to understand these review modes, especially if your courses contain quizzes.

**Server-side review mode** is used only with Adobe Connect Training courses. For courses, a training manager can specify the maximum attempts a learner has to complete or pass the course successfully. A learner is locked into review mode in the following cases:

- The learner has passed or completed the course within the set number of maximum attempts.
- The learner has exceeded the maximum number of attempts allowed to pass or complete the course.

Learners can see whether they are locked into review mode two ways:

- The text “[Review Mode]” appears in the browser title bar when a course is opened.
- This message appears at the top of the screen: “You have exhausted all your attempts and are now in Review Mode. Any choices selected will not be tracked.” (The message most often appears when course is in review mode within a virtual classroom.)

If learners are in review mode and they take any quizzes included in the course, their scores and statuses are not posted to Adobe Connect. This prevents learners from trying to improve their score after passing a course.

**Important:** *Open a course or item in only one browser window at a time and close the window when they finish. Learners may be locked into review mode incorrectly if they open the same item or course in multiple windows simultaneously.*

The server-side maximum retry setting for a course carries over to all Curriculum items that link to the course. Because the server-side retry setting for the course is the only one that is enforced, Adobe recommends disregarding curriculum-level maximum retry settings.

**Client-side review mode** is enforced through the maximum retry setting in presentations created with Adobe Presenter and Adobe Captivate. Client-side review mode applies only to retries attempted within a single browser session. However, client-side review mode can persist across multiple browser sessions if the user exits the presentation before finishing, causing resume data to be sent to the server.

In Adobe Presenter the retry setting is defined in the Quiz Manager pass or fail options. For example, if you set the “If failing grade allow x attempts” option to 1, users have only one chance to take the quiz. Suppose that a user begins taking the quiz, then leaves it to view a slide that is not part of the quiz or begins a second quiz in the presentation. By exiting the first quiz while the presentation is still open (a single browser session), the user exhausts the single allowed attempt and can’t re-enter the quiz. Now suppose that a user enters a quiz, answers one or two questions (but not enough to pass the quiz), and closes the browser. In this second case, the user exited the presentation but not the quiz. When the second case happens, resume data is sent to Adobe Connect and, if the user is permitted another server-side (course-defined) attempt, the user can open the presentation again and continue working on the first client-side attempt (although it is the second server-side attempt).

To prevent possible status and score discrepancies, Adobe recommends setting the client-side maximum retry attempts to 1. (In both Presenter and Adobe Captivate, the default setting is 1.) A client-side setting of 1 does not mean that the user has only one chance to complete or pass the course; the course-level setting governs the maximum number of retries.

You can run Adobe Presenter, Adobe Captivate, PDF, and third-party SCORM content that has been defined as a Training Course from a Training Library or Catalog URL in a web browser. All listed course items are objects within the Content library, with existing permissions, course-level tracking, and information pages. You can access courses from the library and catalog URL.
Edit courses
If you are an administrator or a user with permission to manage a specific Training library folder, you can manage courses.

More Help topics
“About changes to course content” on page 80
“About notifications and reminders” on page 80
“About review modes” on page 81
“Working with content in the Content library” on page 190

Edit course information
You can edit course information, which includes the course name, ID, summary, start date, and close date.

1 Click the Training tab at the top of the Adobe Connect Central window.
2 Navigate to the course.
3 In the course list, click the name of the course.
4 Click the Edit Information link in the navigation list.
5 Edit the course information. You can change the following information:

Course Name  (Required) The name of the course; it appears in the course list and in reports.
Course ID The course number or ID: for example, 100, CS100, and so on.
Summary A course description that appears on the Course Information page.
Course Starts On The date before which users cannot access the course. If you change an existing course’s start date to a later date, no users (not even those who already accessed the course) can access the course until the new start date. If some enrollee have already accessed the course, their tracking and quiz information is retained in reports.
Course Closes On The date after which users cannot access the course.
Max Attempts The maximum number of attempts the enrollee has to pass this course; if you leave Max Attempts blank, you are allowing an unlimited number of retries.
Max Possible Score The maximum score a user can receive. Use this option for course content that is not already graded, such as a PDF, or only sends a partial score, such as Adobe Captivate content (content used determines the maximum score).

Note: For content that includes multiple scored quizzes, the max possible score for the overall content is not automatically detected when the content is added to a course. For example, a presentation containing two quizzes, one with a maximum score of 50 and a second with a maximum score of 40, reports the max score of the last quiz taken (40). For a more accurate total score, consider creating one quiz and distributing the questions throughout the presentation instead of using multiple quizzes. For example, create a quiz with ten questions. In the presentation, show four content slides, quiz questions 1-5, eight more content slides, and then questions 6-10.

6 By default, the Update Information for Any Items Linked To This Item option is selected. Keep this selected if you think you will link any items to the course.
7 Click Save.

Changing the course title or course summary does not change the information on a presentation summary slide. This slide uses the information specified at the time the presentation was originally published. To change this information, republish the content and then reselect the content that the course uses.
Change or update course content
You can change or update the content in a course. If you want to update the content, first publish the updated file to the Content library.

1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the course whose content you want to change. In the course list, click the name of the course to select it.
3. Click the Select Content link in the navigation bar.
4. Navigate to the folder that contains the content that you want to use for the course.
5. Select the button next to the content that you want to use for the course. You can select new content or an updated version of the existing content.
6. Click Save.
7. A warning message is displayed. To update the content, click Yes, Update My Content.

Add or remove course enrollee
If you add enrollee to a course, notify the new enrollee. You can also set up reminders for them.
If you remove enrollee, they do not receive notification and are no longer able to access the course.

1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the course.
3. In the list, click the name of the course.
4. To modify enrollment one at a time, click the Manage Enrollees link in the navigation bar. Do one of the following:
   • Select enrollee in the Available Users and Groups list and click Add. (Press Control-click or Shift-click to select multiple users or groups. To expand a group to select individual members, double-click the group name. Then select individual users.)
   • Select enrollee in the Current Enrollees list and click Remove.
5. To add enrollee in bulk, upload the names in a TXT or a CSV format, using the following steps:
   a. Create a CSV or a TXT file with the list of email IDs of users who already have an Adobe Connect account. Set the title of the first column containing the email IDs of users as login. Click Import Enrollees, and upload the CSV or TXT file. Upon successful import the role of each enrollee is Participant. Change the roles of various enrollees using the user interface, if necessary.
   b. (Optionally) Select the checkbox ‘Send Email Notifications to user enrolled on import’ to send email notifications.

   Note: Duplicate entries in the CSV or TXT file are successfully imported at the first instance. The duplicate instances are ignored and reported after the import.

Change settings for course notifications or reminders
Notifications and reminders help you communicate with course enrollee. You can change the settings of pending notifications and reminders at any time.

1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the course.
3. In the course list, click the name of the course.
4. Click the Notifications link in the navigation bar.
5. Click Pending Notifications.
6. Under Subject, click the name of the notification or reminder you want to change. (Notifications appear in the subject list with the notification icon and reminders appear with the reminder icon.)

7. Click Edit at the bottom of the page.

8. Make changes, such as editing the timing, recipients, or message text. (If you enter email addresses, use commas to separate the addresses.) To edit the email subject and message using a run time field, copy the field name from the Run Time Fields list and paste it into the message subject or body. Do not change the run time field text in curly brackets.

9. Click Send to apply the changes.

Delete a course

Before you delete a course, be aware of the effect of this action:

- The course is removed from the Training library.
- Enrollees can no longer access the course.
- Reports for the course are no longer available. (To prevent access to the course while retaining reporting information, set the course close date and do not delete the course.)
- No more course reminders are sent, and delayed course notifications are not sent.
- The content used by the course remains in the Content library.
- The course is removed from the item list of any curriculum in which it is included. This affects the curriculum reports. Be careful when deleting courses that are included in curriculums.

1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the course.
3. Select the check box to the left of the course that you want to delete.
4. Click the Delete button.
5. On the confirmation page, click Delete.

Creating training curriculums

About curriculums

A curriculum can include courses, presentations, and meetings. You can define prerequisites for a curriculum, and you can design your program so that users can test out of certain curriculum items.

As users complete items in the curriculum, you can track their progress and generate reports to ensure that the curriculum meets the learning objectives.

The key features of curriculums let you do the following:

- Organize items, such as courses and presentations, in logical groups that support a learning path.
- Define prerequisites and test-outs for items, allowing enrollee to bypass certain curriculum items if they pass the corresponding test-out item.
- Specify completion requirements - items required to successfully complete the curriculum.
- Send email notifications and reminders to users regarding the curriculum.
- Generate reports that include curriculum statistics.
· View a visual representation of report data using the Training Dashboard.

More Help topics
“Creating a course” on page 77

Creating a curriculum
A wizard guides you through the main steps of creating a curriculum, such as entering curriculum information and selecting courses for the curriculum. After you create a curriculum, you can complete additional tasks, such as adding enrollee and sending reminders.

In creating a curriculum, your workflow involves the following tasks:

1. Browse to a curriculum location
   You can create or browse to a folder in the Training library in which you want to publish the curriculum (you must have permission to access the folder). When you determine a location, you click New Curriculum to open the New Curriculum wizard and create your curriculum in the selected location.

   ![Navigating the Training library](image)
   A. Determine a location   B. Create another folder or add a new curriculum

   **Note:** If you want to save your curriculum in your User Training folder, you can bypass this procedure by simply clicking the New Curriculum link on the Adobe Connect Central Home page and following the steps to enter curriculum information.

2. Enter curriculum information
   The first page of the New Curriculum wizard lets you enter details, such as descriptive summary information and start and end dates, about the curriculum. (You must enter the curriculum name, but all other fields are optional.) The information that you enter in the wizard appears later on the Curriculum Information page, as well as on the page that enrollee access from their My Training link.

   The Custom URL box displays the first part of the URL that users click to access the curriculum. You can leave the box blank to have Adobe Connect generate a system URL or enter a custom URL in the box. For example, you can enter a word that describes the curriculum.

   **Note:** The start and end dates that you select override the start and end dates for the individual items in your curriculum. For example, if you add a meeting with an end date that already passed, but your end date for the curriculum is in the future, the meeting assumes the end date of the curriculum.

Last updated 3/20/2015
3. **Add items to the curriculum**

After you enter curriculum information in the New Curriculum wizard and click Next, a page appears that lets you add items to the curriculum. When you add an item to a curriculum, you are actually adding a link to the item, not copying the item in a new location within Adobe Connect.

You can add content from the Content library, a meeting from the Meeting library, a virtual classroom, or any existing courses to a curriculum. Content added to a curriculum is now automatically converted to a course so it can be tracked accurately. The new course is added to the automatically created curriculum resource folder. (This folder is in the same location as the curriculum and has the same name as the curriculum with “Resources” appended to the end.)
Note: If you want to group items in folders, do not add the items using the New Curriculum wizard. Instead, exit from the wizard, open the curriculum information page for the curriculum, click Add Item, click New Folder, type in a folder name, click Save, select the new folder (you can also select the root folder or a different folder), click Add Item, and then add items to the folder. New items are always created at the root level and you can rearrange items by clicking the Move button. Folders cannot be nested in other folders.

4. Change the order or remove items, if necessary
After adding content and courses, you can change the order of items to alter the learning path. You also have the option to remove any items.

Note: Although you can move items within a folder, you cannot move items in or out of folders.

5. Select any additional options
The final step when creating a curriculum is to select any options you require from the Additional Options page, such as adding enrollee, setting prerequisites, and sending notification.

More Help topics
“Creating a course” on page 77
“Edit prerequisites, test-outs, and completion requirements” on page 93
“Creating virtual classrooms” on page 96
“Working with content in the Content library” on page 190

View curriculum information and status
After you create a curriculum, you can view and modify curriculum details on the Curriculum Information page.

More Help topics
“Creating a curriculum” on page 85
“About notifications and reminders” on page 80

Display curriculum information
1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the folder that contains the curriculum.
3. Select the name of the curriculum in the course list.

View curriculum status information
Viewing curriculum status offers another way to view a summary report.

1. If you’re not on the Curriculum Information page for the curriculum that you want to view, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2. In the Curriculum Status area, click the View button.
The Reports tab opens on a Summary page. In addition to the same information that appears in the curriculum information area of the Curriculum Information page, the Summary page includes the following information:

Enrolled Users  The number of users enrolled in the curriculum.
Users Completed  The number of users that have accessed the curriculum and successfully completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.

Users In Progress  The number of users that have accessed the curriculum, but have not yet completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.

Note: Two types of users are not included in the curriculum status numbers: first are users that are enrolled in the curriculum, but have not yet accessed the curriculum and, second, users who have been enrolled in this curriculum in the past, but have later been deleted from Adobe Connect.

Adding and deleting items from a curriculum

You can add and delete content and courses from a curriculum after a curriculum is created. For example, you can add any course in your Training library to a curriculum.

Here are a few tips:

• Try to minimize the addition and deletion of courses and content after a curriculum is made available to learners.

• Communicate with learners enrolled in the curriculum. Tell them when content and courses are added or deleted and ask them to log in to the curriculum so their status updates.

• There is a distinction between including an existing course in a curriculum and creating a course for a curriculum. When you add a course to a curriculum and the course exists, the course is not added to the individual curriculum’s Resources folder. Only items that are automatically created for the first time as a course are automatically added to the curriculum Resources folder. You can, however, move or copy items into the Resources folder.

• When a course is added to a curriculum, a link to the course in the Content library is added. This allows learners to receive credit for a course even if the course is taken outside the curriculum. To receive credit for taking the course, the learner must have logged in to the curriculum at least once. (Adobe recommends that curriculum learners always launch items from within the curriculum.)

• If you delete a required item from a curriculum, the status of learners who have completed all other required items changes to Complete.

• After a curriculum has been modified (for example, required items have been added or deleted), ask learners to log back in to the curriculum to have their status and scores updated.

• Sometimes, a learner can take a course and then the course is added to a curriculum in which the learner is enrolled. For the learner to receive credit for having already taken the course, ask the learner to log in to the curriculum. Their status within the curriculum is updated automatically.

More Help topics

“About changes to course content” on page 80

“Working with content in the Content library” on page 190

Add folders and items to a curriculum

After creating a curriculum, you can add folders or items to the curriculum at any time.

Note: Adding or removing items from a curriculum can affect learner transcripts. As a best practice, do not change curriculums once you have enrolled learners. If you do add or remove items, tell learners about the changes to the curriculum and ask them to log in to the curriculum to update their status.
More Help topics
“Creating a curriculum” on page 85
“About changes to course content” on page 80
“Change the user status field in a curriculum report” on page 105

Add a folder to a curriculum
After you create a curriculum, you can group items in folders to organize your items. For example, you can group a set of items in a Beginner Topics folder and another set in an Intermediate Topics folder. New folders are always added at the root level. Folders cannot be nested in other folders.

Note: You add items to a curriculum folder rather than move items already in your curriculum into a folder.

1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 Click Add Item.
3 Click New Folder.
4 On the New Folder page, enter a name for the folder in the Folder Name box, and click Save.
5 In the curriculum list, you can select the folder that you created and add items to it.

Add content to a curriculum
After you create a curriculum, you can add more content as necessary. Content added to a curriculum is now automatically converted to a course so it can be tracked accurately. The new course is added to the automatically created curriculum resource folder. Any further content you add to the curriculum is also automatically converted and placed into the resource folder. This folder is in the same location as the curriculum and has the same name as the curriculum with “Resources” appended to the end. (If you add courses that you have already created to a curriculum, those courses are not placed in the resources folder.)

1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 Click Add Item.
3 Click Add Content.
4 If necessary, browse to the folder that contains the content.
5 Select the check box for the content that you want to add to the curriculum, and click Add.
6 Click Add again.

Add a course, virtual classroom, or meeting to a curriculum
Any courses available in your Training library are available for you to include in a curriculum.

1 If you’re not on the Curriculum Information page for the curriculum you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 Click Add Item.
3 Do one of the following:
   • Click Add Course.
Note: Invitations, enrollments, and reminders that you created for a course are not carried over when you add a course to a curriculum. The notification options for a curriculum apply to all courses inside the curriculum; you cannot set individual notification settings for courses inside a curriculum. (If a course exists outside a curriculum, however, the course invitation, enrollment, and reminder settings are all valid for the course.)

- Click Add Virtual Classroom.
- Click Add Meeting.

Note: To send an Outlook Calendar Event, which lets users add the meeting to their Outlook calendars, you select the iCal option when you send meeting reminders, not when you add the meeting to your curriculum.

4 If necessary, browse to the folder that contains the course, classroom, or meeting.
5 Select the check box for the course, classroom, or meeting that you want to add to the curriculum, and click Add.

Add external content to a curriculum

A curriculum is not limited to Adobe Connect items. You can include external training. For example, you can add a classroom lecture that enrollee should attend. Since a lecture is a live event, you can create an external event to represent the lecture. By using the status override feature, you can then mark the enrollee that attend as “Complete.”

Note: When the user status changes for external training, update the user's completion status manually.

1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 Click Add Item.
3 Click New External Training.
4 In Title, enter the name of the external training.
5 (Optional) In ID, enter identification text or numbers.
6 If the external training item is viewing a website, in the URL box enter a full URL including http. For example, http://www.adobe.com.
7 In Max Possible Score, enter the maximum points to be awarded for completing the external training.

Note: If you plan to use external content as a course within a curriculum, it can be important to set maximum score. Define a maximum score in this location when content is non-graded or when it sends a partial score. For example, Adobe Captivate content only sends the score achieved, say eight, not the score achieved and the maximum score, say 8/10. When the content used to create a course includes a full score, such as 8/10, then the maximum score defined within the content applies and any score set here is ignored.
8 (Optional) In Summary, enter a description of the external training.
9 Click Save.

On the Curriculum Information page, the external training appears in your list of items.

Edit curriculums

You can edit information in a curriculum, such as changing the order of items or removing items. You can also delete any entire curriculum.

Note: Adding items to or removing them from a curriculum can affect learner transcripts. As a best practice, do not change curriculums once you have enrolled learners. If you do add or remove items, tell learners about the changes to the curriculum and ask them to log in to the curriculum to update their status.
More Help topics
“Adding and deleting items from a curriculum” on page 88
“Tips for creating training courses and curriculums” on page 76
“Working with content in the Content library” on page 190

Edit curriculum information
1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 In the Curriculum Information area, click Edit to modify the following information:
   Name A title for the curriculum.
   ID The identification number for the curriculum. (You can assign any code, such as a catalog number.)
   Summary The curriculum description.
   Curriculum Starts On The date on which the curriculum starts. Users cannot access the curriculum before this date
   Note: The start and end dates that you select override the start and end dates for the individual items in your curriculum. For example, if you add a meeting with an end date that already passed, but your end date for the curriculum is in the future, the meeting assumes the end date of the curriculum.
   Curriculum Closes On The date on which the curriculum ends; select from the pop-up menu or select No Close date.
3 When you finish editing the curriculum information, click Save.

Edit external content information
To edit external content information, you must have already added it to the curriculum.
1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 In the list of items, click the external training item name.
3 In the External Training Information area, click Edit.
4 In the Item Info area, edit the Name, ID, URL, Max Possible Score, or Summary information, and click Save.

Change the order of items in a curriculum
1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 Select the check box next to the item that you want to move, and then click either the up or down arrow to move the item in the list.

Remove items from a curriculum
If you no longer want to include an item in a curriculum, you can remove it without affecting the original item that exists in its respective library.
1 If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2 In the list of items, select the check box next to the items that you want to remove, and then click Remove Item.
3 Verify that you do want to remove the selected items, and click Remove.
Send notifications or reminders to curriculum enrollee

You can use the notifications feature to send an email message to enrollee. A typical message tells enrollee that the curriculum is available, provides details about the curriculum, and includes a link to the curriculum. The message can go to all enrollee, or to a subset of enrollee, such as those who have not completed the curriculum.

The reminders feature, similar to the notification feature, lets you send email messages to enrollee. The primary difference between notifications and reminders, however, is that the Reminders page lets you send the messages at specified intervals. The message can go to all enrollee, or to a subset of enrollee.

Note: For users who must adhere to compliance standards, reminders can be set to annually. For more information, see “Working with compliance and control settings” on page 211.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.
2. Click Notifications.
3. Click New Notification or New Reminder. (Notifications appear in the subject list with the notification icon and reminders appear with the reminder icon.)
4. Select a timing option. For reminders, you can set a recurrence option to automatically send out multiple reminders.
5. Select a recipients option. If you enter email addresses, use commas to separate the addresses.
6. (Optional) Edit the email subject and message text. To edit using run time fields, copy the field name from the Run Time Fields list and paste it into the message subject or body. Do not change the run time field text in curly brackets.
7. Click Send or Save.

Cancel notifications or reminders

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.
2. Click Notifications.
3. Click Pending Notifications.
4. Under Subject, select the check box next to the name of the notification or reminder you want to cancel. (Notifications appear in the subject list with the notification icon and reminders appear with the reminder icon.)
5. Click Cancel Notifications.
6. On the confirmation page, click Cancel Notifications.

Delete a curriculum

Before you delete a curriculum, be aware of the following effects of this action:

- The curriculum is removed from the Training library.
- Enrollees can no longer access the curriculum.
- Reports for the curriculum are no longer available. (To prevent access to the curriculum while retaining reporting information, set the curriculum close date and do not delete the curriculum.)
- Curriculum reminders are not sent, and delayed curriculum notifications are not sent.
- Deleting a curriculum is a permanent action. Once it is deleted, you cannot recover a curriculum.
Deleting a curriculum from the Training library does not affect the library items that constitute the curriculum.

1. Click the Training tab in Adobe Connect Central and browse to the curriculum.
2. Select the check box next to the curriculum and then click Delete.
3. After verifying that you want to delete the selection, click Delete.

**Edit prerequisites, test-outs, and completion requirements**

After creating a curriculum, you can make many changes such as assigning prerequisites, assigning test-outs, and editing completion requirements. Adobe recommends using either test-outs or prerequisites, but not both, to create learning paths. Using both is possible, but it can be time-consuming and complicated to test all of the possible workflows learners may encounter.

**More Help topics**

“Edit curriculums” on page 90

**Assign prerequisites to an item**

Assigning prerequisites enforces learner access to items in a specific sequence. A folder cannot be set as a prerequisite. Also, do not set external training items as Required, as Adobe Connect cannot automatically track external items.

*Note: Avoid creating redundant prerequisites; they are confusing for learners and may cause performance issues on your Adobe Connect server.*

1. If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2. In the list of curriculum items, click the name of the item or folder that requires a prerequisite. This procedure refers to this item as the *selected item*.
3. In the Prerequisites area, click Edit.

*In the Course Information Prerequisites area, click Edit to create a specific learning path.*
4. The Select Prerequisite area lists the items in the curriculum. Use the Options pop-up menu next to an item to specify the type of prerequisite:

**Suggested** Indicates that the prerequisite is optional. Users receive a message requesting that they take the prerequisite before taking the selected item.

**Required** Indicates that the prerequisite must be completed successfully, not just completed, before taking the selected item. Do not assign Required status to external content. Adobe Connect cannot verify completion of external content, such as a website URL.

**Hidden** Indicates that the selected item appears on the enrollment page only after the user completes the prerequisite.

5. When you finish selecting prerequisites, click Save.

**Assign test-outs for an item**

You can design the curriculum so that enrollee are not required to take an item if they pass a related test-out item. Folders cannot be configured as test-out items or linked as selected items. Always use a specific course or meeting, not a folder, as a test-out or selected item for any other learning object.

Here are tips for creating test-outs:

- Carefully choose between the Optional, Blocked, and Hidden options. Your learners could have a different path and learning experience depending on which option you select for a test-out.
- You cannot assign a test-out for the first item in a curriculum.
- Do not use chained test-outs. An example of a chained test-out is setting item 1 as a test-out for item 2 and then setting item 2 as a test-out for item 3.

1. If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.

2. In the list of items, click the name of the item that requires a test-out item. This procedure refers to this item as the **selected item**.

3. In the Test-Outs area, click Edit.

4. The Select Test-Outs area lists items in the curriculum. Use the pop-up menu by an item to designate it as a test-out for the selected item, using the following criteria:

**Blocked** Indicates that if the enrollee passes the test-out item, the selected item is unavailable to the enrollee. If the enrollee fails the test-out item, the selected item becomes available.

**Optional** Indicates that if the enrollee passes the test-out item, the selected item is no longer required to complete the curriculum.

**Hidden** Indicates that if the enrollee passes the test-out item, the selected item is hidden from the enrollee. If the enrollee fails the test-out item, the test-out item is visible and available for the enrollee to take.

5. When you finish specifying test-out items, click Save.

**Edit completion requirements**

You can designate an item as **required**, which specifies that an enrollee must successfully complete the item to complete the curriculum. By default, all items are required, but you can set individual items as optional or required without impacting other items.

1. If you’re not on the Curriculum Information page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.

2. In the Completion Requirements area, click Edit.
For each item that you want to specify as required, select Required from the pop-up menu.

When you finish specifying required items, click Save.

**Manage curriculum enrollee**

Adobe Connect Central allows you to view and add enrollee to a curriculum, as well as set access permissions for enrollee.

**More Help topics**

“About notifications and reminders” on page 80

“Edit curriculums” on page 90

**View and add enrollee to a curriculum**

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum.

2. Click the curriculum name to open the Curriculum Information page.

3. To modify enrollment one at a time, click the Manage Enrollees link in the navigation bar. Do one of the following:
   - Select an enrollee or enrollee in the Available Users and Groups list and click Add. Press Control-click or Shift-click to select multiple users or groups. To expand a group to select individual members, double-click the group name. Then select individual users. Click Add.
   - Select an enrollee or enrollee in the Current Enrollees list and click Remove.

4. To add enrollee in bulk, upload the names in a TXT or a CSV format, using the following steps:
   a. Create a CSV or a TXT file with the list of email IDs of users who already have a Connect account. Set the title of the first column containing the email IDs of users as login. Click Import Enrollees, and upload the CSV or TXT file. Upon successful import, the role of each enrollee is Participant. Change the roles of various enrollee using the user interface, if necessary.
   b. (Optionally) Select the checkbox ‘Send Email Notifications to user enrolled on import’ to send email notifications.

   **Note:** After adding enrollee, send notification to the enrollee that the curriculum is available.

   **Note:** Duplicate entries in the CSV or TXT file are successfully imported at the first instance. The duplicate instances are ignored and reported after the import.

**Set permissions for curriculum enrollee**

After you’ve added enrollee to a curriculum, you can determine permissions for enrolled users and groups.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click Manage Enrollees.

3. Select the enrollee or enrolled group in the Current Enrollees column and click Permissions.

4. Select one of the following permissions:
   - Denied prevents the enrollee from accessing the curriculum.
   - Enrolled allows the enrollee to access the curriculum.
   - Pending Approval enables to the enroll to access the curriculum after they are approved.
Remove enrollee from a curriculum
You can remove an individual curriculum enrollee or a group of enrollees at any time.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click Manage Enrollees.

3. Select the enrollee or enrolled group in the Current Enrollees column and click Remove.

Creating virtual classrooms

About virtual classrooms
Users with the Meeting and Training features installed can create virtual classrooms. Users must be a meeting host and training manager to create a virtual classroom. Adobe Connect 9.4 onwards, a Virtual Classroom Manager has the same rights as those of a Meeting Host and a Training Manager and can create a virtual classroom. The VC Manager can use Adobe Connect VCs without having the Meeting Host role. This new role is part of the Named Virtual Classroom licensing, introduced in Adobe Connect 9.4.

Use virtual classrooms to conduct training sessions. Virtual classrooms are added to a curriculum, just like a meeting. Unlike a meeting, virtual classrooms can have a Presenter course added that can impact completion requirements. (Course transcripts are not generated for students who enter a virtual classroom as a guest.)

Note: Completion requirements are no longer user configurable; completion is based on attendance. A learner is marked complete if they attended at all and marked incomplete if they were absent.

Just like meetings, there are three access levels for virtual classrooms: enrolled students only, enrolled students and accepted guests, and anyone who has the URL for the virtual classroom can enter the room.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of virtual classrooms and what you can do in virtual classrooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“About content, courses, and curriculums” on page 71

“Creating a curriculum” on page 85

Creating a virtual classroom
In creating a virtual classroom, your workflow involves the following tasks:

1. Start the Virtual Classroom wizard
On the Adobe Connect Central Home page, locate the Create New menu bar and click Virtual Classroom.

2. Virtual classroom information
On the first page of the Virtual Classroom wizard, you enter background details about the virtual classroom, such as a name and summary. (Only the virtual classroom name and language are required; all other fields are optional.) You can edit this information after the virtual classroom is created.
You can suspend a virtual classroom. Suspending a virtual classroom prevents users from entering the classroom, until the organizer lifts the suspension after preparing the classroom completely, say by creating the room template.

*Note:* By default, the Update Information for Any Items Linked To This Item option is selected. When creating a new virtual classroom, you do not have any items linked to the virtual classroom yet, but keep this item selected if you think you will link any items later.

3. Enroll learners

Only enrolled users can browse to the virtual classroom URL and log in to view the virtual classroom. To enroll large numbers of users, if you have the Event Management application, present the virtual classroom as an event.

You can add and delete learners, as required, after the virtual classroom is created. Also, you can enroll users in bulk.

4. Set up notifications

A virtual classroom notification is an email message telling enrollee how to access the virtual classroom.

When you format your notification, you can use run time fields in the subject line and in the body of the message. These fields are virtual classroom information variables that are automatically filled in for you when the email notification is sent.

You can change the virtual classroom notifications after the virtual classroom is created.

5. Set up reminders

Reminders are optional. A virtual classroom reminder is an email message sent to either all or selected virtual classroom enrollee after you set up the virtual classroom. You can use reminders, for example, to remind enrollee that they are scheduled to enter the virtual classroom or to notify specific individuals that they are required to enter the virtual classroom.

More Help topics

“Creating a course” on page 77

“Creating a curriculum” on page 85

View virtual classroom information

You can view information about a virtual classroom from the Virtual Classroom Information page. This page appears when you click the virtual classroom name in the Training folder list. From this page, you can view or edit the information for a specific virtual classroom, such as name, summary, URL, access details, and telephony information.

1. Click the Training tab at the top of the Adobe Connect Central window.

2. Navigate to the folder that contains the virtual classroom.

3. Select the name of the virtual classroom.

Virtual classroom templates

If you have the Meeting and Training features installed, a Shared Training Templates folder, which contains the Virtual Classroom Template, is automatically installed. Hosts can choose to suspend a Virtual Classroom, before it is used for the first time. Suspending a Virtual Classroom locks out all users, including the host. Suspending is helpful in a scenario where hosts want to make final changes to the templates and ensure that they are applied.

For detailed information about templates, see “Meeting room templates and layouts” on page 14.
Apply a template to a new virtual classroom

- When creating a new virtual classroom, choose a template from the Select Template menu on the Virtual Classroom Information Page. By default, the Default Virtual Classroom template is selected.

  You can move a Virtual Classroom to the Shared Training Templates folder, and use the Virtual Classroom as a template while creating other Virtual Classrooms.

Convert a virtual classroom into a template

If you are a training manager and meeting host, you can create a virtual classroom template. Move the virtual classroom to one of two template folders: Shared Templates (in the Shared Training folder) if you want others to be able to access the template, or My Templates (in your user training folder) if you are the only one who uses the template.

Note: To add a virtual classroom to the Shared Templates folder, you must have Manager permissions for the folder. By default, you have full control over virtual classrooms and templates in your user training folder.

1. From the Training tab in Adobe Connect Central, navigate to the folder containing the virtual classroom to convert.
2. In the Name list, click the check box next to the virtual classroom.
3. Click Move on the navigation bar.

   The name of the virtual classroom is displayed in the left column.

4. Navigate to and select a folder. (Navigate to Shared Training > Shared Templates if you want to share the template with others.)
5. Click Move.

   Your virtual classroom now resides in the template folder that you selected. The template is added to the list in the appropriate folder, either Shared Templates or My Templates.

   When you are creating a virtual classroom with the New Virtual Classroom wizard, you can select the new template from the Select Template pop-up menu. You can customize this classroom just like any other to meet your needs. Once the virtual classroom is created, you cannot apply a new template to it. Instead, create a new virtual classroom by using a new template. If the new template used to create a new virtual classroom contains any courses, then the new virtual classroom also contains the same courses.

Edit virtual classrooms

There are various tasks you can do to manage and maintain the virtual classrooms you have created.

More Help topics
“Creating virtual classrooms” on page 96
“View virtual classroom reports” on page 100
“Associate an audio profile with a meeting” on page 166

Edit virtual classroom and telephony info

1. From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to edit.
2. In the Name column, click a virtual classroom.
3. In the navigation bar, click Edit Information.
4. Edit the virtual classroom information and audio conference settings as required.
5 Click Save.

**Edit virtual classroom courses**

1 From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to edit.
2 In the Name column, click a virtual classroom.
3 Click Manage Courses.

*Note: If a template used to create a new virtual classroom contains any courses, then the new virtual classroom also contains the same courses. Some courses are then pre-populated.*

4 Add or delete courses as required, including courses created in Adobe Captivate.
5 Click Save.

*Note: Virtual classrooms do not support courses based on third-party SCORM content.*

**Edit virtual classroom enrollee**

1 From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to edit.
2 In the Name column, click a virtual classroom.
3 To modify enrollment one at a time, click the Manage Enrollees link in the navigation bar. Do one of the following:
   - Select an enrollee or enrollee in the Available Users and Groups list and click Add. (Press Control-click or Shift-click to select multiple users or groups. To expand a group to select individual members, double-click the group name. Then select individual users.)
   - Select an enrollee or enrollee in the Current Enrollees list and click Remove.
4 To add enrollee in bulk, upload the names in a TXT or a CSV format, using the following steps:
   a Create a CSV or a TXT file with the list of email IDs of users who already have a Connect account. Set the title of the first column containing the email IDs of users as login. Click Import Enrollees, and upload the CSV or TXT file. Upon successful import, the role of each enrollee is Participant. Change the roles of various enrollee using the user interface, if necessary.
   b (Optionally) Select the checkbox 'Send Email Notifications to user enrolled on import' to send email notifications.

*Note: Duplicate entries in the CSV or TXT file are successfully imported at the first instance. The duplicate instances are ignored and reported after the import.*

**Edit virtual classroom notifications and reminders**

You can use the notification feature to send an email message providing details to virtual classroom enrollee, including a link to the classroom. The message can go to all enrollee, or to a subset of enrollee.

The reminders feature in Adobe Connect Central, similar to the notification feature, lets you send email messages to enrollee. The primary difference between notifications and reminders, however, is that the Reminders page lets you send the messages at specified intervals. The message can go to all enrollee, or to a subset of enrollee.

*Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of virtual classrooms and what you can do in virtual classrooms. For more information, see "Working with compliance and control settings" on page 211.*

1 From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to edit.
2 In the Name column, click a virtual classroom.
3 Click Notifications.
4 Click on a notification or reminder in the list. (Notifications appear in the subject list with the notification icon and reminders appear with the reminder icon.)

5 Click Edit.

6 Edit the notification or reminder as required. For example:

- Change the timing option. (For reminders, you can set a recurrence option to automatically send out multiple reminders.)
- Change the recipients. If you enter email addresses, use commas to separate the addresses.
- Edit the email subject and message text. To edit using run time fields, copy the field name from the Run Time Fields list and paste it into the message subject or body. Do not change the run time field text in curly brackets.

7 Click Send.

Edit virtual classroom content
1 From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to edit.
2 In the Name column, click a virtual classroom.
3 Click Uploaded Content.
4 Add, delete, and move content as required.

View and edit virtual classroom recordings
You control who can view a virtual classroom recording by setting the recording as public or private. For more information, see “Play back a recorded meeting” on page 182
1 From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to edit.
2 In the Name column, click a virtual classroom.
3 Click Recordings.
4 View and edit information as required.

View virtual classroom reports
The Reports feature of Adobe Connect Central lets you create reports that show you a given virtual classroom from different perspectives.
1 If you’re not on the Virtual Classroom Info page for the classroom, go to the Training tab in Adobe Connect Central and browse to the classroom. Click the classroom name to open the Virtual Classroom Info page.
2 Click the Reports link, toward the top of the Adobe Connect Central window.
3 The default Summary report shows virtual classroom information and aggregate user information such as a single instance in which a given user has joined and exited the classroom (Unique Sessions); the last time that any invitee entered the classroom (Most Recent Session); number of people invited; number of people who attended; and the greatest number of people who entered the classroom at any one time (Peak Users).
4 Select another report type to obtain different information:

- The By Attendees report lists the name and email address of each virtual classroom participant, as well as the time they entered the classroom and the time they left it.
- The By Course report lists all courses embedded in the virtual classroom. Click on the different embedded courses to view a list of the learners that have taken the course. If courses have been updated over time and there are multiple versions learners have viewed, the reports show which version each learner viewed.
• The By Sessions report lists the start and end time of each session, the session number, and the number of attendees. Clicking the session number displays the participant list for this session, including participant name and entry and exist times for each participant.

• The By Questions report lists each poll by session number, number, and question. You can drill down to two separate views by clicking the appropriate link under the Report column: "View answer distribution" displays a pie chart in which each answer is color-coded with a unique color. "View user responses" provides an answer key that lists each answer for this poll and its corresponding answer number; these numbers map to the pie chart. This option also shows a list of all the participants who responded in this poll and the number of the answer they selected (if the poll question allowed multiple responses, these are all shown for the user).

More Help topics
“View and manage curriculum reports” on page 103

Set self-enrollment options
Self-enrollment options are set using the Training Catalog. Add courses, curriculums, and virtual classrooms to the catalog if you want to use the self-enrollment feature. For more information, see “Manage the Training Catalog” on page 108.

Note: Adobe Connect administrators can change self-enrollment and Training Catalog settings to adhere to standards for governance. For more information, see "Working with compliance and control settings" on page 211.

1 If you are not already on the information page for the course, curriculum, or virtual classroom, go to the Training tab in Adobe Connect Central and browse to the item. Click the course, curriculum, or virtual classroom name to open the information page.

2 Click Training Catalog Settings.

3 Select List in Training Catalog for Learner Self-Enrollment. This selection enables registered users to add themselves to the permission list for the course, curriculum, or virtual classroom in the Training Catalog.

4 Do one of the following:
   • Adobe Connect notifies enrollee of their status by email, when they self-enroll. Enable Catalog Notifications option works only when you select Enable Catalog Self-Enrollment.
   • Select Enrollment Is Open to give all learners access to the course, curriculum, or virtual classroom.

5 Select Display In Training Catalog.

6 Choose one or more locations in the Training Catalog and click Apply Listing or Apply Listing and Continue. (Remember, content must be in the Training Catalog before you use the self-enrollment feature.)

7 Click Save.

Withdraw your self-enrollment
Enrolled users or the ones who have submitted the enrollment request, can both withdraw their enrollment. This option applies to Virtual Classrooms, courses, and curriculums. It is available up to one hour before the start of the training. User is able to click the Withdraw Enrollment button to either remove the Enrollment or to withdraw the enrollment request - in both cases, status goes back to Not Enrolled.

1 If you are not already on the information page for the course, curriculum, or virtual classroom, go to the Training tab in Adobe Connect Central and browse to the item. Click the course, curriculum, or virtual classroom name to open the information page.
2 Click Training Catalog Settings.
3 Select List in Training Catalog for Learner Self-Enrollment.
4 Click on the Withdraw Enrollment button to either remove the enrollment or to withdraw the enrollment request. In both the cases, the status is reverted to Not Enrolled.

Monitoring training with reports

Adobe Connect Central offers a wide range of reporting options. For the training features in Adobe Connect Central, different reports can be generated for courses, curriculums, and virtual classrooms.

More Help topics
“Generating reports in Adobe Connect Central” on page 247

Using report filters

As with other applications in Adobe Connect Central, you can further define the information you see on a particular report by setting report filters. Keep in mind that filters that you set apply to all reports that you create, both for curriculums and for any other Adobe Connect applications. For more information, see “Setting report filters” in “View reports about individual pieces of content” on page 196.

View course reports

The Reports feature of Adobe Connect Central lets you create reports that show you a course from different perspectives. Course reports also enable you to track the performance of specific learners. (When learners access a course, either from a direct course URL or from the course URL within a curriculum, course reports are created.) To use this feature, access the Course Information page, and then click the Reports link. This displays other links that let you define the kinds of report information you can see for this course.

Content and course reports are distinct, because a course is associated with a specific version of content. (In contrast, course and curriculum reports are shared, because a curriculum is only a link to a course.)

1 Click the Training tab at the top of the Adobe Connect Central window.
2 Navigate to a course.
3 In the course list, click the name of the course.
4 Click the Reports link.
5 To generate a report, click any of the following links:
   • Summary shows you course information (name, ID, open date, close date, and URL) and course status (enrolled users, users completed, users passed, and users failed).
   • By Slides/Pages shows a bar graph that lists each slide in the course and the number of times it has been viewed. A table shows the last time each slide was viewed.
   • By Users shows the users who have accessed the course, their status (In Progress, Complete, Passed, or Failed), score, date taken (user’s most recent attempt), time taken (time of most recent attempt), how many times the user took the course, the course version, and the certificate number, if applicable. Click the name of a user to view a bar graph and a table that shows each question and whether the user answered it correctly or incorrectly, as well as the score for the question. You can also click the View Answers link for each question, which displays the answer distribution.
• By Questions shows a table that lists question numbers, questions, the number of times the question has been answered correctly, the number of times the question has been answered incorrectly, the percentage of times the question has been answered correctly, and the question score.

• By Answers shows a table that lists the maximum score, the average score, the high score, and the low score for the quiz. For each question, the table also shows the question number, the question itself, and the answer distribution; that is, how each question was answered, if at all. Click the View Answers link to view a pie chart with a table that provides the answer key and answer distribution. The answer key lists all of the possible answers for the question and their corresponding answer number or letter; the answer distribution lists all of the answers selected for this question, flags the correct answer, and shows the number of users who selected each answer, as well as what percent of the total each number of users represents. Finally, it totals the users by number of users and percent of users. (The Hide Answer Distribution/Show Answer Distribution button is a toggle that lets you hide the distribution of answers for each question, then show them again.)

More Help topics
“View and manage curriculum reports” on page 103
“About Adobe Connect Central reports” on page 247

Downloading and printing course reports
Except for the Summary report, you can export all course reports to a comma-separated values (CSV) file by clicking Download Report Data under the report types links. The reports that are downloaded, respect the filtering and sorting applied on the online reports.

You can also export the By Slides/Pages or By Questions report to a browser window by clicking Printable Version on the left, above the display.

1 Click the Training tab at the top of the Adobe Connect Central window.
2 Navigate to the course.
3 In the course list, click the name of the course.
4 Click the Reports link.
5 Select a report type (By Slides, By Users, By Questions, or By Answers).
6 Do one of the following:
   • Click Download Report Data.
   • Click Printable Version.

More Help topics
“View course reports” on page 102

View and manage curriculum reports
You can view reports, which provide summaries, statistical information, and status information about a curriculum. You can view data for the overall curriculum, for individual users, and by item. Course and curriculum reports are shared, because a curriculum is only a link to a course. (In contrast, content and course reports are distinct, because a course is associated with a specific version of content.) Curriculum reports do not display the specific version of a curriculum a learner completed. Content details are tracked against the object for all content types, including third-party SCORM content.
Note: When upgrading from Acrobat Connect 6 to Adobe Connect 7, existing training materials are migrated, but the data supported in the enhanced Adobe Connect 7 reporting feature is blank for Adobe Connect 6 materials.

Curriculum reports show learner status in several ways:

- In a presentation with no quizzes, Complete is achieved when 100% of the slides in a presentation have been viewed.
- In a presentation with one or more quizzes, In Progress status is listed if all quiz questions with a point value (nonzero weighted) in all quizzes have not been answered. If all questions with a point value have been answered, Adobe Connect lists a Passed or Failed depending if the learner score equals/exceeds or is less than the passing score.

Note: If a course in the curriculum was made available to users before the course was added to the curriculum, any data that existed for that individual course appears in the curriculum report. If you do not want prior data to appear in the curriculum report, you can re-create any courses that existed before you created the curriculum.

- Consolidate curriculum report includes the learner status for each course within a given curriculum, in a single view.

More Help topics
“Export curriculum reports” on page 108
“Change the user status field in a curriculum report” on page 105

View curriculum status report
A Status report offers general information about a curriculum, including the number of enrollee and the number of users who completed the curriculum.

You can filter the report on start or end dates, groups or users, and people managed directly or indirectly.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click the Reports link.

Adobe Connect Central opens, by default, on the Summary report page. In addition to the information that appears in the Curriculum Information area of the Curriculum Information page (such as Curriculum Name, Curriculum ID, URL, and open and close dates), the report contains the following information:

**Enrolled Users** The number of users enrolled in the curriculum.

**Users Completed** The number of users that have accessed the curriculum and have successfully completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.

**Users In Progress** The number of users who have accessed the curriculum and who did not successfully meet the completion requirements. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.

More Help topics
“Export curriculum reports” on page 108
“Change the user status field in a curriculum report” on page 105

View a curriculum report by users
You can view general report data about curriculum enrollee, such as the date on which the user completed the curriculum.
You can filter the report on start or end dates, groups or users, and people managed directly or indirectly.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click the Reports link, toward the top of the Adobe Connect Central window.

3. Click By Users to view the following information for each enrollee:

   **Name**  The name of the enrollee. Click an individual name to obtain details about the enrollee such as status, cumulative score, and number of attempts made to complete curriculum items.

   **Status**  Where the user stands in terms of completing the item.

   **Date Taken**  The date and time on which the item was taken by the enrollee.

   **Certificate #**  A system-generated number that proves the user completed the curriculum and provides the user with a unique ID.

4. To change the number of users who appear in the list, select a different number in the Display pop-up menu.

**More Help topics**

“Export curriculum reports” on page 108

**Change the user status field in a curriculum report**

When you view a curriculum report by user, the override option enables you to change the status of a user. For example, you could change the status of a user from “In Progress” to “Complete.” You can change the status for independent courses and for courses within curriculums. You cannot, however, override the status of a user for a curriculum as a whole.

Overrides are, in general, designed to be used when a situation occurs that may have been out of the user’s control. For example, an error in the training content that caused a user to fail a course. Overrides are also useful when you want to manually set a status for external training sessions such as live workshops, attendance at a field trip, or visiting a website.

The Status field updates each time user status changes for items that Adobe Connect Central tracks. If the user status changes for an external training, you can manually change the status.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click the Reports link, toward the top of the Adobe Connect Central window.

3. Click By Users.

4. In the Name column, click the name of the enrollee whose status you want to change.

A list of items assigned to the enrollee appears. The status column indicates the status for each item.

5. To change the status of an item, click Override and use the Status pop-up menu to select one of the following:

   **Passed**  The user has passed the item.

   **Failed**  The user has failed the item.

   **Complete**  The user has successfully completed the item.

   **In Progress**  The user has clicked at least one time on the item.

6. Enter the user’s score in the Score box. (For items without an associated pass or fail score, you can enter 0.)
7  (Optional) To change the Max Possible Score, navigate to the course information page and change the score there.
8  Click Save.
The updated status appears on the Users report.

**More Help topics**
“Export curriculum reports” on page 108

**View a curriculum report by item**
You can view a curriculum report by item, by selecting the item and selecting the type of report you want to view.
You can filter the report by summary, users, slides/pages, questions, or answers.

1  If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.
2  Click the Reports link, toward the top of the Adobe Connect Central window.
3  Click By Item.
A list appears of all items in the curriculum. The Reports column indicates the type of report that you can generate for each item.
4  Click the link for the type of report that you want to view.
The steps for viewing, downloading, and setting report filters for each item are identical to the procedures for viewing reports in each library. External training, however, is an exception because it does not appear in an Adobe Connect library.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Report Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course</td>
<td>Summary</td>
</tr>
<tr>
<td></td>
<td>By Users</td>
</tr>
<tr>
<td></td>
<td>By Slides/Pages</td>
</tr>
<tr>
<td></td>
<td>By Questions</td>
</tr>
<tr>
<td></td>
<td>By Answers</td>
</tr>
<tr>
<td>Meeting</td>
<td>Summary</td>
</tr>
<tr>
<td></td>
<td>By Attendees</td>
</tr>
<tr>
<td></td>
<td>By Sessions</td>
</tr>
<tr>
<td></td>
<td>By Questions</td>
</tr>
<tr>
<td>External Training</td>
<td>Summary</td>
</tr>
<tr>
<td></td>
<td>By Users</td>
</tr>
</tbody>
</table>

**More Help topics**
“Export curriculum reports” on page 108
View a summary report for external training

Before generating a summary report for external training, update the user status or score for users who have completed the training.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click the Reports link, toward the top of the Adobe Connect Central window.

3. Click By Item.

A list appears of all items in the curriculum. The Reports column indicates the type of report that you can generate for each item.

4. In the Names column, find the external training item and in the Reports column click Summary.

More Help topics

“Export curriculum reports” on page 108

“Change the user status field in a curriculum report” on page 105

View an external training curriculum report by users

Before generating a report for external training by users, update the user status or score for users who have completed the training.

1. If you’re not on the Curriculum Information page for the curriculum, go to the Training tab in Adobe Connect Central and browse to the curriculum. Click the curriculum name to open the Curriculum Information page.

2. Click the Reports link, toward the top of the Adobe Connect Central window.

3. Click By Item.

A list appears of all items in the curriculum. The Reports column indicates the type of report that you can generate for each item.

4. In the Names column, find the external training item and in the Reports column click By Users to view the following information for each enrollee:

   Name  The name of the enrollee. Click an individual name to obtain details about the enrollee such as status, cumulative score, and number of attempts made to complete external training item.

   Status Where the user stands in terms of completing the item.

   Score The score the user received for the external training.

   Date Taken and Time Taken  The date and time when the enrollee took the item.

   Attempts The number of times the user tried to access the external training.

   Certificate # A system-generated number that proves the user completed the external training and provides the user with a unique ID.

   Version The specific version of the external training item taken by the user.
Export curriculum reports
You can export curriculum By Item reports to an Excel file by clicking the Download Report Data button on the Reports page. The reports that are downloaded, respect the filtering and sorting applied on the online reports. You have the option of saving or opening the report.

1. Click the Training tab at the top of the Adobe Connect Central window.
2. Navigate to the folder that contains the curriculum.
3. Select the name of the curriculum in the course list.
4. Click Reports.
5. Click By Item.

In the list of report types for each item, you can download report data for all reports on the list except the Summary report.

6. Click the report type for which you'll download data.
7. Complete one of the following steps:
   - To download the report, click Download Report Data and either save or open the file.
   - To view and print a report by slides/pages or by questions in a browser window, click Printable Version.

Conducting training with Adobe Connect

Manage the Training Catalog
The Training Catalog gives training managers a way to organize courses and curriculums. For example, a training manager can make a large number of courses available using the Training Catalog without placing all of the courses into curriculums. Or, a training manager can create a curriculum and then point learners to a wide variety of supplemental information in the Training Catalog.

Note: When using the Training Catalog, add all of your learners to the Learners permission group. This enables learners to view any training options within the catalog. If you want to limit access to certain training options within the catalog, organize training materials into folders and customize permissions at the folder level.

Adobe Connect administrators set up permissions to the Training Catalog. For more information, see “Configure the Training Catalog” on page 215.

Note: Adobe Connect administrators can change self-enrollment and Training Catalog settings to adhere to standards for governance. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Creating a course” on page 77
“Creating a curriculum” on page 85

Last updated 3/20/2015
Open the Training Catalog
When you first begin using the Training Catalog, it may be helpful to create folders to organize information. For example, you could create folders that represent different departments (Accounting, Human Resources, Facilities, and so on) or different types of training (Beginning, Intermediate, Advanced, and so on).

1. Click the Training tab in Adobe Connect Central.
2. Click Training Catalog.
3. Click New Folder to begin creating folders and organizing the catalog. You can create folders within folders to set up a hierarchy.

Setting permissions in the Training Catalog
You can set permissions for folders and items in the Training Catalog. This is useful if you have your Training Catalog organized in a folder structure and you want to control who can manage and publish to each folder.

1. Click the Training tab in Adobe Connect Central.
2. Click Training Catalog.
3. Select the check box next to a folder or item.
4. Click Set Permissions.
5. In the Current Permissions For list, select an individual or group, click Permissions, and select a permissions level (Denied, View, Publish, or Manage).

Note: By default, the Learners group has View permissions for the root level of the Training Catalog. This default setting allows anyone in the Learners group to browse through the root level of the Training Catalog. You can change the permissions to control who can view the Training Catalog.

Adding items to the Training Catalog
Only courses, curriculums, and virtual classrooms can be added to the Training Catalog; to use content within the Training Catalog, turn the content into a course. When you add a course or curriculum to the Training Catalog, you also specify if learners can enroll themselves.

1. Click the Training tab in Adobe Connect Central.
2. Navigate to the course/curriculum you want to add to the Training Catalog and click on the course/curriculum.
3. Click Training Catalog Settings.
4. Select List in Training Catalog For Learner Self-Enrollment. This enables registered users to add themselves to the permission list for the course or curriculum in the Training catalog.
5. Do one of the following:
   • Select Enrollment Requires Course Manager Approval to require that learners receive approval before being given access to the course or curriculum in the Training Catalog. Select Notify Course Manager(s) Of Approval Requests By Email to receive an email message each time a learner wants to self enroll. (If you do not select this option, check the Training Catalog for learners who have Pending status.)
   • Select Enrollment Is Open to give all learners access to the course or curriculum.
6. Select Display In Training Catalog.
7. Select a location or browser and select one or more folders to display this item.
8. Once you have selected the folders, click Apply Listing.
Informing learners about the Training Catalog

Once you have organized and added content to the Training Catalog, inform your learners.

**Note:** If you are sending a notification email message to learners about a curriculum and supplemental information for the curriculum can be found in the Training Catalog, simply edit the notification text to include a link to the Training Catalog. This gives learners all the information they need in one email message.

❖ Tell learners about the Training Catalog using one of the following methods:
  • Inform them that a new Training Catalog tab is now on their Adobe Connect home page.
  • Send an email message containing a link to the Training Catalog.
  • Place a link to the Training Catalog on your web portal.

**Note:** A link within an email message or on a web portal can also point directly to a course within the Training Catalog.

Approving training enrollee

If you selected the require approval option when you added courses, curriculums, or virtual classrooms to the Training Catalog, manage and approve learners when they want to view items in the catalog. Requiring approval enables you and other training managers to stagger approvals and limit the number of learners that can access a specific course, curriculum, or virtual classroom at the same time.

1 Do one of the following:
  • If you selected the option to be notified by email when learners request approval for a course, curriculum, or virtual classroom in the Training Catalog, click the link in the email message.
  • If you did not select the option notify by email, click the Training tab, navigate to the course, curriculum, or virtual classroom for which you want to approve learners, and click the course, curriculum, or virtual classroom.

2 Click Manage Enrollees.

3 In the Current Enrollees For list, select an individual with the status of Pending Approval.

4 Click Permission and select Enrolled. (You also have the option to change a learner’s permissions to Denied or Pending Approval.)

5 In the dialog box that appears, select Yes if you want to notify the learner that they are enrolled.

Conduct a virtual class

The virtual classroom layout is flexible and provides you with many ways to present information and interact with classroom attendees.

**Note:** If an administrator has enabled a compliance Terms of Use notice, accept it before entering a virtual classroom. (For more information, see “Working with compliance and control settings” on page 211.)

1 From the Training tab in Adobe Connect Central, navigate to the virtual classroom you want to enter.

2 Click on a virtual classroom name from the list below the navigation bar.

3 Click Enter Virtual Classroom or click the classroom URL.
4 Manage incoming attendees by approving and denying their requests to enter. For more information, see “Invite attendees and grant or deny access” on page 19.

5 Share My Screen > Share Course > Select from Course Library. Select courses available in the Course Library. You can share Adobe Captivate courses in your virtual classrooms.

6 Conduct training for attendees. Here are some ideas:
   • Switch between the Lobby, Classroom, and Analysis virtual classroom layouts. You may want to start with Lobby which contains a large Chat pod for attendees to introduce themselves to each other. Next, change to the Classroom layout when sharing courses. Finally, finish in the Analysis layout which offers a Poll pod you can use to ask attendees to rate their virtual classroom experience.
   • Launch courses in the Course Share Pod. Sync and unsync the course as required. For more information, see “Invite attendees and grant or deny access” on page 19.
   • Interact with attendees through the Attendees pod. Ask attendees questions they can respond to using emoticons and encourage them to ask questions by virtually raising their hand. For more information, see "Participating in training sessions and meetings" on page 111.
   • Use the Video pod to broadcast your, or an attendee’s, picture and voice. For more information, see “Enable microphone for participants using computers” on page 170.
   • Move attendees into different subrooms so they can collaborate in a smaller group setting. For more information, see “Breakout rooms” on page 61
   • Use the whiteboard to collaborate with attendees or allow them to collaborate with each other to answer a question or brainstorm ideas. For more information, see “Share a whiteboard” on page 44.
   • Use the Chat pod to communicate with attendees or answer questions. For more information, see "Chat in meetings" on page 54.
   • Take notes, such as questions to research, information to add to a course, or ideas for improving your virtual classroom in the Note pod. For more information, see "Taking notes in a meeting" on page 52.

7 To close the virtual classroom session, select Meeting > End Meeting.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of virtual classrooms and what you can do in virtual classrooms. For more information, see "Working with compliance and control settings" on page 211.

More Help topics
“About virtual classrooms” on page 96
“Creating virtual classrooms” on page 96

Participating in training sessions and meetings

Communicate with training or meeting attendees
To create a sense of community within a meeting or training session and encourage attendees to participate, use the emoticons that appear in the Attendees pod. These emoticons can express an emotion such as laughter or applause, ask the host to speak louder or slow down, or show raised hands.
Here are a few more tips for communicating with meeting and training attendees:

- Explain to attendees how to use the emoticons and audio together and then support them when they try to use the features. If attendees are raising their hands, take and answer their questions so they begin to understand how the communication flow works.

- Be the most active user of emoticons. When an attendee makes a comment, use the emoticons to express laughter or applaud. If you are busy giving a detailed presentation, enlist the help of another host or presenter to be active using emoticons and managing the Attendees pod.

- An easy way to keep attendees involved is by asking simple questions they can quickly answer using the Agree and Disagree emoticons.

- If you have acknowledged an attendee’s raised hand and given them voice rights, you can also allow them to share their screen. (Hover over their name in the Attendees pod and select Request Screen Share). This can be helpful if sharing their screen enables them to clarify a question or provide information.

- In the Attendees pod, hover over an attendee name to mute or unmute their microphone as needed during an audio conference call.

**Note:** Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and virtual classrooms and what you can do in the rooms. For more information, see “Working with compliance and control settings” on page 211.

**More Help topics**

“Share content in the Share pod” on page 33

---

**Ask and accept attendee questions**

1. Using audio or the Q&A pod, a host asks a question.

2. Attendees click the Raise Hand button in the menu bar, and the following occurs:
   - Everyone sees the raised hands next to names in the Attendees pod. If multiple attendees raised their hand, the people who raised their hand soonest appears higher in the list.
   - Hosts receive a notification in the upper right of the meeting room with Approve and Decline buttons. Individual notifications show how many raised their hand and the current attendee’s position in the queue. For example, 4/10 indicates that the attendee was the fourth of ten attendees to raise their hand.

3. In the Attendees pod, select one or more attendees, and choose Enable Audio from the hover menu. To the right of the attendee names, the raised hand icon is replaced with the microphone icon.

4. The attendees receive a notification that they can click Speak Now. If the attendee wants to share their screen, hover over their name in the Attendees pod and select Request Screen Share.

5. When attendees are finished speaking, hover over their names in the Attendees pod, and select Disable Audio. This practice reduces background noise.

**More Help topics**

“View and change attendee status” on page 69

“Conducting training with Adobe Connect” on page 108
Attending virtual classroom training

Attending a virtual classroom session gives you the opportunity to learn new information and participate interactively in the classroom experience.

1. Click the virtual classroom URL link sent to you (by e-mail or IM) from the classroom host.
2. Enter your login information.
3. Participate in the virtual classroom. Here are some ideas:
   • If attendees are using the Chat pod to introduce themselves, add your name, and perhaps location, to the conversation.
   • The Course Share Pod is where the host shares their screen or content such as a presentation or document. The Share pod is where users typically direct most of their attention, during a classroom session. If a presentation contains a quiz, the host can unsync the presentation, allowing individual attendees to take the quiz on their own. Third-party SCORM content may not play properly in the share pod. Content types that do not play properly are not available to the user when browsing for content to share.
   You can select Adobe Presenter courses using the Share Course workflow and play the courses in the Share pod. You can also play animations, embedded objects, quizzes, and interactions.
   • Use emoticons in the application bar to interact with the host and other attendees. You can raise your hand, express agreement, or disagreement, and even ask the host to speak more loudly or softly. The emoticons are an easy way to start participating in the classroom.
   • Raise your hand and if the host approves your request, use the VoIP toolbar to broadcast your voice. This is useful if you have a detailed question to ask or if you want to provide information to the class.
   • If the host opens a whiteboard, collaborate with other attendees on the task at hand. Whiteboards allow a group of attendees to answer a question together and are also useful for brainstorming ideas. For more information, see “Share a whiteboard” on page 44.
   • Throughout the session, use the Chat pod to communicate with attendees or answer questions. Hosts can allow private chat between attendees or they can turn off this feature. For more information, see “Chat in meetings” on page 54.
   • At the end of a session, the host may take a poll. Simply read the question and vote using the radio buttons.
4. When the session is finished, the host closes the virtual classroom.

More Help topics
“Communicate with training or meeting attendees” on page 111

Self-enrollment in training courses

Training managers make training courses, curriculums, and other items available to registered users through the Training Catalog, you can enroll yourself.

1. From the Adobe Connect Home page, click Training Catalog.
2. In the course list, select a course and click Enroll.

Your status for that course changes to Pending. An e-mail message is sent to you stating that you asked for course approval and a separate message is sent to the training manager asking for their approval.

3. If the training manager approves your request to enroll, you receive an e-mail message with your new status and a link to the course. Your status changes from Pending to Enrolled. When you are ready, click the course link in the e-mail message and take the course.
More Help topics
“Withdraw your self-enrollment” on page 101
“Communicate with training or meeting attendees” on page 111
“Attending virtual classroom training” on page 113

Creating and managing seminars

About seminars
Use Adobe Connect Seminars to create a special type of meeting. Seminars bring attendees to a meeting room on a specific day between set start and end times. The seminar exists only for that time. (By contrast, the meeting room in which the seminar occurs exists before, during, and after the seminar).

Unlike a meeting, which normally has ten people or fewer and can recur, a seminar has a minimum of 50 participants, is often a one-time or infrequent event, and involves little audience participation. At least one seminar presenter or host must be in the room in order for others to enter, even if the seminar is public. The default seminar room looks different from the default meeting room. Also, seminars can be created only in a Seminars Rooms, whereas meetings can be created either in a shared folder or a user folder.

Note: Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of seminar rooms and what you can do in seminar rooms. For more information, see “Working with compliance and control settings” on page 211.

Large and small seminars
A seminar that allows more than 600 participants is considered a Large Seminar. A seminar accommodating less than 600 participants is considered a Small Seminar. Only one large seminar can be scheduled during a given time period. Whereas, you can schedule multiple events using a single regular seminar.

The license you purchase is either for small seminars, run as a regular meetings, or for large seminar, run as large meetings. When scheduling a Seminar Session using a Seminar Room, you specify the number of attendees.

Seminar Room and Seminar Session
In Adobe Connect, a seminar license is available in the tab Seminars > Shared Seminars. Each license that you purchase, appears as a folder in the Shared Seminars tab. To schedule a seminar, you create an instance of a Shared Seminar basing it on a seminar room. Such different instances of Shared Seminars are called Seminar Sessions. Each session is a stand-alone webinar that participants attend.

Adobe Connect 9.4 onwards, a Named Webinar license is introduced. If you avail this license, a Users Seminars tab and My Seminars tab is available that allows you to manage your webinars.

Various webinars that you conduct, are individual instances of the available Shared Seminars. These instances are called Seminar Sessions and are available in the tab Seminars > Seminar Sessions.

More Help topics
“About meetings” on page 4
“Record a meeting” on page 178
Pre-seminar tasks
Careful pre-seminar planning helps a seminar run smoothly and streamlines follow-up activities.

1. Determine the expected number of participants for your seminars
If your organization purchased Seminars, it obtained a specific number of seminar licenses. The number of seminar attendees cannot exceed the number of concurrent users allowed for your license. Your Seminars administrator has information about how many licenses your organization purchased and how many concurrent seminars you can conduct at a time. If you think you need more licenses, let the administrator know early. The Seminar Calendar lists the schedule for all the seminar licenses that you possess. You can view your time slot to determine if a seminar license is available for the slot.

For accounts with seminar license for large meetings, make one of the following selection for the Expected Number of Participants:

- Regular if attendees are <=600
- Large if attendees are >600

2. Access the Seminar library
Seminar files and folders are stored in the Seminar library. Users who have the correct permissions can manage and organize these files and folders. You reach the Seminar library through the Seminars tab.

Note: The seminars you are scheduled to attend, appear on the Home tab of your Adobe Connect Central application under "My Meetings," not the Seminars tab.

3. Establish permissions
Attendance permissions define attendee roles in a seminar, such as participant, presenter, and host. You assign these permissions when you create a seminar. The Seminar Administrators can also modify them during the seminar and after the seminar is over by editing the participant list.

Seminar library permissions determine who can manage the library folders. Of the six built-in groups, only Administrators have Manage permissions for the Shared Seminar folder. Authors, Training Managers, Meeting Hosts, Seminar Administrators, Webinar Managers, and Event Managers are assigned Denied permissions by default. The administrator can override those default permissions and allow others access to the Shared Seminar folder. (There are no Publish or View permission types as there are for the Content library.) To manage folders other than the Shared Seminar folder, you must have Manage permissions for that folder in the Seminar library.

4. Register and approve attendees
Depending on the type and purpose of a given seminar, the Seminar Administrator may want to have the guests register. If so, the host must have Adobe Connect Events as part of the Adobe Connect Central application; registration for any meeting, training, presentation, or seminar can only be done through the Event Management tab. If the host has this tab, they must first create the seminar from the Seminars tab using the Seminar wizard. Then, they create an event and select the seminar they have created as the event.

More Help topics
“Working with content in the Content library” on page 190

Create a seminar
After obtaining correct permissions, create seminars using the Seminar wizard.
1. Start the Seminar wizard

Create or browse to a Shared Seminar in the Seminar library where you place your seminar (you must have permission to access the folder). When you determine a location, click the New Seminar Session button to open the wizard.

2. Enter seminar information

On the first page of the Seminar wizard, enter background details about the seminar, such as a name and summary, and select a template to use. (Only the seminar name and language are required; all other fields are optional.) You can edit this information after the seminar is created. You schedule various sessions using a single seminar room, thereby reusing a seminar URL.

3. Schedule seminar sessions

A Shared Seminar is a placeholder for all your future sessions. After creating a New Seminar Room, schedule the various instances of your seminar as Seminar Sessions. Your seminar URL remains the same as the base seminar room does not change. However, the schedule and the duration of a seminar can change with each session. The maximum number of participants are determined by your seminar license.

Note: Outside of a scheduled seminar session, all participants are made to exit the session. Only five participants are allowed in a seminar room, in the order: Session creator, Hosts in alphabetical order, Presenters in alphabetical order.

4. Select seminar participants

If your seminar is limited to invited guests only, the next step is to select the seminar participants. For a seminar limited to registered guests and accepted users, you can select users and groups to be participants or presenters in your seminar. These users are able to log in to the seminar directly. Uninvited users who have the URL to the seminar meeting room can attempt to log in as guests. In this case, as a host, you can grant admission to guests on an individual basis.

5. Send invitations

The final step is to send participants email invitations containing the date, time, duration, and location of the seminar. Send invitations as you create the seminar, or create and send the invitations at a later time.

More Help topics

“Pre-seminar tasks” on page 115

Schedule a Seminar

You schedule a seminar session using a seminar room as a base. The seminar URL, coming from seminar room, remains the same, while duration and schedule changes with each seminar session.

1. In Adobe Connect, click Seminars > Shared Seminars.

2. In the Shared Seminars List, click on a seminar that you wish to use to create a seminar room.

3. Click Seminars > Seminar Sessions and do one of the following:

   - Click New Seminar Session, to create a session. Provide the various details of your seminar session, like name, start time, duration, summary. Use an appropriate Seminar Room from the drop-down menu.

   - Select an existing seminar session and click Duplicate Seminar Session. Specify the required details. To search for an existing seminar session, you can narrow down the results displayed using the date filter.

Note: Here, seminars rooms from Shared Seminar licenses are displayed with a Shared prefix. If you have a Named Webinar Manager license, then the seminar rooms associated with this license are also displayed.
Note: You can schedule multiple seminar sessions in advance.

4 Click Create to create a specific session using your seminar room.

Your specific seminar sessions are created in advance before each session starts. The base URLs of the respective seminar rooms are used as the URLs of the sessions. The recording and the reports for each session are available when you open a completed session in Seminar Sessions tab.

You can create an ad-hoc seminar session from inside a seminar room, by clicking New Instant Session, in the notifier pop up in the upper-right corner.

Resolve seminar scheduling conflicts

When creating a new seminar, if its schedule overlaps with an existing seminar, Adobe Connect does not allow you to create the new seminar. To avoid the conflict, it suggests checking the seminar calendar and resolving the conflict. To check the seminar calendar:

1 Go to Seminars > Seminar Calendar. All your seminar licenses have a unique entry in the left sidebar.
2 Choose a specific date. The view will refresh to show you seminar instances on the selected date in the calendar view.
3 Click on a specific session. An Event Details pop up dialog displays the details of the session.

Alternatively, to see the list of all seminar sessions scheduled over a longer period of time, follow these steps:

1 Go to Seminars > Seminar Sessions.
2 Adjust the From and To dates. All the Seminar Sessions scheduled across all your Shared Seminars using all your licenses are listed.
3 Check the Start Time and Duration of all the instances to locate the conflict.

Extending seminars beyond the scheduled time

A Seminar Session that continues beyond the scheduled time is automatically extended twice, for 30 minutes each time. A Seminar Session is extended only if there is no overlap with another pre-scheduled session. If a pre-scheduled session conflicts with the extension of the currently running seminar, the current seminar ends in 10 minutes. The Hosts receive an in-meeting notification that the current session cannot be extended and it ends in 10 minutes.

If a seminar runs beyond the scheduled duration, the seminar is automatically extended twice for 30 minutes each time. Thereafter, the Host is presented with an in-meeting notification to manually extend the seminar for 30 minutes at a time. The ongoing seminar session is extended if there are no conflicts with a pre-scheduled seminar session. The Seminar Administrator is notified at each extension.

Standby mode and scheduling ad-hoc Seminar Session

When you open a Seminar Room outside a scheduled Seminar Session, the room opens in a standby mode. The standby mode allows Hosts to prepare the room for the seminars, to do room testing, and to become more familiar with the Adobe Connect seminar environment. Only ten participants are allowed in a seminar room, in the order: Session creator, Hosts in alphabetical order, Presenters in alphabetical order.

The Seminar Administrator get a notification pop up displaying the number of users rejected entry in the currently open seminar session due to the quota limit. After the seminar room owner creates an instant session, the participants can join by re-opening the seminar session.
Follow these steps to create an ad-hoc Seminar Session.

1. Open a Seminar Room outside any scheduled sessions. It opens in a standby mode.
2. Click in the upper-right corner of the Seminar Room, to open the notifier.
3. Click New Instant Session.

**Note:** An ad-hoc Seminar Session is created, only when it does not overlap with another scheduled session.

**Note:** Only the owner of a seminar room can create instant sessions. For example, if a seminar room from the Named Webinar license is used, only the Webinar Manager who is owner of the room has the right to start instant session.

---

### Send seminar invitations

You can send email invitations when creating a seminar session. After a seminar begins, you can contact invitees by sending an email from the Seminar Session Information tab or from within the meeting room. For more information about latter, see “Contact invitees from a meeting” in “Invite attendees and grant or deny access” on page 19. For former, follow these steps:

1. On the Seminar Session Information page, select Invitation.
2. Modify the Subject and Message Body fields. These fields are pre-populated with the information to join.
3. Click Send Email to launch the local email client and send the email.

**Note:** The system can generate an individual attendance report for registered users. Accepted guests are represented in the total number of attendees, but no individual attendance report is available for accepted guests.

### View seminar information

To view or modify an existing seminar, you must have both of the following permission types:

- **File management permissions** You must have Manage permissions for the seminar folder or file, because when you change a seminar that you created, you are effectively changing the file or folder in the Seminar library.
- **Attendance permissions** You must be the host for the seminar, because you are also changing the parameters of the seminar itself.

### View a seminar profile

1. Click the Seminars tab at the top of the Adobe Connect Central home page.
2. Navigate to the folder that contains the seminar and select the seminar name.

### View a seminar participants list

If you have Manage permissions for a seminar, you can view a list of all invited participants for each seminar room.
Note: If this seminar is presented as an event, view the information in the Event Management tab. For information, see “Adobe Connect Events” on page 122.

1. Click the Seminars tab at the top of the Adobe Connect Central home page.
2. Locate the seminar under a specific license and click its name.
3. Click the Edit Participants link.

View a list of content uploaded from a seminar
If you have Manage permissions for a seminar folder, you can view a list of all content that has been uploaded to the server from a seminar room within that folder.

1. Click the Seminars tab at the top of the Adobe Connect Central home page.
2. Locate the seminar under a specific license and click its name.
3. Click the Uploaded Content link. A list of uploaded content appears.
4. To view information about an item, click its name.
5. To change the title or summary of the piece of uploaded content, click Edit, make your changes on the Edit page, and click Save.
6. To return to the uploaded content list, click Return To Uploaded Content.

View a seminar recordings list
You can view a list of the recorded seminars.

1. Click the Seminars tab at the top of the Adobe Connect Central home page.
2. Locate the seminar under a specific license and click its name.
3. Click the Recordings link.
4. To view information about an item, click its name.
5. To change the title or summary of a specific recording, click Edit, make your changes on the Edit page, and click save.

View recordings of specific seminar sessions
You create specific Seminar Sessions using a seminar room as a base. The recordings for all seminar rooms are available as described above. The recordings of specific Seminar Sessions are also accessible separately.

1. Click the Seminars tab at the top of the Adobe Connect Central home page.
2. Locate the seminar under a specific license and click its name. You can filter sessions based on a date range.
3. Click the Recordings link and access the session recording.

View seminar folder license information
You can view information about how many seminar licenses your organization purchased. This can be helpful when planning the number of people to invite to a seminar.

1. Click the Seminars tab at the top of the Adobe Connect Central home page.
2. Locate the Seminar Room in the list and click on its name.
3. Click License Info.

Note: If you create a seminar under a seminar license folder that has a start date in the future, no one will be able to enter the Seminar room.
Edit seminars
If you are an administrator or have Manage permissions for a seminar folder, you can add participants, remove them, and change participant permission roles (host, presenter or participant). Administrators are able to access the seminar rooms and access the related content or recordings and reports, as well as, move or delete any content or delete a seminar room itself. However, they cannot schedule sessions or create new seminar rooms in user folders. This behavior is similar to how Account Administrators are able to access user meeting folders and access meeting and content but cannot create new meetings.

Edit seminar information
1 Click the Seminars tab at the top of the Adobe Connect Central home page.
2 Navigate to the folder that contains the seminar and select the seminar name.
3 Click the Edit Information link.
4 Edit the options as necessary. For details, see “Edit meeting information” on page 27.
5 Click Save.

Add or remove seminar participants
You can add or remove seminar participants at any time.
1 Click the Seminars tab at the top of the Adobe Connect Central home page.
2 Navigate to the folder that contains the seminar and select the seminar name.
3 Click the Edit Participants link.
4 To add participants, do one of the following in the Available Users And Groups list. To remove participants, do one of the following in the Current Participants list:
   • To select multiple users or groups, Control-click or Shift-click.
   • To expand a group to select individual members, double-click the group name.
   • To search for a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.
5 Click Add or Remove as required. (If you expanded a group to select individual members, you can double-click Up One Level in the list to restore the original list.)
6 (Optional) If you added participants, set permissions. From the Set User Role menu at the bottom of the Current Participants list, assign a permission type (participant, host, or presenter) for each user or group you added.

Change a seminar participant’s role
Seminar participants can be assigned the following roles: presenter, participant, or host.
1 Click the Seminars tab at the top of the Adobe Connect Central home page.
2 Navigate to the folder that contains the seminar and select the seminar name.
3 Click Edit Participants.
4 In the Current Participants list, do one of the following:
   • To select multiple users or groups, Control-click or Shift-click.
   • To search for a name in the list, click the Search button at the bottom of the window, enter the name to display it in the list, and then select it.

Last updated 3/20/2015
5 For each name, select the new user role (presenter, participant, host, or Denied) from the pop-up Set User Role menu at the bottom of the Current Participants list.

6 Click a link in the navigation bar to perform another task or click Seminar Information to view details about the seminar.

**View data about seminars**

The Seminar Dashboard provides a graphical representation of statistical data about your seminars. Click the Seminar Dashboard link under the tab bar, at the top of the Seminar's window.

The data, which reflects all the seminars you have created, appears in three-bar graphs; click any of the bar graphs to view the Summary Report for this seminar.

- **Most Active Seminars Over Last 30 Days** Determined by the number of sessions.
- **Most Participants Seminars Over Last 30 Days** Determined by the number of participants.
- **Most Viewed Recordings Over Last 30 Days** Determined by the number of views (the number of times each archived seminar has been viewed).

You can click any individual seminar in any of the three-bar graphs to view more detailed information about the seminar.

**Seminar reports**

Use the Reports feature of Adobe Connect Central to create reports that summarize seminar information from different perspectives. Reports are created from the Reports link on the Seminar Information page.

Reports for Seminar Rooms can be accessed by accessing a room and clicking Reports. The room reports contain Aggregate User Data about sessions and invitees. Reports for Seminar Rooms are available as an overall Summary and reports By Attendees, By Sessions, and By Questions.

You create specific seminar sessions using seminar rooms as base. The reports for specific sessions are also available separately. Access a session in Seminar Sessions tab of Seminars and click on Reports. It shows reports about the attendees and poll-related questions.

**More Help topics**

“Generating reports in Adobe Connect Central” on page 247

**Join a seminar from Adobe Connect Central**

If you are scheduled to attend a seminar, the seminar name appears in the My Meetings list on the Home tab in the Adobe Connect Central window. In addition, if you have Outlook and have accepted the invitation to the seminar, the seminar appears on your Outlook Calendar. (Seminars you create are listed under the Seminars tab.)

You can determine if the seminar you are joining is already in progress by checking the date and time shown for the seminar. If the date is in the past, the seminar appears on your meeting list under expired meetings, but you can still enter the room to view content.

1 Click My Meetings.

2 Next to the seminar you want to attend, click Open.
Chapter 4: Adobe Connect Events

Adobe® Connect™ Events enables users to manage the full life cycle of large or small events, including registration, invitations, reminders, and reports. Adobe Connect events can be used with meetings, seminars, presentations, or training. An event generally involves many participants, so it requires careful pre-event planning and post-event management.

About Adobe Connect Events

Events overview
An Event is a meeting, seminar, presentation, course, curriculum, or virtual classroom wrapped with pre-event and post-event management features. Event management features include registration, reminders, and event-tracking surveys and reports.

Consider creating an event in the following situations:

- You want participants to register. You also want the option to screen participants for the event based on their registration information.
- You want to create branded event pages, such as listing and description pages that publicize the event as well as branded registration and login pages.
- You want to customize the collected participant data for your reports. Because this data is based on registration information, it supplements the reports that relate to event content, such as the responses to quiz questions in a course or polling questions for a meeting.
- You want people outside your organization to participate. Events are often listed on public websites, so many participants can find your event there and register at the site.
- You want to send automatically generated e-mail messages, such as invitations, reminders, registration confirmations, and thank you notes.
- You want to track individual campaigns, such as e-mail offers, search engine campaigns, or banner ad campaigns.

An event has three phases:
- Pre-event tasks include determining the number of licenses available, creating content, establishing permissions, and inviting, registering, and reminding event participants.
- In-event activity requires the attendance of participants. It requires presenters’ attendance for on-demand events or when an event includes a meeting or seminar.
- Post-event tasks include redirecting the participant’s browser to a specific URL, answering outstanding questions from participants, and monitoring various event-tracking activities through surveys and reports.

More Help topics
“Best practices for events” on page 124
“Creating an event” on page 131
Pre-event tasks

Careful pre-event planning and task maintenance can ensure that events run smoothly and that post-event activities can be completed quickly.

1. **Determine how many licenses you have**

   Before you set up an event, determine how many licenses you have. Based on your account license, you can set the registration limit for a particular event while creating the event. Check with your Adobe Connect Central administrator for licensing issues.

2. **Specify content for the event**

   Before you create an event, the content for the event must exist in Adobe Connect Central. (When you are setting up the event with the Event wizard, you must specify the content, meeting, course, curriculum, virtual classroom, or seminar on which to base your event.) The following list shows several examples:
   - To create a training event using a course or curriculum, the course or curriculum must exist in the Training library.
   - To present content as an event, store the content in the Content library.
   - To use a meeting or a seminar as an event, the meeting or seminar must exist in the Meetings or Seminar library.
   - To use a virtual classroom as an event, the virtual classroom must exist in the Training library.

3. **Establish event permissions**

   Permissions are important because they determine who can participate in, view, and manage events. Attendance permissions determine the roles and functions of attendees. An Event Manager assigns attendee roles when setting up the event in the Participant Management tab.

   Attendees can have the following roles and permissions:

   **Invited**  People who are sent an invitation to the event and are invited to register for the event.

   **Denied**  A person who has registered, but is not given access to the event by the host.

   **Pending Approval**  A person whose registration has not been approved by the Event Manager.

   **Participant**  A person who can attend the event as a guest or a registered user from your organization. They have limited permissions.

   **Presenter**  A person who shows content to attendees. Presenters are assigned Presenter permissions.

   **Host**  The person who has full control of a meeting or seminar room used for an event. The host has full Presenter and Manage permissions and can assign permissions to others.

   **Note:** The Presenter and Host roles are used for live events (meetings and seminars) only. For all non-live events, only the Participant, Invited, and Denied roles are used.

   Event library permissions define who can create events, modify events, and perform the tasks associated with the Event library files and folders, such as adding and deleting files. The file management permissions are Manage and Denied.

4. **Register and approve attendees**

   Events require registration but don’t always require approval. By default, an event does not require approval, but you can change the setting when you create the event. If you do not require approval, anyone who registers is approved automatically. In this case, all registrants can attend the event, providing you have a sufficient license. (As the event host, you can always deny approval to anyone before the event occurs.) Requiring approval lets you control who attends the event. You can also let a person directly enter a live meeting immediately after registering for the meeting.
More Help topics
“Best practices for events” on page 124
“Creating an event” on page 131

In-event tasks
Much of the work involved in creating an event occurs during the content creation and pre-event stages. If the correct content exists and you have completed the pre-event tasks, the actual event goes smoothly. However, you may need to complete a few tasks during an event, especially if it is live.

Non-live on-demand events  Events that do not happen in real time. Participants click a link to view a presentation or take self-paced course or curriculum. You can notify potential participants of the event through an e-mail invitation or by publishing the event on the public events listing page of the organization website. Both the e-mail invitation and the website listing contain a link that opens a registration form for the event. In many cases, no in-event tasks take place during non-live events.

Live events  Scheduled, real-time events. During the event, it may be necessary to coordinate multiple presenters or approve attendees.

More Help topics
“Best practices for events” on page 124
“Creating an event” on page 131

Post-event tasks
After an event, there are several tasks and administrative activities to perform.

Thank attendees  Send a thank you e-mail message to attendees. Also, consider sending an e-mail message to people who were not able to attend.

Read reports  View event reports to obtain statistical data and participant information. Reports enable you to assess the success of the event and make adjustments to future events.

View the Event dashboard  Refer to the Event dashboard for a graphical representation of statistical data about the last ten of your most active events. The dashboard data reflects the last ten most active events over the past six months, in your My Events folder.

Check the library  Organize the event files in your library.

More Help topics
“Pre-event tasks” on page 123
“Creating an event” on page 131

Best practices for events
Here are some tips and tricks for tasks that you perform for live events and during meetings and seminars associated with events:

• Create a lobby. The lobby can be a Chat pod where participants meet and greet each other before the event begins.
• Use PowerPoint animations. Appropriate use of PowerPoint animations can bring an event to life with motion and sound. Don’t add so many, however, that the animations become distracting.
• Incorporate polls into your event. Polls give you instant feedback so you know if your message is getting through. They provide an easy way for your audience to actively participate in the event.

• Leverage video assets. If you have appropriate video files, add them to your events.

• Coordinate carefully between co-presenters. Choose Meeting > Enable Presenter Only Area to include items such as an agenda with notes and moderated Q&A pod. Consider giving presenters "enhanced participants rights" versus "presenter rights."

• With preloaded content, do a dry run before the event, at the same time of day you intend to conduct the event (network traffic differs by time of day). Use the exact hardware and network connections you plan to use for the real event.

More Help topics
“Events overview” on page 122
“Creating an event” on page 131

Creating and editing events

Create and modify templates and the Event Catalog
Adobe Connect event pages, Event Catalog, and emails are created using pre-defined templates. Before you can create an event page, create a template to address your requirements. Multiple templates can be designed, stocked, and shared in advance, to address the varied needs of an organization.

Create templates
You get more flexibility in designing pages, catalogs, and emails for events, if you use templates to create them. Before you create an event, you can create a template to capture requirements for that event that are generic and applicable to other events. You can design and stock multiple templates, in advance, to address the varied needs of your organization. You can use pre-defined templates (and modify them further if you so wish) for event pages, event catalogs, and emails.

You can create customized event page templates including a landing page, a speaker information page, a registration page, and a login page. While two event page templates are included, Event Managers and Event Administrators can create any number of custom branded templates by using a number of rich components such as images, Adobe Flash content, tables, charts, carousels, and more.

Event Managers can create private templates and Event Administrators can create shared templates to address the various requirements of your organization. Typically, shared templates are created to ensure consistency and branding for all your organization’s communications.

1 Go to Event Templates or Email Templates, in Event Management tab.
2 Click the Edit templates link against Event Template or Email Template option.
3 In the AEM instance launched, click Shared Template link in Event or Email Templates. Click Create New Template button in the upper-right corner of the screen, to create either an event template or an email template, respectively
4 Provide a template name, select the Access type, and select a base template.
5 Click Create.
Manage templates
Event administrators can update, rename, delete, or copy existing templates. Event Managers can only create a private copy of the shared templates. Adobe Connect 9.4 onwards, Virtual Classroom Managers and Webinar Managers also have the permission to create a private copy of existing templates. Also, for any renewed accounts that use Seminars and Events features, Seminar Administrators also have the permission to create a private copy of existing templates.

1. Go to Event Templates or Email Templates, in Event Management tab.
2. Click the Edit templates link against Event Template or Email Template option.
3. In the AEM instance launched, click a requisite option in the left margin. Move the pointer above the existing templates to display the options Edit Template, Create a Copy, Delete Template, and Rename Template.

AEM components to design Adobe Connect templates
Adobe Connect uses AEM technology to design and lay out email and event templates and Event Catalog. The designed templates can be shared and access control governs their usage. Adobe Connect also offers AEM components customized for Adobe Connect users and administrators. These AEM components can be dragged onto the template area and configured to quickly design and layout templates.

Container
A container provides a demarcated area, in an event template, to contain any components you put there. Container helps demarcate an area of the page by allowing you to customize its background and restrict its dimensions.

Event Banner Small
Showcase the small event banner, uploaded as Small Banner Image in event information, on the various event pages and in the email. You can customize various properties of the event banner such as, size, description, alignment, and title. Recommended size for small images is 560x230 pixels.

Event Banner Large
Showcase the large event banner, uploaded as Large Banner Image in event information, on the various event pages and in the email. You can customize various properties of the event banner such as, size, description, alignment, and title. Recommended size for large images is 740x300 pixels.

Event Carousel
Display a carousel view of the image uploaded as Large Banner Image in event information, for the featured events.

Event Duration
Display the duration of an event. The duration is calculated based on the timings mentioned in event details in Adobe Connect Central.

Event Information Brief
Display brief information about an event, entered as Event Information, in event information. You can also customize the font properties of the information.

Event Information Detail
Display the detailed information about an event, entered as Detailed Information field. You can also customize the font properties of the information.
**Event List**
Display a list of events, to create a catalog of events. You can filter the event listing using the existing event tags to display only selected events. You can showcase the events with logo, control alignment, display future events, control text formatting of the page, and so on. A few prominent settings available in this component are described below:

**Events Per Page** Specifying various numeric options in this field provides users the option customize the number of events displayed per page. To provide users with multiple options, use Add Item link to add more values.

**Tag Panel Position** Specify whether the Popular Tags panel is displayed on top of the components, on the right side of the components, or not displayed at all.

**Tag Panel Title** Edit the title of the tag panel.

**Show All Tags** Enabling this checkbox displays the upcoming events on the Event Catalog page without any filtering.

**Show Only Selected Tags** When Show All Tags is not selected, you can select some of these tags to display only the corresponding upcoming events.

**Event Logo** Choose whether to display the logo of the event on the Event Catalog page or not. You can also set the width of the event logo in pixels. Maximum value of width is 500px.

**Date View** Set the first day of the week.

**Display Future Events** Set number of days ahead of the current date to display upcoming events on catalog page up to this date.

**Filter by Tags** You can enable or disable tag based filtering. When enabled, you have the option to select a few tags and specify one of the following options:

- Show events having any of the selected tags.
- Show events having all of the selected tags.
- Show events having none of the selected tag.

**Text Properties** In this tab, you can adjust the text properties for the various elements of the Event Catalog page such as, header, event name, and tag panel list.

**Color Properties** In this tab, you can set the color properties, fill style, border color, and so on, for the header and the popular tags section.

**Labels Configurations** In this tab, you can change the default values of different labels in the Event list component.

**Event Login**
Provide the login workflow to event attendees, on the Event Login page.

**Event Logo**
Add a logo of your event. Various parameters you can use to customize the display of the event logo are its size, description, alignment, and title.

**Event Name**
Display the name of the event, mentioned as Name in event information. You can customize the font properties.
Event page menu
Insert a tabbed bar containing links to the various event pages namely, Event Info, Speaker Info, Event Registration, and Event Login Page. You can create the design and layout of these four pages individually. To customize a particular event page, click the link of that page in the Event page menu, and use the available AEM components to design the page. Modify the Page Menu Options in the settings of this component, to display the event pages and their name in the tabbed bar.

Event Registration
Provide the event registration workflow from where user register for a particular event, on the Event Registration page.

Event Start Time
Display the event start time, as mentioned in the event information in Adobe Connect Central, on event page or in email.

Event Time
Display the event time, as mentioned in the event information in Adobe Connect Central, on event page or in email.

Header
Insert a header on the event page that displays the logo uploaded in Adobe Connect Central. You can also set the time zone of the various timings displayed on the page.

Horizontal Line
Draw a horizontal line to demarcate various sections of the event page, using this component. You can control the blank space above the line using the height parameter.

Horizontal Separator
Create a horizontal separator with specified blank space to improve readability of the event page, using this component. The height parameter controls the height of the blank space.

Link Button
Create a button which links to event details, register page, speakers page, catalog page, or any other web page of your choice. You can customize the style of the button. The prominent customizations provided through the settings of this component are the following:

Link To
Provide the hyperlink of the destination of the Link Button. The available options are Event Details, Register Page, Speakers Page, Catalog Page, and Hyperlink. If you select the Hyperlink option, provide the destination link in the Hyperlink field.

Style
Define the style of the button by selecting Round Corners, Round Corners with Arrow, Plain Button, or Custom Image. If you select Custom Image, you can construct your own button by uploading images in the Left Image, Center Image, and Right Image tabs.

Height
Set the height of the button to display the button label as desired on the custom images uploaded.

Label
Customize the various properties of the button like, label, font size, font color, and font family.

Speaker Brief Overview
Display the Speaker Overview, entered in the event information in Adobe Connect Central, in your event templates. You can also specify the font properties.
**Speaker Detailed Overview**
Display the Speaker Detailed Overview, entered in the event information in Adobe Connect Central, in your event templates. You can also specify the font properties.

**Speaker Image**
Display the Speaker Image, uploaded in the event information in Adobe Connect Central, in your event templates. You can also specify the various image properties such as, size, description, alignment, and title.

**Speaker Name**
Display the Speaker Name, as mentioned in the event information in Adobe Connect Central, in your event templates. You can also specify the font properties.

**Text**
Insert text using a WYSIWYG editor. You can also adjust the font properties of the text.

The Text component available in the email templates provides additional Runtime Fields. Using these fields you can insert the values of the following variables in your emails automatically.

- Audio Conference Details
- Event Creator Name
- Event Description
- Event Duration
- Event Login Url
- Event Name
- Event Registration Url
- Event Site Url
- Event Start Time
- Event Summary
- Event Time
- Event Url
- First Name
- Last Name
- Login
- Time Zone
- User e-mail
- Speaker Name
- Speaker Overview
- Speaker Detailed Overview
- Speaker Info Url
Text & Image
Insert text and images, and format their styles in one go, using this component. You can enter text using a WYSIWYG editor, set the font properties, upload an image, and format the properties of the image, like, alternative text, description, size, title, and alignment.

Time Zone
Set the time zone of all the timings displayed on a page. Any timing displayed on the page is converted to the specified time zone. You can align the time zone to left, center, or right.

Account logo
Display a logo of your organization, that is added in Adobe Connect Central, on the event page or in the email. You can customize its properties such as, size, description, alignment, and title.

Title
Insert a title using a WYSIWYG editor and set its display style, using this component.

Event Associator
Event Associator component associates an Adobe AEM page with an Adobe Connect event. You can create a one-on-one mapping to an event on the associated Adobe Connect instance. You can modify the event association any time. You can specify which Event Page, a AEM page represents. For more information, see AEM Webinars Integration with Adobe Connect.

Event Calendar Invite
This component inserts a Download Calendar Invite button on the Registration Confirmation page. You can customize the text of the Event invitation email and can also change the label of the button.

AEM page actions to manage Adobe Connect template
AEM instance provides various page actions to manage the templates you design.

Create New Template
You can also select the page action, Create a new template, to start creating a fresh template. Select a base template and whether you want the new template to be Shared or Private.

Create a Copy
Create a copy of an existing template, with a different name. You can also specify whether the new template is shared with others or is private.

Reset Template
Reset the design and layout of a template to another template. After clicking Reset Template, you can select a base template from a list.

Delete Template
Click to delete the template that is open. When you delete a template, the events using the template revert to using the system default template.

Page Title & Background
Set the title of the page, background settings like, image, color, and more.
Activate Template
Activate a template, after you edit it, for the changes to take effect on the publish instance. All the pages published live using a template, start using the updated version of the template, once the edited template is activated. Activate newly created templates, for the templates to be available for use.

Creating an event
You create an event using the Event wizard. It guides you through the tasks of creating a name and including a summary and detailed information about the event. You can select an image to associate with the event. You can also select the content, determine participants, and define various phases in which emails are sent to participants.

Events are built around content, such as a course or curriculum, a meeting, virtual classroom, or a seminar. The content must exist in the appropriate library before you create the event. You cannot create the content when you create the event. You can use any single file from your Content, Meetings, Training, or Seminar library.

1. Start the Event wizard
To start the Event wizard, click the Event Management tab in Adobe Connect Central, navigate to the event folder, and click New Event.

   To quickly copy settings from an existing event, select it and click Duplicate Event. Then enter a unique name, URL, and start and end dates for the event.

2. Enter event information
On the first page of the Event wizard, select the event template. Then, enter background details about the event, such as name, summary, and detailed information. The event template, event name, time zone, and language are required. Other fields are optional.

The various event pages are created using AEM. AEM server used to host your pages depends on whether you are using hosted Adobe Connect or your own Adobe Connect server. For the field 'Host Event URLs on', choose the destination of the Event Pages. To host the Event Pages on your own AEM server, select External AEM Server. This option is available on the accounts that are already linked with an External AEM server.

To allow for simplified event registration, you can create events that do not require a password. Participants can log in to such events using just their email address. To enable users to register for an event without them having to provide a password, select the Register Without Password option when creating an event. It helps non-registered, guest users log in easily, by entering their email address. Users who are registered on the Adobe Connect server, are required to log in using their user name and password for all events.

If allowed by Account Administrators, you can select Register with Social Profiles to allow users to register for event using their Facebook or Google+ accounts. The option to use social profiles to register and log in, is available only on hosted offering of Adobe Connect and not on the on-premise deployments.

While creating an event, you can categorize the event as a Live event or an On-demand event. In a Live event, a presenter conducts a meeting or a seminar, or leads a virtual classroom. In an On-demand event, users can access training courses, curriculum, or content from the Adobe Content library. Normally, Live events are scheduled in advance and participants join for a stipulated time. On-demand events are for presenting pre-recorded content—users can log in to On-demand events at their convenience. If you create an on-demand event, you can present content either from the Adobe Connect library or from a training course or curriculum. If you create a live event, you can present an Adobe Connect meeting, seminar, or virtual classroom.

You can use banners on event pages and in the event emails to make the content more appealing. You can provide small and large images for banners. Recommended size for small images is 560x230 pixels and for large images is 740x300 pixels.
You can provide the following information about the speaker. Information about the speaker is added to the emails and the event pages.

- the name of the speaker
- an image of the speaker—the image can be a photograph or any other image (for example a company logo)
- a brief overview of the speaker
- a detailed overview of the speaker

Event Administrators can apply the Featured Event tag to display an event in the Featured Events section of the Event Catalog. You can also add a logo, banner images, an image for the speaker, and details about the speaker. You can edit event information after you create the event.

Note: If you change the event start date to a future date, participants and presenters can still enter the meeting room at any time.

3. Select content
Content for an event must exist before you create an event. After you select a type of content, you cannot change the content type. You can, however, substitute different content of the same type. For example, if you create an event based on a seminar, you can substitute a different seminar for the one you originally used when creating the event.

4. Create registration
You determine the questions that participants must answer on the registration form. The information creates a guest profile for tracking the participant. Four mandatory questions are preselected on the Create Registration form. They include E-mail address, Password, Retype password, and Name. You can select any of the other questions.

For events that include guests (for example, people who find your event listing on your organization’s public website), you may obtain the company name and URL for screening purposes. For example, if the applicant works for a competitor, consider denying access. Select the Enable Campaign Tracking option to report on registrations by campaign source.

5. Customize registration
You have a considerable flexibility in designing a registration page for an event, including custom multiple-choice, short-answer, and yes/no questions. You can also change the order of questions and delete questions at any time.

Event Administrators can introduce a join button in the registration confirmation email. Instead of the long, personalized link to join an event, the registrant sees only the Join button.

6. Select event participants
For an event limited to registered guests and accepted users, you can select users and groups to be participants or presenters in your event. These users are able to log in to the event directly. Uninvited users who have the URL to the event meeting room can attempt to log in as guests. As a host, you can grant admission to guests on an individual basis.

7. E-mail options
The penultimate step in the Event wizard is to send participants e-mail invitations containing the date, time, duration, and URL of the event. You can make your event emails more appealing and eye-catching by using rich HTML-based emails. You can design different templates for different types of emails. For example, an event invitation can contain information about the date, time, duration, and URL of the event. You can send invitations as you create the event. Alternatively, you can create and send the invitations at a later time.

Define triggers to send various notifications to users, such as event reminders and registration approval notifications. You can either set a specific date for these notifications or set a relative date.
Using Adobe Connect 9
Adobe Connect Events

You can create up to four custom triggers. You can select a template for a custom trigger and set up recipient groups and email aliases to which users can send queries. You can set a specific date for the custom trigger or a date relative to the date you create the event.

To ensure that you configured email triggers correctly, send a test mail to your email ID before you publish the event.

8. Campaign IDs
You can add a campaign ID to use with the email options for the event to track email campaigns. For more information, see “Use campaign tracking with an event” on page 146.

More Help topics
“Change an existing event” on page 136
“Best practices for events” on page 124
“Use campaign tracking with an event” on page 146
“Set login and password policies” on page 226

Preview and modify registration and event pages
You can preview registration and event pages, modify them (for example, by changing their logos), and make them public.

More Help topics
“Change an existing event” on page 136
“Best practices for events” on page 124

Preview a registration or event page
1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the event and click its name in the list.
3. Next to Participant View, select one or more of the following pages to generate a preview:
   • Event Login
   • Event Landing
   • Event Registration
   • Speaker Information

Make a folder and a catalog public
The event listing page, which can be branded for your organization, displays a list of upcoming events and displays the following for each:
   • Event logo
   • Event name
   • Description (the Event Information text)
   • A Register button, which takes the user to a registration form
   • An Event Details button, which takes the user to the event information page; it includes the Detailed Information text

Last updated 3/20/2015
The Event Catalog lists all the events created in Adobe Connect. Also, the events in a single folder appear on one listing page, if you make the folder public.

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the desired folder.
3. Click Make This Folder Public.

The folder is now public and a URL is listed. The URL can be made available and anyone can view the event listing page from the hosted public pages.

**Preview an event listing page for a specific folder**

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the folder containing the events whose listing page you want to view.
3. Make the folder public, if necessary. The button above the list of folders and events is a toggle between private and public. If the button says Make This Folder Public, click the button.
4. Click the URL below Public Event Listing URL For This Folder.

The event information appears exactly as it appears on the event listing page.

5. To close the preview window, click the Close button in the upper-right corner.

*Note: Remember to make this folder private again after you preview the page if you do not want the folder to be publicly available yet.*

**Preview the event listing for a single event**

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the event and click its name.
3. Next to Participant View, click Preview Event Landing, Event Registration, or Speaker Information page.

The event information appears exactly as it appears on the event listing page.

4. To close the preview window, click the Close button in the upper-right corner.

**Preview event emails**

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the event and click its name.
3. Click the E-mail Options tab.
4. Click Send Test Email. Preview the test emails that are sent to your email id based on the email options you selected.

**Change the logo associated with the event**

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the event and click its name.
3. Do one of the following:
   - Click the Edit Information link above the title bar
   - Click the Edit link inside the title bar.
4. Click Browse to find a new image file for the event.
5. Select the image file, and click Open.
6 Click Save.

**Change the small banner associated with the event**
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the event and click its name.
3 Do one of the following:
   • Click the Edit Information link above the title bar
   • Click the Edit link inside the title bar.
4 Click Browse to find a new small banner image file for the event.
5 Select the image file, and click Open.
6 Click Save.

**Change the large banner associated with the event**
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the event and click its name.
3 Do one of the following:
   • Click the Edit Information link above the title bar
   • Click the Edit link inside the title bar.
4 Click Browse to find a new large banner image file for the event.
5 Select the image file, and click Open.
6 Click Save.

**Change the image of the speaker for the event**
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the event and click its name.
3 Do one of the following:
   • Click the Edit Information link above the title bar
   • Click the Edit link inside the title bar.
4 Click Browse to find a new speaker image file for the event.
5 Select the image file, and click Open.
6 Click Save.

**Publish events**
When you publish an event, the following events occur:
- All selected e-mail message options become active. For example, if you selected the first option, send e-mail invitations, the invitations are automatically sent and you can no longer customize them. You can, however, still customize any other selected e-mail messages. You can also edit the invitation text and then invite more people—the new text is used.
The registration form with its associated URL becomes available, and prospective attendees can begin registering for your event.

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the event and click its name in the list.

The Event Information page appears. Next to Status, the following message appears: “This event has not been published and listed on your site. Emails have not been sent.”

3. Click Publish.

A confirmation message appears: “Publishing this event will send e-mail based on your selected mail options.”

4. Click Publish again.

The Event Information page appears with this status message: “This event has been published. E-mail options are active.” The Publish button disappears.

**More Help topics**

“Send event invitations” on page 144

“Best practices for events” on page 124

**Change an existing event**

Before an event occurs, you can change its beginning time, change participant permissions, or make other modifications.

Check the Current Participants list periodically to ensure that you have enough licenses for the number of attendees listed. In addition, ensure that all attendees meet approval criteria.

Also check the most current registration reports, which show information about your attendees and invitees. If you selected or customized questions to help identify potential participants, you can also view the responses to questions.

**More Help topics**

“View information about an event” on page 148

“Best practices for events” on page 124

**Notify users of a change**

If you modify an existing event, for example, by setting a new start time, you can easily notify users by e-mail.

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the desired folder.
3. Click the name of the event you want to change.
4. Open the E-mail Options page and select Show Reminder When Updates Need To Be Sent.
5. Click Save.
6. Open the Event Information page and scroll to the Status field.
7. Click Edit/Send Notifications, make any necessary changes, and click Send.
Change event information
You can edit the text on the Event Information page for event participants. If you select the e-mail option “Notify users when event has been updated,” any invitee whom you have previously notified about the event automatically receives updated information.

Note: If you sent prior invitations without selecting the “Notify users when event has been updated” option, do so before changing the profile information. Selecting the option ensures that potential attendees are aware of your changes.

1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired folder.
3 Click the name of the event you want to change.
4 Do one of the following:
   • Click the Edit link next to Event Information.
   • Click the Edit Information link.
5 Change any of the following:
   • Edit the event name. The name appears in the event list and in reports. This is a required field.
   • Edit the event information. The information can be up to 254 characters in length. This text appears on the Event Information page and in event reports.
   • Edit detailed information about the event (up to 4000 characters in length).
   • Enable (or disable) registration using social profiles, by checking (or unchecking) the checkbox, Register with Social Profiles.
   • Edit the start time or end time of the event.
   • Edit the time zone of the event.
   • Change the registration limit for attendees based on your account license.
   • Edit the small banner, large banner, speaker image, and event logo. The logo file can be in BMP, GIF, JPG, or PNG format. The best size to use is 100x135 pixels.
   • Change the language for the event. Customarily you select the language used by the presenter or the language used by most event attendees.
   • Change the event user policy to add new users as guests or full Adobe Connect users. Adobe Connect Administrators configure the appropriate Event User Policy for the system.
   • Change the option to approve participants after they register for the event. (In general, it is best to have this option selected because it allows you to control who has access to the event.)
   • Change the option for the event to be visible in the Event Catalog.
   • Change the option to allow participants to directly join a live event after registering.
   • Modify speaker details and associate tags to the event.
   • Enable (or disable) Engagement Tracking for participants, by checking (or unchecking), the checkbox Enable opt out for participants. This option may or may not be made available by your Account Administrator.
6 Save your changes in one of two ways:
   • Click Save.
   • Click Save and Rebuild.
Change registration questions
You can change any registration question, except the required questions (first name, last name, e-mail, and password), which the system uses to validate a user.

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the desired folder.
3. Click the event you want to change.
4. Click Registration Questions.
5. Modify the registration questions:
   - To add a question to the registration page, select the check box to the left of the question and click Save.
   - To remove a question from the registration page, deselect the check box to the left of the question and click Save.
6. To modify, delete, or add custom questions, click Customize.
   - To change the order of questions in the list, select the check box to the left of the question, and click Shift Up or Shift Down.
   - To delete a question, select the check box to the left of the question and click Remove.
   - To modify a custom question, click the question text in the Customize window.
   - To add a question, click the button that corresponds to the type of custom question you want to add: New Multiple Choice, New Short Answer, or New Yes/No.
7. When you finish, click Return To Registration Menu.

Add a multiple-choice question
1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the desired folder.
3. Click the event you want to change.
4. Click Registration Questions.
5. Click Customize.
6. Click New Multiple Choice.
7. In the Question window, type a question in the box.
8. Type a possible answer for Answer 1. You can delete an answer at any time by clicking the Delete button next to it.
9. Click the Add Above or Add Below buttons to add another answer above or below Answer 1. If you click Add Above, Answer 1 becomes Answer 2.
10. Type another possible answer.
11. Repeat steps for a maximum of four answers.
12. Alternatively, you can provide all answers in one step. Select Specify Answers As Comma Separated (CSV) Value, to use the option to provide all the answers in one step as comma separated or new line separated values.
13. To require that users answer the question, select Response Is Required.
14. Click Save. The Customize Registration window appears, showing your new question.

Add a short-answer question
1. Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired folder.
3 Click the event you want to change.
4 Click Registration Questions.
5 Click Customize.
6 Click New Short Answer.
7 Type a question in the box.
8 Select a validation type for the question.
9 To require that users answer the question, select Response Is Required.
10 Click Save. The Customize Registration window appears, showing your new question.

**Add a yes/no question**
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired folder.
3 Click the event you want to change.
4 Click Registration Questions.
5 Click Customize.
6 Click New Yes/No.
7 Type a question in the box.
8 To require that users answer the question, select Response Is Required.
9 Click Save. The Customize Registration window appears, showing your new question.

**Change event content**
You can replace event content only with content of the same type, for example, you can replace one meeting with another. You cannot add any new content to the Content library from here. You can select only existing content for your event.

If you purchased Adobe Presenter, you can publish presentations from PowerPoint to the Content library for your event. To use an existing presentation for an event, republish it to a different folder. If you do not, the reporting information for the original presentation is merged with the event-specific report data. In addition, event-specific data is carried over into future reports for the original presentation.

*Note: For content other than courses and curriculum, the system tracks only whether the user has viewed the event. For example, users who view only the first slide in a presentation are reported as having attended the event. In contrast, users who view only a few of the slides in a course or curriculum are not reported as having attended. In other words, users must complete and return the course to appear on the report as attendees. (Also, you can view Time In and Time Out information by viewing the event By Attendee report.)*

1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired folder.
3 Click the event you want to change.
4 At the top of the Event Information page, click the Select Content link.
5 If the required content does not appear in the list, navigate to the file or folder where it resides:
   - Click the appropriate link at the top of the tab (for example, Shared Content if you are replacing content).
• Scroll to the folder or file that you want. Either select the check box to the left of it or click the folder or file, as appropriate. If you are in the Content library, click Up One Level to navigate to a higher folder directory.

6 Click Save.

**Change event templates**

You can replace an existing template for your event landing page with a predefined AEM template. In addition, you can edit a predefined template in AEM and use the customized template for your event landing page.

To change an event template:

1 Click the Event Management tab in Adobe Connect Central.
2 Click Event Templates.
3 Select the required event template.

To edit a template, click Edit Template and edit the template in the design view using AEM Sidekick components.

**Change email templates**

You can replace an existing template for email notifications with a predefined AEM template. In addition, you can edit a predefined template in AEM and use the customized template for email notifications.

To change an email template:

1 Click the Event Management tab in Adobe Connect Central.
2 Click Email Templates.
3 Select the appropriate email template.

To edit a template, click Edit Template and edit the template in the design view using AEM Sidekick components.

**Change event e-mail options**

You can change e-mail options for any of the e-mail notification, reminders, or follow-up messages before they are sent. (Some messages are selected by default.)

You can customize an e-mail message. In several types of messages, you can attach a Microsoft Outlook Calendar (iCal) entry that adds the event to the recipient's Outlook Calendar. You can also request responses from the participants. Select the Request Response checkbox, when customizing the email. The option is selected by default. Only Microsoft Outlook users on Windows can send back a response to the Event organizers.

When you customize an e-mail form, there are several fields in curly brackets ({}) in the Message Body area. In general, do not change any of the fields, unless you have a specific reason. The curly brackets contain variables that the system replaces with actual values that are specific to your event. For example, the event-time field displays the start time you specified. You may want to change the time to 15 minutes earlier to ensure that the actual event begins on time. To change the time, type the new time in the event-time field.

**Note:** You may want to add any of the extra run time fields to the e-mail message. Please note that {user-email} is the e-mail address of the Event Manager, not invited attendees. For the recipient's login-ID in the event notification, use the {login} field.

1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired folder.
3 Click the event.
4 Click the Email Options link at top of the Events tab. Do any of the following:
   • Select the check box to the left of the e-mail messages you want to send.
   • Deselect any e-mail messages you do not want to send.
   • Click Customize next to any messages that you want to edit. For example, you can change the name of the creator to the name of the host, or the time to Greenwich Mean Time.
5 Click Save to save your changes or Cancel to exit the e-mail form.
6 Click Send Test Email to preview the email before it is sent to the intended recipients.

Edit the mailing list
You can add and delete users, groups, and guests from the mailing list.

Note: Each time you create an event, the system creates a group named after the event and populates it with the invited users. This arrangement lets you easily invite the same people to a follow-up event. To invite the same people, select the group from the previous event in the Users And Groups list.

1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired folder.
3 Click the event.
4 Click Participant Management.
5 Edit users or guests:
   • Click Add Guest and type or paste in e-mail addresses for all your invitees; use commas to separate the addresses.
   • Click Add User/Group and, in the Available Users And Groups list, select each user and/or group that you want to invite.
   • Click Registration Groups and, in the Possible Groups list, select each group you want to invite. (You must be an account administrator to select event registration groups.)
   • Click Import/Export List and then click Browse to navigate to a comma-separated value (CSV) file.
   • Click Edit/Send Invitations to customize and send the event invitation. (You can edit the invitation, but do not change any of the items in curly brackets ({}) in the message body.)

Note: You may choose to add any of the extra run time fields to the e-mail message. Please note that {user-email} is the e-mail address of the Event Manager, not invited attendees. For the recipient’s login-ID in the event notification, use the {login} field.

Tips for creating event mailing lists
Keep in mind the following, when you create mailing lists:
   • A guest is an Adobe Connect user with limited access. Guests can attend only those events for which they are approved. Also, guests cannot log in to Adobe Connect Central.
   • Anyone with an Adobe Connect account in your organization is a user.

Note: Before sending out invitations, check with your Adobe Connect Central administrator for licensing issues. If more people register for the event than you have licenses for, attendees may not be able to join the event when they try to log in.

If the number of guests you are planning to invite is limited, you can type or copy and paste their e-mail addresses using the Add Guest function. If this number is high, you can import a comma-separated values (CSV) file of users.
If you are inviting Adobe Connect users, you can use the Select Participants page to add users to the event invitation list and assign them permissions.

After you create the list, you can send out the invitations using default text or a customized invitation.

More Help topics
“Add event participants using a CSV file” on page 144
“Best practices for events” on page 124

Add and manage event participants
You can add or remove participants for an event and change participant or presenter permissions if you are an administrator or presenter. You can add participants to an event at any time after creating an event. Participants can be added as guests, users, or groups.

More Help topics
“Change an existing event” on page 136
“View information about an event” on page 148

Add guests
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired event and select it.
3 In the Event Information page, click Participant Management in the navigation bar.
4 Click Add Guest.
5 In the box, type or paste the e-mail addresses of the people you want to invite. (Separate e-mail addresses with commas.)
6 When you finish, click Save.

Add participants
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired event and select it.
3 In the Event Information page, click Participant Management in the navigation bar.
4 Click Add User/Group.
5 In the Available Users And Groups list, select a user or group and click Add. You can also click Search to find a user or group that is not listed.

As you add users and groups, the Current Participants list on the right is updated to reflect your changes.

Note: Each time you create an event, the system creates a group named after the event and populates it with the invited users. This arrangement lets you easily invite the same people to a follow-up event. To invite the same people, select the group from the previous event in the Users And Groups list.
6 When you finish, click OK.

Remove participants from an event
1 Click the Event Management tab in Adobe Connect Central.
2 Navigate to the desired event and select it.
3 In the Event Information page, click Participant Management in the navigation bar.
4 Select the groups or users that you want to delete from the participants list.
5 Click Remove.

*Note:* Participants that are removed from the event do not receive an invitation and cannot join the event unless event access is changed to Anyone.

**Change permissions of event participants**

Users can opt out of receiving event invitation emails. For such users, instead of permission in Participant Management you see an opted out status. Event Hosts or Event Managers cannot change the permissions for the users who have opted out.

1 Select the Event Management tab in Adobe Connect Central.
2 Navigate to the desired event and select it.
3 In the Event Information page, click the Participant Management link in the navigation bar.
4 In the Users And Groups list, select the user or group whose permission you want to change.
5 Click Set User Role. From the pop-up menu, select the new permission type to assign. The permission types are: Denied, Invited, Pending Approval, Participant, Presenter, and Host. (Presenter and Host are available only if the event is a meeting or seminar.) If you are the administrator, you can provide special access to specific users or groups to perform detailed event-related configuration tasks. These tasks include editing group membership, configuring event analytics, creating campaign IDs, and managing event tags and email aliases.

**Designate a group for approved event registrants**

You can designate a group that event registrants are automatically assigned to when they are approved for the event. This arrangement is useful when you conduct a follow-up event because you have the registered attendees organized into one group.

*Note:* Only account administrators can select event registration groups.

1 Select the Event Management tab in Adobe Connect Central.
2 Navigate to the desired event and select it.
3 In the Event Information page, click the Participant Management link in the navigation bar.
4 Click Registration Groups.
5 In the Possible Groups list, select a group and click Add. The selected group name appears in the Current Group Membership list.

**Convert guests to full users**

If you are an Administrator, you can convert existing guests to full users. This distinction can be important because only full users, not guests, can log in to the Adobe Connect Central administration site. Full users also appear on enrollment and permission lists.

1 Select the Administration tab in Adobe Connect Central.
2 Select Users And Groups.
3 Select Manage Guests.
4 In the Current Guests list, select a guest.
Click Convert To User.

Conversely, if you wanted to change a full user into a guest, you would select a user in the Current Users list and then click Convert to Guest.

### Add event participants using a CSV file

If you have a comma-separated values (CSV) file that contains names and e-mail addresses, you can import the file to add participants to an event. Keep in mind these requirements, when you import a CSV file:

- Empty lines in the file are not allowed. If the CSV file contains empty lines, the import operation fails.
- Names that contain a comma must be in quotes. For example, the name John Doe, Jr., must appear in the CSV file as “John Doe, Jr.” for the file to import correctly.
- Do not include a header row in the CSV file.
- At minimum, the CSV file must contain columns for first name, last name, and e-mail address. For example:

<table>
<thead>
<tr>
<th>Name</th>
<th>First Name</th>
<th>Last Name</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Michael</td>
<td>Betts</td>
<td></td>
<td><a href="mailto:mbetts@mycompany.com">mbetts@mycompany.com</a></td>
</tr>
<tr>
<td>Rachel</td>
<td>Blatt</td>
<td></td>
<td><a href="mailto:rblatt@mycompany.com">rblatt@mycompany.com</a></td>
</tr>
<tr>
<td>Rebecca</td>
<td>Bloom</td>
<td></td>
<td><a href="mailto:rbloom@mycompany.com">rbloom@mycompany.com</a></td>
</tr>
<tr>
<td>Charles</td>
<td>Bond</td>
<td></td>
<td><a href="mailto:cbond@mycompany.com">cbond@mycompany.com</a></td>
</tr>
<tr>
<td>Paul</td>
<td>Davis</td>
<td></td>
<td><a href="mailto:pdavis@mycompany.com">pdavis@mycompany.com</a></td>
</tr>
</tbody>
</table>

**Note:** Guest users that were imported into a CSV file in Adobe Connect Enterprise 5.1 (Breeze 5.1) do not have first and last name columns, just one name column, so they are exported with the full name in the first name column and a blank in the last name column.

1. Click the Event Management tab in Adobe Connect Central.
2. Navigate to the desired event and select it.
3. In the Event Information page, click Participant Management in the navigation bar.
4. Click Import/Export List.
5. Click Browse, and navigate to the desired CSV file.
6. Click Upload.

**More Help topics**

“Change an existing event” on page 136

### Send event invitations

If you are an administrator, an event host, or a user with permissions to manage a specific Event library folder, you can send event invitations.

An event invitation is an e-mail message that is sent to event attendees, informing them of the date, time, duration, and URL of the event. The way that invitations are sent depends on the type of event:

**Invitees Only** If your event is for registered users only, you create a custom e-mail message in Adobe Connect Central. You can send the e-mail to all registered participants and presenters, presenters only, or participants only. You can customize the subject and message body. You also have the option to attach a Microsoft Outlook Calendar iCal so that participants can add the event to their Outlook Calendar.
Anyone  If your event is open to anyone who receives the event URL, you can create an e-mail message in your default e-mail program. This message contains a pre-populated subject and a pre-populated message (event date, time, duration, location, and summary), but you can edit the text.

1  Select the Event Management tab in Adobe Connect Central.
2  Navigate to the desired event and select it.
3  In the Event Information page, click the Participant Management link in the navigation bar.
4  Click Edit/Send Invitations in the navigation bar.
5  (Optional) If you want to send a blind copy of the invitation to anyone, add the e-mail address in the BCC Recipients box. This can be useful if, for example, you want coworkers to know that you sent the invitation.
6  Edit the subject and the message body.

If you edit the text, there are several fields in curly brackets ({}). In general, do not change any of the fields, unless you have a specific reason. The curly brackets contain variables that the system replaces with actual values that are specific to your event.

Note: If you choose to add any of the extra run time fields to the e-mail message, please note that {user-email} is the e-mail address of the Event Manager, not invited attendees. For the recipient’s login-ID in the event notification, use the {login} field.

7  To attach an iCal, select the check box next to the Attach Microsoft Outlook Calendar Event (iCal) To E-mail Message option.
8  Click Send.

More Help topics
“Change an existing event” on page 136
“Preview and modify registration and event pages” on page 133

Opt out from event invitations
Event Administrators can edit an event template to provide an option for invitees to opt out of all event invitations in the future.

To provide this option, add the runtime field Invitations Opt Out URL to a template. The invite contains a link to opt out. Upon clicking it, the users get a confirmation email with a link to opt out.

Event Administrators can download the opt out report to check the status of each participant.
Add the opt out option to a template
To add the option for users to opt out from future event invitations, follow these steps:

1. Log into Adobe Connect Central and access Event Management > Email Templates page.
2. Select the relevant event invitation template and click Edit template.
3. Insert a Text component from the AEM Sidekick and add the Invitations Opt Out URL runtime field.

Download the opt out report
To download the opt out report, follow these steps:

1. Log into Adobe Connect Central and access Event Management > Event Administration > Email Opt Out page.
2. Click Download Opt Out Report and save the CSV file locally.

Note: The users who opt in after opting out, are not listed in the CSV report.

Facilitate opt in
To facilitate opt in for the interested users, follow these steps:

1. Log into Adobe Connect Central and access Event Management > Event Administration > Email Opt Out page.
2. Copy the Opt-in link from Event Invitations Opt-in Link For Your Account section.
3. Share the link with the users who want to opt in to receive event invitations again.

Use campaign tracking with an event
Use the campaign tracking option to track registered users based on campaign source. The Events registration and attendance reports list campaign sources alongside user names. Common campaigns include e-mail offerings, search engine campaigns, and banner ad campaigns.

By default, the Enable Campaign Tracking option is selected on the Campaign IDs page when you create an event. You can select the campaign tracking option after you publish the event and send invitations. In this case, invitees who already registered using the registration URL in your original e-mail invitation are not tracked.
Note: To track a campaign, modify the registration URL for the event. You can’t change the registration URL for the Event Listings page and the Event Information page. If you want to use the Event Listing page or the Event Information page, you cannot track a campaign.

More Help topics
“Creating an event” on page 131
“Change an existing event” on page 136
“Preview and modify registration and event pages” on page 133

Manage Campaign IDs
Event creators can add Campaign IDs to their events, when creating or editing their events. They can reuse existing Campaign IDs, from a unique tab.

Event Administrators create Campaign IDs that can be used across all events. To create a Campaign ID, follow these steps:
1. Navigate to Events Management > Event Administration > Campaign IDs.
2. Click Create.
3. Enter the Campaign ID and an alias. Optionally, add comments to describe the Campaign ID.
4. Click Save.

Add campaign tracking to an existing event
1. Open Adobe Connect Central and click the Event Management tab.
2. Open an event. Click Campaign IDs.
3. Specify the Campaign ID in the Campaign Id for E-mails field.
4. Optionally, select Campaign IDs and click Get URLs, to generate the associated Event Page URLs for existing campaign IDs created by an Event Administrator.
5. Click Save.

The Campaign ID automatically appears in the email templates that you use to send email notifications for the event.

Add a campaign ID to the event URLs
Once the campaign tracking is enabled, Adobe Connect tracks the origin of participants using the campaign ID. Adobe Connect adds the specified campaign ID to the automatically generated invitation email. If you share the event URL via other channels, generate and use the URL containing the Campaign IDs. Follow are the steps below to create a URL with the campaign ID.
1. Open Adobe Connect Central. Click Event Management.
2. Open the event and click Campaign IDs.
3. Select one or more campaign IDs and click Get URLs. Event Administrators create the campaign IDs.
4. Copy the Event Page URLs for offline usage.
**Test the URL with campaign tracking ID**
To test the new URL, you disable e-mail invitations, publish the event, register for the event, and then check the registration report.

1. Open Adobe Connect Central and click the Event Management tab.
2. Select the event to display the Event Information page.
3. Select E-mail Options.
4. Deselect the Send Event Invitations option.
5. Click Save.
6. At the bottom of the Event Information page, the status message reads, “This event has not been published and listed on your site. Emails have not been sent.” Click Publish.
7. A confirmation message appears. Click Publish again. The Event page displays and the status message now reads, “This event has been published. E-mail options are active.”
8. To test your modified registration URL, register for the event. Open a web browser in a new window.
9. In the word-processing application, copy the modified registration URL (with the campaign ID parameter and custom campaign ID added). Paste the URL into the new web browser window and press Enter or Return.
10. In the registration form, fill out the required fields using your name and e-mail address.
11. Click Submit.
12. Check your e-mail program for an event confirmation message.
13. Now that you have registered for the event, you can see your name and the campaign tracking ID in the registration reports. Open Adobe Connect Central and click the Event Management tab.
14. Select the event to display the Event Information page.
15. Select Reports.
17. In Registration Report, click Download Report Data. In the Excel spreadsheet that opens, check that the correct ID number appears in the Campaign Tracking ID column next to your name.

**Cancel events**
You can cancel an event that you previously created and send participants an email informing them about the cancelation. Only event hosts can cancel an event.

1. Open Adobe Connect Central and click the Event Management tab.
2. Select the event to cancel from the list of events and click Cancel.
3. Click the Send Email link to send the cancelation email to participants.

**Managing events**

**View information about an event**
You can view various types of information about an event from the Adobe Connect Central application. Administrators, event hosts, and a user with permissions to manage an Event library folder can view event information.
**More Help topics**

“Change an existing event” on page 136

“Add and manage event participants” on page 142

**View a participants list**

1. In Adobe Connect Central, click the Event Management tab.
2. Navigate to the folder that contains the desired event and select it.
3. In the Event Information page, click the Participant Management link.

The names of registered participants and groups appear.

**View an uploaded content list**

You can view a list of content that is uploaded to Adobe Connect Server. An administrator, an event host, or a user with permissions to manage a specific Event library folder can view the content list.

1. In Adobe Connect Central, click the Event Management tab.
2. Navigate to the folder that contains the desired event and select it.
3. Click the Select Content link.

A list of all uploaded content appears.

**Viewing data about events**

The Event Dashboard provides a graphical representation of statistical data related to your events. To view the Dashboard, click the Event Dashboard link under the tab bar, at the top of the Event window.

The data reflects the events in your My Events folder. The data appears in one-bar graph showing the most active events over the last six months (determined by the number of sessions). You can click any individual event in the graph to view more detailed information about the event.

**Viewing status of emails for an event**

Event Managers can track the status of emails sent for an Event against all email triggers. The option is available in the E-mail Options tab under an event.
E-mail options to track email status

1. Log into Adobe Connect Central and access Event Management > My Events page.
2. Click on the name of the event for which you want to check the email status.
3. Click on the E-mail Options tab and click Download Email Report.
4. The fields listed in the downloaded CSV report are Type, Recipients, Email Subject, Email Trigger, Email Template, Date Scheduled, Date Completed, and Status.

The status has one of the following values and reasons:

**Blocked**: Unpublished/Cancelled When an event is not yet published or when a published event is cancelled.

**Queued** The emails are queued to be sent.

**Sent** Successfully sent the emails.

**Opted out of email invitations** Users can opt out of receiving event invitations. This status against a user indicates this scenario.

**Bounced/Error** If for some reason an email cannot be sent, for example, in case of an erroneous email address.

**Event Catalog**

To improve event discovery, Adobe Connect automatically generates a master Event Catalog listing all the events published to the catalog. The Events Catalog can be embedded in any website using the embed code from the settings. It is also possible to create multiple folder-level event catalogs for folders in the Event Management tab. The Event Catalog provides a list view and a date view for event listing.

An Event Catalog lists all the upcoming events for an Adobe Connect account on a single page. You can also edit the list of events and change the order of events in the catalog. Events can be filtered based on tags and featured events can be highlighted in a carousel.
Access the Event Catalog
You can view a list of events that appear as a catalog on your organization’s website when you publish the events. You can also edit the list and change the order of events in the list.

1 In Adobe Connect Central, click the Event Management tab.
2 Click Event Catalog.
3 Do one of the following:
   • Click View to view the Event Catalog.
   • Click Edit to edit the Event Catalog.

If you applied the Featured Events tag to an event when you created the event, it appears in the Featured Events section. A carousel in the Featured Events section displays the large banner of each featured event.

View pre-filtered Event Catalog
To highlight a specific category of events, you can share the URL of the Event Catalog pre-filtered using a particular tag. You can construct this URL using the ID of the tag.

1 In Adobe Connect Central, click the Event Management tab.
2 Click Event Catalog.
3 Open this URL in a browser. Click a tag from the Popular tags section.
4 The URL ends in a numeric value that is the ID of the tag. Copy it from the browser's address bar.
5 To the URL copied in step 3, append `#currentSearchTag=<ID of the tag>`. You can now share this constructed URL. By visiting this URL, the readers can view only the events of the specific category.

*Note:* Only the Event Administrators can apply the Featured Events tag to an event.

Set Event Catalog branding
The Event Administrators can customize the layout and branding of the Event Catalog. To customize the Event Catalog:

1 In Adobe Connect Central, click the Event Management tab.
2 Choose Event Catalog, and then click Edit.
3 Edit the template in the design view.

Event administration
Event Administrators manage Adobe Connect events for their entire organization. Event Administrators manage permissions for individual users and groups, set permissions for Event Managers, and create additional Event Administrators and Event Managers. They are also responsible for managing group memberships for users, event tags, email aliases, analytics administration, the Event Catalog, and shared templates. Event Administrators can highlight any event as a featured event.

Editing group membership
Event Administrators can add or remove members from the Event Managers group. They can use Editing Group Membership option to assign the Event Manager role to a group or a person.
To add or remove members from groups:

1. In Adobe Connect Central, click the Event Management tab.
2. Choose Event Administration > Edit Group Membership.
3. Do one of the following:
   - From Possible Group Members, select a member and click Add. The member is added to the current Event Managers group.
   - From Current Group Members, select a member and click Remove. The member is removed from the current Event Managers group.

**Enabling analytics**
Adobe Connect Central provides event reports using a web application. If you have an Adobe SiteCatalyst account, you can also access event data in your Adobe SiteCatalyst account.

To enable analytics:

1. In Adobe Connect Central, click the Event Management tab.
2. Choose Event Administration > Analytics Administration.
3. To access event reports only from the Adobe web application, select Basic Reports.
4. If you have an Adobe SiteCatalyst account, provide your credentials and click Save.
5. If necessary, Account Administrators can enable opt out for the Account. The option to 'Enable opt out for participants' is available when creating an event. For more details, see “Configure Engagement Tracking” on page 214.

   If this option is enabled, Adobe Connect excludes engagement index and private chat message count when reporting event meeting information to event hosts.

After you enable analytics, reporting database is synchronized periodically. It may take up to a day for you to view event reports.

**Managing event tags**
Tags enable users to filter events on your organization’s website or other websites where you publish the event. If you apply the Featured Events tag to an event, it appears in the Featured Events section of the Event Catalog.

To add tags to an event:

1. In Adobe Connect Central, click the Event Management tab.
2. Choose Event Administration > Manage Event Tags.
3. Select a tag from the list.

   You can add a tag to the list. You can also delete an existing tag from the list or modify the tag.

**Managing email aliases**
Adobe Connect Central lets you configure email aliases to which event registrants can send email queries. In addition, you can send responses from the alias.

To add an event alias:

1. In Adobe Connect Central, click the Event Management tab.
2. Choose Event Administration > Manage Email Aliases.
3 Select an email alias from the list.
You can add an email alias to the list. You can also delete an existing email alias from the list or modify the alias.

**Managing Campaign IDs**
Event Administrators can create campaign IDs that can be used across the organization. Use of consistent campaign IDs add uniformity and ease of use to campaign tracking. To know more about Campaign mapping and ID management, see “Manage Campaign IDs” on page 147.

**Configuring the format of the User Information Report**
Event creators can access the event report provided out of the box and also the custom reports titled user information report. Event Administrators can create New Export Template and define the data that appears in an exported CSV file.

**Creating an export format**
1 In Adobe Connect, click on Event Management > Event Administration > Export Wizard.
2 Click New Export Template.
3 Provide a name for the template. This name is displayed in the Format pop-up menu, in the User Information Report section.
4 (Optionally) Click the checkbox Don’t include header row in the report, if you do not want any header row in the exported spreadsheet report.
5 Select the information that you want the report to contain in Choose a Field pop up menu.
6 Specify a customized name for the selected field in Custom Label name for field.
7 To ensure that every cell in the exported spreadsheet has some value in it and is not blank, specify a default value in Prefill field with default value. If no information is available for a cell, the specified default value is inserted.
8 To add more rows, click Add More. When finished click Create.

**Editing an existing export report**
1 In Adobe Connect, click on Event Management > Event Administration > Export Wizard.
2 Select a template to edit by clicking its checkbox. Click Edit.
3 Add more columns to the report by clicking Add More and defining the values of new rows.
4 Remove report columns by resetting the value in Choose a Field column to the empty entry.
5 Making any other required changes in other fields and click Save.

**Delete an existing export report**
1 In Adobe Connect, click on Event Management > Event Administration > Export Wizard.
2 Select one or more templates to delete by clicking their checkbox. Click Delete.
3 Click OK to confirm deletion.

**Change the default export report**
1 In Adobe Connect, click on Event Management > Event Administration > Export Wizard.
2 Select a template by clicking its checkbox. Click Set Default.
Managing Shared Templates
Event Administrators have considerable flexibility in designing pages, catalog, and emails for an event. Before they create an event, a template to address the requirements is required. Adobe Connect supports shared and private templates. An Event Manager can create only private templates and an Event Administrator can create only shared templates. Event Administrators can create shared templates to address the various requirements of your organization. Also, only Event Administrators can edit such templates. Typically, shared templates are created to ensure consistency and branding for all your organization’s communications.

More Help topics
“Create and modify templates and the Event Catalog” on page 125

Event reports
Adobe Connect sends tracking data to Adobe SiteCatalyst for reporting purposes. Adobe Connect uses Adobe SiteCatalyst reporting tools to provide event reports based on this data. The reports display event statistics from different perspectives.

You can access event reports using the Adobe web application. If you have an Adobe SiteCatalyst account, you can access event data in your account in addition to the reports using the Adobe web application.

An event host, administrator, or a user with permissions to manage a specific event library folder configures event reports.

More Help topics
“About Adobe Connect Central reports” on page 247

Opt out from tracking
Enable opt out to provide an option to the participants to opt out from providing non-explicitly submitted information to hosts. When participants choose to opt out, Adobe Connect excludes engagement index and private chat message count when reporting meeting information to hosts. Adobe Connect continues to report generic event-related information.

Opt out option, if provided by hosts, is available for participants of Adobe Connect meetings, virtual classrooms, seminars, and events. However, if a meeting, a virtual classrooms, or a seminar room is associated with an Event, the opt out settings of the Event take precedence.

If the opt out option is enabled, Adobe Connect indicates so in each report tab. Only Account Administrators can enable opt out. To know more about enabling the opt out functionality, see “Enabling analytics” on page 152. Also, see “Configure Engagement Tracking” on page 214 for more details.

View Event Reports
1 Log in to Adobe Connect Central.
2 Click the Event Management tab.
3 From the list of events, select the event for which you want to view reports. The Event Information tab is displayed.
4 Click the Reports tab. The Summary tab is displayed.

The Summary tab displays the following:

Event Information Provides information such as, event name, brief description of the event, start time, and end time.
Aggregate User Data Aggregate registration data for event participants. The report includes the following information:

- **Invited** The number of people invited to the event.
- **Registered** The number of people who completed the registration form and were approved by the event host.
- **Pending** The number of people waiting to be approved to attend the event.
- **Approved** The number of people approved to attend the event. This number includes people who completed the registration form and were approved. It also includes people who are approved directly, such as event presenters, and do not need to register.
- **Denied** The number of people who completed the registration form but were denied registration. For example, registration can be denied if the registration URL is made public on a website or through e-mail and people register for the event by mistake.
- **Attended** The number of people who attended the event.

User Information Report Select the required format of the report from the pop-up menu and click Download Report Data to download a CSV file. The report provides comprehensive information about the event, while respecting the filtering and sorting applied on the online reports.

The default report, Adobe_Standard, contains the information that is displayed in the online report. The file includes aggregate information that is tracked from the start of registration until the end of the event. The file includes information on whether a particular registered or invited participant attended the event. For attendees, the file contains information such as login name, campaign IDs, answers to registration questions, and answers to questions during the event. The file also includes information on qualified leads based on the criteria set in Set Qualified Lead section.

For more information on customizing these CSV reports, see “Configuring the format of the User Information Report” on page 153.

Conversion Funnel User activity data from the time a user views the event page until the user completes attending the event. This report identifies qualified leads based on the criteria set in the Set Lead Criteria section under the Registration tab. A qualified lead may be a potential customer based on pertinent information the user provides while registering or during the event.

Conversion funnel allows you to gauge promotion effectiveness and identify qualified leads

5 Click the Registration tab to view reports pertaining to event registration.
The Registration tab displays the following:

Set Qualified Lead  Lets you specify the criteria to identify Qualified leads. For example, time spent by attendees in the event, answers to registration questions, and answers to poll questions.

User Information Report  Click Download Report Data to download a CSV file that provides comprehensive information about the event. The file includes aggregate information that is tracked from the start of registration until the end of the event. The file includes information on whether a particular registered or invited participant attended the event. For attendees, the file contains information such login name, campaign IDs, and answers to questions provided by them during the event. In addition, the file contains information on the requirements to be analyzed by the host. The file also includes information on qualified leads based on the criteria set in Set Qualified Lead section.

Campaign Report  You can gauge the success of different campaign promotions for your event with the Campaign Report. It lists the aggregate information of the various campaigns (for example, social media and email campaigns) that you conducted to publicize an event. It details the number of participants who visited the information and registration pages along with a count of the participants who registered and logged in to the events for all the campaign IDs. The report also shows the number of people who logged in to the event and the number of qualified leads, for each campaign tracking ID you used. To enable this report, select Enable Campaign Tracking while creating or editing an event.
**Registration Questions**  The Registration Questions Report shows the count of responses to an event’s registration questions. This report can be helpful in determining dropout rates on specific questions.

<table>
<thead>
<tr>
<th>Registration Questions</th>
<th>Count of responses to registration questions for the event.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you used ...</td>
<td>250</td>
</tr>
<tr>
<td>Within how much...</td>
<td>200</td>
</tr>
<tr>
<td>Varify Password*</td>
<td>250</td>
</tr>
<tr>
<td>Password*</td>
<td>500</td>
</tr>
<tr>
<td>Last Name*</td>
<td>500</td>
</tr>
<tr>
<td>First Name*</td>
<td>500</td>
</tr>
<tr>
<td>Email Id*</td>
<td>500</td>
</tr>
</tbody>
</table>

*Registration Questions report shows the count of responses for various registration questions*

6. Click the By Answers tab to view the distribution of answers to registration questions. In other words, use this tab to view the number of answers provided for each question.

7. Click the Content tab to view reports pertaining to event content.

   The Content tab displays the following:

**Engagement Report**  The Engagement Report uses information directly from the Engagement Meter for an event, showing how the engagement and attendance levels varied during that event. As you move the pointer over the report, you can see the specific numbers at any given time during a meeting.

*Engagement report indicates the overall engagement of participants*
Chat and Q&A Usage  The bar charts in this report provide a quick and easy way to see the total number of chat messages and Q&A for a given event. For example, it shows the total chat messages, the number of public messages, and the number of private messages exchanged.

This report also displays data such as total questions asked during the event and number of questions answered. Use this data to calculate the number of unanswered questions. This report does not include the count for the users who choose to opt out of analytics tracking.

Chat and Q&A Usage report

File Download Activity  If a file is made available for download during an event, the count of participant downloads is indicated in this report. For each resource downloaded, displays the number of people who downloaded the resource. Also displays the number of attendees for the event.

File Download Activity shows the resources downloaded during an event

Poll Activity  Similar to the Chat and Q&A Usage reports above, this report provides an at-a-glance view of poll activity, namely the number of respondents to each poll question and poll attendance.
Poll Activity shows the count of poll responses

**Attendee Status Usage** Pie chart that displays information on status changes that occurred during the event. For each status, displays the number people who changed their status to the particular status during the event.

**Start and End Times Report** Use this report to see exactly when participants enter and leave an event.

**Data stored by Adobe Connect**

Adobe Connect and Adobe SiteCatalyst captures and processes host, participant, and event data, to generate the various reports and provide detailed analytics. Adobe Connect also displays individual engagement level in the Attendees pod, in the meeting.

Following is the list of the various participant and event details stored.

- The following activities of an individual are captured:
  - Poll responses
  - Q&A activity
  - Login time
  - Event registration answers
  - Files downloaded
  - Event login
  - Campaign ID with which registration form was accesses
- The following activities in a meeting are captured, without capturing the participant identity:
  - Meeting per minute Engagement
• Meeting per minute Attendance
• Meeting total Chat count
• Meeting Attendee status change count
• The following event registration activities are captured:
  • Individual Registration page answers
  • Registration complete
  • Campaign ID used with the registration form
• The following data in a course or a curriculum is captured:
  • Interactions answered in courses (question data)
  • Overall tracking data like, Score, Status, Time, Location, and Quiz data
  • Number of attempts
  • Time spent consuming the content
  • Date and time when a course is undertaken
  • Curriculum ID, if a course is launched from a curriculum

**Attending Adobe Connect Events**

Attending an Adobe Connect event is similar to attending an Adobe Connect meeting, seminar, or training session. The main difference is that attendees must register before joining an event.

**Registering for and joining events**

Adobe Connect events require registration, though not all registrations require an approval. You can register for and join an event in the following ways:

• If an event host invites you by providing your email, you receive an email containing links to the various Event Pages. Register and login using these links. If configured, you can also register and join using your Facebook or Google+ login.

• To allow for simplified event registration, you can create events that do not require a password. Non-registered users can attend such events using just their email address. Users who are already registered on your Adobe Connect server, must enter their user name and password to attend an event. To enable this feature, select the Register Without Password option when creating an event. It helps non-registered, guest users log in easily by entering their email address.

• If required, a join button can be introduced in the template of registration email confirmation message by an Event Administrator. After a user registers for an Event, they receive an email with a link to attend the Event. The link is associated with a join button. Instead of the entire personalized link the registrant sees a the personalized join button. The button auto-populates the login name with the email ID when attempting to attend the Event.

• If the event is listed on a public website (typically when it is open to the website visitors), you click the registration link to access the registration form. To register, provide the requisite information. You can also use your social login (Facebook or Google+), if hosts provide the option.

*Note: The option to use social profiles to register and log in is available only on hosted offering of Adobe Connect and not on the on-premise deployments.*
Then, depending on the way the event was created, you may receive a notification e-mail that provides your status (pending, approved, or denied) and a link to join the event. The link can be personalized to auto-populate the attendees login name with the email ID when attempting to attend the Event. Besides the link, the email can also contain dial-in telephone number and participant code that you use to phone in, if appropriate.

In addition, e-mail invitation may contain a calendar invite in an iCal format. You can add it in your e-mail client or organizers that support iCal format.

- If you are an Adobe Connect user and the event was created in the same Adobe Connect account as yours, the event also appears in Adobe Connect Central. Join it from your Adobe Connect calendar. For more information, see “Enter a scheduled event from Adobe Connect Central” on page 162.
Opting out from engagement tracking

When participants opt out of engagement tracking, Adobe Connect does not provide non-explicitly submitted information to event hosts. Engagement index and private chat message count are excluded when reporting event meeting information.

The participants can opt out during registration. Participants can opt out only after joining an Adobe Connect session (a meeting, a virtual classroom, a seminar, or an event). The opt out option is available in the in-meeting notifier, in the top right corner of the meeting room.

Enter a scheduled event from Adobe Connect Central

If you are an Adobe Connect user, an event is created in the same Adobe Connect account as yours, and you register for the event, the link to join the event also appears in Adobe Connect Central. To join such an event:

1. Log in to Adobe Connect account. On the Home tab, click My Calendar.
2. In the calendar, navigate to the date of the event and click on the date.
3. Under Details, locate the event you want to enter and click Open.

If you have not registered yet or need approval, you may need to log in, enter your password, and complete the registration form.
Chapter 5: Audio and video conferencing

Audio in meetings

Audio conferencing options
Adobe Connect supports the following solutions for adding audio to meetings and training sessions. Contact your administrator to find out which audio conferencing options are available for your account.

Built-in VoIP
Adobe Connect broadcasts audio in meetings or training sessions using VoIP and the microphones on attendees’ computer systems. See “Audio in meetings” on page 163.

Universal voice audio providers
Universal voice audio providers enable Adobe Connect to broadcast all telephone-based audio into an Adobe Connect meeting room over VoIP. Both account administrators and hosts can configure audio conferencing providers for universal voice. See “Using universal voice” on page 166.

Integrated telephony adaptors without universal voice
These adaptors, which are extensions to Adobe Connect written in Java, provide communication between Adobe Connect and specific audio conferencing providers. Integrated adaptors have advanced call capabilities, allowing hosts to control the audio conference from the meeting. Adobe provides several integrated telephony adaptors for hosted installations. For example, MeetingOne, Arkadin, PGi, and InterCall are integrated telephony adaptors. Integrated adaptors in licensed installations can also be configured for universal voice. See “Using integrated adaptors” on page 164.

The following table compares the universal voice and integrated telephony solutions.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Universal Voice Audio Provider</th>
<th>Integrated Telephony Adaptor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast audio in Adobe Connect over VoIP</td>
<td>Yes</td>
<td>Yes, if enabled for universal voice</td>
</tr>
<tr>
<td>Enhanced call control. For example, mute, hold, and so on.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Record audio with Adobe Connect Meeting</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Requires Flash Media Gateway (bundled with the Adobe Connect installer)</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

More Help topics
“Creating and arranging meetings” on page 13
“Starting and attending meetings” on page 18
“Edit meeting information” on page 27
“Creating training curriculums” on page 84
“Creating virtual classrooms” on page 96
Using integrated adaptors

Include attendees in an audio conference call
Hosts have several options for dialing out to include participants in an audio conference call. You can dial out to a registered participant by using the telephone number stored in their profile or by entering a new telephone number. To include an unregistered participant in the audio conference call only, you can enter a new name and number to dial.

More Help topics
“Audio conferencing options” on page 163
“Creating and arranging meetings” on page 13
“Starting and attending meetings” on page 18
“Creating training curriculums” on page 84
“Creating virtual classrooms” on page 96

About audio conference status
After attendees connect to an audio conference, status icons appear next to their names.

*Note:* Status icons do not appear for user-configured audio providers.

<table>
<thead>
<tr>
<th>Attendee status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the phone</td>
<td>📞</td>
</tr>
<tr>
<td>Talking</td>
<td>📞</td>
</tr>
<tr>
<td>Dialing in progress</td>
<td>📞</td>
</tr>
<tr>
<td>On hold</td>
<td>📞</td>
</tr>
<tr>
<td>Muted</td>
<td>📞</td>
</tr>
</tbody>
</table>

*Note:* Some audio conference providers do not support the On Hold feature.

More Help topics
“Audio conferencing options” on page 163
“Enable microphone for participants using computers” on page 170

Create and use audio profiles
An audio profile is a collection of audio conference settings that map to an audio provider. You use audio profiles whenever you use an audio provider with Adobe Connect Meeting. Audio providers are companies that offer audio conferencing services that work with Adobe Connect. For more information about audio providers, see “Audio conferencing options” on page 163.
Create an audio profile

All audio profiles include the audio provider and profile name. The remaining information includes numbers and access codes that hosts provide for meetings. The text boxes that appear for entering this information depend on the provider. For integrated providers, the requested information comes from their configuration code. For universal voice providers, the requested information comes from host-defined steps in the dialing sequence. See “Define a dialing sequence” on page 220.

Note: You can ensure that the audio conference settings and other profile information successfully start an audio conference. Run the test on the Enter Provider Information page (Administration > Audio Providers or My Profile > My Audio Providers, select a provider, and click Edit). See “Test a dialing sequence” on page 222.

Meeting hosts, limited administrators, and administrators can create audio profiles.

1. In Adobe Connect Central, click My Profile > My Audio Profiles.
2. Click New Profile.
3. Select an audio provider and name the profile.
   - **Provider** Audio providers configured for universal voice by an account administrator or host. Selecting a provider binds the audio profile to the information configured for the provider.
   - **Profile Name** A unique name that represents something meaningful to you, such as the purpose of the audio profile.
     
     If the account administrator or host included a URL for the provider, it appears in the Profile Information window. This URL can link to an information page with details on how to create the audio profile.
4. Fill in the remaining information and click Save. Saving the profile automatically enables it for use. You can change the sequence of the local conference numbers in the Profile Information.

   ![New Audio Profile window with provider-specific fields](image)

   To enable or disable an existing audio profile, select it in My Audio Profiles, click Edit, change the Profile Status menu, and click Save.

5. For Arkadin audio provider, enter the SIP access number, if provided by Arkadin. If the SIP access number is not provided, duplicate the value in the Toll free access number, from the SIP access number field.

Edit or delete an audio profile

You can change the profile name, and enable or disable an existing audio profile. You cannot change the audio provider. You specify a provider only when you create a profile.

1. In Adobe Connect, click My Profile > My Audio Profiles.
2 Select a profile and click Edit.
3 Change the profile name or status and click Save.
4 To delete an audio profile, select it and click Delete.

**Associate an audio profile with a meeting**
When you associate an audio profile with a meeting, you include the audio conferencing settings defined for the audio provider.

1 Do one of the following:
   • Create a meeting and enter the required information (click Meetings > New Meeting).
   • Open an existing meeting and click the Edit Information tab.
2 In the Audio Conference Settings section, select Include This Audio Conference With This Meeting. Select the profile from the menu and click Save.
   All the profiles you created appear in the menu.

*Note: If you change the audio profile once you start the meeting, the new conference settings take place only after you end and restart the meeting. Wait for a few minutes to see the changes. The changes are immediate when you change the audio profile from the Audio Conference Preferences dialog from within a meeting.*

<table>
<thead>
<tr>
<th>Audio Conference Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ Do not include any audio conference with this meeting.</td>
</tr>
<tr>
<td>○ Include this audio conference with this meeting.</td>
</tr>
<tr>
<td>(Please note that audio conference setting changes would be effective for next meeting sessions only.)</td>
</tr>
<tr>
<td>○ Include other audio conference with this meeting.</td>
</tr>
<tr>
<td>Conference Number(s):</td>
</tr>
<tr>
<td>Moderator Code:</td>
</tr>
<tr>
<td>Participant Code:</td>
</tr>
</tbody>
</table>

Selecting an audio profile for a meeting

**Using universal voice**
The universal voice solution enables you to conduct a live audio conference with meeting participants over VoIP. Participants hear any telephone-based audio through their computer speakers and can broadcast their voices either via telephone or computer microphone. Hosts can record the audio conference with Adobe Connect Meeting.

**Configure a universal voice audio provider (administrators/hosts)**
Administrators configure audio providers for all users of an account. Users can configure audio providers for their personal use in audio conferences.
1. Add or edit an audio provider.
You can configure virtually any audio provider to use universal voice functionality, as long as an account exists with the provider. The first step is to set up identification details, including the name of the provider and telephone numbers for dialing into the meeting. See “Create or edit audio providers” on page 219.

2. Add a dialing sequence.
For hosted accounts, the Adobe Connect server uses the dialing sequence to join the audio conference, when the host joins the meeting. In this step, you set up the conference number, DTMF tones, and pauses for dialing into an audio conference. See “Define a dialing sequence” on page 220.

3. Test the dialing sequence.
To verify that the dialing sequence works as expected, you can execute the steps, including the user-defined steps, and then adjust the dialing sequence accordingly. See “Test a dialing sequence” on page 222.

Create and use an audio profile (administrators/hosts)

1. Create an audio profile.
For any audio provider in your account, you can create one or more audio profiles for setting up audio conferences. See “Create and use audio profiles” on page 164.

2. Create a meeting and select an audio profile.
You create a meeting using the Meeting wizard, but instead of entering audio conference settings manually, you select one of your audio profiles. These audio profiles contain the conference settings for the audio provider. See “Associate an audio profile with a meeting” on page 166.

Start an audio conference (hosts)

1. Enter the meeting room.
Hosts start the meeting, and participants receive an invitation by email or instant message to join the meeting. See “Join a meeting” on page 22.

2. Start the audio conference.
From the meeting room, hosts start the audio conference so that Adobe Connect can join the conference. See “Start meeting audio” on page 168.

Meeting hosts can configure an audio profile to automatically start with the meeting. Hosts do not have to manually start the audio profile. For more information, see “Change Audio Conference Settings from within a meeting” on page 173.

3. (Optional) Record the audio conference.
Hosts can record telephone-based audio along with the web conference. The audio is played back with the audio conference. See “Record a meeting” on page 178.
Best practices for starting a universal voice conference

If a host starts an audio conference, as a moderator and then leaves the meeting room, the conference ends for all participants. However, if a host starts the audio conference as a participant and then leaves the meeting room, the audio conference continues for the remaining participants. Depending on your audio provider, you may need a moderator code or a leader pin number to start an audio conference.

To avoid ending the audio conference if you leave the meeting room, do the following:

1. Create an audio profile that uses a participant code to start the audio conference. See “Create and use audio profiles” on page 164.
   For user-configured providers, make sure that the dialing sequence includes a participant text box. This text box appears when you create an audio profile based on that provider.

2. Enter the Adobe Connect Meeting room, and start the audio conference.

3. Use a telephone to dial into the meeting.

More Help topics
“Audio conferencing options” on page 163
“Define a dialing sequence” on page 220
“Join audio conference” on page 169

Enable audio in meetings

Start meeting audio
Audio for a meeting is not enabled by default. Meeting hosts can configure an audio conference to auto-start when the meeting is first launched. Depending on the configuration, the audio conference starts with or without prompting the user. If these settings are changed during a meeting, the changes are effective from the next launch of the meeting.

To start an audio conference and set its preferences, do the following:

1. Navigate to the Meeting Information page for a specific meeting.

2. Click Enter Meeting Room.
3 From the Audio menu, choose one of the following:

**Microphone Rights for Participants**  This option appears if there is no audio profile attached to the meeting. Choose this option to enable audio conference using VoIP.

**Start Meeting Audio**  This option appears if an audio profile is attached to the meeting.

4 Specify how you want the attendees to join the meeting's audio conference. You can specify one or more of the following. The availability of the options depends on the meeting’s audio and system configuration.

To access the various audio conference preferences, click Audio > Audio Conference Settings. For more information, see “Change Audio Conference Settings from within a meeting” on page 173.

**Note:** If Universal Voice is configured, you can select both options. Participants can join the audio conference either using their computer’s microphones, or join the meeting using their phone. Start broadcasting to enable participants to hear any telephone-based audio through the computer speakers and broadcast their voices to telephone users using the microphone. When you stop broadcasting, VoIP users are audible to phone users, but phone users are not audible to the meeting users.

5 Click Start.

Once meeting audio has been started, attendees join the audio conference.

**Join audio conference**

After a host starts an audio conference, depending on the settings for audio conference, a notification window may appear to all attendees. The following options are possible:

- Dial in and dial out information is presented to attendees.
- The audio conference preset by the host starts.
- Additionally, hosts see the dialog to start audio conference and to configure the Audio Conference settings in the Preferences.

After choosing the appropriate option if necessary, attendees can then broadcast their voices via their telephones or computer microphones.

**Join audio conference from in-meeting Audio menu**  You can join an audio conference from the pop-up menu items, using the following steps:

1 To connect to conference audio, click the telephone button in the main menu bar.

2 In the Join Audio Conference dialog box, select one of the following:

   - **Dial-out**  Receive a call from the meeting on the telephone number you enter.
   - **Dial-In**  Dial in using the number and instructions provided in the text box.

   If a dial-in token is provided, hosts can mute specific attendees. Without a dial-in token, hosts must first merge attendees with the related phone number in the Attendees pod. (See “Merge two listings for the same caller in a conference call” on page 171.)

   If audio is broadcasted in a meeting, meeting users are given an option to Listen Only, in the pop-up dialog box. When you click Listen Only, you are passively placed in the audio conference. For more information, see “Change Audio Conference Settings from within a meeting” on page 173.

   - **Using Microphone (Computer/Device)**  To connect using your computer microphone and speakers. (See “Broadcast your voice using VoIP” on page 170.)

**Join the audio conference started by default**  Hosts can configure an audio conference to automatically start when attendees join a meeting.
Manage audio within meetings

Enable audio for participants using computers
By default, only hosts and presenters can use their microphones for audio. However, hosts can enable participants to broadcast by doing any of the following:

- To enable audio for all participants, choose Audio > Microphone Rights For Participants. icon displays for all participants in the Attendees pod.
- To enable audio for specific participants, select one or more in the Attendees pod. Then choose any of the following from the pop-up menu: Enable Audio, Make Host, or Make Presenter. icon displays next to the participant in the Attendees pod.

Using the same pop-up menu, hosts can later disable audio for specific attendees, reducing background noise.

Allow only one speaker to use the microphone at a time
Hosts can avoid overlapping conversations by doing the following:

- Choose Audio > Enable Single Speaker Mode.

An asterisk appears next to the microphone button in the main menu bar. When one speaker clicks the button, it’s disabled for other users until the current speaker clicks the button again. This option is available only when using VoIP for audio and the option is not available when using a combination of VoIP and telephony for audio.

Enable Lecture Mode (MeetingOne only)
In MeetingOne audio conferences, you can enable Lecture mode. In the Lecture Mode, only the MeetingOne host and Adobe Connect hosts and presenters can speak. All other attendees in the meeting are unable to transmit audio as they are muted or their microphone rights are suspended.

- Choose Audio > Enable Lecture Mode.

Broadcast your voice using VoIP
1. In the main menu bar, click the microphone button .

As you speak, sound waves appear in the button icon, indicating audio level.

2. (Optional) To the right of the microphone button, click the menu button and choose Adjust Mic Volume if you are too loud or quiet. Or choose Mute My Mic to temporarily stop broadcasting (for a cough or other interruption).

You can select which microphone to use for audio, if you have more than one microphone connected. Click Audio, click Select Microphone, and choose from the displayed list of microphones.

When an attendee is speaking, the microphone icon is displayed next to their name in the Attendees pod. If configured from the Attendees pod menu, the names of active speakers are displayed in the pod.
Adjust or mute audio volume

Each attendee can customize audio volume on their system.

❖ In the main menu bar, select any of the following from the speaker menu:

  Mute My Speakers  Entirely disables or enables audio. (Click the speaker icon to quickly toggle this option.)
  Mute Conference Audio Only  Retains any audio playing in the Share and Video Telephony pods.
  Adjust Speaker Volume  Displays a slider attendees drag to customize volume.

Call out to a new telephone user

1. Choose Audio > Call a New User.
2. Enter the participant’s name, select country, and enter the telephone number.
3. Select Call to dial the participant’s phone number immediately.

The attendee is called on the phone and the Call in Progress icon is displayed to the right of the attendee’s name.

Call out to a participant logged in to Adobe Connect

1. In the Attendees pod, select the name of the participant to add to the audio conference.
2. From the pod menu, click Attendee Options > Call Selected User.

The Call Telephone User dialog box appears. You can enter an appropriate phone number in the box.
3. Click Call.

Merge two listings for the same caller in a conference call

If attendees dial into an audio conference without a token, they appear twice in the Attendees list. The attendees appear once with their name and for the second time with their masked phone number. Hosts can merge the listings into one.

1. In the Attendees pod, do one of the following:
   • Drag a number and drop it on the name of the participant.
   • Select a participant name and the number and choose Merge from the menu.
   • Select a participant name and the number and from the pod menu, select Merge Users.
2. Click the confirmation button. To hide this button in the future, check Don’t Ask Again.

Note: For audio conference features to function in your meeting or training session, enable the conference adapter.

Stop or pause audio broadcast

You can either stop or pause audio broadcast in an Adobe Connect session. Stopping audio broadcast, not only stops the audio integration but also breaks the UV line. The Pause Audio Broadcast option pauses the audio broadcast without breaking the UV line. When audio broadcast is stopped, participants joining via telephone can continue to talk, while other participants cannot hear them. However, when audio broadcast is paused, participants connected via telephone line can hear the participants connected via VoIP but the participants using VoIP cannot hear those using a telephone line.
Using Adobe Connect 9

Audio and video conferencing

A. Pause audio option in Audio pop up menu  B. Notifier indicating paused audio

These options support various scenarios where hosts want to handle audio broadcast during meetings in a specific way. For example, during longer meeting breaks, hosts may want to stop broadcasting audio or participants on telephone bridge can have a discussion without other participants hearing it.

1. Choose Audio > Stop Audio Broadcast or Audio > Pause Audio Broadcast.
2. To resume the audio broadcast, choose Audio > Start Audio Broadcast.

Note: Hosts can stop a broadcast for all attendees, but not for a specific participant.

Stop an audio conference or change audio mode

Do one of the following.

- Choose Audio > Stop Meeting Audio.
- Choose Audio > Change Meeting Audio Mode.

See “Best practices for starting a universal voice conference” on page 168 to avoid ending a conference when hosts leave.

Adjust audio quality

Quickly optimize settings with the Audio Setup wizard

1. Select Meeting > Audio Setup wizard.
2. Follow the onscreen instructions to optimize audio quality. If a dialog box appears requesting access to your camera and microphone, click Allow.

Set advanced audio options

1. Choose Meeting > Preferences and click Microphone in the left pane.
2. Select Use Enhanced Audio to automatically cancel echoes, control microphone volume, and suppress noise. Deselect this option if you experience any issues with the audio quality.
3. Select Automatic Gain Control to enable your microphone volume to adjust automatically in response to changes in voice level. Deselect this option if audio volume fluctuates unpredictably.
4. For Acoustic Echo Cancellation Mode, select one of the following:
**Note:** Install the Adobe Connect add-in to use these options.

**Full Duplex** Enables multiple users to speak at one time. If echo feedback results, select another option (this option is preferred for most systems).

**Half Duplex** Enables only one user to speak at a time. Use this option if microphones on your system are unusually sensitive (transmitting unwanted background sound) or if you have poor echo cancelation.

**Headphones** Optimizes audio settings for use with headphones. This option uses Full-Duplex mode, in which multiple users can speak at one time.

5 For Audio Quality, choose the setting that does not degrade sound:

**Fast** Provides the fastest performance but the lowest audio quality. (Use this option for systems with slower CPUs.)

**Best** Provides the slowest performance but the best audio quality. (Use this option for systems with faster CPUs.)

**Custom** Enables you to select options for audio quality settings. Use this option if the standard settings do not provide adequate results. Choose from the following options:

- For Echo Path, select 128 (the default setting) or 256. The higher setting provides greater suppression of audio feedback. This setting uses more CPU resources and is recommended for systems that do not use headphones.
- Select Noise Suppression (selected by default) to reduce the amount of noise that the microphone picks up. Deselect this option to make the microphone more sensitive.
- Select Non Linear Processing (selected by default) to use non-linear processing for audio data. Deselect the option to use standard processing (and fewer CPU resources).

6 Select Use Speex Codec in this meeting room, to take advantage of this VOIP-optimized technology. Attendees can use this option from within the browser. Options range from Fast for fastest performance and poorest quality, to Best for slowest performance and best quality.

**Change associated audio profile from within a meeting**

Hosts can change the associated audio profile from within a meeting room.

1 Click Audio > Stop Meeting Audio, if the meeting audio is already started.

2 Do one of the following:

   - Click Audio > Audio Conference Settings.
   - Click Meeting > Preferences > Audio Conference.

3 Change the Audio Profile Settings from the pop-up list.

   **Note:** You can also modify your audio profiles by clicking Manage Audio Profiles link.

4 You can also modify other Audio Conference Settings

   **Note:** The changes to audio conference take effect only after the meeting is relaunched.

**Change Audio Conference Settings from within a meeting**

Hosts can change the various audio settings used in a meeting room, from within the room.

1 Click Audio > Stop Meeting Audio, if the meeting audio is already started.

2 Click Meeting > Preferences > Audio Conference.

3 You can set the default settings for audio conference:

   - Select Using Microphone (Computer/Device) for your audio.
Audio and video conferencing

- Select Allow participants to use Microphones to allow all the participants in the meeting to participate in the verbal discussion.
- Select Using Phone to use a telephone to attend the audio conference.
- If your audio profile permits using both, microphone and a telephone, simultaneously, the option Broadcast Telephony audio is displayed and is selected by default. If you use both options, Broadcast Telephony audio option remains selected.
- Select Provide Dial-in details to participants, to display dial-in options to participants when the audio conference starts.
- Select Provide Dial-out option to participants, to display the dial-out field, where participants can provide their telephone number to accept calls from the meeting.
- Select the checkbox Start Audio Conference automatically with this meeting, to start audio conference when a meeting starts.
- Select the checkbox Show Start Audio Conference dialog when meeting starts, to prompt to start the audio conference when the meeting starts.

Video in meetings

Note: Adobe Connect administrators can change pod, audio, and video settings to adhere to standards for governance. For more information, see "Working with compliance and control settings" on page 211.

Connect to video telephony streams

The Video Telephony pod lets hosts share video streams with attendees, including any audio. When one-way communication is sufficient for a presentation, a telephony stream can be preferable to a two-way conference.

1 Choose Pods > Video Telephony.
2 Click Open Stream.
3 From the pop-up menu, choose the appropriate device.
   Your Adobe Connect administrator establishes the list of available devices. (See “Configure video telephony devices” on page 222.)
4 Click Connect.

The Video Telephony pod appears for all attendees. When attendees hover the mouse over the pod, a volume control appears for stream audio.
To display volume control, hover the mouse over Video Telephony pod.

5 In the upper right of the pod, hosts can click Pause Stream or pod menu to access Close Stream, Change Stream, or Mute Audio options.

Enable participants to share webcam video

By default, only hosts and presenters can broadcast video. However, hosts can enable participants to broadcast by doing any of the following:

- To enable video for all participants, click the menu button to the right of the microphone button, and choose Enable Video for Participants.
- To enable video for specific participants, select one or more in the Attendees pod. Then choose any of the following from the pop-up menu: Enable Video, Make Host, or Make Presenter.

Share webcam video

Hosts, presenters, and participants with enhanced rights can simultaneously share video from webcams connected to their computers.

You can select the webcam feed to broadcast if you have multiple webcams working. If a user changes the selection or a connected webcam is unplugged, the change happens in real time. Also, Adobe Connect remembers this setting, irrespective of the Adobe Flash Player settings on the local machine.

About video layouts

To display the video feeds in a meeting, Filmstrip and Grid layouts are available. In Filmstrip layout, the main video occupies most of the Video pod area and the rest of the videos appear as smaller feeds within a filmstrip. Hosts, Presenters, and participants with enhanced video rights can set a video feed as the primary video from among all the video feeds.

In Full Screen mode, the Title bar is not visible and only the video feeds are displayed. Hover the pointer at the upper edge of the full screen video to access the menu options and the Exit Full Screen button.
Filmstrip mode allows participants to focus on one speaker

When a meeting host switches to Filmstrip layout, the Host’s video is the main video. A host can mark any video as the main video. If any feed is hidden from the strip, a scroll icon is available at the end. Any user can scroll the strip on either sides to see other available feeds. Scrolling the feed does not impact the display of other users.

<table>
<thead>
<tr>
<th>Layout</th>
<th>Aspect ratio on Windows</th>
<th>Aspect ratio on Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>User defined</td>
<td>Widescreen (16:9) with pillar boxing</td>
</tr>
<tr>
<td>Filmstrip</td>
<td>User defined</td>
<td>Widescreen displayed in 4:3 ratio</td>
</tr>
</tbody>
</table>

When using Filmstrip mode, Adobe Connect typically consumes less bandwidth and processor, as compared to, the Grid Mode. This provides a better meeting experience for all the attendees.

**Share your video**

1. Click the Start My Webcam button in the main menu bar or Video pod.

In the Video pod, a preview image appears so you can adjust camera position. If you want to use a different connected camera, select it from the Video pod menu.

   To cancel video sharing, click outside the preview image in the Video pod.

2. Click Start Sharing to broadcast your video to all participants.

3. To pause or stop video, hover the mouse over Video pod, and click the Pause or Stop icons.

When video is paused, the last image broadcast from your camera remains static in the Video pod until you click Play to resume broadcasting. When video is stopped, the broadcast image disappears entirely.

   Hosts can pause or stop video from any attendee.
Audio and video conferencing

Webcam video in Video pod and the available controls

A. Stop sharing the webcam
B. Hosts can switch to the Grid layout when multiple webcams are being used
C. Hosts can switch to the Filmstrip layout when multiple webcams are being used
D. Make the Video pod full screen.
E. Menu icon to access all options of the Video pod
F. Close video (appears when a meeting host or a meeting presenter hovers pointer over the video)
G. Pause video (appears when anyone hovers pointer over the video)

To optimize bandwidth consumption, share your video using the Adobe Connect addin. A persistent notifier to use the addin is displayed. For details about addin, see “Sharing a computer screen, document, or whiteboard” on page 33.

Notification to use addin for video sharing

Settings to share webcam video

You can access various options either directly from the Video pod menu by accessing Video pod preferences.

- In Filmstrip mode, to set a video as the main video, hover pointer over the video and click Set as Main Video.
- You can maximize the Video pod within the meeting room. Click the icon, and click Maximize.
- You can select a particular webcam to use in your meetings from the Video pod. Click the menu icon, and from the Select Camera option, choose one of the attached webcams.
- Hosts can select either the Filmstrip or the Grid layout. Alternatively, click or icon in the title bar of the Video pod.
- You can make the Video pod Full Screen. In Full Screen mode, the Title bar is not visible. Hover the pointer at the upper edge of the full screen video to access the menu options and the Exit Full Screen button. Alternatively, hit escape key to turn off the full screen mode.

Note: Full Screen mode is different from the Maximize option. When the former option is used, a Video pod occupies the entire screen, whereas when the latter is used, the Video pod occupies the entire meeting room.

- Hosts and Presenters can enforce their view settings for all the attendees, by clicking Force Presenter View.

Note: Force Presenter View option in the Video pod is not available in Break Out rooms.

- In the Preferences, select Disable Webcam Preview to disable preview when you start your webcam and start sharing the video.
• In the Preferences, select Highlight Active Speakers to visually highlight the video of the speaker who is speaking at the moment. Multiple videos are highlighted, if multiple participants are speaking simultaneously.
• You can choose the aspect ratio from the two available options—Standard (4:3) and Wide Screen (16:9). These changes are applicable to all the participants sharing their webcam.

Recording and playing back meetings

About recording meetings
A host can record a meeting or training session. When played back, the recording shows exactly what the attendees saw and heard. Everything that happens in the room is recorded, except for the Presenter Only area and breakout rooms. You can start and stop recording at any time, so you decide what content to record. A host can create a reference archive of meetings and make the recordings available to attendees.

When you record a meeting, consider the following:
• If you use VoIP and the Video pod to broadcast audio to meeting attendees, all audio is recorded automatically.
• If you use the universal voice solution, you record the audio with the meeting. All telephone-based audio is recorded, and can be played back with the audio conference.
• If you do not use universal voice, you can use your speakerphone and your computer microphone as recording devices. All audio input to your computer is captured and recorded but is not broadcast to participants. (Because audio is not directly integrated with the meeting in this case, the quality can be lower than using a direct method.)
• If you use an integrated telephony adaptor, begin your recording from within Adobe Connect, not from a telephone key command.
• The meeting recording is assigned a URL and added to the Recordings page associated with the meeting room in Adobe Connect Central. To play a recording, you need an Internet connection, the recording URL, and permission to view it.

Note: Adobe Connect administrators can change recording settings to adhere to standards for governance. These settings affect how meetings and training sessions are recorded and what is recorded. For more information, see “Working with compliance and control settings” on page 211.

More Help topics
“Edit a recorded meeting” on page 180
“Create an offline recording” on page 181

Record a meeting

Start recording a meeting
1 If you have associated a universal voice audio profile with the meeting, choose Audio > Join Audio Conference.
2 Choose Meeting > Record Meeting.
3 In the Record Meeting dialog box, enter a name and summary for the meeting recording.
   A recording icon (red circle) appears in the menu bar to indicate that the meeting is being recorded.
   You can pause an ongoing recording. Anything you do in the live meeting during the time you pause the recording is not recorded.
Audio and video conferencing

A. Pause audio option in Audio pop up menu  B. Notifier indicating paused audio

Note: If a problem occurs during the recording, an error message appears in the upper-right corner of the window. You can try to reconnect to the conference audio, record the meeting without audio, or stop recording the meeting.

Stop recording a meeting
❖ From the Meeting menu, deselect Record Meeting.

The meeting recording is saved and is available for playback at any time.

About editing meeting recordings

After recording a meeting or training session, you can use the built-in editor to remove sections of the recording. The editor is useful if the recording contains periods of silence or unnecessary information. Following are some tips for editing recordings:

• To edit a meeting or virtual classroom recording in the Content library, you must have Manage or higher permissions for the recording. If you created the meeting or virtual classroom, you have these rights by default.

• To edit a recording under Meeting > Recordings or Training > Recordings, you must have Host permissions. You can create an index using time tags to enable participants to easily view and navigate through the recording. You can also edit/delete the existing auto-generated time tags.

In addition, you can also create sections within a recording using chapter markers. You can hide the names of participant interacting over chat and retain the content of these interactions.

• The last edited version of the recording is saved and includes all information from earlier editing sessions. The link to your recording does not change after editing. Users given the link and rights to access the recording see the most recent version saved, including any edits that were made.

• Multiple users can open a recording in edit mode at the same time. However, after one user saves their changes, others editing at the same time receive an error when they try to save their changes.

Note: Adobe Connect administrators can change recording settings to adhere to standards for governance. These settings affect how meetings and training sessions are recorded and what is recorded. For more information, see “Working with compliance and control settings” on page 211.
**More Help topics**

“Record a meeting” on page 178

“Create an offline recording” on page 181

“Working with content in the Content library” on page 190

**Edit a recorded meeting**

Editing a recording is useful if the recording contains sections of silence or unnecessary information that you want to remove before making the recording available.

1. From the Adobe Connect Central home page, click Meetings or Training, and then click the meeting or classroom that includes the recording.

2. Click Recordings.

3. Click Edit Recording in the Actions pop-up menu, next to the recording that you want to edit.

4. Simply click the Play button to watch the recording from the beginning, or first drag the progress marker to a specific location.

5. Use the selection markers to specify the areas of the recording you want to remove, and click the Cut button.

6. (Optional) At the left of the meeting window, click the triangle to show the Events Index pane, where you can “Navigate to specific events in recordings” on page 183.

7. (Optional) To remove changes, click Undo to remove individual edits made you last saved, or Revert to Original to restore the recording to its original state.

8. Remove any additional sections. When you have finished, click Save.

*Note: Adobe Connect administrators can change recording settings to adhere to standards for governance. These settings affect how meetings and training sessions are recorded and what is recorded. For more information, see “Working with compliance and control settings” on page 211.*

**More Help topics**

“Record a meeting” on page 178

“Create an offline recording” on page 181

“Working with content in the Content library” on page 190

**Convert meeting recording to MP4 format**

You can convert the recordings of your meetings, virtual classrooms, and seminars to MP4 format.

In the Recordings tab of an individual meeting, besides the Edit, Make offline, and View Original options, there is an added option 'Make MP4'. You can download the MP4 recording, can play it on mobile devices, and configure the Access Type feature on MP4 recordings. Conversion to MP4 format is a server-side activity and when you click Make MP4, the recording gets queued for server-side generation of MP4.
Prerequisites to creating MP4 recordings are:

- Adobe Connect hosted account.
- Purchase the license to create MP4 recordings.
- Enable the Make MP4 option to be visible in the Recordings tab. Adobe Connect administrators can do so from Compliance and Control settings.
- Add user in the Meeting Hosts group (or Seminar Administrators group for a seminar). User must have access to a meeting, a virtual classroom, or a seminar. If you are not the owners of a meeting, take access to the meeting and its recordings.

Note: Resolution of a recording is 1024 x 768, irrespective of the webcam resolution or the size of the meeting window.

Post-conversion the MP4 recordings is uploaded back into the meeting, in the Recordings tab. Meeting Hosts and Seminar Administrators can access it using the URL or download it for offline usage.

More Help topics
“Customize compliance and control settings” on page 211
“Access MP4 conversion queue” on page 223

Create an offline recording

If you want people who do not have access to an Adobe Connect server to view a meeting recording, create an offline version. The offline recording is saved as an FLV file, which can be viewed in FLV playback, and distributed via email, CD, or a server.

Note: Creating an offline recording takes approximately the same amount of time as the duration of the original meeting recording.

You can minimize the offline recording window or view other windows on top of it without interfering with the contents of your recording.

1 From the Adobe Connect Central home page, click Meetings or Training, and then click the meeting or classroom that includes the recording.
2 Click Recordings.
3 Next to the specific recording you want to use, click Make Offline.
4 If Help text appears, click Proceed with Offline Recording. Then specify a location for the finished FLV file.

The meeting begins playing, creating the offline file.

5 As needed, click the Pause/Resume, Stop And Save, and Start New controls:
   - The Pause/Resume button temporarily stops the offline recording. This functionality can be useful if you must download a large file and do not want to strain system resources. When you click Resume, the recording continues from where it was paused. The finished recording is one continuous file regardless of how many times you paused and resumed recording.
   - The Stop and Save button ends the creation of a recording, which is useful if you want to record portions of a meeting as separate files. Click Start New to resume recording where you left off.

6 When the recording process finishes, close the offline recorder window. (If the window is minimized, it closes automatically.)
**Note:** Adobe Connect administrators can change recording settings to adhere to standards for governance. These settings affect how meetings and training sessions are recorded and what is recorded. For more information, see “Working with compliance and control settings” on page 211.

**More Help topics**
“Record a meeting” on page 178
“Edit a recorded meeting” on page 180
“Working with content in the Content library” on page 190

**Play back a recorded meeting**

A host or presenter makes the recording URL available so attendees can play the recording. Every recording is automatically assigned a unique URL and is stored on the Recordings tab for the meeting room in Adobe Connect Central.

When you play a recording, a recording navigation bar appears in a space below the meeting room. For optimal performance, a high-speed Internet connection is recommended for recording playback.

You control who has access to the recording:

- Any user invited to the meeting using the invitees or enrollee tabs in Adobe Connect Central can view the recording if given the recording URL.
- Hosts can view information, such as permissions, if they have rights to browse to the Adobe Connect Central folder where the recording is stored.
- Anyone with Internet access can view the recording if you make it public. Alternatively, you can move the recording to the Content library and set specific user permissions (moving the recording to the Content library is irreversible.)

**Note:** Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

**More Help topics**
“Record a meeting” on page 178
“Working with content in the Content library” on page 190

**Play a recording from Adobe Connect Central (hosts and presenters)**

1. From the Adobe Connect Central home page, click Meetings or Training, and then click the meeting or classroom that includes the recording.
2. Click the Recordings option.
3. Click the name of the recording.
4. Do one of the following:
   - To view the last edited version of the recording, click the URL For Viewing.
To view the full, original, unedited version of the recording, click View Original. You either view the original version of the recording or the latest edited version; multiple edited versions of the recording are not saved. (If the recording was never edited, the URL For Viewing is the same as View Original.)

**Play a recording from a URL (attendees)**

Hosts and presenters most often tell attendees about a recording by sending an email message containing a URL link to the recording.

- Click the recording URL that the presenter sent to you.

The recording opens in your browser and is ready for playback. If you are unable to open the recording, check if you have the permission to access the recording.

**Navigate to specific events in recordings**

For each meeting recording, a new indexed event is created for every chat message, layout change, slide change, and camera start or stop. Each event is listed in an Events Index, along with a timestamp. You can filter and browse the index to quickly navigate to specific events.

1. At the left of the window for the recorded meeting, click the triangle to show the Events Index pane.

2. Do either of the following:
   - Click the Filter pop-up menu to select specific events to view. You can show all events, a single event, event types, or any combination of events that can be indexed. Events that can be filtered include layout changes, chat messages, slide changes, and users joining or leaving the Attendees or Video pod.
   - Search for specific events: type keywords into the search box and click Find. All events that contain a match appear highlighted. You can look for names of meeting participants, text in all Notes pods, text in all Chat pods, and text on meeting slides.

**More Help topics**

“Edit a recorded meeting” on page 180
Managing recorded meetings

You can view all recordings made for a particular meeting, change permissions, rename, or move a recording, or view a content report for a recording. Also, a recorded meeting can be used as content for another meeting. (If a recording has been edited, edits are preserved if the recording is moved to the Content library.)

**Note:** Adobe Connect administrators can change pod, sharing, and other settings to adhere to standards for governance. These settings affect the layout of meeting rooms and what you can do in meeting rooms. For more information, see “Working with compliance and control settings” on page 211.

More Help topics

“Record a meeting” on page 178

“Working with content in the Content library” on page 190

View a list of recorded meetings

If you are an administrator or have Manage permissions for a meeting folder, you can view the recordings that have been created from a meeting room.

1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Recordings link on the navigation bar.

Move recordings to the Content library

An administrator or a user with permissions to manage a specific Meetings library folder can move meeting recordings from the folder to the Content library.

Moving a meeting recording to the Content library is useful if you want to give access to people other than the original invitees.

**Note:** To make a recording available to anyone in the world that is given the recording URL, see “Play back a recorded meeting” on page 182.

1. Click the Meetings tab at the top of the Adobe Connect Central home page.
2. Navigate to the meeting that has recordings you want to move.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Recordings link on the navigation bar.
5 Select the check box to the left of any recording that you want to move.
6 Click Move To Folder on the navigation bar.
7 Navigate to the folder in the Content library where you want to move the recording. (As you navigate, the new destination appears in the upper right of the Adobe Connect Central window.)
8 Click Move.

Edit recording information
1 From the Adobe Connect Central home page, click Meetings or Training. Then click the meeting or classroom that includes the recording.
2 Click the Recordings option.
3 Click the name of the recording.
4 In the Recording Information bar, click Edit.
5 Revise the title, summary, and language as desired.
6 To update any items linked to the recording with the revised information, select Update Information For Any Items Linked To This Item.

Delete a meeting recording
Only an administrator or a user with permissions to manage that specific Meetings library folder can delete a meeting recording.

If you delete a meeting room, you can retain the associated meeting recordings. You are prompted to move all the recordings to your My Content section. You can choose to not move the recordings and delete them along with the meeting room.

---

**You have selected the following item(s) to delete:**

![Amit's Meeting*](image)

* - This item has other items linked to it. If you delete this item, then the links that point to this item will also be broken. Please verify that this is what you want to do before proceeding.

To permanently delete the item(s) listed above, click on the "Delete" button. Deleting a folder will permanently delete all of the items within it, and may break links that are associated with these items.

- Move associated recordings (if any) to content folder.

---

**Prompt to save recordings while deleting a meeting room**

1 Click the Meetings tab at the top of the Adobe Connect Central home page.
2 Navigate to the meeting that has recordings you want to delete.
3 Click the meeting name in the list.
4 In the Meeting Information page, click the Recordings link on the navigation bar.
5 On the Recordings page, select the check box to the left of any recording you want to delete.
6 Click Delete above the list.

Last updated 3/20/2015
7 Click Delete on the confirmation page.

Adobe Connect Webcast

Adobe Connect Webcast is designed to support one-to-many and few-to-many communication with large, dispersed audiences. These events can be conducted for marketing programs, internal and external communication initiatives, and continuing education applications. Each event can be customized based on the feature and branding requirements of the event host or sponsor.

The Adobe Connect Webcast interface provides access to the live event, including audio or video streaming and presentation content. Access to the webcast is typically provided through a registration URL. Registered attendees have access to the live event and on-demand replay (which remains associated with the same URL as the live event). Typical webcasts can include the following attendee features:

- Submit question box
- Refer a friend hyperlinks
- Additional content download options
- Poll questions and surveys
- Option to participate by conference call

Audio and video communication is typically one way in Adobe Connect Webcast. Hosts and moderators present audio or video content to the audience. The question submission and polling features enable attendees to provide feedback on the event content. These events also provide robust reporting capabilities to webcast hosts to indicate attendee engagement, and whether any questions submitted during an event require follow-up.

Each webcast can have a different appearance, depending on the nature of the event and the customer’s needs. To access an Adobe Connect Webcast, attendees must have Adobe Flash Player 10 or higher, a browser, and Internet connectivity.

For more information, see www.adobe.com/go/learn_on24_webcast_en.
Chapter 6: Managing content

Adobe Connect Central has four libraries: Content, Training, Meetings, and Event Management. The Content library holds content that you use in meeting rooms and virtual classrooms. Content includes presentations, SWF files, image files, audio files, video files, and so on. The Training library holds Curriculums, Courses, and Virtual Classrooms. The Meetings library contains meeting rooms. The Event Management library holds events.

Working with library files and folders

Administrator, limited administrators, and users with Manage permissions can create and navigate folder hierarchies in libraries. Use these hierarchies to organize content in the libraries.

Administrators, limited administrators, and users with Manage permissions can also set permissions to determine what tasks each user can perform in the libraries. For example, a manager could set up a folder for each department and assign Manage permissions to each department chairperson.

More Help topics

“Libraries” on page 238

“Setting permissions for library files and folders” on page 237

Create a folder

Administrators, limited administrators, and users with manage permission for a specific folder can create subfolders within it.

Note: Administrators set permissions for limited administrators on the Administration > Users and Groups section of Adobe Connect Central. By default, limited administrators can set permissions for content, but an administrator could choose to revoke this ability.

1 Click Content, Training, Meetings, or Event Management at the top of the Adobe Connect Central window.

Note: No one can create a folder in the Seminars library.

2 Navigate to the location where you want to add the new folder.

3 Click New Folder on the menu bar above the folder list.

4 Enter the name of the new folder on the new page that appears.

5 (Optional) In Summary, enter information about the new folder.

6 Click Save to create the folder.

More Help topics

“Delete a file or folder” on page 189

“Edit file or folder information” on page 189
Open a folder

1. Click Content, Training, Meetings, Seminar Room, or Event Management at the top of the Adobe Connect Central window.
2. Click the name of the folder.

The folders and files within that folder appear. The name of the selected directory appears in the navigation links at the top of the browser window.

More Help topics
“Delete a file or folder” on page 189
“Edit file or folder information” on page 189

Move a file or folder

You can move a folder or a file in a library. When you move a folder, all of the items within the folder also move to the new location. You can move folders and files in the Content, Training, Meetings, or Event Management libraries using the Move button. You can move folders and files in these libraries and in the Seminar Rooms libraries using the Up One Level button. In Seminar Rooms libraries, you can choose to move uploaded content or recordings that are saved with a seminar.

1. Click Content, Training, Meetings, Seminars, or Event Management at the top of the Adobe Connect Central window.
2. Navigate to the folder or file that you want to move.
3. Select the check box to the left of the item that you want to move. For a seminar, choose Uploaded Content or Recordings if you want to move either of those types of items saved with the seminar.
4. Do either of the following:
   - Click Up One Level to move the item up one level in the library folder directory.
   - Click Move (this option is not available for the Seminars tab). Select a folder in the folder directory tree, or click Up One Level. Click Move and then click OK to apply the change.

More Help topics
“Delete a file or folder” on page 189
“Edit file or folder information” on page 189

Move up a level in the folder hierarchy

❖ Click the Up One Level button on the navigation bar above the folder list.

The folders and files within the parent folder appear. The name and location of the parent folder appear in the navigation links list at the top of the browser window.

More Help topics
“Delete a file or folder” on page 189
“Edit file or folder information” on page 189
Return to a folder

Above the functional links is a list of navigation links called the navigation trail, which indicates your current location in the directory structure. You can move to any parent (higher) folder shown in the navigation trail.

❖ Click the name of a parent folder in the navigation trail.

The folders and files in the higher parent directory appear. The name and location of the parent folder appear in the navigation links at the top of the browser window.

More Help topics
“Move a file or folder” on page 188
“Edit file or folder information” on page 189

Delete a file or folder

When you delete a library folder or file, it is permanently removed from the library and cannot be retrieved. Be careful to delete only those items you do not need. If you delete items from the Content library that are linked to meetings, events, seminars, or courses, the deleted content is unavailable from them. When you delete an item, Adobe Connect Central indicates whether the item is linked and allows you to cancel the deletion. In Seminar Rooms libraries, you can choose to delete uploaded content or recordings that are saved with a seminar.

Note: For the Training library, if you delete a training folder containing a course that was part of a curriculum, the deleted course is still listed on the Curriculum information page as a course item. However, the course is no longer available.

1 Click Content, Training, Meetings, Seminars, or Event Management at the top of the Adobe Connect Central window.
2 Navigate to the folder or file.
3 Select the check box to the left of the item that you want to delete. For a seminar, choose Uploaded Content or Recordings if you want to delete either of those types of items saved with the seminar.
4 Click Delete on the menu bar above the content list.
5 Click Delete again to permanently delete the selected items, or click Cancel to cancel the deletion.

More Help topics
“Move a file or folder” on page 188

Edit file or folder information

You can edit the title or name of a library item and other information, using the Edit Information button.

Note: If you are editing a Seminar library folder, you can view information about the Seminar license for that folder to see how many users and meetings are available for a specific Seminar folder. In the navigation bar next to the Editor Information link, click License Info. Information that appears includes title, summary, start date, end date, number of concurrent users, and number of concurrent meetings.

1 Click the Content, Training, Meetings, Seminars, or Event Management tab at the top of the Adobe Connect Central window.
2 Navigate to the folder or file.
3 Click on the folder or file.
4. Click the Edit Information link in the navigation bar below the navigation trail.
5. Edit the title, name, or other properties that you want to change.
6. Click Save.

**More Help topics**
“Open a folder” on page 188
“Move a file or folder” on page 188

**Edit seminar folder names or descriptions**
1. Click the Seminars tab at the top of the Adobe Connect Central window.
2. Navigate to the folder and click its name.
3. Click the Edit Information link above the seminar list.
4. Enter a new name for the folder and, if desired, a description in the Summary text input box.
5. Click Save.

**More Help topics**
“Creating and managing seminars” on page 114

**Working with content in the Content library**

**Content library supported file types**
All content in the Content library must be one of the following types:

- A single PDF file
- A single PPT or PPTX file
- A single SWF file
- A single HTML file
- A single Adobe Captivate SWF file
- Adobe Captivate content published through the Adobe Captivate application
- Adobe Presenter content published through the Presenter plug-in
- Presenter content packaged as a ZIP file
- A ZIP file that contains multiple SWF files and extra files (images, XML files, and so on) and a file called index.swf that is loaded first
- A ZIP file that contains multiple HTM or HTML files and extra files (images, SWF files, and so on) and one file called index.htm or index.html
- A ZIP file that contains a single PDF file.
- An FLV file
- A single image (JPEG, GIF, or PNG)
- A single audio file (MP3)

Last updated 3/20/2015
• A single video file (MP4 or F4V)
• MP4 recording of meetings, virtual classrooms, and seminars that can be played on the supported mobile devices.

*Note:* You can also publish third-party SCORM content to the Content library. Filename for SCORM launch file or references can not contain '+' character or begin with a number.

**More Help topics**
“View content” on page 194

“View data about all content” on page 196

**Upload content**
Only members of the built-in Authors group with Publish permissions for a specific Content library folder can upload files to that folder.

You can upload new versions of content that exists in the Content library.

*Note:* If you have Adobe Presenter or Adobe Captivate installed, you can also use the Publish option within those applications to upload content to the Content library. You can also upload content from a Meeting room.

**More Help topics**
“View content” on page 194

“View data about all content” on page 196

**Upload files to the Content library**
1 In Adobe Connect Central, do either of the following:
  • On the Home tab, select Content from the Create New bar.
  • On the Content tab, click the New Content button.
2 Under Select Content File, click Browse to locate the file, click its name, and then click Open.
3 Enter a title for the new content file (required) and a summary (optional) in the Enter Content Information text boxes.
4 (Optional) Enter a custom URL (if you do not assign a custom URL, the system automatically assigns one).
5 (Optional) In Summary, enter information about the new content.
6 Click Save.

The file is uploaded to the server and appears in the content folder.

*Note:* If you attempt to upload a file of an unsupported file type, the Enter Content page reappears with the message “Invalid file format selected.”

**Upload a new version of a file to the Content library**
1 On the Home tab, click Content.
2 In the Content List, click the content file you want to update.
3 Click Upload Content.
4 Click Browse to locate a file in the format specified in the message, click the name of the file, and then click Open.
 Click Save.
The new version of the content is uploaded to the Content library. To check that the process was successful, find the file in the Content List and check the Date Modified. You can also go to the Content Information page, click the URL, and view the new version of the content.

**Uploading AICC content**
For Adobe Connect to track scores in quizzes and data, content must be AICC-compliant. To upload AICC content into the Content library, store the files in a ZIP archive and upload it from Adobe Connect Central. Do not upload the content from a meeting room.

Keep in mind the following when you create AICC content:
- The content package must have an index.htm or index.html file that the server relies on to launch the content.
- Content must report “Incomplete” on all communications until the user has finished interacting with the content.
- The content must be able to report either “complete” or “passed” to indicate that the user has finished interacting with the content.

**Download files from the Content library**
Users who have permission can download Content library files to their computers. If the content is composed of more than one file, it is packaged into a ZIP file.

1 Click the Content tab.
2 Navigate to the content file that you want to download.
3 Click the name of the content file.
4 Click the Download Content link on the navigation bar.

5 Under Download output file, click the content filename.
Users who have Manage permission can download a presentation to deploy it on the Internet or distribute it on a CD. You can download the presentation PPT source files or output files. To deploy a presentation, download the output files and extract them.
6 Save the file to your disk.
More Help topics
“View content” on page 194
“View data about all content” on page 196

Download presentation source files from the Content library
Downloading source files can be helpful if you no longer have your source files for an Adobe Presenter presentation. (It is critical that you do not overwrite the PPT filename extension with a PPC extension; if you do, the file can become unusable.)

Note: The only source files available for download are files that have been uploaded. For example, Adobe Presenter and Adobe Captivate give users the option to upload or not upload source files. If the option to upload source files is not selected, those files are not available for download later.

1 Click the Content tab.
2 Navigate to the presentation and click its name.
3 Click the Download Content link on the navigation bar.
4 In Download source files, click a file.
5 Save the file to your disk.
6 (Optional) In Download output files, click the zip file and save it to your disk.

More Help topics
“View content” on page 194
“View data about all content” on page 196

Creating custom URLs
When you add a piece of content, a new meeting, a new course or curriculum, a new seminar, or a new event, you can create a custom URL for the content. This URL is unique across the entire Adobe Connect account and identifies the content.

A.
B.

A custom URL can be used with one piece of content at a time. For example, if you assign the custom URL /yourname to a piece of content, you cannot assign that URL to another piece of content or to a meeting, nor can any other user who shares your account assign that URL to anything. If you delete the content that uses the custom URL, the custom URL becomes available for reuse.

If another user is currently using the custom URL, you receive an error message when you enter the URL. If you want to, you can check with your administrator to see who is using the URL.
Custom URL rules:

- You cannot edit a custom URL after you create it.
- You cannot use digits (0 - 9) at the beginning of a custom URL.
- After the first character, the other characters can be alpha-numeric, an underscore, or a hyphen.
- The URL can have maximum of 60 characters, including the two forward slashes (/) before and after the URL.
- If you enter any uppercase letters, they are automatically converted to lowercase letters to conform to URL case sensitivity conventions.
- Do not use any of the following reserved keywords in your custom URL:

<table>
<thead>
<tr>
<th>account</th>
<th>content</th>
<th>idle</th>
<th>report</th>
</tr>
</thead>
<tbody>
<tr>
<td>acrobat</td>
<td>course</td>
<td>info</td>
<td>sco</td>
</tr>
<tr>
<td>adobe</td>
<td>cs</td>
<td>input</td>
<td>search</td>
</tr>
<tr>
<td>admin</td>
<td>cs2</td>
<td>lifecycle</td>
<td>seminar</td>
</tr>
<tr>
<td>administration</td>
<td>curriculum</td>
<td>macromedia</td>
<td>send</td>
</tr>
<tr>
<td>api</td>
<td>data</td>
<td>meeting</td>
<td>service</td>
</tr>
<tr>
<td>app</td>
<td>default</td>
<td>metadata</td>
<td>servlet</td>
</tr>
<tr>
<td>archive</td>
<td>download</td>
<td>monitor</td>
<td>soap</td>
</tr>
<tr>
<td>breeze</td>
<td>event</td>
<td>open</td>
<td>source</td>
</tr>
<tr>
<td>builder</td>
<td>fcs</td>
<td>output</td>
<td>src</td>
</tr>
<tr>
<td>close</td>
<td>flash</td>
<td>photoshop</td>
<td>stream</td>
</tr>
<tr>
<td>com</td>
<td>gateway</td>
<td>presenter</td>
<td>systems</td>
</tr>
<tr>
<td>common</td>
<td>go</td>
<td>producer</td>
<td>training</td>
</tr>
<tr>
<td>connect</td>
<td>home</td>
<td>public</td>
<td>user</td>
</tr>
<tr>
<td>console</td>
<td>hosted</td>
<td>publish</td>
<td>xml</td>
</tr>
<tr>
<td>defaultEventTemplate</td>
<td>defaultMeetingTemplate</td>
<td>defaultTrainingTemplate</td>
<td>collaboration</td>
</tr>
<tr>
<td>collaboration</td>
<td>pdf</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

More Help topics

“Upload content” on page 191

“View data about all content” on page 196

View content

You can open content for viewing from the Content library. If you have the URL for viewing the file, you can also browse to it directly from any browser window.

More Help topics

“Upload content” on page 191

“View data about all content” on page 196
View content in the Content library
1. Click the Content tab at the top of the Adobe Connect Central window.
2. Browse the Content library, and click a filename to view the associated Content Information page.
3. Click the URL For Viewing link.
A new browser window displays the selected file or presentation.

View content in a web browser
1. Open a browser window.
2. Enter the URL for viewing the content in the browser URL address box or click a link received in an e-mail.

Send a content URL by e-mail
Every content file in the Content library has a unique URL that lets users view the contents of the file. You can send this URL to other people by e-mail from within Adobe Connect Central.

Adobe Connect creates a unique version of the URL for each e-mail recipient. Compared to pasting the URL in an e-mail, using Adobe Connect Central has these advantages:

- You can request that Adobe Connect send you a return receipt when an e-mail recipient clicks the web link. You can track who viewed the contents because a unique URL was created for each recipient.
- Recipients can view the content without having to log in to Adobe Connect. This is true even if the permissions for the content file in the Content library are not set for public viewing.

1. Click the Content tab at the top of the Adobe Connect Central window.
2. Navigate to the content file and click its name.
3. Click E-mail Link on the navigation bar.
4. Enter the e-mail addresses for all recipients in the To box on the E-mail Link page.
If necessary, separate multiple e-mail addresses with commas to create a unique URL for each e-mail recipient.
5. Edit the Subject and Message Body text boxes as needed.

Note: Do not delete the information in the curly brackets (“{tracking-url}”) in the message body. This placeholder is replaced with the content URL in the e-mail message.
6. Select Generate a Return Receipt When Content Is Viewed to receive an e-mail notification when a recipient views the content file; otherwise, clear the check box.
7. Click Send.

More Help topics
“Creating custom URLs” on page 193
“Upload content” on page 191
Viewing data about content

View data about all content

1 In Adobe Connect Central, click Content > Content Dashboard.

The Content Dashboard provides a graphical representation of statistical data about your content. The data reflects all of the content in your My Content folder and is output to the following categories:

Most Viewed Content Over Last 30 Days The number of views.

Most Effective Presentations Over Last 30 Days Determined by percentage of slides viewed across all viewers.

Most Recently Viewed Content Over Last 30 Days In list format, shows the name, content type, number of views, and last time this content was viewed. The most recently viewed is listed first.

Aging Content In list format, shows the name, content type, and last time this content was viewed. The most recently viewed is listed last.

Click any item to view the corresponding Content Information page.

2 To print the data, click Printable Version.

More Help topics

“Content library supported file types” on page 190

“Upload content” on page 191

View reports about individual pieces of content

Note: In Adobe Connect 7 and later, you can retrieve data about individual pieces of content from a new Reports wizard (in Adobe Connect Central, click Reports > Content). This section of the documentation describes an older user interface for viewing data about individual pieces of content. This user interface was left in the product for backwards compatibility. The new Reports wizard is a better reporting tool.

You can download reports whenever necessary to analyze information about how content is being used.

Where appropriate, you can restrict the information you see on a report by specifying report filters. When the filters are in effect for a given report, the Report Filters link appears above the report display.

Any filters you set apply to all reports that you create, both for the specific report and for any other Adobe Connect functionality. For example, if you create a training report after you set filters for a content report, the filters apply to the training report. This rule applies to any date range you specify. If you do not clear a date range filter that you set for one report, it applies to all reports.

Note: Report filters are only saved for the current session. If you set report filters, click Save, then logout of Adobe Connect, when you log in again the report filters you previously set are not retained. However, the Reports wizard does save filters across sessions.

More Help topics

“About Adobe Connect Central reports” on page 247

“Content library supported file types” on page 190

“Upload content” on page 191
**Set report filters**

1. Access the information page (for example, the Content, Meeting, or Course Information page) for the file whose report filters you want to set.

2. On the information page, click the Reports link above the Content Information title bar. A set of report links appears above the title bar, with Summary highlighted, and the Summary report for this meeting appears below the information heading.

3. Click the report type for which you want to set filters. The data for the report type you selected appears in the Adobe Connect Central window.

4. Click the Report Filters link, to the right of the No Filters Have Been Set label. 

5. Set one or more of the following filters:
   - To set the date range filters, select the From and To check boxes and the start and end dates and times. For example, if you select a date range for the By Slides report, it shows only the slides that were viewed within the specified dates.
   - To set filters for groups, click the Add/Remove Groups link and select the check box for the groups you want to track in your report. The data on the report applies only to the members of a specific group that participated. You can select more than one group, and then deselect any group.
   - To select team members (managers only), click either Show Data From People I Manage Directly or Show Data From People I Manage Directly And Indirectly.

6. Click Save at the bottom of the Set Report Filters page. The report page reappears with the filters you set, above the display bar.

**Download reports**

1. Access the information page (for example, the Content, Meeting, or Course Information page) for the file whose report you want to download.
2. On the information page, click the Reports link above the Content Information title bar.
3. Click a report type, for example, By Slides or By Questions.

**Summary** The Summary provides the content name, the date that the content was last modified, and the number of times this content was viewed.

**By Users** This report available for recordings of meetings and virtual classrooms is a report of registered users viewing a recording. This report is similar to the Meeting By Attendees report and has the same columns and an additional column of Total Time Viewed. This report works for public recording as well. However, guest viewers are not reported as Adobe Connect does not require guest viewers to provide their details when viewing a recording.

**By Slides or By Pages (PDF)** Applies to presentations only. A bar graph lists each slide in the presentation by slide number and the number times it was viewed. Below the graph is a table with the same information, which also includes the last time each slide was viewed.

**By Questions** A bar chart shows each question, color-coded as correct or incorrect, and the number of respondents to the question. Click a question in the bar to display a pie chart with a table that provides the answer key and answer distribution. The answer key lists all possible answers for the selected question and their corresponding answer number or letter. The answer distribution lists all of the answer choices selected for this question, flags the correct answer, and shows the number of users who selected each answer, as well as what percent of the total each number of users represents. Finally, the chart totals the users by number of users and percent of users. Below the graph is a table that provides an overview of all questions, listing each question by number, name, number of correct answers, number of incorrect answers, percentage of correct, percentage of incorrect, as well as the score.

**By Answers** A table provides the maximum score, the passing score, the average score, and the high score for the quiz. For each question, the table also shows the question number, the question itself, and the answer distribution; that is, how each question was answered, if at all. Click the View Answers link to display a pie chart with a table that provides the answer key and answer distribution. The answer key lists all of the possible answers for the selected question and their corresponding answer number or letter. The answer distribution lists all of the answer choices selected for this question, flags the correct answer, and shows the number of users who selected each answer, as well as what percent of the total each number of users represents. Finally, the chart totals the users by number of users and percent of users.

**Note:** Adobe Connect resets content scores for quizzes and surveys each time the user retrieves the content. This means that if a user closes the quiz or survey without completing it, then returns to it later, all of the previous answers are lost. If you do not want the score to reset, and you have access to the Training tab, you can create a course and select the content in question as the course content. This way, you have turned the content into a course.

The Hide Answer Distribution/Show Answer Distribution button is a toggle for showing and hiding the distribution of answers for each question.

4. Click the Download Report Data button.

This exports all the report data to a comma-separated values (CSV) file. You can either save or open the report. If you are running Adobe Connect Central in an Internet Explorer browser and choose to open the report, Windows automatically opens it in Microsoft Excel. In this case, double-click each cell to see its information.

Another option is to save the CSV file to your desktop, select Notepad from the Accessories menu (select Start > Accessories > Notepad), and open the file from Notepad, which makes it easier to read.

In addition, if the Printable Version button appears for a report, you can click the button to export the report to a browser window and print the report.

**Remove report filters**
1. Access the information page (for example, the Content, Meeting, Course Information page, and so on) for the file whose report filter you want to remove.
2 On the information page, click the Reports link above the Content Information title bar.
3 Click a report type, either By Slides, By Questions, or By Answers.
4 Click the Report Filters link.
5 In the Set Filters page, do either of the following:
   • To clear all filters, click Reset.
   • To clear a specific filter, deselect the check box and click Save; if it’s a group, click Add/Remove Groups, deselect the group check box, and click Save.
Chapter 7: Administering Adobe Connect

Getting started administering accounts

Working in Adobe Connect Central
Adobe Connect Central is a web application used for working with Adobe Connect accounts. Administrators use Adobe Connect Central to manage an account and its users. Meeting hosts use Adobe Connect Central to create and schedule meetings. Training managers use Adobe Connect Central to create courses and enroll participants.

Log in to Adobe Connect Central
1 In a browser window, enter the account URL included in the Welcome e-mail.
2 On the Login page, enter your login and password.
   Note: The credentials are stored if you check the Remember Me checkbox. You can remove the saved data by manually clearing browser cookies.
3 Click Login.

Edit your profile
1 In Adobe Connect Central, click My Profile.
2 Do any of the following:
   • Click My Profile to view your user information.
   • Click Change My Password to change your password.
   • Click Edit My Preferences to change your time zone and language.
   • Click My Audio Profiles to select or create an audio profile for an audio conference.
   • Click My Audio Providers to select or create your own audio providers. These providers are not available to other users on the account.
   • Click Group Memberships to view your group memberships.
   • Click Organization to view your manager and team member information.

Determine Adobe Connect version number
Knowing your version number can be useful, especially when contacting Adobe Connect Support, or when reporting any issues with an application.
   Do one of the following:
   • On the Adobe Connect Central login page, move your insertion point over the Help link. The version number appears.
   • In a web browser address field, enter http://<Adobe Connect_url>/version.txt and press Go.

Search content
1 Start Adobe Connect Central.
2 Do one of the following to search any content to which you have access permission:
   • Type keywords directly into the Search text box on the Home page to search through content.
   • Click Advanced Search.

3 If you selected Advanced Search in step 2, do one of the following:
   • Select Search Within Content to search recordings, courses, presentations, or all of them. If desired, use the Show menu to narrow your search.
   • Select Search Titles and Descriptions to search content, meetings, training, seminars, folder or all of them. If desired, use the Show menu, Field menu, and Date Created fields to further narrow your search.

4 Type keywords into the search field and click Go.
Detailed results are listed in the bottom pane. Click a column header to sort the results.

5 (Optional) Click on the name of an item to open the item for viewing. Click a parent folder to open the folder that contains the item.

Note: It is possible to have access to an object, but not to the folder containing the object.

Adobe Connect Central icons
Adobe Connect Central uses icons to represent meetings, seminars, presentations, courses, and curriculums.

Course A presentation that is associated with a group of enrolled learners with tracking for each individual. The course can be used independently or as part of a curriculum.

Curriculum A group of courses and other learning content that guides students along a learning path. Curriculum can include Adobe Connect content, presentations, meetings, seminars, and external content such as classroom sessions and reading lists.

External training In a curriculum, training that occurs outside Adobe Connect, such as classroom training.

Event An Adobe Connect event includes registration, invitations, reminders, and reporting. Events usually involve a large number of participants and are built upon an Adobe Connect meeting, seminar, presentation, or training.

Meeting An online real-time meeting in which a host or presenter can show slides or multimedia presentations, share screens, chat, and broadcast live audio and video.

Virtual Classroom An online class with customizable layouts and reusable, archived content. Virtual classrooms have audio and video capabilities, as well as breakout rooms for collaborative learning.

Seminar A seminar is a scheduled meeting conducted for at least 50 participants and involves little audience participation or interaction.

Archive A recorded meeting or seminar, that users can view at their convenience.
Authorware content Files created in Macromedia Authorware from Adobe. Authorware is a visual tool for creating e-learning applications.

Presentation A presentation created with Adobe Presenter, a plug-in for Microsoft PowerPoint that lets users add audio, quizzes, and visual features to a PowerPoint presentation. PPT and PPTX files are converted to presentations when they are uploaded to Adobe Connect.

Image file (JPEG, GIF, PNG, BMP) Image files can be drawings, photographs, charts, graphs, icons, or any other type of graphics.

FLV file A video file.

HTML file File defining the structure and layout of a web document using various tags.

MP3 file An audio file.

PDF file An Adobe PDF file.

SWF file A Flash Player multimedia file.

Creating administrators

Administrators are users who manage Adobe Connect for their entire organization. Administrators create, remove, and manage user accounts. Administrators manage permissions for individual users and groups. Administrators perform these tasks using a web application called Adobe Connect Central.

There are two levels of Adobe Connect administrator: administrator and limited administrator. Administrators have full administrative privileges. Limited administrators have lesser administrative privileges. Administrators can set permissions for limited administrators.

The first administrator is created when Adobe Connect is installed or when the account is created. The administrator can then create additional administrators and limited administrators. For example, an administrator can create limited administrator accounts for Help Desk employees who support Adobe Connect users.

Create an administrator
1 Log in to Adobe Connect Central.
2 Click Administration > Users and Groups.
3 Select a user and click Information.
4 Click Edit Group Membership.
5 Select the Administrators group and click Add.

Create a limited administrator
1 Log in to Adobe Connect Central.
2 Click Administration > Users and Groups.
3 Select a user and click Information.
4 Click Edit Group Membership.
5 Select the Administrators - Limited group and click Add.

Set permissions for the limited administrators group
1 Log in to Adobe Connect Central.
2 Click Administration > Users and Groups.
3 Select Administrators - Limited and click Information.
4 Click Edit Limited Administrator Permissions.
5 Select the check boxes beside the permissions you want to grant in the following sections and click Save.

**Users and Groups** Checking View User Data lets limited administrators view information about users and groups in the Administrator > Users and Groups tab.

Checking Reset Password lets limited administrators create a temporary password for a user. See “Edit user information” on page 232.

Checking Modify current users and groups lets limited administrators edit user and group information. See “Managing users and groups” on page 232.

Checking Add users and groups using Web interface lets limited administrators use the Administration > Users and Groups interface. Checking Add users and groups using CSV import lets limited administrators import users and groups from a CSV (comma-separated value) file. See “Creating and importing users and groups” on page 224.

Checking Delete users and groups lets limited administrators delete users and groups. See “Managing users and groups” on page 232.

Checking Modify user profile fields lets limited administrators access the Administrator > Users and Groups > Customize User Profile tab. See “Customize user profile fields” on page 225.

Checking Change the login and password policies lets limited administrators access the Administration > Users and Groups > Edit Login and Password Policies tab. See “Set login and password policies” on page 226.

Checking Cost Centers lets limited administrators access the Administrator > Users and Groups > Cost Centers tab. See “Allocate meeting minutes to cost centers” on page 210.

**Account Management** Checking Edit account information lets limited administrators access the Administration > Account > Edit Information tab to edit the default language, time zone, and Event user policy for accounts. Limited administrators can also edit the primary contact information for accounts.

Checking Receive Notifications about Account Capacity and Expiration lets limited administrators access the Administration > Account > Notifications tab. See “Edit account notification settings” on page 206.

**Customization** Lets limited administrators access the Administration > Customization tab if the customization feature is enabled for their account. See “Customize the branding of an account” on page 207.

**Reports** Checking View disk usage and reports lets limited administrators view reports in the following sections of Adobe Connect Central:
- Administration > Account > Disk Usage
- Administration > Account > Reports
- Administration > Administration Dashboard

Checking View System Usage Reports lets limited administrators view System Usage reports in the Reports wizard (click the Reports tab in Adobe Connect Central). See “Generating reports in Adobe Connect Central” on page 247.

**Compliance and Control** Lets limited administrators access the Administration > Compliance and Control tab to ensure that the account adheres to government standards for privacy, communication, and archiving. See “Working with compliance and control settings” on page 211.

**Permissions** Lets limited administrators set permissions for content in the Content, Training, Meetings, Seminars, and Event Management libraries in Adobe Connect Central. Within the library, choose Set Permissions. See “Set permissions for content files and folders” on page 245.

6 Click Reset to Default to restore default limited administrator permissions.
**View and edit account information**

The Account Summary page appears when you click the Administration tab. It describes the applications and products that are enabled for this account.

Most of the account information on the Account Summary page cannot be changed through Adobe Connect Central. You can modify the following account settings in Adobe Connect Central:

- Default time zone
- Default language
- Event user policy (if the Events feature is part of your account)
- Primary contact information

The information that you modify here applies to the entire account. (To change your own user account profile information, click My Profile > Edit My Preferences in Adobe Connect Central.)

**View account information**

1. Log in to Adobe Connect Central
2. Click the Administration tab.

The Account Summary shows details about your account and its features.

Under the Features and Advanced Features headings, you see information about your account. The check mark by the application name means that it is enabled.

**System Features** Bandwidth per Month shows the amount of data transmitted to or from your account monthly compared to the amount of bandwidth you are allowed to use. Disk Usage (MB) shows the amount of hard drive space consumed by your account compared to the amount of disk space you are allowed to use.

**Presentation** The number of authors in your installation compared to the number that is permitted.

**Training** The pricing model that your organization uses for training. Training managers lists the number of managers in your installation compared to the number that is permitted. Named Training Learners lists the number of learners that have been added to the learners group compared to the number that is permitted. (Only members of this group can view training content.) Training Concurrent Learner License Limit lists the number of users who can simultaneously view training content. Adobe Connect 9.4 onwards, Virtual Classroom Managers lists the current number of users in Virtual Classroom Managers group compared to the number of licenses provisioned.

**Meeting** The pricing model that your organization uses for attendees. Meeting Hosts lists the number of hosts in your installation compared to the number that is permitted. Meeting Peak Concurrent Users lists the number of users who can simultaneously attend meetings. (The Soft Limit is the amount of quota that was purchased and the Hard Limit is the amount of quota that is enforced.) The Concurrent Users Per Meeting is the number of users who can simultaneously attend a single meeting. Burst Pack Minutes are prepaid overage minutes. One burst pack comes with 5000 minutes.

**Seminars** The number of Seminar Administrators in your installation compared to the number that is permitted. Adobe Connect 9.4 onwards, Webinar 100 Managers, Webinar 500 Managers, and Webinar 1000 Managers are listed and indicate current number of users in the group compared to the number of users provisioned.

**Event Management** The number of Event Managers in your installation compared to the number that is permitted.

**Enable FlashPaper** An Adobe product that enables you to convert HTML, Microsoft Word, and PowerPoint files into Flash documents for the web. Adobe has stopped new feature development for FlashPaper. Adobe recommends using PDF to present and collaborate on documents in Adobe Connect.

**Customization and Rebranding** A feature that allows you to customize and brand your account.
Requires SSL connection  A feature that determines whether your account uses SSL to encrypt all communication between the server and connected users.

Reports  A feature that allows you to access the Reports wizard.

Edit account information
1  Log in to Adobe Connect Central.
2  Click the Administration tab.
3  Click Edit Information.
4  Do any of the following:
   • To change the default language, select a language from the Default Language pop-up menu.
   • To change the default time zone, select a time zone from the Default Time Zone pop-up menu.
   • To change the rule for event registrants, select an option from the Event User Policy pop-up menu.
   • To change the contact information, enter a first name, last name, and e-mail address in the Primary Contact text boxes.
5  Click Save.

Pricing models
The pricing model determines how your organization pays for its usage. It is associated with the quota and usage information that you see under System Features. There are different models for training and meetings.

There is one pricing model for training:

Concurrent learners  This model limits how many learners can be active in all courses or curriculums at the same time.

There are two pricing models for meetings. You can view the information associated with the model your organization purchased:

Named organizer  This model limits the number of users who can initiate meetings. Each named organizer can initiate one active meeting at a time. A meeting started without the named organizer has all attendees with Participant privileges until the named organizer arrives in the meeting. When the first named organizer joins the meeting, privileges of all the other attendees are restored to the values set before the meeting.

Each meeting is limited to the number of participants specified in the license file. A named organizer must be present to start a meeting, and all participants are demoted to participant level, five minutes after the last named organizer has left the room. Users’ roles and permissions are restored when any named organizer returns. Named Organizer must be a member of the Meeting Hosts group.

Note: A named organizer can attend a maximum of two simultaneous meetings. Regardless of this user’s actual privileges in the ongoing meetings, an attempt to attend a third meeting generates an error message.

Concurrent attendee  This model limits how many participants can be active in a meeting at the same time. The limit does not affect seminar attendees.

Note: You cannot have quotas for named organizers and concurrent attendees at the same time.

Seminar rooms quotas do not affect any other quotas. The seminar attendee limit determines the number of participants that can be simultaneously active in a seminar. This limit applies to each seminar room independently.
Both the named organizer and concurrent attendee pricing models display the same fields. However, some fields are irrelevant based on the pricing model your organization has purchased:

- In Adobe Connect 9.3, if your organization uses the concurrent user model, then the Concurrent Users Per Meeting field is irrelevant. The account is bound by the information in the Meeting Peak Concurrent Users field. If the Concurrent Users Per Meeting field displays “unlimited,” Adobe Connect does not limit the size of any given room. However, an upper limit specifies the number of concurrent users the account supports. Adobe Connect 9.4 onwards, you can have meetings with Concurrent User Model that also have Concurrent Users Per Meeting limit.

- If your organization uses the Named Organizer model, Adobe Connect specifies a maximum room capacity. This value is displayed in the Concurrent Users Per Meeting field. The Meeting Peak Concurrent Users field is irrelevant when using the named organizer model. The reason is that Adobe Connect limits the number of organizers using the Concurrent Users Per Meeting field. The number is typically set to 100 users.

**Edit account notification settings**

Adobe Connect notifies the account administrator (and optionally, additional users) when an account license is about to expire. Adobe Connect also notifies the administrator when an account approaches its various capacities.

1. Log in to Adobe Connect Central.
2. Click the Administration tab.
3. With Account selected, click Notifications and choose the desired settings.

**Configure multiple product notifications**

To notify users about frequent updates, administrators send multiple system maintenance notifications and account-based product notifications simultaneously. For example, an administrator may want to send a breakfix notification to all users in addition to the regular account-based Adobe Connect upgrade notifications.

User accounts are preconfigured to receive maintenance notifications. You can configure specific user accounts to receive product-based notifications following these steps:

1. Choose Administration > Account > Notifications.
2. Under Product Notification Settings, select the start date and end date for the notifications.
3. In the message box, type the notification message and click Save. When the user opens a meeting, the product notification message is displayed in the Notifications pod.

You can configure a user account to receive a maximum of three notifications at a time. Normally, you send two maintenance notifications and a single product-based notification. However, based on requirements, you can configure a specific user account to receive three maintenance notifications. The maintenance notifications have a higher priority compared to product-based notifications. Therefore, maintenance notifications appear on the top in the Notifications pod. If a user closes a notification, the notification reappears on the Notifications pod when the user reopens the meeting. Alternatively, the user can choose Don’t show this message again to prevent the notification from reappearing when the meeting reopens.

**View account usage information**

1. Log in to Adobe Connect Central and click the Administration tab.
2. Click Administration Dashboard to see a graphical representation of your quota usage across the system.
3. Move the pointer over any bar to see the precise maximum figure for that bar.

The gray bar represents your current usage, and the dark green bar represents your limit.
4 Click either bar in a group quota graph to display a group information page.
The group information page lists the name and a description of the group. Click the View Group Members button to
view current members and add new members.

**Customize the branding of an account**
If your organization purchased the customization features, the Customization link is enabled on the Administration
tab. The customization features let you adapt the appearance of Adobe Connect to match the branding of your
organization.
To see your customization changes, log out and log back in to Adobe Connect Central and refresh the browser.

**Customize the Adobe Connect Central user interface**
Use the Customize Banner link to customize the following elements of the Adobe Connect Central user interface (user interface):

- Background color.
- Top links text color (for the Help and Logout links in the upper-right corner).
- Navigation text color (for the links below the tab bar).
- Selection highlight color.
- Table header color (for the bars that identify page titles or columns on list pages).
- Banner logo, the image that appears in the upper-left corner of Adobe Connect Central. The image must be a JPEG, PNG, GIF, or BMP file and must be 360 x 50 pixels.

*Note: Use an image with white background rather than a transparent image.*
1. Click the Administration tab.
2. Click Customization.
3. In the list to the right of the color grid, click the item whose color you want to change.
4. Do one of the following:
   - Click a color in the grid.
   - Enter a color code, such as #33CC66, into the text box.
5. To change the color swatch to the previous setting, click Clear. To restore all colors and the banner logo to the
defaults, click Reset To Default.
6. To select a banner logo, click Browse below the Banner Logo heading and browse for the logo image (JPEG, PNG,
GIF, or BMP file). If you don’t select a logo, the Adobe Connect logo appears in the banner.
7. Click Apply to save your changes.

Your changes appear in 5 seconds to 10 seconds; alternatively, you can refresh the page.

Note: After you select a banner logo, the logo displays in the preview area. When you click Apply to save your changes,
sometimes the banner preview area displays the old banner. The new banner logo displays correctly for users. To see the
correct banner, log out and back in to Adobe Connect Central and refresh the browser.
**Customize the login page**

Use the Customize Login link to customize the login page. You can modify any of the following attributes:

- Meeting title color
- Login text color
- Background color (login area color)
- Main logo image, which must be a 410 x 310 pixel JPEG, PNG, GIF, or BMP file

1. Click the Administration tab.
2. Click Customization.
3. Click Customize Login.
4. In the list to the right of the color grid, click the item whose color you want to change.
5. Click a color in the grid.
6. To change the color swatch to the previous setting, click Clear. To restore the original setting, click Reset To Default.
7. To select a main logo, click Browse below the Main Logo heading and browse for the logo image (JPG, PNG, GIF, or BMP file). If you don’t select a logo, the Adobe Connect logo is used as the main logo.
8. Click Apply to save your changes.

Your changes appear in 5 seconds to 10 seconds; alternatively, you can refresh the page.
Note: After you select a logo, the logo displays in the preview area. When you click Apply to save your changes, sometimes the banner preview area displays the old logo. The new logo displays correctly for users. To see the correct logo, log out and back in to Adobe Connect Central and refresh the browser.

Customize the appearance of Adobe Connect meetings

Use the Customize Meeting option to modify the appearance of Adobe Connect meetings. The settings you apply here appear in every meeting created in your account. (These settings do not affect the meeting layout.)

1. Click the Administration tab.
2. Click Customization.
3. Click Customize Meeting.
4. In the list to the right of the color grid, click one of the following:
   • Menu highlight color
   • Button focus color (the color outline that appears around a button when you move the pointer over it)
   • Background color
   • App bar color (the color of the upper application bar)
   • App bar text (the color of menu text)
5. Click a color in the grid.
6. To change the color swatch to the previous setting, click Clear. To restore the original setting, click Reset To Default.
7. To select a meeting logo, click Browse, and choose a JPEG, PNG, GIF, or BMP file that’s 50 x 31 pixels (other sizes are scaled to fit). If you do not select a logo, the Adobe Connect logo is used.
8. To link the logo to a website, enter a path in the Logo URL box.
9. Click Apply to save your changes.

Your changes appear in 5 seconds to 10 seconds; alternatively, you can refresh the page.

Allocate meeting minutes to cost centers

When you import users to Adobe Connect, you can associate each user with a cost center. If users are associated with cost centers, you can enable cost center reporting to determine how much each cost center is using Adobe Connect.

The easiest way to associate users with cost centers is when you import users in a CSV file or synchronize with an LDAP directory service. If you don’t use either of these methods, you can also associate a user with a cost center manually.

If cost center reporting is disabled, meetings are not tracked for reporting purposes. If users are not assigned to cost centers and meetings are billed per attendee, Adobe Connect does not track data for those users.

More Help topics
“Import users and groups from CSV files” on page 227

Associate users with cost centers manually

1. Log in to Adobe Connect Central.
2. Click the Administration tab then click Users and Groups.
3. Select a user from the list and click Information.
4 Click Edit information.
5 Click the Choose button beside the Cost Center box.
6 Select a cost center from the list. If the cost center isn’t in the list, click the plus sign to add it.
7 Click Save.

**Enable cost center reporting**
1 Log in to Adobe Connect Central.
2 Click the Administration tab.
3 Click Users and Groups then click Cost Centers.
4 Choose a radio button to determine how minutes are allocated.
   If you choose Allow each meeting host to determine how minutes are allocated, the host can choose from a Cost Center pop-up menu when creating a meeting.
5 To search, add, delete, or edit a cost center, click Manage Cost Centers.
6 Click Save.

**Disable cost center reporting**
1 Log in to Adobe Connect Central.
2 Click the Administration tab.
3 Click Users and Groups then click Cost Centers.
4 Deselect Enable Cost Center Reporting.
5 Click Save.

**Working with compliance and control settings**
Organizations operating in regulated industries are required to comply with government standards. These standards dictate how and when employees can communicate and whether the organization must record and archive communication. For example, some organizations are required to log all communications that take place on their networks.

Organizations can also choose to retain communications between employees or between employees and external users to meet standards of internal control. Use the compliance and control settings to adhere to standards and control the global meeting experience.

Compliance and control settings are global settings that affect the entire Adobe Connect account. Settings apply immediately to all meeting sessions that begin after the settings are saved. Settings do not apply to meetings that are in progress when settings are saved. Settings apply to recent meetings up to 10 minutes after the meetings end.

*Note: Not all compliance features are available to Hosted customers.*

**More Help topics**
“Share your screen” on page 35

**Customize compliance and control settings**
1 Log in to Adobe Connect Central.
2 Click the Administration tab.
3 Click Compliance and Control.

4 Click Pods Management and do any of the following:
   - Choose Disable Edit My Info menu item to prevent attendees from updating their name in a meeting or an event. If this option is selected, only hosts can update the information of an attendee.
   - Select any pods you want to disable in meeting rooms and virtual classrooms. If you disable a pod, the pod and all information in the pod is erased in every meeting room that contains the pod. Disabling pods can leave empty space in meeting room layouts. Update your meeting templates and resize the pods to fill up any spaces.
   - Choose Disable Attendee Display Settings to disable the attendees display settings in the Preferences dialog in a meeting.
   - Choose whether to disable interactive audio between VoIP and conference bridge.
   - Choose whether to disable broadcast from conference bridge. The audio from the bridge is used for recording only.
   - Choose whether to disable Video telephony.

5 Click Share Settings and do any of the following:
   - Choose whether to Disable Desktop sharing, Disable Windows sharing, or Disable Applications sharing. Individual screen sharing modes lets you disable screen sharing modes and prevents users from sharing unauthorized content. For more information on screen sharing modes see “Screen sharing options” on page 36.
   - Choose whether to Disable Request for Control to prevent users from requesting control of another user’s shared screen.
   - Choose whether to Disable screen sharing’s “Pause and Annotate” feature to disable the Share pod’s overlay whiteboard.
   - Choose whether to Restrict screen sharing to specific processes to specify applications that users can share. See “Specify applications to share or block” on page 213.
   - Under the Document Sharing settings, choose one or more of the following. If you select all the options, the Share Documents option is removed from the Share pod.

Choose Share pod: disable uploading of documents to the meeting, to prevent users from sharing documents on their computers.

Choose Share pod: disable uploading of documents from the Content and Course libraries, to prevent users from sharing documents that are published in the content and course libraries. This setting prevents users from uploading content directly into a meeting room. A host or presenter can share only content that was preloaded into Adobe Connect Central.

Choose Disable Whiteboard, to disable the whiteboard from the Share pod.
   - Under Room Bandwidth Settings, set the following to manage the room bandwidth.

Set the default values for bandwidth usage and video quality using the sliders.

Optionally, administrators can prevent the meeting hosts from changing these setting from meeting preferences.

**Note:** When Room Bandwidth Settings are updates, the settings of the existing meetings are retained, unless an administrator overrides all settings. In the latter case, new and existing meetings are affected.

   - Choose Disable File Share pod, to remove the file share pod from all meetings.
   - Select Disable Breakout rooms to prevent creating breakout rooms.
   - Select Disable option to open the web link on ending the meeting.

6 Click Recordings and Notice and do any of the following:
Note: Only the Enable compliance notice setting is available to hosted customers. Hosted customers cannot force recording settings or enable chat transcripts.

- Select Lock Recording Settings For All Meetings and Record All Meetings (On), to record all meetings. No one can stop the recording, not even the meeting host. Only administrators can access forced recordings unless you select Publish Recording Links In Meeting Folders. In this case, the meeting host can access the recording through the link available in the meeting folder. The meeting host can edit the forced recording but administrators can still access the original recording as needed. The Presenter Only Area and breakout rooms are never recorded. If you record all meeting activities, choose Disable Breakout rooms on the Share Settings page. Select Never Record Any Meeting (Off), to disable the Meeting > Record Meeting command in all meeting rooms.

Note: MP4 encoding of recorded meetings is a hosted-only feature. It is not available for on-premise customers.

- Select Enable MP4 Encoder, to make the Make MP4 option visible in the Actions pop-up menu, in the Recordings tab of meetings, virtual classrooms, and seminars. Meeting and seminars hosts are able to trigger conversion of their recordings to MP4 format, only if this option is selected.

Note: MP4 encoding of recorded meetings is a hosted-only feature. It is not available for on-premise customers.

- Select Enable Chat Transcripts to log all chat messages on the server. The transcripts contain the name of the room, the name of the sender, the name of the recipient, the date and time, and the message body for each chat message. Transcripts are stored on the Adobe Connect server in the folder `rootinstall\content\account-id\sco-id\version\output` (for example, `C:\breeze\content\7\21838-1\output`). The file name format and type is `roomname_date_time.xml`. Chat transcripts do not log text in the Note pod and chat communication in breakout rooms. To record all text-based conversation, disable the Note pod and breakout rooms.

- Select Enable Compliance Notice and enter notice text to force all users to accept the terms of the notice before entering meeting rooms. The acceptance is recorded in the server log. For example, licensed customers can use this notice to inform users that a meeting is or is not being recorded.

- Under the Record meeting audio on Telephony Provider’s Bridge, select the audio providers for which recording also needs to be done on the provider’s audio bridge. By default, the recording is done using Universal Voice for audio providers.

7 Click Training Settings and select whether you want to enable open enrollment.

8 Click Save to save changes.

Specify applications to share or block
To prevent users from sharing unauthorized applications or processes, you can do one of the following:

- Create a whitelist of authorized applications
- Create a blacklist of applications or processes that cannot be shared

These two options are mutually exclusive: you can either specify a whitelist or a blacklist. Applications that are included in the blacklist are not available for participants, presenters, and hosts to share. To prevent users from sharing unauthorized applications or processes, enter separate Windows and Mac OS applications in the text boxes. The list of available items appears when users select Windows or Applications from the Start Screen Sharing window.

1 Select the Restrict screen sharing to specific processes (check to define process lists) option.

2 To determine the name of the application executable:

Windows  Do one of the following:

- Navigate to the application folder (Typically `C:\Program Files\application folder`) and read the application executable name. For example, the executable name of Microsoft Office PowerPoint is `POWERPNT.EXE`.
- Start Windows Task Manger (right-click an empty spot in the Windows Taskbar and choose Task Manager from the context menu). Then select the Processes tab to list all running processes.
Mac OS  Do one of the following:

- Navigate to the application folder and read the application’s executable name.
- Open the Activity Monitor (Mac OS X 10.3 or later) or the Process Viewer (Mac OS X 10.0 and 10.2). Select All Processes from the Show pop-up menu to list all running processes.

3  Select one of the following options:

- Allow Only The Sharing Of The Following Processes.
- Prevent The Sharing Of The Following Processes.

4  Enter the list of executable names as colon-separated values for Windows and Mac. For example,

Windows  powerpnt.exe:winword.exe:notepad.exe

Mac OS  iTunes:iPhoto:iChat

5  Click Save.

View forced recordings

1  In Adobe Connect Central, administrators can click Content > Forced Recordings to view all the forced recordings in an account.

2  Click a recording name to view information about the recording.

3  Do one of the following:

- Click Edit to edit the title, summary, or language of a recording.
- Click the URL for Viewing to view the recording.

Create a link to a forced recording

Links point to the latest version of the recording. If any editing is done to the recording (either directly or through any link), the edits are reflected in all the links to that recording.

1  In Adobe Connect Central, administrators can click Content > Forced Recordings to view all the forced recordings in an account.

2  Select the checkbox for the meeting you want to link.

3  Click Create Link.

4  Navigate to the Content folder where you want to add the link.

5  Click Create Link.

Delete forced recordings

Only administrators can delete forced recordings.

1  In Adobe Connect Central, click on Content > Forced Recordings to view all the forced recordings in an account.

2  Select the checkbox for the meeting you want to delete.

3  Click Delete.

Configure Engagement Tracking

Engagement is tracked via Engagement Dashboard in seminars, meetings, virtual classrooms, and events. When configured, participants can opt out from engagement tracking. When participants choose to opt out, Adobe Connect excludes engagement index and private chat message count when reporting event meeting information to event hosts.
Account Administrators control various settings for opt out for Engagement Tracking and provide Event Administrators with limited control over opt out.

1. Access Administration > Compliance and Control > Engagement Tracking in Adobe Connect.
2. Make the desired selections to configure engagement tracking. The following settings are available, separately, for events and meetings, virtual classrooms, and seminar rooms.

**Enable opt out for participants** Mandatorily provide the opt out option to the participants.

**Allow override of admin settings by host** Hosts can override the Account Administrators default settings, when creating an Adobe Connect session. An additional option to Enable opt out for participants is available.

**Note:** If either of meetings, virtual classrooms, or seminar rooms are associated with an event, the settings of the event take precedence.

3. Click Save.

The above changes in the settings are effective immediately for all the new Adobe Connect sessions.

**More Help topics**

“Enabling analytics” on page 152

**Configure the Training Catalog**

Only administrators have access to the Training Catalog by default. An administrator must set permissions for the Training Catalog before Training Managers can use it. Administrators can create any folder and permissions structure. For example, an Administrator could give the whole Training Managers group permission to manage the root folder of the Training Catalog. In another example, an Administrator could create folders for each Training Manager.

**Create a custom URL and name for the Training Catalog**

Creating a custom URL is optional. If you don’t create one, the system generates one, but it’s easier to use a URL you create.

1. Log in to Adobe Connect Central.
2. Click Training > Training Catalog > Edit Information.
3. Enter a name for the top-level folder.
4. Enter a custom URL.

All bookmarks to content in the Training Catalog use the custom URL. If you change the custom URL, existing bookmarks break.

5. (Optional) Enter a description for the folder in the Summary field.

**Create a folder structure and set permissions**

1. Log in to Adobe Connect Central.
2. Click Training > Training Catalog.
3. If you want Training Managers to create their own folders and set permissions for those folders, while in the root folder, click Set Permissions.
4. Select Training Managers and click Add to give them permissions to the root folder.
5. If you want to create a folder structure, while in the root folder, click New Folder and give the folder a name and, optionally, a description.

Last updated 3/20/2015
Click Set Permissions to set permissions for the new folder.
Select any groups or users you want to have permission and click Add.
You can repeat these steps to create any folder and permissions structure you desire.

Make local help and support pages available
Using the in-product help links, the on-premise users can access help and documentation local to their environment, instead of being directed to adobe.com. Adobe Connect administrators and the organization’s IT department can provide local, targeted content and troubleshooting information to their users before the users reach out to content hosted on adobe.com. The landing page, as access via the in-built help system must be available at http://www.example.com/system/help/support/.

Adobe Connect Central How To Topics

Content
- “Working with content in the Content library” on page 190
- “Upload content” on page 191
- “Viewing data about content” on page 196

Training
- “About Adobe Connect Training” on page 71
- “Creating training courses” on page 77
- “Creating training curriculums” on page 84
- “Creating virtual classrooms” on page 96
- “Monitoring training with reports” on page 102
- “Manage the Training Catalog” on page 108

Meetings
- “Meeting basics” on page 4
- “Create meetings” on page 13
- “Start meetings” on page 18
- “Start meeting audio” on page 168
- “Meeting room templates and layouts” on page 14
- “Share a document or PDF” on page 40
- “Share a presentation” on page 42
- “Upload and manage files using the File Share pod” on page 50
- “Updating meetings” on page 24
- “Viewing data about meetings” on page 30
Configure audio providers for universal voice

About universal voice audio providers

Audio providers are companies that provide audio conferencing services that work with Adobe Connect. Administrators configure the audio providers that everyone on an account can use. Hosts configure providers for a specific use, such as a meeting. Both account administrators and hosts can configure an audio provider for universal voice.

The configuration for a universal voice audio provider includes the details required for hosts and participants to join an audio conference. They include the telephone numbers and steps required to dial into the audio conference. The configuration also specifies the host-defined options. For example, administrators configure the tones and pauses for dialing into a meeting. Hosts provide the meeting ID and any passwords that participants use to join the audio conference.
Once you configure a universal voice audio provider, meeting hosts can create audio profiles that map to the provider. Audio profiles contain the audio conference settings used to start an audio conference.

Universal voice audio providers include these types:
- Integrated telephony providers that have been enabled for universal voice.
- User-configured by a meeting host or account administrator.

For more information about Adobe Connect audio providers, see “Audio conferencing options” on page 163. Adobe Connect accepts either a free phone numbers originating in the United Kingdom of the format 0800 or 0808 or an international free phone numbers of the format 00800.

**View audio providers**

All available audio providers for a specific account appear in the Provider Information window. Each audio provider is configured with descriptive information and a dialing sequence for connecting to an audio conference. You can view the information associated with any audio provider on the account. Only enabled providers can be edited.

**Note:** Administrators, limited administrators, and hosts can access this window.

1. Do one of the following to view the provider list:
   - (Administrators) Click the Administration tab at the top of the Adobe Connect Central window, and then click Audio Providers.
   - (Hosts) Click My Profile in the Adobe Connect window, and then click My Audio Providers.

2. To view provider information, select the provider in the list.

![Available audio providers and audio conference information for one provider](image)

**More Help topics**

“Using universal voice” on page 166

“Create and use audio profiles” on page 164

Last updated 3/20/2015
Create or edit audio providers

Use the New/Edit Audio Provider window to configure universal voice audio providers. Fields in the New/Edit Audio Provider dialog box with a red star are required.

When you add an audio provider to an account, the provider appears in the Provider Information window (Administration > Audio Providers or My Profile > My Audio Providers).

New Audio Provider window

1 Do one of the following to view the provider list:
   - (Administrators) Click the Administration tab at the top of the Adobe Connect Central window, and then click Audio Providers.
   - (Hosts) Click My Profile in the Adobe Connect window, and then click My Audio Providers.

2 Do one of the following to add conferencing details for a provider:
   - To add a provider, click New Provider.
   - To edit a user-configured provider, select the provider in the left pane and click Edit.

3 Add or change conference identification details and click Save.

   **Provider Name** Name of the audio provider, such as MeetingPlace.

   **Provider Status (Enabled/Disabled)** Only enabled providers can be edited. Enabled providers appear to hosts when they set up an audio profile for an audio conference. You can enable multiple providers for an account.

   **Important:** Disabling a provider also disables all the current audio profiles set up for this provider and disassociates the audio profiles from the meetings.

   **URL** A link to an information page. For example, this page can include conference account details for hosts to use when setting up their audio profiles. The information page could also be a sign-up page for purchasing a conference account from an audio provider. Account administrators typically create these information pages.
**Dial-In Numbers** Numbers for dialing into a meeting. To add dial-in numbers, click Add Number, click the word Location, and type a name, such as Internal or the country name. Click the word Number and type the dial-in number. The dial-in numbers appear in the upper-right corner of the meeting room.

*Note:* Provide either a free phone number originating in the United Kingdom of the format 0800 or 0808 or an international free phone numbers of the format 00800.

**Dial-In Steps** A sequence of DTMF tones and pauses for dialing into an audio conference. The dialing sequence also includes the conference number as the first step.

### Define a dialing sequence

The *dialing sequence* or *dial-in steps* are DTMF tones and pauses for dialing into an audio conference. On hosted accounts, the Adobe Connect server uses the dialing sequence to join the audio conference in the background when the host joins the conference in the meeting room. Some DTMF tones can be host-defined options, such as participant codes. You build a dialing sequence for a provider by placing these items in sequence in a table.

A well-defined dialing sequence can require small and frequent adjustments to the dial-in steps. One way to create the flow of steps is to dial into the audio conferencing service using a telephone and take notes. For example, dial in as a moderator and start the audio conference. Use a separate telephone to dial into the conference as a participant, and then write down the steps to enter the conference.

---

**Example of a dialing sequence**

A. Telephone number to join the audio conference | B. DTMF tones and pauses between actions | C. Name for the step | D. Values entered to program the step | E. Displayed in meeting | F. Not displayed in meeting | G. Displays information as a text box
Most options appear in pop-up menus. To display a pop-up menu, click the information in each row.

<table>
<thead>
<tr>
<th>Display In Meeting</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>Info</td>
</tr>
<tr>
<td>False</td>
<td>Info</td>
</tr>
</tbody>
</table>

Available choices for the Display In Meeting column

1. In the Dial-In Steps section of the New/Edit Provider window, click Add Step.
2. In the Action column, click the information in the first row, and select Conference Number from the pop-up menu. Enter the dial-in number for the meeting room and specify the remaining information for that step.
3. For each remaining step in the dialing sequence, specify DTMF tones and pauses.
4. To move a step up or down in the sequence, select the step and use the Up or Down Arrows.
5. To delete a step, select it and click Remove.
6. When you’re finished, click Save.

**Dialing sequence options**

**Action column**
- **Conference Number** The telephone number for joining the audio conference. The conference number must be the first step in the dialing sequence. *Hosted accounts*, where Adobe provides the server for the account, require a toll free U.S. telephone number to join an audio conference. *On-premise or licensed accounts* can use any number. Only one conference number is allowed.
- **DTMF** Buttons on a telephone keypad, such as the pound key (#).
- **Delay (ms)** The delay in milliseconds between each action. These delays provide pauses before a meeting participant enters information. For example, users wait for a welcome announcement before entering a participant code. You specify the amount of delay in the Key/Number column.

**Label column**
- **Label** An identifier for the action. For example, to program a DTMF action for a meeting ID, replace the word Label in the column with Meeting ID. Only labels for Defined By Host actions appear in the program. In the Meeting ID example, a text box labeled Meeting ID appears when hosts create an audio profile for this provider.

**Key/Number column**
In this column, you choose which steps a host has to define. Host-defined steps appear when a meeting host sets up an audio profile for an audio conference.
- **(blank)** The numbers or symbols on a telephone keypad required to complete the step. For example, to program a pause of 5000 milliseconds for users to wait for a welcome announcement, click the blank option and enter 5000.
- **Defined By Host** Account administrators choose this option when they want hosts to enter information while setting up an audio profile for an audio conference. For example, a host-defined DTMF action with the label “Meeting ID” requires the host to enter the meeting ID when setting up the audio profile.
Display In Meeting column
The pop-up menu in this column is available only for Defined By Host steps.

**False/True** Determines whether the information for this action is displayed in the meeting invitation and upper-right corner of the meeting room window.

Input Type column
The pop-up menu in this column is available only for Defined By Host steps. The options define how information appears when hosts set up audio profiles. These options also determine how the information appears in read-only pages, such as the Audio Conference Information section in a meeting room.

**Text** Displays a single-line text box in the audio profile, and a single line of information in read-only pages.

**Password** Shows the information as asterisk characters (*).

Test a dialing sequence
It’s a good idea to test the dialing sequence before you use it to start an audio conference. Using this test, you can ensure that you have accounted for all the required steps and that the delays between steps are sufficient. If you have added any host-defined steps to the dialing sequence, be prepared to enter that information in the Test Dial-In Steps dialog box. For example, to have Adobe Connect dial into the audio conference as a participant, enter the participant code in the dialog box.

1. Click Test Dial-In Steps at the bottom of the dialing sequence.
2. Fill in the host-defined text boxes.
3. Click Adobe Connect in the Test Dial-In Steps dialog box.
   As soon as the call is answered, you can hear if audio is being broadcast.
4. Listen to the audio and then adjust the dialing sequence as necessary.

*Note: If the provided free phone numbers are not the type of numbers recommended above, the dial out fails.*

Delete an audio provider
1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Audio Providers.
3. Select the provider in the Audio Providers list and click Delete.

Configure video telephony devices
Adobe Connect officially supports the Tandberg 990MXP and Edge 95 video conferencing devices; other Tandberg H.264 devices work similarly.

For more information, see the Tandberg website.

1. At the top of the Adobe Connect Central window, click Administration.
2. Click Video Telephony Devices.
3. In the Device Name box, enter the name you want users to see in the meeting client.
4. Enter the SIP (Session Initiation Protocol) Address defined for the device in the Flash Media Gateway server. (For more information, contact your system administrator.)
5 Click Save.

**Change the timeout period**

To keep Adobe Connect Central more secure, you can change the length of time a session remains open without activity. When the session reaches your specified timeout period, any unsaved data is lost.

1 At the top of the Adobe Connect Central window, click Administration.
2 Click Account.
3 Click Session Settings.
4 Enter a timeout length in minutes.
5 Click Save.

**Access MP4 conversion queue**

Meeting Hosts and Seminar Administrators can convert the recordings of meeting, virtual classroom, and seminar to MP4 format. See "Convert meeting recording to MP4 format" on page 180, for more information.

The conversion to MP4 is a server-side activity. Meeting Hosts and Seminar Administrators can trigger conversions that are then queued on the Adobe Connect server. Adobe Connect administrators have access to the queue at Administrations > Account > MP4 Encoder Queue.

*Note:* Adobe Connect administrators enable this tab in Compliance and Control settings. Only then this tab is visible on the user interface.

The queue displays the following three types of queued jobs:

- Conversion jobs just added to queue and not yet processed by the server.
- Conversion jobs being processed by the server.
- Conversion jobs that have failed to convert.

*Note:* Completed conversion jobs are not shown in the MP4 Encoder Queue.

In the conversion queue, Adobe Connect administrators can take the following actions:

- Notify the job owners of any type of conversion job, with any message.
- Access the email ID of the job owners.
- Cancel a queued recording request.

  *Note:* Recording Job Owners can also cancel the queued job requests.

  *Note:* You cannot cancel an in-progress conversion job.

**More Help topics**

"Customize compliance and control settings" on page 211

"Convert meeting recording to MP4 format" on page 180
Enhancing Adobe Connect account security

Adobe Connect administrators can enhance the security of their account from the Administration tab.

1. Click on Administration > Account > More Settings.
2. Select Requires SSL Connection (RTMPS), so Adobe Connect enforces the use of RTMPS protocol.
3. Select Enable Enhanced Security, to force Web Services APIs to use secure (HTTPS) connection and generate new session identifier after successful login.

   Note: It is recommended to check Enhanced Security option.

Creating and importing users and groups

Workflow for creating and importing users and groups

The following overview summarizes the workflow involved in setting up user accounts.

1. (Optional) Customize user profile fields.
   A user profile field is an attribute of your organization’s Adobe Connect user profile. The fields for First Name, Last Name, and e-mail are required and cannot be modified. However, you can add other predefined fields, create new fields, and change their order in the user profile. See “Customize user profile fields” on page 225.

2. (Optional) Set login and password policies.
   You can set login and password policies, password expiration, password format, and password length. See “Set login and password policies” on page 226.

3. Create custom groups.
   Adobe Connect includes several built-in groups, see “Built-in permission groups” on page 239. You can also import groups. If you need additional groups, you can create custom groups in Adobe Connect Central. It’s a good idea to create custom groups first so you can add users as you import them to the account. See “Create a custom group manually” on page 230.

4. Add users and groups.
   To add users and groups to Adobe Connect, use the Lightweight Directory Access Protocol (LDAP), comma-separated value (CSV) files, or create users and groups manually.

   Working with LDAP-acquired users and groups    In LDAP-enabled organizations, Adobe Connect acquires all its user data directly from the user directory of your organization. This data includes information such as login, name, and phone number. You would probably not be involved in adding new users or groups to the system, because this process occurs outside Adobe Connect Central. Once the LDAP integration is configured, manually assign LDAP-acquired users or groups to the Built-in group appropriate for their job functions. For more information, see Migrating, Installing, and Configuring Adobe Connect guide available online at www.adobe.com/go/connect_documentation_en.

   Importing users and groups through CSV files   You can import large numbers of users and groups through a CSV file. Your directory might have a utility for exporting users and groups to CSV files, or you can create CSV files yourself. Your CSV files must be in a specific format. You can modify the imported users and groups in the same way you would any user or group that was manually created. See “Import users and groups from CSV files” on page 227.
Adding users and groups manually  You can assign new users to a Built-in group, or you can create custom groups that are specific to your organization. It is best to create these groups before creating users manually. See "Create a user manually" on page 231 and "Create a custom group manually" on page 230.

5. Assign users to groups.

Once you have imported or created users and groups, set permissions so users can access content and create meetings, trainings, events, or seminars. The Built-in groups have default permissions. Assign users and groups to the Built-in groups as an easy way to set permissions. User account administration is simpler when you are managing groups rather than individuals. See “Add or remove group members” on page 236.

Customize user profile fields

Add user profile fields to match the user profile fields in the directory of your organization.

When you customize user profile fields, you can add predefined fields, create custom fields, and remove fields. When you modify a field, you can change any of its attributes. You can also designate a field as required, or add a comment describing a field.

Note: Do not create multiple custom fields with the same name.

Include user profile fields

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. Click the Customize User Profile link above the Users And Groups list.

The list of the user profile fields appears; First Name, Last Name, and E-mail are flagged with red asterisks (*) to indicate that they are required.

4. Select the check box for any field on this page that you want to include as part of the user account profile.
5. To move an item up or down in the list, select its check box and click the Shift Up or Shift Down button.

The information in the user profile fields is displayed in reports. Reports display mandatory fields and the first ten fields listed in the Customize User Profile screen. Use the Shift Up and Shift Down buttons to move fields into the desired positions.

Add predefined fields

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. Click the Customize User Profile link above the Users And Groups list.
4. Click the Add Predefined Field button.
5. Click the check box for any fields that you want to add.
6. Click Save.
7. To move an item up or down in the list, select its check box and click the Shift Up or Shift Down button.

Create custom fields

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. Click the Customize User Profile link above the Users And Groups list.
4 Click the New Field button.
5 Type a name for this field.

If you want, you can type a comment in the Comment text input box. You can also select the Required check box for the Field Type if you want this field to be required.

6 Click Save.
7 To move an item up or down in the list, select its check box and click the Shift Up or Shift Down button.

**Modify user profile fields**
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Click the Customize User Profile link above the Users And Groups list.
4 Click the name of the field that you want to modify to open it.
5 Do any of the following:
   • Change the field name. (Although you can change it, you cannot delete it.)
   • Type, change, or delete a comment in the Comment text input box.
   • Select or deselect the Required check box for the Field Type.
6 Click Save.

**Remove user profile fields**
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Click the Customize User Profile link above the Users And Groups list.
4 Select the check boxes for the fields that you want to remove.
5 Click Remove.
6 On the remove confirmation page, click Remove to delete these fields, or click Cancel to cancel the operation.

**Set login and password policies**
Match the Adobe Connect login and password policies to the policies of your organization. Any policies you establish are valid for all Adobe Connect applications.

1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Click Edit Login And Password Policies and enter desired values.
4 Click Save.

**Login Policy**
Administrators can allow users to use e-mail address as the login. The login credentials must be unique across all users.
Password Policies
Use the settings in this section to allow for your organization’s password management policies. Administrators can enforce password expiry after a pre-defined time period, requirements of specific characters in passwords, minimum and maximum length of passwords, and use of passwords not used previously.

By default, Prevent reuse of old passwords is not selected. Administrators can enable it and can set an appropriate limit on the number of older passwords tracked. If users try to reuse their older passwords, they are prompted with an appropriate message on the user interface.

Room Passcode
If Enable Meeting Hosts To Enforce Passcode option is enabled, meeting hosts can enforce an alphanumeric password to access a meeting room. (See “Edit meeting information” on page 27.)

Social Login For Events
Select the applicable options to allow users to register and log in the event using social network profiles. When allowed event hosts control these social login options for individual events. This option is available only on hosted offering of Adobe Connect and not on the on-premise deployments.

Option to register and log in using social accounts can be enabled by an Administrator

Note: If Account Administrator disables registration via social accounts, attendees already registered via their social profiles can continue to authenticate using their social profiles. New registrations using social profiles are disabled.

Import users and groups from CSV files
Before you import users, create a CSV file containing the users you want to add to Adobe Connect. The CSV file you create must include user information in the following format:

<table>
<thead>
<tr>
<th>first-name,</th>
<th>last-name,</th>
<th>login,</th>
<th>email,</th>
<th>password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mary,</td>
<td>Betts,</td>
<td><a href="mailto:mbetts1@mycompany.com">mbetts1@mycompany.com</a>,</td>
<td><a href="mailto:mbetts1@mycompany.com">mbetts1@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Robert,</td>
<td>Blatt,</td>
<td><a href="mailto:rblatt2@mycompany.com">rblatt2@mycompany.com</a>,</td>
<td><a href="mailto:rblatt2@mycompany.com">rblatt2@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Ron,</td>
<td>Bloom,</td>
<td><a href="mailto:rbloom3@mycompany.com">rbloom3@mycompany.com</a>,</td>
<td><a href="mailto:rbloom3@mycompany.com">rbloom3@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Charles,</td>
<td>Bond,</td>
<td><a href="mailto:cbond4@mycompany.com">cbond4@mycompany.com</a>,</td>
<td><a href="mailto:cbond4@mycompany.com">cbond4@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Jennifer,</td>
<td>Cau,</td>
<td><a href="mailto:jcau5@mycompany.com">jcau5@mycompany.com</a>,</td>
<td><a href="mailto:jcau5@mycompany.com">jcau5@mycompany.com</a>,</td>
<td>private1</td>
</tr>
</tbody>
</table>

Here are some additional tips for using CSV files:

- Because of browser limitations, if you have a large number of users to add, create several smaller CSV files instead of one large CSV file.
- If the file contains empty lines, the import operation fails.
• Names that contain a comma must be in quotes. For example, the name John Doe, Jr., must appear in the CSV file as “John Doe, Jr.”.

• The header format for custom fields is x-field-id (for example, x-45704960). To determine the field ID, in Adobe Connect Central, select Administration > Users and Groups > Customize User Profile. Click the field name. In the browser address bar, locate the filter-field-id parameter in the URL. The filter-field-id value is the field-id. For example, for the custom field Cost Center, filter-field-id=cost-center, and the header format is x-cost-center.

  Note: You can also obtain the field ID from the XML API calls custom-fields or acl-field-list.

• The user information in the CSV file must take login and password policies into consideration. For example, if an e-mail address is used as the login name, the login and e-mail values in the CSV file must be identical. Alternatively, if there are password policies (certain length, format, special characters, and so on) these policies must also be applied in the CSV file.

More Help topics
“Set login and password policies” on page 226
“Create a custom group manually” on page 230
“Setting permissions for library files and folders” on page 237

Create new users
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups and then click Import.
3 Select Create New Users.
4 Under the Select File To Import bar, browse to the CSV file you want to import.
5 Click the Upload button.

If any errors occur, the first ten errors are displayed in red text. (Errors on duplicate user login/email are not reported.) Make any necessary corrections and reimport the file; then repeat steps in this procedure.

Import users from a non-UTF-8 encoded CSV file
You can import users from a CSV file that isn’t UTF-8 encoded. When importing a non-UTF-8 encoded file, append the appropriate encoding parameter to the import URL.
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups and then click Import.
3 Check the URL in the browser address line. It looks like http://<Adobe Connect Server>/admin/administration/user/import.
4 Click at the end of the URL in the browser address line and add “?encoding=<encode>” to the address. It looks like http://<Adobe Connect Server>/admin/administration/user/import?encoding=<encode>. Specific examples include the following:
  • http://<Adobe Connect Server>/admin/administration/user/import?encoding=sjis
  • http://<Adobe Connect Server>/admin/administration/user/import?encoding=euc_kr
5 After modifying the URL address, click Enter.
6 Select Create New Users.
7 Under the Select File To Import bar, browse to the CSV file you want to import.
8 Click the Upload button.

If any errors occur, the first ten errors are displayed in red text. (Errors on duplicate user login/e-mail are not reported.) Make any necessary corrections and reimport the file.

**Import groups from a CSV file**

Use the group import option to import groups into the Adobe Connect database. After you import the group CSV file, you can assign new users to the groups.

When you create the CSV file, ensure that it is in a format that Adobe Connect can use. The required column headers in the CSV file are name and description. The following is an example of a group CSV file that is adaptable for Adobe Connect:

```
name, description
group1, test1
group2, test2
```

1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Click the Import link above the list.
4 Under the Select Import Type bar, select the Create New Groups option.
5 Under the Select File To Import bar, browse to the CSV file that you want to import.
6 Click the Upload button.

If any errors occur, the first ten errors are displayed in red text. Make any necessary corrections and reimport the file; then repeat steps 3-6.

7 If you assign users to custom groups, set library permissions for the groups. For more information, see “Setting permissions for library files and folders” on page 237.

**Import users and add them to a group**

Use this option to import new users and add them to a Built-in or previously created group. The Built-in group names appear in the menu for group selection as default groups. After you create a group manually, its name also appears in the menu for group selection. You can use the import option to assign large numbers of users to multiple groups.

You can select only one group for the users you import from one CSV file. Create a different CSV file for each set of users you want to add to a specific group. After you import these users, you can assign these users to additional groups, or assign the whole group to another group.

The following example shows the minimum user information required for the CSV file. You can add other information in the CSV file to pre-populate other user properties. The CSV file you create must include user information in the following format:
Click the Administration tab at the top of the Adobe Connect Central window.

2 Click Users And Groups.

3 Click the Import link above the list of users and groups.

4 Under the Select Import Type bar, select Create New Users And Add Them To A Group.

5 Under the Select File To Import bar, browse to the CSV file that you want to import.

6 Click the Upload button.

Adobe Connect logs a message if groups in the CSV file exist in Adobe Connect.

7 Add the new users to a group. For more information, see “Add or remove group members” on page 236.

8 Set permissions for these users. For more information, see “Setting permissions for library files and folders” on page 237.

Add existing users to a group

1 Click the Administration tab at the top of the Adobe Connect Central window.

2 Click Users And Groups.

3 Click the Import link above the list.

4 Under Select Import Type, click Add existing users to a group.

5 Select a group from the pop-up menu next to the Add existing users to a group option.

6 Under the Select File To Import bar, browse to the CSV file that you want to import.

7 Click the Upload button.

Create a custom group manually

Groups that you create manually are referred to as custom groups.

A group can contain both users and other groups.

1 Click the Administration tab at the top of the Adobe Connect Central window.

2 Click Users And Groups.

3 (Optional) To check that the group does not exist, enter its name in the Search text input box at the bottom of the list.

4 Click the New Group button at the bottom of the list.

5 Enter the name and description of the new group.

6 Do one of the following:
   • To add this group without adding members, click Finish.
To add members, click Next.

7 In the Possible Group Members list, select each user and group that you want to assign to this group, as follows:
   • To select multiple users or groups, press Control-click or Shift-click.
   • To select individual names, double-click the group name. Double-click Up One Level in the list to return to the original list.
   • To search for a name in the list, click Search at the bottom of the list and enter the name.

8 Click Add.

To remove a name that you have added, select it and click Remove.

9 Repeat step 3 through step 8 for each group you want to add.

10 Click Finish.

11 Click the View Group Members button to review the group members and adjust.

**More Help topics**
“Import users and groups from CSV files” on page 227

**Create a user manually**

When you add new users, enter a new password they can use to log in to Adobe Connect. This password is sent to the user by e-mail. By default, the users are prompted to change the password after they log in for the first time. You can also add audio conference settings for users.

After you create a user, you can select a manager for the user. A user can have only one manager. If the user you created is a manager, you can assign the user team members. The manager can view report data for team members using the Manager Reports option on the Home tab.

**More Help topics**
“Import users and groups from CSV files” on page 227

**Create users**

1 Click the Administration tab at the top of the Adobe Connect Central window.

2 Click Users And Groups.

3 Click the New User button at the bottom of the list.

4 Enter the last name, first name, and e-mail address. Add any optional information, such as company name or address.

5 In the New Password text box, type a new password to mail to this user, and then retype it for confirmation. If the user has an e-mail address, leave the E-mail, The New User Account Information, Login And Password box selected. If the user does not have e-mail, deselect it.

6 (Optional) In step 5 you provide a password for users to log in for the first time.

7 (Optional) Enter any audio conference settings in the appropriate text boxes.

8 To assign this user to one or more groups, click Next.

If you don’t want to assign this user to any groups, go to step 11.
In the Possible Groups list, select each group to which you want to assign this user as follows:

- To select multiple groups, press Control-click or Shift-click.
- To select individual names, double-click the group name. Double-click Up One Level to return to the original list.
- To search for a name in the list, click Search at the bottom of the window and enter the name.

Click Add.

Click Finish.

Add team members for a user

1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Select the name of the user and click Information at the bottom of the list.

If necessary, click Search and enter the name of the user in the Search text box to locate the name in the list.

4 Click the Edit Team Members link to select team members for this user.
5 In the Possible Users list, select each team member you want to assign to this user as follows:
   - To select multiple users, press Control-click or Shift-click.
   - To search for a name in the list, click Search at the bottom of the window and enter the name.
6 Click Add.

To remove a team member you have added, select it and click Remove; to add more team members, repeat step 5 and step 6.

Managing users and groups

Edit user information

If you are an administrator, you can modify the components of a user account. You can change any information you added in custom user profile fields.

However, an Administrator cannot change a user’s password. Although you can assign a temporary password to a new user when you create the user account, you cannot later change this password. Even if a user forgets the password, you cannot change it. The user must click the “Forgot your password? Click here” link when logging in to Adobe Connect. No one can change the password of another user; you can only change your own password.

Change user information

1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Select the name of the user and click Information at the bottom of the list.

If necessary, click Search and enter the name of the user in the Search text box to locate the name in the list.

4 In the Login and Password area, you can use these options:
   - To send a link to the user so that they can reset their password, click Send a link to reset this user’s password. A message appears informing you that the e-mail was sent. Click OK to return to the User Information page.
• To set a temporary password for this user that you can provide directly (for example, by telephone), click the Set
temporary password for this user. The temporary password page appears with a system-generated password for this
user. Click Save to return to the User Information page.

A user login is suspended after five consecutive failed login attempts occur within 15 minutes. Using these options,
Administrators can help blocked users to reset their password and access their account.

5 Click the Edit Information link.

6 Edit any of the fields that you want to change.

7 Click Save.

Unblock suspended user accounts
A user login is suspended after five consecutive failed login attempts occur within 15 minutes. When an account gets
suspended, the account owner gets an email notification. Users can gain access to their suspended accounts either on
their own or with the help of an Administrator

User account suspension message

• The email notification contains the contact information of Account administrator. Account administrators can
reset the account password to a temporary password.

• Account owners can reset their password on their own by clicking forgot password and using the link in the
resulting email.

• Account owners can also use the reset link in the email notification of suspension, to reset the password.

Assign a manager to a user
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Select the name of the user and click Information at the bottom of the list.
If necessary, click Search and enter the name of the user in the Search text box to locate the name in the list.
4 Click the Select Manager link.
5 In the Possible Managers list, select the manager to whom you want to assign this user.
To search for a name in the list, click Search at the bottom of the window and enter the name.
6 Click the Set Manager button.
To remove this manager from list, select the name and click Remove Manager; to replace the manager, repeat step 5 and step 6.

Assign a user to a group
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Select the name of the user and click Information at the bottom of the list.
If necessary, click Search and enter the name of the user in the Search text box to locate the name in the list.
4 Click the Edit Group Membership link.
5 In the Possible Groups list, select each group to which you want to assign this user as follows:
   • To select multiple groups, press Control-click or Shift-click.
   • To expand a group so you can select individual names, double-click the group name. Double-click Up One Level in the list to return to the original list.
   • To search for a name in the list, click Search at the bottom of the window and enter the name.
6 Click Add.
To remove a group from this window, select it and click Remove.

Remove a user from a group
1 Click the Administration tab at the top of the Adobe Connect Central window.
2 Click Users And Groups.
3 Select the name of the user and click Information at the bottom of the list.
If necessary, click Search and enter the name of the user in the Search text box to locate the name in the list.
4 Click the Edit Group Membership link.
5 In the Current Group Membership window, select the group from which you want to remove this user as follows:
   • To select multiple groups, press Control-click or Shift-click.
   • To search for a name in the list, click Search at the bottom of the window and enter the name.
6 Click Remove.

Convert guests to full users or full users to guests
You can convert guests to full users or full users to guests. Full users can log in to Adobe Connect Central. However, guests cannot log in to Adobe Connect Central. Full users also appear on enrollment and permission lists. You can convert guests to full users. A typical example is of an Event in which many guests registered that you would now like to turn into full users.
1 Select the Administration tab in Adobe Connect Central.
2 Select Users and Groups.
3 Click Manage Guests.
4 In the Current Guests list, select a guest or in the Current Users list select a user.
5 Click Convert to User or Convert to Guest.
Delete a user account

If you are an administrator, you can delete any user account. Once the user account has been deleted, this user is permanently deleted from the system and the following occurs:

- The user is removed from all group lists.
- The user is removed from the enrollee lists for all courses.
- Reports for the user are no longer available.
- If the deleted user was a manager, direct reports now have a blank manager field.
- If the deleted user created any content, assign another user to manage the content.
  
  If the user is a member of a Built-in group, the group is credited with one member. For example, if the deleted user was a member of the Authors group, the Authors group can add a user.

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. If necessary, click Search and enter the name of the user in the Search text box to locate the name in the list.
4. Select the name of the user. (You can select multiple users by pressing Control-click or Shift-click to delete more than one user simultaneously.)
5. Click Delete at the bottom of the list.
6. On the confirmation page, click Delete to delete the user, or click Cancel to cancel the operation.

More Help topics

“Delete a group” on page 236

View group information

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. Select the group name and click Information at the bottom of the list.
   
   If necessary, click Search and enter the group name in the Search text box to locate the name in the list.
4. Click the View Group Members button.

More Help topics

“Change a group name or description” on page 235

“Add or remove group members” on page 236

Change a group name or description

If you are an administrator, you can edit the name or description for any group— even Built-in groups, although Adobe does not recommend this practice.

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. Select the name of the group and click Information at the bottom of the list.
If necessary, click Search and enter the name of the group in the Search text box.

4  Click the Edit Information link.
5  Edit the fields you want to change.
6  Click the Save button.

**Add or remove group members**

If you are an administrator, you can add both users and groups to a group. You can also remove them.

**Add members to a group**
1  Click the Administration tab at the top of the Adobe Connect Central window.
2  Click Users And Groups.
3  Select the name of the group and click Information at the bottom of the list.

If necessary, click Search and enter the name of the group in the Search text box to locate the name in the list.

4  Click the View Group Members button.
5  In the Possible Group Members list, select each user or group that you want to add to this group as follows:
   •  To select multiple groups, press Control-click or Shift-click.
   •  To expand a group so that you can select individual names, double-click the group name. Double-click Up One Level in the list to return to the original list.
   •  To search for a name in the list, click Search at the bottom of the window and enter the name.
6  Click Add.

To remove a user or group from this window, select it and click Remove.

**Remove members from a group**
1  Click the Administration tab at the top of the Adobe Connect Central window.
2  Click Users And Groups.
3  Select the name of the group and click Information at the bottom of the list.

If necessary, click Search and enter the name of the group in the Search text box to locate the name in the list.

4  Click the View Group Members button.
5  In the Current Group Membership window, select each user and group that you want to remove from this group, as follows:
   •  To select multiple users or groups, press Control-click or Shift-click.
   •  To search for a name in the list, click Search at the bottom of the window and enter the name.
6  Click Remove.

**Delete a group**

If you are an administrator, you can delete any group except a Built-in group. Deleting a group does not delete individual members of the group.
Before deleting a group, consider the impact on the permissions of the members and other groups. If the group had permissions to access files or folders in a library, the group members can no longer access those files or folders. However, the members can still access the files and folders if they belong to another group with permissions for those files or folders.

1. Click the Administration tab at the top of the Adobe Connect Central window.
2. Click Users And Groups.
3. Select the name of the group. (You can select multiple groups by pressing Control-click or Shift-click to delete more than one group simultaneously.)
   If necessary, click Search and enter the name of the group in the Search text box to locate the name in the list.
4. Click Delete at the bottom of the list.
5. On the confirmation page, click Delete to delete the group; click Cancel to cancel the operation.

More Help topics
“Delete a user account” on page 235

Setting permissions for library files and folders

Administrators, limited administrators, and users with Manage permissions for a folder can set permissions for working with content in Adobe Connect libraries. An administrator must design the permissions structure for an account. Once the permissions structure is created, users with Manage permissions for folders in libraries can set permissions for those folders.

More Help topics
“Working with library files and folders” on page 187
“Working with content in the Content library” on page 190

Workflow for setting permissions

To avoid listing and managing large numbers of users on the permission profile for a file or folder, use a group-based permission system. Create your system as follows:

1. Design a permissions system using groups
   You can give certain groups access to parts of the system as appropriate. To design your system, understand libraries, groups, and permissions precedence. See “Libraries” on page 238, “Built-in permission groups” on page 239, and “Multiple permissions precedence” on page 245.

2. Create folders using descriptive names
   Use names that describe the contents of the folder—for example, Human Resource Content, Product Support Content, and so on. See “Set permissions for content files and folders” on page 245.

3. Create custom groups using descriptive names
   Use names that describe the permissions of the group—for example, Human Resource Content Managers, Shared Content Viewers, and so on. See “Create a custom group manually” on page 230.
4. **Assign permission types for your groups to specific folders or files**

For example, assign the Human Resource Content Managers group permission to manage the Human Resources folder in the Shared Content folder. See “Set permissions for content files and folders” on page 245.

5. **Add users to groups**

It’s easier to create groups first, then add users to whichever groups are necessary for them to obtain appropriate permissions. See “Add or remove group members” on page 236.

Permissions assigned to users take precedence over permissions assigned to groups. If you want to deny a user access to certain folders, you can assign a user-based permission for those folders.

**Libraries**

The Content, Training, Meetings, Seminars, and Event Management tabs in Adobe Connect Central each contain a library of files organized in folders. Files that you store in the Training, Meetings, Seminars, and Event Management libraries are available for activities in those respective tabs only. Files in the Content library can be accessed from all tabs in Adobe Connect Central.

Administrators, limited administrators, and users with Manage permissions can set permissions to determine which tasks each user can perform in the libraries.

*Note:* Administrators set permissions for limited administrators in the Administration > Users and Groups section of Adobe Connect Central. By default, limited administrators can set permissions for content, but an administrator could choose to revoke this ability.

Except for the Seminar library, each library has the following two top-level folders:

**Shared Content** When Adobe Connect is installed, only the administrator has access privileges to the Shared folders. Administrators can assign permissions for the Shared folders in any way appropriate. Only members of the Built-in group associated with that library can create new functions (meetings, events, and so on) in the folder. However, Manage permissions for a Shared folder can be assigned to any user. For example, in the Meetings library, any user with Manage permissions for a folder can manage the folder. Only meeting hosts can create new meetings in a folder.

**User Content** When a user is assigned to a specific Built-in group, Adobe Connect creates a user folder for that individual in the associated library. For example, any users assigned to the meeting host group receive a folder in the User Meetings folder in the Meetings library. It is this folder the user sees when accessing the Meetings tab. Users can manage their own user folders, including setting permissions that give other users access privileges to the folders.
Seminar library folders have a different structure. In the Seminar library, there are no user folders; instead, each folder represents a different seminar license that your organization purchased. Users assigned to the Seminar Administrators group have Manage permissions for all Seminars folders. Seminar Administrators can add and delete seminars, assign Manage permissions to other users, and create new seminars.

**Built-in permission groups**

Adobe Connect has eight built-in permission groups, each associated with a different library. Each member of a Built-in group has a user folder in the corresponding library. Each member of the Meeting Hosts and Training Managers groups also has a user folder in the Content library, and can author content for that folder.

You cannot change the permissions for these groups, but you can extend them by assigning individuals or groups to more than one built-in group. In addition, the administrator can create custom groups and assign these groups permissions for specific library folders.

There are eight built-in groups:

- Administrators
- Administrators - Limited
• Meeting Hosts
• Training Managers
• Virtual Classroom Managers
• Seminar Hosts (Adobe Connect 9.4 onwards, this group is called Seminar Administrators.)
• Event Managers
• Webinar Managers
• Event Administrators
• Authors
• Learners

Each group reflects a specific set of access needs across all the libraries. There are groups for each purchased account feature. For example, the Event Manager group only exists if the Events feature is part of the account.

Administrators assign users and groups to the appropriate Built-in groups. Members of a Built-in group can create new instances of the function associated with that library. For example, if you are a meeting host, you can create new meetings.

Members of a Built-in group cannot access the Shared folder directory of the library of the group unless you assign them Manage permissions. You can also assign Manage permissions for a folder in the Shared folder directory to other users who are not part of that Built-in group. Although they can manage folders, they cannot create anything in that library, because they are not part of that Built-in group.

The following table summarizes the permissions each Built-in group has for each library:

<table>
<thead>
<tr>
<th>Built-in group</th>
<th>Content library</th>
<th>Training library</th>
<th>Meetings library</th>
<th>Seminar library</th>
<th>Events library</th>
<th>Additional permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Everything but Publish</td>
<td>Manage</td>
<td>Manage</td>
<td>Manage</td>
<td>Manage</td>
<td>Manage users, groups, and user accounts; view content folders for all users</td>
</tr>
<tr>
<td>Author</td>
<td>Publish/Manage</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Learner</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Training Manager</td>
<td>Publish/Manage personal folder</td>
<td>Manage</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Virtual Classroom Manager</td>
<td>Publish/Manage personal folder</td>
<td>Manage</td>
<td>None</td>
<td>None</td>
<td>Manage</td>
<td>None</td>
</tr>
<tr>
<td>Meeting Host</td>
<td>Publish/Manage personal folder</td>
<td>None</td>
<td>Manage</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Event Manager</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>Manage</td>
<td>None</td>
</tr>
</tbody>
</table>
Administrators group
Administrators have complete control of the entire Adobe Connect system. You can make any user an administrator by adding them to the Administrator group. Individual or other group permission cannot override the permissions for the members of the Administrator group.

Administrators can perform the following actions:

- Manage the users and groups in the account, including creating, deleting, and editing them.
- Manage the Content library, including viewing, deleting, moving, and editing files or folders. View reports for files. Set permissions for files or folders. Create new subfolders.
- Manage the Training library, including viewing, deleting, moving, and editing files or folders. View reports for files. Set permissions for files or folders. Create new subfolders. Enroll users, send notifications to enrollers, and set up course and curriculum reminders.
- Manage the Meetings library, including viewing, deleting, moving, and editing files or folders. View reports for files. Set permissions for files or folders. Create new subfolders.
- Manage the Event library, including viewing, deleting, moving, and editing files or folders. View reports for files. Set permissions for files or folders. Create new subfolders. Send invitations, and change content and e-mail options.
- Manage the Seminar library, including viewing, deleting, moving, and editing files or folders. View reports for files. Set permissions for files or folders. Create new subfolders.
- View account information, account features, account quotas, and account reports. If your organization has purchased this option, customize the Adobe Connect branding.

Limited administrators group
Limited administrators have limited control of the Adobe Connect system. You can make any user a limited administrator by adding them to the Administrator - Limited group. Administrators can determine which permissions limited administrators have.

Authors group
If you assign a user to this group, Adobe Connect creates a folder for this user in the User folder of the Content library. (The shortcut called My Content points to this folder.) By default, a member of the Authors group has Publish and Manage permissions only for the My Content folder.

Your account limits the number of users that you can add to the Authors group.
Members of the Authors group can perform all of the following actions if they have Publish permissions on the specified folder:

- View content and content folders.
- Publish and update content.
- Send e-mail messages containing links that send a notification to the author as soon as the recipient accesses the link.

**Training Managers group**

Members of the Training Managers group are users who are responsible for organizing and coordinating training.

If you assign a user to this group, Adobe Connect creates a folder for this user in the User folder of the Training library. (The shortcut My Training points to this folder.) By default, a training manager can manage only their folder in the User Training folder.

A training manager can perform the following actions:

- Manage their own user folder in the Training library, performing all file-management functions, as well as create and manage courses and curriculums, enroll users, send notifications to enrollers, and set up reminders.
- Have access to folders in the Content library.
- View training reports for the courses or curriculums that they created.

**Virtual Classroom group**

Members of this new group can create virtual classrooms with a capacity of up to 200 participants in the My Trainings section. The group members also have access to the Event Management section.

- All Training Manager permissions
  - Access to Content and Training tabs
  - My Content and My Training folders, with manage permissions
  - Content dashboard
  - Shared Training, with manage permissions
  - Training Catalog, with manage permissions
  - Users and Groups (Training tab)
  - Training dashboard
  - Can see reports inside specific training
  - Reports tab with permissions to Content, Course, Curriculum, Virtual Classrooms, Learner, and Saved Queries sections.
- All Event Manager permissions
  - My Events tab, with manage permissions
  - Shared Events, with manage permissions
  - Event dashboard
  - Can see reports inside specific event
  - Can view Event Catalog (Can edit Event Catalog if also a member of Event Administrators group)
  - Ability to create his own event and email templates (Cannot edit shared templates unless also a member of Event Administrators group)
• Ability to see available Event tags when creating or editing Events (Cannot apply Featured Event tag unless also a member of Event Administrators group)
• Ability to see available email aliases when customizing event email triggers and selecting Reply To option
• Ability to see available Campaign IDs when creating or edition events

Event Managers group
If you assign a user to this group, Adobe Connect creates a folder for this user in the User folder of the Event library. An Event Manager can perform the following actions:
• Manage events in the shared folders if they are hosting the event and have manage permissions for the folder that contains an event.
• Manage their own Event library user folder, performing all file-management functions, and create and manage all aspects of an event in this folder.
• View event reports.
• Create events and manage their own folders in the Event library.
• Create private templates or make private copies of existing shared templates.
• Assign attendee roles when setting up the event in the Participant Management tab.

Event Administrators group
Members of the Event Administrators group assign users to the Event Managers group and perform the overall administration of an event. An Event Administrator can perform the following actions:
• Assign Event Manager role to the registered users.
• Create custom event templates and manage existing shared templates. Update, rename, delete, or copy existing templates.
• Create and manage tags in the Event Catalog. Event tags make it possible to filter the events in the Event Catalog.
• Apply the Featured Event tag to display an event in the Featured Events section of the Event Catalog.
• Create Reply To options for email triggers
• Configure analytics, by providing Adobe SiteCatalyst credentials.
Using the tags and the templates, Event Administrators control the Event Catalog layout and branding completely.

Meeting Hosts group
Members of the Meeting Hosts group create meetings.
If you assign a user to this group, Adobe Connect creates a folder for this user in the User folder of the Meetings library. Meeting hosts can manage only their My Meetings folders in the User Meetings folder. Meeting hosts can manage meetings in the Shared folders if they are hosting the meeting and have Manage permissions for the folder that contains the meeting.
A meeting host can perform the following actions:
• Manage their User Meetings folder, performing all file-management functions, and create and manage meetings, which involve adding, deleting, and assigning attendance permissions to presenters and participants. Create and organize meeting rooms. Edit a meeting or change its participant list.
• View meeting reports.
• Create content.
• View content files and folders for which they have access permissions.
• Publish and update content.

**Seminar Administrators group**
Because of the way seminars are licensed, the permissions for Seminar Administrators are different from other groups.

Unlike other libraries, the Seminar library does not have a User folder. The Seminar library consists only of the Shared folder, and each folder in this directory corresponds to a seminar license that your organization purchased. Only Seminar Administrators and Account Administrators can manage these folders. A Seminar Administrator can manage all the folders in the Seminar library.

Seminar hosts can perform the following actions:
• Manage all Seminar library folders, performing all file-management functions, and create and manage seminars, which involve adding, deleting, and assigning attendance permissions to presenters and participants; creating and organizing seminar rooms; and editing a seminar or changing its participant list.
• View seminar reports.

**Webinar groups**
Three new groups defined are Webinar Manager 100, Webinar Manager 500, and Webinar Manager 1000. The numbers indicate the maximum participant capacity. These groups are available as system groups with membership driven by the number of licenses provisioned in any account. A user can be a member of only one of these three groups at a time.

The members can create seminars in the My Seminar tab within the license they own. Also, the members cannot access the seminars they do not have access to.

• All Seminar Administrator permissions
  • Access to Seminars tab, Seminar Sessions, Seminar Calendar, and Seminar Dashboard with access to content they own
  • Can schedule sessions in My Seminars tab, from shared seminar licenses and named webinar license they own
  • No access to User Seminars tab
• All Event Manager permissions
  • My Events tab, with manage permissions
  • Shared Events, with manage permissions
  • Event dashboard
  • Can see reports inside specific event
  • Can view Event Catalog (Can edit Event Catalog if also a member of Event Administrators group)
  • Ability to create his own event and email templates (Can edit shared templates if also a member of Event Administrators group)
  • Ability to see available Event tags when creating or editing Events (Can apply Featured Event tag if also a member of Event Administrators group)
  • Ability to see available email aliases when customizing event email triggers and selecting **Reply To** option
  • Ability to see available Campaign IDs when creating or edition events
  • Meeting rooms created by this user have Engagement Dashboard pod available
About custom groups

Custom groups are groups that you create yourself. You can define specific folder and file permissions for the group in the different libraries. You can assign permissions to a custom group by assigning it to the appropriate Built-in groups.

For example, you could create a custom group called “Global” that contains a group for each country in which your company has an office (for example, United States and Germany). Each country group could contain a group for each office in that country (for example, San Francisco and Boston). Within each of these offices, you could define more groups by job function, and then assign each of these groups the appropriate Built-in group designations.

In this example, you created a hierarchical set of groups called nested groups, because each group is contained by the one above it in the hierarchy. By default, nested groups have the permissions of the parent group. You can expand or restrict these permissions by setting custom permissions for these groups in the relevant libraries.

Multiple permissions precedence

If a user belongs to one or more groups, it is possible that multiple permissions apply to a single file or folder. In such a case, permissions are resolved as follows (higher numbered levels take precedence):

- **Level 1**: If the user has View, Publish, or Manage permissions through group-acquired permissions, the permission granting the greatest access to features applies. These three group permissions are additive.
- **Level 2**: If the user has any Denied permission through group-acquired permissions, all group-acquired View, Publish, or Manage permissions are removed and the user is not allowed access.
- **Level 3**: If the user has View, Publish, or Manage permissions through user-specific permissions, these permissions are additive to the corresponding group-acquired permissions. In addition, these permissions override any group-acquired Denied permission.
- **Level 4**: If the user is assigned the Denied permission setting through user-specific permissions, the user is denied access regardless of any group-acquired permissions.
- **Level 5**: If the user is a member of the Administrator group, the administrator permission applies, regardless of any other individual or group setting.
- **Level 6**: If there are no permissions applied by either user or group (and none is inherited from a parent folder), the user cannot access or perform any actions on the folder or file.

The following table illustrates the way that group and user permissions apply:

<table>
<thead>
<tr>
<th>Group G1 permissions</th>
<th>Group G2 permissions</th>
<th>Union (G1, G2) permissions</th>
<th>User permissions</th>
<th>Resulting permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Publish</td>
<td>Publish</td>
<td>Manage</td>
<td>Publish+Manage</td>
</tr>
<tr>
<td>Manage</td>
<td>None</td>
<td>Manage</td>
<td>Publish</td>
<td>Publish+Manage</td>
</tr>
<tr>
<td>Denied</td>
<td>Publish</td>
<td>Denied</td>
<td>Manage</td>
<td>Manage</td>
</tr>
<tr>
<td>View</td>
<td>Manage</td>
<td>Manage</td>
<td>View</td>
<td>Manage</td>
</tr>
<tr>
<td>Manage</td>
<td>None</td>
<td>Manage</td>
<td>Denied</td>
<td>Denied</td>
</tr>
<tr>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

Set permissions for content files and folders

Only an administrator, a limited administrator, or a user with Manage permission for that library file or folder can customize the permissions list for a file or folder.
Note: Administrators set permissions for limited administrators in the Administration > Users and Groups section of Adobe Connect Central. By default, limited administrators can set permissions for content, but an administrator could choose to revoke this ability.

1. Click the Content, Training, Meetings, Seminars, or Event Management tab in Adobe Connect Central.
2. Navigate to the folder or file and click its name to open it.
3. Click Set Permissions on the navigation bar.
4. Click Customization. (If the permissions for this item have been modified before, the Customization button does not appear. Proceed to the next step.)

The Available Users and Groups pane displays users and groups for whom you can define permissions for the library item. The Current Permissions pane displays users and groups who already have permissions for the library item. You can change the existing permissions if desired.

5. To add a user or group to the Current Permissions pane, select the name in the Available Users And Groups list and click Add.

6. To set the permissions for a user or group, select the name in the Current Permissions list and click Permissions.

7. Select one of the following permissions from the pop-up menu:

   Manage Users or groups with Manage permission for a folder or file can view, delete, move, and edit the file or folder, view reports for files in that folder, set permissions for the file or folder, and create new folders. However, they cannot publish to that folder.

   Denied Users or groups with a Denied permission setting for a folder or file cannot view, publish, or manage this folder or file.
**Publish** Users or groups with a Publish permission setting for a folder or presentation can publish, update, and view presentations, as well as view reports for files in that folder. However, these users must also be members of the Built-in Author group, as well as have Publish permission, to publish content to this folder.

**View** Users or groups with a View permission setting for a folder or file can view any content in the folder, or can view the individual file.

---

**Generating reports in Adobe Connect Central**

**About Adobe Connect Central reports**

The reporting feature in Adobe Connect enables you to quickly and easily obtain a wide variety of useful data about your Adobe Connect installation.

The wizard-based interface lets you select a general type of report, and then make choices to specify exactly the information that you need. For example, suppose that you choose to create a course report. After selecting a course, you view current enrollment details or view the entire enrollment history for the course. Another example is when you create a meeting report, you view a summary of activity for one room over time. Alternatively, you view details about one specific meeting session.

Information provided in the system usage reports help you fine-tune your Adobe Connect installation and costs. For example, you can obtain facts about system activity for a particular cost center.

Important general information about reports:

- If you have direct reports, click Manager Reports to see data about trainings completed, meetings attended, and events attended for each direct report. Click the name of a direct report to list their direct reports.
Groups cannot be used as a sort option. The groups column contains multiple values if a user is a member of multiple groups. When a user belongs to more than one group and you sort by group, sorting only uses the first group in the list. For information aggregated by group, use the Group report option where available, for example, in the Learner and User reports.

- The default sort order for all reports that contain user names is by last name.
- Sort column information in ascending or descending order by clicking the column headers (except the group column header).
- Add or remove column headers dynamically by selecting or deselecting “Select fields” in the Report wizard.

Note: If you upgraded from Adobe Connect Enterprise Server 6 to Adobe Connect Server 7, legacy training materials migrated to the new server. However, the Adobe Connect Server 7 Reports wizard supports new data fields that are not reported for legacy training materials. The new data fields appear blank. Also, the definitions of some fields in the new reports may be slightly different from the fields offered in the old reports. For example, in the new reports the field “enrolled” includes all enrolled users, but in the old reports it only included active enrolled users. For details about report fields, see individual report descriptions in this document.

Working with reports

After you create a report, use the Report wizard to do any of the following:

- Click New or Cancel to return to the home page of the Report wizard.
- Click Edit Query or Previous to change filter and field settings.
- Click Save Report and give the report a descriptive name so you can access it from the Saved Queries module.
- Click Print to print the report.
- Click Download Report to save the report as a CSV file.

Accessing reports

Your access to reports is based on the groups to which you belong.

<table>
<thead>
<tr>
<th>Built-in group</th>
<th>Report module permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>All</td>
</tr>
<tr>
<td>Limited Administrator</td>
<td>System Usage, Saved Queries. However, administrators can remove access. See &quot;Creating administrators&quot; on page 202.</td>
</tr>
<tr>
<td>Authors</td>
<td>Content, Saved Queries.</td>
</tr>
<tr>
<td>Training Managers</td>
<td>Content, Course, Curriculum, Virtual Classroom, Learner, Saved Queries.</td>
</tr>
<tr>
<td>Event Managers</td>
<td>None.</td>
</tr>
<tr>
<td>Learners</td>
<td>None.</td>
</tr>
<tr>
<td>Meeting Hosts</td>
<td>Meeting, Saved Queries.</td>
</tr>
<tr>
<td>Seminar Administrators</td>
<td>None.</td>
</tr>
</tbody>
</table>

Creating custom fields in reports

Adobe Connect offers you the flexibility to customize reports. Through customization, you create reports that show you just the information you want to see. You can eliminate columns of information you don’t require and add columns that give you data you need. Refining reports makes your reports smaller in size and more useful.
When you customize a user profile, the top 20 fields appear and you can assign custom field priority. It is important to prioritize custom fields in order of importance; reports include only the top ten fields, including the e-mail custom field.

For details about how to create custom fields, see “Customize user profile fields” on page 225.

**Analyze a sample report**

The following steps were taken to create the sample report:

1. Click the Reports tab at the top of the Adobe Connect Central window.
2. Click Curriculum.
3. Navigate to a specific curriculum, select the curriculum, and click Next.
4. On the left, click Specify Report Filters.
5. Select Filter Using A Date Range and enter dates.
6. Select Filter By User Groups and select a group.
7. On the left, select Add or Remove Report Fields.
8. Select additional fields, as desired.
9. On the left, select Options.
11. Click Create Report.

The sample report shows the following information:

- The name of the curriculum is ABC Curriculum.
- The report was filtered to only show data from September 1, 2006 to October 1, 2008.
- The report was filtered to only show members of the group named Alphabet Group.
• The following information shows in the Summary section:
  • In the selected group, there are 26 learners enrolled in the curriculum.
  • Of the 26 enrolled learners, 4 have completed the curriculum.
  • Of the 26 enrolled learners, 10 have completed some of the curriculum. They are reported as “Number in Progress.”
  • Of the 26 enrolled learners, 12 have not started the curriculum. They are reported as “Number not Started.”
• The following detailed information is listed below the Summary section:
  • Last name of each learner from the specified group enrolled in the curriculum.
  • First name of the learner.
  • Status of the learner, such as Not Taken, In Progress, or Complete.
  • If applicable, the certificate number for the learner. (The certificate number is a system-generated number and unique ID that proves the learner completed the curriculum.)
  • The version of the curriculum that the learner has used. (Update curriculums by adding learners or changing content and such changes. Some creators never update their curriculums, so there is one version only.)
  • Date and time the learner last accessed the curriculum.
  • The name of the group to which the learner is assigned. For this report, it is specified that only the information about learners in the Alphabet Group is viewed. So only one group name is listed.

After viewing the report, you have several options. To sort the information in different ways, click column headers. For example, in the sample report, click Last Access to see which learners have accessed the curriculum recently. You can also save, print, or download the report.

Using course reports
Course reports provide information about individual courses you created and the learners enrolled in the course. The course report shows how a course is used. The report lists if the course is taken, how often it is taken, and if users pass, fail, or complete the course. Course reports showing individual learners taking a specific course enable you to see who has taken the course, their status, and their score.

The historical course report includes information about unenrolled and deleted users. Viewing data about unenrolled and deleted learners helps you analyze how the course has been used over time. For example, you can see how many learners have not completed the course and if that number is rising or falling.

Create course reports
1 Log in to Adobe Connect Central and click Reports.
2 Click Course.
3 Select a course from the Training library and click Next.
4 Click Specify Report Filters. (Optional) Enter a date range and/or select a specific User Group.
5 Click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
6 Click Options. Select the course report to create: Course Report or Historical Course Report Which Includes Unenrolled And Deleted Users
7 Click Create Report.
Read course reports
The table lists the specific information that appears in columns within course reports. All column headings do not appear in all course reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempts</td>
<td>The number of attempts made to pass the course compared to number of attempts allowed. For example, 1 of 3 means that the learner made one attempt and a total of three attempts are available.</td>
</tr>
<tr>
<td>Certificate</td>
<td>A system-generated number that proves the learner completed the course and provides the learner with a unique ID. (Course status for a learner must be complete or passed to receive a certificate number.)</td>
</tr>
<tr>
<td>Date deleted</td>
<td>Where applicable, the date the learner was deleted from the Adobe Connect Enterprise system.</td>
</tr>
<tr>
<td>Date enrolled</td>
<td>Date the learner was added to the enrollment list for the course.</td>
</tr>
<tr>
<td>Date unenrolled</td>
<td>Date the learner was removed from the enrollment list for the course.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the learner enrolled in the course.</td>
</tr>
<tr>
<td>Group</td>
<td>All groups this learner is a member of are listed here. This column does not sort.</td>
</tr>
<tr>
<td>Last access</td>
<td>Last time the learner accessed the specific course.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of the learner enrolled in the course.</td>
</tr>
<tr>
<td>Manager</td>
<td>The first and last name of the user’s manager.</td>
</tr>
<tr>
<td>Number complete</td>
<td>Number of learners who completed the course.</td>
</tr>
<tr>
<td>Number enrolled</td>
<td>Total number of learners ever enrolled in the course. Archival data is included.</td>
</tr>
<tr>
<td>Number failed</td>
<td>Learners who failed the course.</td>
</tr>
<tr>
<td>Number in progress</td>
<td>Learners who started, but not yet completed the course.</td>
</tr>
<tr>
<td>Number not started</td>
<td>Learners who did not start the course.</td>
</tr>
<tr>
<td>Number passed</td>
<td>Learners who passed the course.</td>
</tr>
<tr>
<td>Score</td>
<td>Score the learner received for the course.</td>
</tr>
<tr>
<td>Status</td>
<td>Where the learner is in the course workflow. For example, the learner has not opened the course (Not Started), has opened, but not completed the course (In Progress), or has finished the course (Complete).</td>
</tr>
<tr>
<td>Version</td>
<td>If multiple versions of the course were uploaded, this column states which version the learner used.</td>
</tr>
</tbody>
</table>

Using curriculum reports
Curriculum reports show how learners use a curriculum and the courses and virtual classrooms in the curriculum. The curriculum report lists summary information, such as how many learners are enrolled and how many are in progress. The report also shows information about learners enrolled in the curriculum, including their name, status, and the last time they accessed the curriculum.

The curriculum objects report lists information by learning objects, usually a course or a virtual classroom. You can see data such as the name of the learning object, the average learner score for the object, and if prerequisites are set. Viewing curriculum object data can help you analyze how learners are using specific objects within a curriculum.

Create curriculum reports
1. Log in to Adobe Connect Central and click Reports.
2. Click Curriculum.

Last updated 3/20/2015
3 Select a curriculum from the Training library and click Next.
4 Click Specify Report Filters. (Optional) Enter a date range and/or select a specific User Group.
5 Click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
6 Click Options. Select the curriculum report to create: Curriculum Report or Curriculum Report Showing Curriculum Objects.
7 Click Create Report.
8 (Optional) If you selected Curriculum Report Showing Curriculum Objects in step 6, click the name of any learning object in the generated report. Clicking a name creates a report about the specific learning object.

**Read curriculum reports**
The table lists the specific information that appears in columns within curriculum reports. All column headings do not appear in all curriculum reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active version</td>
<td>If there are multiple versions of the curriculum object, the latest version is listed here.</td>
</tr>
<tr>
<td>Average score</td>
<td>The average learner score for the curriculum object.</td>
</tr>
<tr>
<td>Certificate</td>
<td>A system-generated number that proves the learner completed the curriculum and provides the learner with a unique ID. (Curriculum status for a learner must be complete or passed to receive a certificate number.)</td>
</tr>
<tr>
<td>Contents</td>
<td>Description of curriculum object, such as presentation or Flash movie file.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the learner enrolled in the curriculum.</td>
</tr>
<tr>
<td>Group</td>
<td>All groups the learner is a member of are listed here. This column does not sort.</td>
</tr>
<tr>
<td>Last access</td>
<td>Last time the learner opened the curriculum.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of the learner enrolled in the curriculum.</td>
</tr>
<tr>
<td>Learning object</td>
<td>Name of the learning object.</td>
</tr>
<tr>
<td>Number complete</td>
<td>Learners who have completed the curriculum.</td>
</tr>
<tr>
<td>Number enrolled</td>
<td>Learners who have enrolled in the curriculum.</td>
</tr>
<tr>
<td>Number in progress</td>
<td>Learners who have started, but not yet completed the curriculum.</td>
</tr>
<tr>
<td>Number not started</td>
<td>Learners who have not started the curriculum.</td>
</tr>
<tr>
<td>Percentage complete</td>
<td>Percentage of learners who have “Completed” status for the curriculum object.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Complete these curriculum objects before attempting the curriculum object listed on this line.</td>
</tr>
<tr>
<td>Required or Optional</td>
<td>States if learner must complete the curriculum object to complete the curriculum or if the object is optional.</td>
</tr>
<tr>
<td>Status</td>
<td>Where the learner is in the curriculum workflow. For example, the learner has not opened the course (Not Started), has opened but not completed the course (In Progress), or has finished the course (Complete).</td>
</tr>
<tr>
<td>Test Outs</td>
<td>Curriculum objects that can be completed instead of the object listed on this line.</td>
</tr>
<tr>
<td>Type</td>
<td>Description of the curriculum object.</td>
</tr>
<tr>
<td>Version</td>
<td>If multiple versions of the curriculum were uploaded, this column states which version the learner used.</td>
</tr>
</tbody>
</table>
Using learner reports

Learner reports show all course, virtual classroom, and curriculum activity for an individual or group. The individual learner report enables you to see how a learner is progressing through assigned training. Detailed information in the report includes number of assignments given to the learner, number completed, number in progress, and number not started. The group learner report shows similar information, but for an entire group instead of a single learner.

Learner reports are useful because they show details about how individuals and groups are using your courses and curriculums. You can determine if learners are taking and completing training assignments, how quickly they are working, and what scores they are receiving.

Create learner reports

1. Log in to Adobe Connect Central and click Reports.
2. Click Learner.
3. From the menu, select a Learner report type: Individual Learner or Group.
4. Select an individual learner or a group and click Next.
5. Click Specify Report Filters. (Optional) Enter a date range.
6. Click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
7. Click Create Report.
8. (Optional) If you selected Individual Learner report in step 3, click the name of any learning object in the generated report. Clicking a name creates a report about the specific learning object.

Read learner reports

The table lists the specific information that appears in columns within learner reports. All column headings do not appear in all learner reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempts</td>
<td>Number of times the learner tried to complete the learning object. (Attempts are tracked at the learning object level only.)</td>
</tr>
<tr>
<td>Certificate</td>
<td>A system-generated number that proves the learner completed the course, virtual classroom, or curriculum and provides the learner with a unique ID. (Course or curriculum status for a learner must be complete or passed to receive a certificate number.)</td>
</tr>
<tr>
<td>Contents</td>
<td>If the learning object is a course, the course content type is listed, such as presentation or image.</td>
</tr>
<tr>
<td>Last access</td>
<td>For a curriculum, the date when any object within the curriculum was last accessed.</td>
</tr>
<tr>
<td>Learning object</td>
<td>Name of the learning object.</td>
</tr>
<tr>
<td>Number complete</td>
<td>Learners who completed the learning object.</td>
</tr>
<tr>
<td>Number in progress</td>
<td>Learners who are still in progress with the learning object.</td>
</tr>
<tr>
<td>Number not started</td>
<td>Learners who did not start the learning object.</td>
</tr>
<tr>
<td>Number of learning assignments</td>
<td>Total number of assignments. If the learner is enrolled in a course outside a curriculum, and the course also exists within the curriculum, the item is counted twice.</td>
</tr>
<tr>
<td>Score</td>
<td>Score achieved on learning objects attempted to date.</td>
</tr>
</tbody>
</table>
Using content reports

Content reports provide detailed information about the content you have uploaded to Adobe Connect. (Content can be in the following formats: PPT, PPTX, FLV, SWF, PDF, GIF, JPG, PNG, mp3, HTML, or ZIP.) For example, a content report about a PDF shows page name, number of times each page was viewed, and last date each page was viewed.

A content report showing question details enables you to view information about questions in a presentation (PPT or PPTX file). For example, you could select a presentation containing a question with five multiple choice answers. Running a content report showing question details allows you to see how many learners picked each of the five possible answers. This report is useful for refining the questions in your presentations. If you feel too many learners are passing or failing a presentation, use this report to determine which questions to make easier or more difficult.

Create content reports
1. Log in to Adobe Connect Central and click Reports.
2. Click Content.
3. Select a piece of content from the library and click Next.
4. Click Specify Report Filters. (Optional) Enter a date range and/or select a specific User Group.
5. Click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
6. Click Options. Select the type of content report to create: Content Report or Content Report Showing Question Details.
7. Click Create Report.

Read content reports
The table lists the specific information that appears in columns within content reports. All column headings do not appear in all content reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Where the learner is in the course/curriculum workflow. For example, the learner has not opened the course/curriculum (Not Started), has opened but not completed the course/curriculum (In Progress), or has finished the course/curriculum (Complete).</td>
</tr>
<tr>
<td>Type</td>
<td>Description of the learning object. For example, course, curriculum, or classroom.</td>
</tr>
<tr>
<td>Version accessed</td>
<td>If multiple versions of the learning object were uploaded, this column states which version the learner used.</td>
</tr>
<tr>
<td>Average score</td>
<td>The average learner score for the content.</td>
</tr>
<tr>
<td>Content type</td>
<td>Description of the content. For example, presentation, image, or SWF file.</td>
</tr>
<tr>
<td>Current disk usage</td>
<td>Current size, in KB, of the content file.</td>
</tr>
<tr>
<td>Last modified date</td>
<td>Last date that changes were made to the content file.</td>
</tr>
<tr>
<td>Last view date</td>
<td>Last date that a user viewed the content file.</td>
</tr>
<tr>
<td>Maximum score</td>
<td>Highest score a learner received on the content file.</td>
</tr>
<tr>
<td>Minimum score</td>
<td>Lowest score a learner received on the content file.</td>
</tr>
<tr>
<td>Number of questions</td>
<td>Total number of questions the content file contains.</td>
</tr>
</tbody>
</table>
Using virtual classroom reports

Virtual classroom reports provide details about how virtual classrooms are being used over time. Use the Virtual Classroom Report to see the names, enrollment dates, and completion status for learners in the classroom.

Use the Virtual Classroom Session Attendance Report to view data about a specific session within a virtual classroom. You can see details such as session duration, total number of attendees, attendee names, and the times attendees entered and exited. The information in this report helps you determine if the correct people attended a session and how long they remained in the room. You can also compare different sessions. For example, suppose that the same training course is offered in the same virtual classroom at two different times. By running a session report for each time, you can determine which one had higher attendance.

Create virtual classroom reports

1. Log in to Adobe Connect Central and click Reports.
2. Click Virtual Classroom.
3. From the menu, select a virtual classroom report type: Virtual Classroom Courses Report or Virtual Classroom Session Attendance Report.
4. Select a virtual classroom from the Training library and click Next.
5. Click Specify Report Filters. (Optional) Enter a date range and/or select a specific User Group.
6. Click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
7. Click Create Report.

Read virtual classroom reports

The table lists the specific information that appears in columns within virtual classroom reports. All column headings do not appear in all virtual classroom reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number selected</td>
<td>Number of learners who selected this option.</td>
</tr>
<tr>
<td>Page name</td>
<td>Full name of the page. (For PDF content only.)</td>
</tr>
<tr>
<td>Page number</td>
<td>Number corresponding to the page number in the content file. (For PDF content only.)</td>
</tr>
<tr>
<td>Percentage selected</td>
<td>Percent of learners who selected this option.</td>
</tr>
<tr>
<td>Question description</td>
<td>The actual question from the question slide. For a multiple choice question, each possible choice is listed on its own line.</td>
</tr>
<tr>
<td>Question number</td>
<td>Number corresponding to the question number in the presentation.</td>
</tr>
<tr>
<td>Responses</td>
<td>Different possible responses to the question.</td>
</tr>
<tr>
<td>Slide name</td>
<td>Full name of the slide.</td>
</tr>
<tr>
<td>Slide number</td>
<td>Number corresponding to the slide number in the presentation.</td>
</tr>
<tr>
<td>Total duration</td>
<td>For movie or music file, the total length in hours/minutes/seconds of the file.</td>
</tr>
<tr>
<td>Total pages</td>
<td>For a PDF, the total number of pages in the file.</td>
</tr>
<tr>
<td>Total slides</td>
<td>For a presentation, the total number of slides in the file.</td>
</tr>
<tr>
<td>Total views</td>
<td>The total number of times this content was viewed.</td>
</tr>
<tr>
<td>Unique views</td>
<td>The number of uniquely identified viewers who accessed this content.</td>
</tr>
</tbody>
</table>
## Using meeting reports

Meeting room reports show how meeting rooms are being used. The Meeting Room Summary Report enables you to get data about an individual meeting room over time and across sessions. You can obtain information including total unique number of attendees, number of unique sessions, and average duration of a meeting. This information can help you determine if meeting room activity is low. Conversely, if the report shows that a meeting room is busy, you could create more meeting rooms to better manage the workload.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned role</td>
<td>Role as assigned on the manage enrollee page. (Does not show if role changed while in the virtual classroom.)</td>
</tr>
<tr>
<td>Date deleted</td>
<td>Date the learner was deleted from the virtual classroom.</td>
</tr>
<tr>
<td>Date enrolled</td>
<td>Date the learner was enrolled in the virtual classroom.</td>
</tr>
<tr>
<td>Date unenrolled</td>
<td>Date the learner was removed from the enrollment list for the virtual classroom.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of the specific virtual classroom session selected.</td>
</tr>
<tr>
<td>Email</td>
<td>E-mail address of the learner enrolled in the virtual classroom or the learner listed for the specific virtual classroom session selected.</td>
</tr>
<tr>
<td>First entry time</td>
<td>First time the learner entered the virtual classroom.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the learner enrolled in the virtual classroom.</td>
</tr>
<tr>
<td>Last access</td>
<td>Date when the learner last entered the virtual classroom.</td>
</tr>
<tr>
<td>Last exit time</td>
<td>The last time the learner exited the virtual classroom. (Learner may have entered and exited multiple times.) Changing status to “stepped away” does not count as an exit. Only a lost connection or a voluntary closure of the classroom window creates an exit time.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of the learner enrolled in the virtual classroom.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Yes value in this field indicates that the user accessed the meeting using a smartphone or a tablet. Else the value is No.</td>
</tr>
<tr>
<td>Multiple entrances logged</td>
<td>Lists if learner entered and exited more than once during this session.</td>
</tr>
<tr>
<td>Number complete</td>
<td>Learners who have completed the virtual classroom requirements.</td>
</tr>
<tr>
<td>Number in progress</td>
<td>Learners who have logged in, but not yet completed the virtual classroom requirements.</td>
</tr>
<tr>
<td>Number not started</td>
<td>Learners who have not logged in to the virtual classroom.</td>
</tr>
<tr>
<td>Participants attended</td>
<td>Total number of learners who at least entered the classroom. Does not include any learners with preassigned role of Host or Presenter.</td>
</tr>
<tr>
<td>Participants enrolled</td>
<td>Total number of participants enrolled in the virtual classroom. This number does not include participants assigned the Host or Presenter role.</td>
</tr>
<tr>
<td>Start time</td>
<td>Time that the specified virtual classroom session selected began.</td>
</tr>
<tr>
<td>Status</td>
<td>Where the learner is in the virtual classroom workflow. For example, if the learner has not entered the classroom yet, their status would be Not Taken. When a learner exits a virtual classroom, their status is Complete.</td>
</tr>
<tr>
<td>Total attended</td>
<td>Total number of learners who entered the specified virtual classroom session.</td>
</tr>
<tr>
<td>Total duration attended</td>
<td>Total amount of time (sum of all time between each entrance and exit) the learner was actually in the virtual classroom. If attendee was present, from 11:45-12:00 and then 12:10-12:15, their total duration would be 00:20:00.</td>
</tr>
<tr>
<td>Total enrolled</td>
<td>Total number of learners enrolled in the specified virtual classroom session.</td>
</tr>
</tbody>
</table>
The Individual Meeting Session Report enables you to view information about a specific session within a meeting room. You see details such as total number of attendees, total number of guests, and all attendee names. By comparing planned duration to actual session duration, you determine if a meeting ended sooner or later than planned. The information in this report also helps you determine if the correct people attended a specific meeting and how long they stayed in the room.

**Create meeting reports**
1. Log in to Adobe Connect Central and click Reports.
2. Click Meeting.
3. From the menu, select a meeting report type: Meeting Room Summary Report or Individual Meeting Session Report.
4. Select a meeting from the library and click Next.
5. Click Specify Report Filters. Optionally, enter a date range and/or select a specific User Group.
6. Click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
7. Click Create Report.

**Read meeting reports**
The table lists the specific information that appears in columns within meeting reports. All column headings do not appear in all meeting reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average duration</td>
<td>The average length of meeting sessions that took place in this meeting room.</td>
</tr>
<tr>
<td>Average duration attended per session</td>
<td>For the specific attendee, the average amount of time they spend in meetings in this meeting room.</td>
</tr>
<tr>
<td>Average users</td>
<td>Across all sessions in this meeting room, the average number of attendees in a session.</td>
</tr>
<tr>
<td>Current disk usage (kb)</td>
<td>Space usage, in KB, by this meeting room.</td>
</tr>
<tr>
<td>Date of session</td>
<td>The date this specific meeting session took place.</td>
</tr>
<tr>
<td>First entry time</td>
<td>Time that the first attendee entered the meeting room for this specific meeting session.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of meeting attendee.</td>
</tr>
<tr>
<td>First session</td>
<td>Date of the first meeting session that took place in this meeting room.</td>
</tr>
<tr>
<td>First session attended</td>
<td>The date the specific attendee first attended a meeting session in this meeting room.</td>
</tr>
<tr>
<td>Intermittent activity</td>
<td>Lists if attendee entered and exited more than once during this meeting session.</td>
</tr>
<tr>
<td>Last exit time</td>
<td>The last time the attendee exited the meeting. (The attendee may have entered and exited multiple times.) Changing status to stepped away does not count as an exit. Only a lost connection or voluntary closure of the meeting window creates an exit time.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of meeting attendee.</td>
</tr>
<tr>
<td>Manager</td>
<td>The first and last name of the user’s manager.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Yes value in this field indicates that the user accessed the meeting using a smartphone or a tablet. Else the value is No.</td>
</tr>
<tr>
<td>Most recent session</td>
<td>Date of the most recent meeting session that took place in this meeting room.</td>
</tr>
<tr>
<td>Most recent session attended</td>
<td>Date that this specific attendee last attended a meeting session in this meeting room.</td>
</tr>
</tbody>
</table>
Using system usage reports

System usage reports show, from different perspectives, how your organization is using Adobe Connect. All of the reports can be filtered by specifying a date range. Adobe Connect system administrators typically create and use system reports.

The system reports are different from each other and provide distinct data. First, you select a type of system report: Individual Usage, Group Usage, Cost Center Usage, Full System Usage, Burst Pack Usage, or Mobile Usage. Then, you are given specific options for the report you selected.

The Individual Usage report provides information about how a single user is interacting with Adobe Connect. The report includes total meeting minutes, total trainings completed, and total storage consumption. The report helps you determine how many meetings and training sessions a user has attended. The storage consumption number tells you which individuals uploaded the most content.

The Group Usage report shows many details about a group of users. The top of the report lists summary information about the group, including total number of members, total meeting minutes, and total consumption. The second section of the report lists the individual members and data for each, such as total meeting minutes, login status, and manager name. Run Group Usage reports for different groups to compare and see, for example, which groups are using Adobe Connect the most and least.

The Cost Center Usage Report shows how members of a specific cost center are using Adobe Connect. One section of the report lists individuals of the cost center and their system usage. Another section lists meetings billed to the cost center and details, such as total number of attendees and meeting owner name. The Cost Center Usage Report helps you track Adobe Connect minutes and costs. Run separate reports for different cost centers to compare their statistics. To get the same information as this report, that is run across all cost centers, rather than a single cost center, generate Consolidated Cost Center Usage report.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak users</td>
<td>Across all sessions, the highest number of attendees in the meeting room at the same time.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Time scheduled for the specific meeting session. (A meeting may be scheduled for one hour, but not actually use the entire hour.)</td>
</tr>
<tr>
<td>Role on entry</td>
<td>Attendee’s assigned role when they entered the meeting.</td>
</tr>
<tr>
<td>Total duration attended</td>
<td>Adds up all the times in between each entrance/exit and compiles the total amount of time the attendee was actually in the meeting. If the attendee was present from 11:45-12:00, and then from 12:10-12:15, their total duration would be 00:20:00</td>
</tr>
<tr>
<td>Total guests</td>
<td>Total number of guest entries. (Cannot determine unique guests.)</td>
</tr>
<tr>
<td>Total hosts assigned</td>
<td>Total number of attendees who entered the meeting with host status.</td>
</tr>
<tr>
<td>Total presenters assigned</td>
<td>Total number of attendees who entered the meeting with participant status.</td>
</tr>
<tr>
<td>Total time in meeting room</td>
<td>Total amount of time (sum of all time between each entrance and exit) the attendee was actually in the meeting room. If attendee was present, from 11:45-12:00 and then 12:10-12:15, their total duration would be 00:20:00.</td>
</tr>
<tr>
<td>Total unique attendees</td>
<td>Total number of separate, distinct attendees in the meeting room/session.</td>
</tr>
<tr>
<td>Total unique registered attendees</td>
<td>Total number of separate, distinct registered attendees in the room/session.</td>
</tr>
<tr>
<td>Unique sessions</td>
<td>Total number of separate, distinct meetings that took place in this meeting room.</td>
</tr>
<tr>
<td>Unique sessions attended</td>
<td>Total number of separate, distinct meeting sessions this individual has attended</td>
</tr>
</tbody>
</table>
The Full System Usage report provides a high-level summary of Adobe Connect usage. Optionally, filter the report by group and/or by specifying a date range. System, meeting, and training summaries are provided on a single page. This report is useful for telling management and other departments how your organization uses Adobe Connect.

The Burst Pack Usage Summary report lists how many burst packs minutes your organization is using. (Organizations purchase burst pack minutes when they require more minutes in a particular time period.) The report also shows the number of active rooms and the peak number of users. Use this report to control usage and costs of Adobe Connect.

The Mobile Usage report provides details about users accessing Adobe Connect from smartphone and tablets. The two mobile-related reports that are available are Mobile System Usage Report and Mobile Device Information Report. These reports show the device types, the total number of unique users who have connected to sessions with a mobile device, the total number of minutes spent connected from a mobile device, and the peak concurrent value of total number of mobile users. It is possible to distinguish between meeting, seminar, and virtual classroom mobile minutes. Also filters can be applied for date ranges, so that the administrators are able to see some trends over time.

Create system usage reports
1. Log in to Adobe Connect Central and click Reports.
2. Click System Usage.
3. From the menu, select a usage report type: Individual Usage, Group Usage, Cost Center Usage, Consolidated Cost Center Usage, Full System Usage, Burst Pack Usage, or Mobile Usage.
4. Select an individual, group, or cost center and click Next.
5. Click Specify Report Filters. (Optional) Enter a date range.
6. For Individual usage, Group Usage, Cost Center Usage reports, or Mobile Usage reports, click Add Or Remove Report Fields. Select and deselect the fields to display in the report.
7. Click Create Report.
8. (Optional) If you selected Cost Center Usage in step 3, click Download Report and choose a report to download as a spreadsheet.
9. (Optional) If you selected Burst Pack Usage in step 3, you can show the report by Hour or Day.

Read system usage reports
The table lists the specific information that appears in columns within system usage reports. All column headings do not appear in all system reports.

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active login users</td>
<td>Number of users in this group, cost center, or full system that are currently logged on the system.</td>
</tr>
<tr>
<td>Active room(s)</td>
<td>One or more rooms where overage minutes have been used.</td>
</tr>
<tr>
<td>Distinct meeting rooms</td>
<td>Number of separate meeting rooms owned by the individual, group, cost center, or the full system. If an individual has no host privileges, this number is zero.</td>
</tr>
<tr>
<td>End date</td>
<td>Date and time when the meeting session tracked in the report ended.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of an individual user.</td>
</tr>
<tr>
<td>Group</td>
<td>The name of the selected group. This column does not sort.</td>
</tr>
<tr>
<td>Last login date</td>
<td>Last date and time the individual, member of group, or member of cost center logged in to Adobe Connect.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of an individual user.</td>
</tr>
<tr>
<td>Column heading</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Login status</td>
<td>Status of the user. For example, if the user is not currently logged in to Adobe Connect, their status is Inactive.</td>
</tr>
<tr>
<td>Manager</td>
<td>The first and last name of this user's manager.</td>
</tr>
<tr>
<td>Meeting name</td>
<td>Name of a meeting billed to the selected cost center.</td>
</tr>
<tr>
<td>Meeting owner email</td>
<td>E-mail address of the person who created the meeting.</td>
</tr>
<tr>
<td>Meeting owner first name</td>
<td>First name of the person who created the meeting.</td>
</tr>
<tr>
<td>Meeting owner last name</td>
<td>Last name of the person who created the meeting.</td>
</tr>
<tr>
<td>Peak concurrent meeting users</td>
<td>Highest number of people in meeting rooms at the same time for the full system. For example, if the number is 100, 100 people is the largest number of people that were in meeting rooms at the same time.</td>
</tr>
<tr>
<td>Peak users</td>
<td>Highest number of users reached in room(s) where overage minutes have been used.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date and time when the meeting session tracked in the report started.</td>
</tr>
<tr>
<td>Storage consumption (kb)</td>
<td>Current amount of space, in KB, used by the individual, group, or cost center. In the Full system report, storage consumption numbers are listed for the entire system and for meetings.</td>
</tr>
<tr>
<td>Total attendees</td>
<td>Total number of attendees when unique attendees from each session are added. If the same person attended two sessions, they are counted twice in this total attendees number.</td>
</tr>
<tr>
<td>Total burst pack minutes</td>
<td>In the Cost Center Usage report, total burst pack minutes used by the entire cost center and for individual meetings billed to the cost center. In the Burst Pack report, the total number of burst pack minutes for the full system is listed.</td>
</tr>
<tr>
<td>Total host minutes (hh:mm:ss)</td>
<td>Total number of minutes the individual, group, group member, cost center, or cost center member spent in meeting rooms as a predefined host. Does not include host minutes when the user was temporarily promoted to the host role. In the Full System Usage report, the total host minutes for the entire Adobe Connect installation is listed.</td>
</tr>
<tr>
<td>Total hosts</td>
<td>Total number of users with host status in the group, cost center, and full system.</td>
</tr>
<tr>
<td>Total learner training completions</td>
<td>Total number of learners that completed courses and curriculums in the Full system.</td>
</tr>
<tr>
<td>Total Mobile Minutes</td>
<td>Duration of total mobile sessions attended or hosted by individual (in Individual Usage report) or by all the group members (in Group Usage report).</td>
</tr>
<tr>
<td>Total meeting minutes (hh:mm:ss)</td>
<td>Total number of minutes, across all roles and sessions, spent within meeting rooms by the individual, group, group member, cost center, or cost center member. The Full System Usage report shows total number of meeting minutes across all users in the system.</td>
</tr>
<tr>
<td>Total meeting sessions</td>
<td>Total number of individual meetings billed to the selected cost center.</td>
</tr>
<tr>
<td>Total training managers</td>
<td>Total number of individuals in the Adobe Connect system with training manager permissions.</td>
</tr>
<tr>
<td>Total training storage consumption</td>
<td>Total amount of storage (in KB) used for training objects, such as courses, curriculums, and virtual classrooms.</td>
</tr>
<tr>
<td>Total trainings completed</td>
<td>Total number of trainings (courses, curriculums, and virtual classrooms) completed by the individual, group, member of group, cost center, or member of cost center.</td>
</tr>
<tr>
<td>Total unique training objects</td>
<td>Total number of training objects (courses, curriculums, and virtual classrooms) in the full system.</td>
</tr>
<tr>
<td>Total users</td>
<td>Total number of users in the group, cost center, or full system.</td>
</tr>
</tbody>
</table>
View and download account summary reports

When you click the Administration tab, the Account Summary page appears. On this page, you can click the Reports link to access several reports that summarize account information. Some reports are downloadable and others are not.

View Mobile Usage Reports
1. Log in to Adobe Connect Central.
2. Click the Administration tab.
3. With Account selected, choose Reports.
4. Click View Mobile Usage Reports.
This report summarizes Adobe Connect usage through tablets and smartphones.

View Training Reports
This report summarizes learner quota information (number of learners compared with the number allowed).

Reports are available for accounts with the concurrent learner setup. These reports allow the Account Administrators to view information related to usage and license utilization.
1. Log in to Adobe Connect Central.
2. Click the Administration tab.
3. With Account selected, choose Reports.
4. Click View Training Reports.
The following information is available in the report, for a given duration:
• Peak concurrent learners using the account in the given period
• The numbers of users denied, during a given duration, due to concurrent users quota limit
Concurrent learner training reports

These two reports can be seen at a granularity of days, weeks, or months. The reports can be downloaded as CSV files too.

**View Meeting Reports**

1. Log in to Adobe Connect Central.
2. Click the Administration tab.
3. With Account selected, choose Reports.
4. Click View Meeting Reports.
This report shows the maximum number of attendees supported at one time (the concurrent peak) for the current month compared with the allowable quota.

This report also shows the number of users currently participating in meetings, both live and recorded. You can use this list to monitor meetings and click a meeting name to intervene. For example, to free up spaces for another meeting, enter an active meeting and send the host a message requesting that some participants leave the meeting.

**View and download Downloadable Reports**

1. Log in to Adobe Connect Central.
2. Click the Administration tab.
3. With Account selected, choose Reports.
4. Click View Downloadable Reports.
5. Click Report Filters and choose how to filter the data that the report returns.
6. Click one of the Download Report Data buttons.

You can download five different kinds of reports as CSV files that you can export to external systems.

*Note: Each downloaded report that you save is named “data.csv” by default. When you save the file, give it a unique identifying name; for example, “interactionsMarch05.csv.”*

**Interactions downloadable report data**

This report summarizes user access. A unique transaction ID is generated each time a user attends a meeting, attends a seminar, views content, takes a course, or accesses a curriculum. The Interactions report presents the following data:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>transaction-id</td>
<td>Unique ID for this transaction.</td>
</tr>
<tr>
<td>sco-id</td>
<td>Unique ID used by Learning Management System (LMS) to identify different Shareable Content Objects (SCO).</td>
</tr>
<tr>
<td>type</td>
<td>Type of object accessed, such as content, meeting, or event.</td>
</tr>
<tr>
<td>name</td>
<td>Object name as it appears in the content listing.</td>
</tr>
<tr>
<td>url</td>
<td>Object that the user accessed.</td>
</tr>
<tr>
<td>principal-id</td>
<td>Unique ID for the user.</td>
</tr>
<tr>
<td>login</td>
<td>Name of user who accessed this transaction.</td>
</tr>
<tr>
<td>user-name</td>
<td>Unique user name.</td>
</tr>
<tr>
<td>score</td>
<td>The score of the user.</td>
</tr>
<tr>
<td>status</td>
<td>Status of transaction: passed, failed, complete, or in-progress.</td>
</tr>
<tr>
<td>date-created</td>
<td>Date this transaction occurred.</td>
</tr>
<tr>
<td>date-closed</td>
<td>Date this transaction ended.</td>
</tr>
</tbody>
</table>

The Interaction report excludes certification numbers and max scores.

**Users downloadable report data**

This downloadable report lists users and associated profile attributes using data listed in the following table:
Data is generated in this view whenever a user creates, updates, or deletes a user.

If you select the Include Custom Fields option, custom information from user profiles is added to the report. When customizing user profiles, there are three mandatory fields (first name, last name, and e-mail) and you can include up to eight additional custom fields. To customize user profiles, choose Administration > Users and Groups > Customize User Profile. Move the eight additional fields you want to include to the top of the list.

The Users report excludes the following information:

- Password, which is not stored in plain text.
- Time zone and language, which are not available in human readable form; for example, PST is 323.

*Note: Deleted users do not appear in the Users report. Deleted users continue to exist in the Interactions report.*

**Assets downloadable report data**

Data is generated in an Assets report whenever a user creates a meeting, event, seminar, curriculum, or course, or uploads content. The report lists the following data on system objects (such as meetings, content, and courses):

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sco-id</td>
<td>Unique ID used by Learning Management System (LMS) to identify different Shareable Content Objects (SCO).</td>
</tr>
<tr>
<td>url</td>
<td>Unique identifier for the object.</td>
</tr>
<tr>
<td>type</td>
<td>Either a presentation, course, FLV file, SWF file, image, archive, meeting, curriculum, folder, or event.</td>
</tr>
<tr>
<td>name</td>
<td>Object name as it appears in the content listing.</td>
</tr>
<tr>
<td>date-created</td>
<td>Date on which the object is scheduled to begin.</td>
</tr>
<tr>
<td>date-end</td>
<td>Date on which the object is scheduled to end.</td>
</tr>
<tr>
<td>date-modified</td>
<td>Date this object was modified.</td>
</tr>
<tr>
<td>description</td>
<td>Object summary information entered when a new meeting, content, course, or other object type is created.</td>
</tr>
</tbody>
</table>

**Questions downloadable report data**

The Questions report lists responses to questions and quizzes from all the Adobe Connect applications. Data is generated in this report whenever a user answers a quiz question in a course or curriculum, answers a registration question, responds to a poll in a meeting or seminar, or adds a custom form to a meeting, seminar, course, or curriculum. The report provides the following information:
The Question report excludes the following information:

- Correct or Incorrect, which can be determined by checking for a nonzero score
- Date answered, which does not exist in the version 410 schema

**Slide Views downloadable report data**
The Slide Views report describes the slides or pages viewed by Adobe Connect users. Report data is generated whenever a user views content, a course, or a curriculum. The report provides the following data:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>transaction-id</td>
<td>Unique ID for this transaction.</td>
</tr>
<tr>
<td>page</td>
<td>Number of the slide or page that was viewed.</td>
</tr>
<tr>
<td>date-created</td>
<td>Date of the viewing.</td>
</tr>
<tr>
<td>principal-id</td>
<td>Unique ID for the user.</td>
</tr>
</tbody>
</table>